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Part 1
Getting Started

This part of the AdminStudio 10.0 User Guide includes the following chapters:

e AdminStudio 10.0 Help Library
e Getting Started with AdminStudio

e Using the AdminStudio Interface
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AdminStudio 10.0 Help Library

AdminStudio enables systems administrators to rapidly prepare error-free applications to deploy into their
enterprise environment through a structured process built on application management best practices.

The AdminStudio Start Page provides information on major tasks that you can accomplish using AdminStudio,
quick access to AdminStudio tools, and links to help resources.

The AdminStudio user documentation contains information about the functionality and features of all of the
components of AdminStudio and is presented in the following sections:

Table 1-1 « AdminStudio Help Library

Topic Content

Part 1: Getting Started

Getting Started with Describes how to use the AdminStudio Start Page tabs—which

AdminStudio provide process information on how to perform key tasks using
AdminStudio tools—to quickly get started evaluating and using
AdminStudio.

Using the AdminStudio Describes the AdminStudio Interface, the central application for

Interface AdminStudio. From it, you can launch the AdminStudio tools,

create workflow templates and projects, use AdminStudio
Enterprise Server tools, and connect to and create Application
Catalogs.
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Table 1-1 « AdminStudio Help Library (cont.)

Part 2: Managing Users, Roles, Permissio

]

Topic

Managing Users, Directory
Services, and User Logins

Managing Roles and
Permissions

Managing Application Catalog
Databases

Content

ns, Application Catalogs

Explains how to create an account for each person that you
want to have access to AdminStudio, and how to import users
or groups of users from a directory service. Also explains how
to set up the AdminStudio account, domain account, single
sign-on, and guest account login methods.

Explains how to create and edit roles to manage access to
AdminStudio functionality.

Explains how to use Application Manager to import
applications into the Application Catalog, organize them, and
set up automatic import. It also explains how to share
Application Catalog data in your enterprise.

Part 3: Repackaging and Customizing Installations

Repackaging Legacy
Installations Using the
Repackaging Wizard

Converting Legacy
Installations Using the
Repackager Interface

Performing Automated
Repackaging and Virtualization
Using the Automated
Application Converter

Explains how to use Repackager’s Repackaging Wizard to
convert existing legacy installations into Windows Installer
(MSI) packages.

Explains how to use the Repackager interface to create and
modify Repackager project files, and how to build those files
into InstallShield Editor projects or Windows Installer
packages.

Explains how to use the Automated Application Converter to
examine a group of setups and perform automated
virtualization of those setups (including peforming automated
repackaging of those setups that require it).

(:

Using the Virtual Package
Editor

Creating Customized Virtual
Applications

Explains how to use the Virtual Package Editor to edit App-V
packages and perform tasks such as customizing your App-V
applications, resolving virtualization Best Practice issues and
application conflicts, and fixing run-time problems.

Explains how to use the InstallShield Virtualization Assistants to
create customized virtual applications in the Microsoft App-V,
VMware ThinApp, and Citrix XenApp virtual application formats.
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"y
4
L]

Part 4: Testing Windows Installer Packages

Topic

Customizing and Authoring
Installations Using
InstaliShield

Customizing Installations
Using Tuner

Chapter 1: AdminStudio 10.0 Help Library

Content

Describes how to use InstallShield Editor to create setup
packages that utilize Windows Installer technology, while
harnessing the flexibility provided by InstallScript. Also explains
how to use InstallShield to create virtual applications.

Explains how to use Tuner to create a transform file to add to,
modify, or remove information from a Windows Installer
package.

Identifying and Resolving
Application Conflicts Using
ConflictSolver

Testing and Fixing Application
Compatibility Using
Compatibility Solver

Explains how to use ConflictSolver to identify conflicts
between Windows Installer packages before you deploy them,
and resolve the problems before they affect your end users.

Explains how to test for application readiness on Microsoft
Windows 7 (32-bit and 64-bit) and Windows Server 2008 R2
platforms, as well as compatibility with Internet Explorer 8.0.

Identifying and Resolving
Package Errors Using
PackageExpert

Analyzing the Impact of
Installing Microsoft Operating
System Patches

Isolating Applications Using
Application Isolation Wizard

Ensuring Package Quality
Using QualityMonitor

Explains how to use PackageExpert to automate the operation
of specific tests and resolutions against Windows Installer
(.msi) software packages. PackageExpert can check the
integrity of your Windows Installer packages, and identify and
resolve any issues relating to Windows Vista OS deployment.

Explains how to import Microsoft application patches into the
Application Catalog and thoroughly test the impact they will
have on your environment before they are deployed.

Explains how to use the Application Isolation Wizard to
solve component versioning conflicts by modifying an
application so it always loads the versions of
components—such as DLLs—with which it was originally
developed and tested.

Explains how to use QualityMonitor to run a series of built-in
tests to installed Windows Installer-based products, helping to
ensure they run correctly, especially in a locked-down
environment.
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Table 1-1 « AdminStudio Help Library (cont.)

Topic

Content

Part 5: Preparing Installations for Deployment

Preparing Packages for
Distribution Using Distribution
Wizard

Distributing Packages Using
Configuration Manager Web
Console

'

Analyzing Installations Prior to
Deployment

=
E!.'_i

:}1.

Explains how to use the Distribution Wizard to assist you in
deploying your package (and any associated transforms) to a
network location, an FTP server, as an administrative
installation, or using any of the following distribution
technologies:

®  Altiris

e LANDesk

e ManageSoft

e Marimba

® Microsoft Configuration Manager
e Microsoft SMS

e Tivoli

e ZENworks

Explains how to use Configuration Manager Web Console,
a Web-based application, to configure package distribution
options and distribute setup packages without going to
Configuration Manager Server.

Explains how to use the Predeployment Test tool to
determine if a Windows Installer .msi package will succeed or
fail when it is installed in production by finding issues with disk
space, install conditions, and conflicts with .msi packages
already installed on the system.

License-Enabling Packages
& Using FLEXwrap

Explains how to use FLEXwrap to inject software licensing
technology into existing Windows Installer (.msi) packages so
that they can track usage of the executables in those
packages.

Part 6: Using Enterprise Tools: Job Manager and Report Center

Generating and Viewing
Reports in Report Center

u

= Automating Tasks Using
E Job Manager

Explains how to use the Report Center to report on or view all
of the information regarding the applications in your
Application Catalog from a single location.

Explains how to use Job Manager to automate time
consuming application migration tasks, saving you time and
enabling you to enforce standardized business practices on
the packaging process.
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What's New in AdminStudio 10.0

Detailed information on the new features in AdminStudio 10.0 is available in the AdminStudio 10.0 Release Notes
You can view the Release Notes by selecting ReadMe from the Help menu of the AdminStudio interface.

A PDF version of the Release Notes is also available in the AdminStudio section of the Flexera Software Web site:

http://www.flexerasoftware.com/products/adminstudio/resources.htm

AdminStudio Editions and Components

AdminStudio 10.0 is available in Standard, Professional, and Enterprise Editions. You have the option of

purchasing an additional Virtualization Pack and Application Compatibility Pack. Also, functionality varies
depending upon whether you have purchased the Per Admin pricing model or the Per Desktop pricing model.

Table 1-2 * AdminStudio Editions and Components

Edition

Standard

AdminStudio

Tools

® Repackager

® Distribution Wizard

® FlexWrap
e InstallShield 2011
e Tuner

® Application Isolation Wizard

Functionality

e Windows Installer
repackaging

e Windows Installer
customization

® Preparation for distribution

AdminStudio 10.0 User Guide ADS-1000-UG00

Application
Virtualization Pack Compatibility Pack
Tools N/A

e Automated Application
Converter (Single
Application Version)

e Virtual Package Editor
® Microsoft App-V Assistant
e ThinApp Assistant

o Citrix Assistant

Functionality

e Convert to virtual
applications

® App-V package editing
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Table 1-2 « AdminStudio Editions and Components (cont.)

Edition

Professional

62

AdminStudio

Tools

Same as Standard, plus:

ConflictSolver
Application Manager
OS Snapshot Wizard
QualityMonitor

Predeployment Test

Functionality

Same as Standard, plus:

Application management

Testing, validation, and
conflict testing

Standard reporting

Virtualization Pack

Tools
Same as Standard, plus:

e Automated Application
Converter (Single
Application Version) with
Virtualization Suitability
Testing

Functionality

Same as Standard, plus:

e Test for virtualization
suitability

e Store App-V data in
Application Manager

® App-V package testing,
validation, and conflict
testing

e Automated conversion of

legacy packages to
Windows Installer

ADS-1000-UG00

Application
Compatibility Pack

Tools & Functionality

Compatibility Solver with the
following functionality:

® Project-level compatibility
assessment and cost/effort
reporting for all applications

® Application testing and
reporting for Windows 7 (32-
and 64-bit versions)

®  Auto-fixing for Windows 7
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Table 1-2 « AdminStudio Editions and Components (cont.)

Edition

Enterprise
(Per Admin)

Enterprise
(Per
Desktop)

AdminStudio 10.0 User Guide

AdminStudio

Tools
Same as Professional, plus:

e PackageExpert

® OS Security Patch Wizard
e Job Manager

e Report Center

e Software Repository

® Security Console
Functionality

Same as Professional, plus:

® Application Readiness
Dashboard

® Process and workgroup
management features

Tools & Functionality

Same as Enterprise
(Per Admin)

ADS-1000-UG00

Virtualization Pack

Tools
Same as Professional, plus:

e Automated Application
Converter (Multiple
Application Version) with
Suitability Testing

Functionality

Same as Professional, plus:

e Automated conversion of
multiple packages to virtual
applications

e Automated conversion of
multiple legacy packages to
Windows Installer

® Application Readiness
Dashboard (Including
Virtualization Reports)

Tools & Functionality

Same as Enterprise
(Per Admin)

AdminStudio Editions and Components

Application
Compatibility Pack

Tools & Functionality

All of the Compatibility Solver
functionality available in
Professional, plus:

e Detailed compatibility
assessment reports

® Application testing and
reporting for Windows 7 (32-
and 64-bit versions), and
Windows Server 2008 R2

e Merge multiple databases
for centralized reporting

Tools & Functionality

All of the Compatibility Solver
functionality available in
Enterprise (Per Admin), plus:

e Testing can be done on
groups of applications at a
time

Web Application
Compatibility (Optional)

® Test compatibility of web
applications with 1IS web
server

e Test compatibility of web
applications with Internet
Explorer 8 browser

® Test integration of desktop
application with Internet
Explorer 8 browser
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Documentation Edition Notes

Documentation on features that are only available in specific Editions or add-on Packs include the following notes:
Table 1-3 » Documentation Edition Notes

Edition/Pack Note

Professional
v |

Edition - This feature is included with AdminStudio Professional and Enterprise Editions.

Enterprise

Edition - This feature is included with AdminStudio Enterprise Edition.

Virtualization Pack

Edition ° This feature is included in the AdminStudio Virtualization Pack.

Application
Compatibility Pack

Edition - This feature is included in the AdminStudio Application Compatibility Pack.

E

Note * For a comprehensive list of the features available in the AdminStudio Standard, Professional, and Enterprise
Editions, plus the add-on features available for Enterprise Edition, see the AdminStudio Web site.

Activating AdminStudio

When you launch AdminStudio or one of its tools for the first time, you are notified that you are using a time-limited
trial version, and you are given the opportunity to evaluate the product or to activate it by entering a valid Serial
Number for an AdminStudio Edition.

Task: To activate AdminStudio:
1. Install AdminStudio, as described in the AdminStudio Client Tools Installation Guide.

2. Launch AdminStudio or one of its tools. A dialog box opens, stating that you are using a time-limited trial
version.

3. Select Activate or Purchase AdminStudio and click Next. The AdminStudio Product Activation dialog
box opens, prompting you to enter a serial number.

4. Enter the serial number of the edition you purchased and click the Activate button. After a few seconds, you
will receive a message that activation was successful.
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5. Click Finish. AdminStudio will launch.

E

Note - If you want to evaluate the AdminStudio Enterprise Server Web tools (Job Manager, Report Center, Security
Console), you need to obtain an Enterprise Server Evaluation Serial Number from an AdminStudio Sales
Representative.

Ports Used in Activation

AdminStudio product activation uses ports 80 (HTTP), 443 (HTTPS), and 8443. If these ports are locked down or if
you do not have an available internet connection, you can activate AdminStudio using one of the following
alternative methods:

e Self-hosted activation using FLEXnet License Server—Your organization can choose to purchase and
use a self-hosted FLEXnet License Server to manage their AdminStudio licenses. Using the FLEXnet License
Server eliminates the need to manually activate each installation of AdminStudio over the internet.

e Offline activation—You can perform offline activation using email.

Silent Activation

AdminStudio supports silent activation, enabling you to use public Windows Installer properties to enter the Serial
Number automatically and activate during installation. To enable silent activation, you need to set the PRODUCTID
and ASACTSTATUS public Windows Installer properties. The following is an example of how to accomplish this via the
command line:

<AdminStudio_Install_Directory>Setup.exe /v'"PRODUCTID=XXXXXXX-XXX-XXXXXXXXXX ASACTSTATUS=1"
You can additionally make the installation completely silent by adding the /s and /qgn switches as follows:

<AdminStudio_Install_Directory>Setup.exe /s /v'"PRODUCTID=XXXXXXX-XXX-XXXXXXXXXX ASACTSTATUS=1 /gn"

E

Note » Consult the Windows Installer Help Library for any additional Windows Installer command line options.

Evaluating AdminStudio

You can choose to evaluate AdminStudio for 21 days. By clicking Continue to Evaluate AdminStudio dialog box
that opens when you launch AdminStudio, you can begin evaluating the AdminStudio 10.0 Enterprise Edition client
tools. To evaluate the AdminStudio Enterprise Server Web tools, you need to contact AdminStudio Sales and
obtain an evaluation serial number.

Information about evaluating AdminStudio is presented in the following sections:
e FEvaluating AdminStudio Enterprise Edition Client Tools
e Evaluating AdminStudio’s Microsoft App-V Support
e Evaluating the Automated Application Converter “Multiple Application” Option

e FEvaluating the AdminStudio Enterprise Server Web Tools
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Task:
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Evaluating AdminStudio Enterprise Edition Client Tools

To evaluate the Enterprise Edition client tools, perform the following steps.

To evaluate the AdminStudio Enterprise Edition client tools:
1. Install AdminStudio, as described in the AdminStudio Client Tools Installation Guide.
2. Launch AdminStudio. A dialog box opens, stating that you are using a time-limited trial version.

3. If you want to evaluate AdminStudio, select Continue to Evaluate AdminStudio and click Next (or just wait
ten seconds). The product will launch.

e  When you run AdminStudio in this trial mode, all of its features are fully available.

e Each time you open AdminStudio while you are in evaluation mode, this dialog box shows you how many
days are left in your trial period.

4. If you have five or fewer days left in your trial period, the dialog box remains open, requiring you to click before
you can proceed. Do one of the following:

a. |If your trial period is not over, you can continue to use AdminStudio by selecting the Continue to
Evaluate AdminStudio option and clicking Next.

b. If you have already purchased a serial number or want to purchase one online, select Activate or
Purchase AdminStudio and click Next.

Evaluating AdminStudio’s Microsoft App-V Support

While evaluating the AdminStudio Enterprise Edition client tools, you will be able to convert a Windows Installer
package to an App-V application using the Automated Application Converter, Repackager, and the InstallShield

App-V Assistant. However, an App-V application built using an evaluation version of AdminStudio will display the
following message every time it is launched:

Thiz package wasz created with an evaluation verzion of InstallShield.

Figure 1-1: Evaluation Version Message

After purchasing the AdminStudio Virtualization Pack, you will be able to remove this message by rebuilding the
App-V application.
Evaluating the Automated Application Converter “Multiple Application” Option

The Multiple Application option of Automated Application Converter is only available when purchased on the
AdminStudio “Per Desktop” licensing model.

E

Note - If you purchase Automated Application Converter on the “Per Admin” licensing model, you will only be able
to convert one package at a time, using one virtual machine.
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When using an evaluation version of AdminStudio, you will be able to use the Multiple Application option to convert
a directory full of Windows Installer packages into individual virtual packages, but the conversion will be limited to
three packages per run, using only one virtual machine. Therefore, only the first three packages that Automated
Application Converter encounters will be converted to virtual applications.

Evaluating the AdminStudio Enterprise Server Web Tools

If you want to evaluate the AdminStudio Enterprise Server Web tools (Job Manager, Report Center, Security
Console), you need to obtain an AdminStudio Enterprise Server Evaluation Serial Number from an AdminStudio
Sales Representative.

Task: To evaluate the AdminStudio Enterprise Server Web tools:

1.

2.

5.

Follow the steps in Evaluating AdminStudio Enterprise Edition Client Tools.

Contact an AdminStudio Sales Representative and obtain an AdminStudio Enterprise Server Evaluation Serial
Number.

Open the AdminStudio interface and select About AdminStudio from the Help menu.

Click Activate. The Upgrade and Activate dialog box opens.

AdminStudio

Upgrade and Activate 4
Available AdminStudio Editions ‘

I vou have a valid serial number, click O to activate or upgrade vour current edition.
‘fou can view more details about each edition on the AdminStudio Web site or by clicking any of the
edition's hyperlinks.

° Enterprise Edition Enterprise-class solution; includes web-based server access with
additional security, reporting and automation,

@ Professional Edition  Designed For professional packagers; includes application management;
includes testing and conflict resolution; includes distribution options,

O Standard Edition Entry level option; basic repackaging and editing.

wehich edition is right for me?

Buy onling

[ OK H Caniel ]

Select the | have an AdminStudio Enterprise Server evaluation serial number option and click OK. The
Evaluate Enterprise Edition dialog box opens.

Evaluate AdminStudio Enterprise Server,

Enter below the serial number you obtained from the sales department ko
enable the evaluation of AdminStudio Enterprise Server,

AdminStudio Enterprise Server Evaluation Serial Mumber:

Cancel
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6. Enter the serial number and click OK. You will be prompted to install the AdminStudio Enterprise Server on the
current machine.

7. Click Yes. The AdminStudio Enterprise Server installation begins.

8. Install AdminStudio Enterprise Server, as described in the AdminStudio and Workflow Manager Installation
Guide, which is available on the AdminStudio Downloads site.

Upgrading Your Product Edition

Task:

An upgrade feature has been built-in to AdminStudio that allows you to activate features in a higher Edition without
re-installing the application. You just need to enter a Serial Number for the upgrade that you purchased, and the
features of that Edition are immediately unlocked and are available to you.

To upgrade, perform the following steps:

To upgrade your AdminStudio Edition:

1. Contact an AdminStudio Sales Representative and purchase a Serial Number for the desired Edition.
2. Launch AdminStudio.

3. Onthe Help menu, click About AdminStudio. The About AdminStudio dialog box opens.

4. Click the Upgrade button. The Upgrade and Activate dialog box opens.

5. Click OK to upgrade your edition. The AdminStudio Product Activation dialog box opens, prompting you
to enter the serial number of the edition that you want to upgrade to.

6. Enter the serial number of the edition you purchased and click the Activate button. After a few seconds, you
will receive a message that activation was successful. The functionality of the upgraded edition is immediately
available to you.

Using Help

68

Help is available both from the AdminStudio interface Help menu and directly from certain individual interface
elements.

When you have questions about this product, first consult the AdminStudio Help Library, which is the complete
user’s guide for using AdminStudio.

Web-Based Online Help
Web-based online help is available to you 24 hours a day, seven days a week, on our Web site at:

http://helpnet.flexerasoftware.com
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Documentation as PDF
AdminStudio documentation is also available as a PDF. Visit the AdminStudio Downloads site at:

http://www.flexerasoftware.com/downloads.htm

Help Conventions

In this documentation, reader alert and style conventions are used to bring your attention to specific information or
help you identify information.

e Reader Alert Conventions

e Style Conventions

Reader Alert Conventions

Reader alerts are used throughout this documentation to notify you of both supplementary and essential
information. The following table explains the meaning of each alert.

Table 1-4 « Reader Alert Conventions

Image Alert Name Description

— Note Notes are used to draw attention to pieces of information that should stand
=i out.

0 Important Note Important notes are used for information that is essential for users to read.
& Caution Cautions indicate that this information is critical to the success of the desired

feature or product functionality.

ey Tip Tips are used to indicate helpful information that could assist you in better
‘n-P utilizing the desired function or feature.
. Best Practices Best Practices alerts instruct you on the best way to accomplish a task.
W
- Edition-Specific = Edition-specific notes indicate that the information applies to a specific edition
L= Note of a product (such as Professional or Premier edition).
Procedure The Procedure graphic indicates that procedural instructions follow.

=
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Style Conventions

The following style conventions are used throughout this documentation.

Table 1-5 * Style Conventions

Style

User
Interface
Elements

Variables

Code

User-
Inputted Text

File Names
and Directory
Paths

.INI File Text

Command-
Line
Statements

Environment

Example

On the File menu, click Open.

fileName

#define HWND_BROADCAST Oxffff

Type $D(install).

My files are located in the
C:\MyDocuments\SampleCode directory.

Insert the line LimitedUI=Y into the file to display
only the Welcome dialog box when the
Windows Installer package is run.

To run the installation silently, enter:

Setup.exe /s /v/qn

Set the value of the windir environment

Description

User interface elements appear in bold
when referenced in tasks.

Variables appear in italics.

Code snippets appear in a monospace
typeface.

Text that is to be entered as a literal value
is displayed in a monospace typeface, in
bold, and in blue.

File names and directory paths are

presented in a monospace typeface.

Text in .INI files is presented in a
monospace typeface.

Command-line statements and
parameters are presented in a
monospace typeface.

Environment variables are presented in a

Variables variable. monospace typeface.

Examples Create two groups, one called Admin and the Examples are presented in bold.
other called General.

Functions FeatureAddItem adds a new feature to a Functions are presented in presented in
script-created feature set. bold.

Properties In the Name property, enter a name for this Properties are presented in bold.
custom control that is unique among all of the
controls in your project.

Screen If you type an incorrect parameter, the message = Screen output (from a log file or from the

Output The system cannot find the path specified. | console) is displayed in a monospace

is displayed.

typeface, and in blue.
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Style

Links

Example

Obtain the latest white papers, project samples,
and more from:

http://www.mycompany.com/downloads.htm

Chapter 1: AdminStudio 10.0 Help Library
Contacting Us

Description

Links appear in blue.

Contacting Us

You may contact us from anywhere in the world by visiting our Web site at:

http://www.flexerasoftware.com

AdminStudio 10.0 User Guide

ADS-1000-UG00
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Getting Started with AdminStudio

The AdminStudio Start Page, which is designed to help you quickly get started evaluating and using AdminStudio,
provides process information on how to perform key tasks using AdminStudio tools. Information is organized into
the following tabs:

Table 2-1 + AdminStudio Start Page Organization

Icon

(FR\.

Start Page Tab

Getting Started

Description

Describes the main tasks that you can use AdminStudio to accomplish,
and provides links to additional information. See Getting Started Tab.

Test for Application
Compatibility

Migrate to
Application
Virtualization

Migrate to Windows
Installer

Provides a flowchart that outlines how to use Compatibility Solver to
test for application readiness on Microsoft Windows 7 32-bit and 64-bit
platforms, as well as compatibility with Internet Explorer 8.0. See Test
for Application Compatibility Tab.

Provides a flowchart that outlines the steps required to migrate your
application portfolio into virtual applications that are ready for
deployment within the enterprise. See Migrate to Application
Virtualization Tab.

Provides a flowchart that outlines the steps required to migrate legacy
setups (such as .exe files) to deployable Windows Installer packages
(.ms1i). See Migrate to Windows Installer Tab.

AdminStudio 10.0 User Guide

Set Up Infrastructure

ADS-1000-UG00

Lists the infrastructure setup steps that you need to perform prior to
using AdminStudio for the first time: connect to an Application Catalog,
configure virtual machines, set e-mail notification settings, and
configure Compatibility Solver. See Set Up Infrastructure Tab.
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Getting Started Tab

The Getting Started tab of the AdminStudio Start Page describes the main tasks that you can use AdminStudio to
accomplish, and provides links to additional information. It also provides a link to information on setting up
AdminStudio infrastructure.

To quickly get started evaluating and using AdminStudio, click on the link of the task you want to accomplish:

Table 2-2 * Getting Started Tab

Link Description

Test for Application Test for application readiness on Microsoft Windows 7 (32-bit and 64-bit) and

Compatibility Windows Server 2008 R2 platforms, as well as compatibility with Internet Explorer
8.0.

Migrate to Automatically repackage and convert Windows Installer packages, as well as setups

Application in other formats, into virtual applications in Microsoft App-V, VMware ThinApp, and

Virtualization Citrix XenApp formats.

Migrate to Windows Capture, repackage, and customize installations, analyze packages for conflicts with
Installer target applications, and prepare packages for distribution.

Set Up Infrastructure | Create/connect to a Microsoft SQL Server Application Catalog database. Prepare
virtual machines for use in automated repackaging and testing.
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Test for Application Compatibility Tab

Edition « AdminStudio Compatibility Solver is included in the AdminStudio Application Compatibility Pack. Support
for Internet Explorer 8 is included in the Web Application Compatibility Pack.

The flowchart on this tab outlines how to use Compatibility Solver to test for application readiness on Microsoft
Windows 7 (32-bit and 64-bit) and Windows Server 2008 platforms, as well as compatibility with Internet Explorer
8.0.

E

Note -« Prior to performing these steps, you should have already set up infrastructure as outlined in the Set Up
Infrastructure Tab.

To test for application compatibility, perform the following steps:
e Perform Portfolio Application Compatibility Reporting (Migration Project Scoping)
e Pinpoint Specific Compatibility Issues

e Fix Compatibility Issues

Perform Portfolio Application Compatibility Reporting
(Migration Project Scoping)

For instructions on how to perform portfolio application compatibility reporting, see the following help topics:

Table 2-3 * Perform Portfolio Application Compatibility Reporting (Migration Project Scoping)

# Step Description
1 Browse for or Drag and Drop See Importing Packages into Compatibility Solver.
Packages

The Compatiblity Solver Help Library is available on Flexera
Software’s HelpNet site:

http://helpnet.flexerasoftware.com

2 Select the Platform Reports to See Selecting the Platforms for the Summary Application
Run Compatibility Report.

The Compatiblity Solver Help Library is available on Flexera
Software’s HelpNet site:

http://helpnet.flexerasoftware.com
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Table 2-3 - Perform Portfolio Application Compatibility Reporting (Migration Project Scoping)

#

3

4

Step

Load Packages to Test

View Summary Application
Compatibility Report

Description

See Loading Packages in Compatibility Solver.

The Compatiblity Solver Help Library is available on Flexera
Software’s HelpNet site:

http://helpnet.flexerasoftware.com

See Viewing the Summary Application Compatibility Report.

The Compatiblity Solver Help Library is available on Flexera
Software’s HelpNet site:

http://helpnet.flexerasoftware.com

Pinpoint Specific Compatibility Issues

For instructions on how to pinpoint specific compatibility issues, see the following help topics:

Table 2-4 - Pinpoint Specific Compatibility Issues

#

5

Step

Select Packages to Test

Run Compatibility Assessment
of Packages

Description

See Selecting Packages.

The Compatiblity Solver Help Library is available on Flexera
Software’s HelpNet site:

http://helpnet.flexerasoftware.com

See Running Reports.

The Compatiblity Solver Help Library is available on Flexera
Software’s HelpNet site:

http://helpnet.flexerasoftware.com
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View the Status and Details of
Detected Compatibility Issues

Click on the Fixes Available Icon
to View Description of Issues
With Fixes

See Viewing Reports.

The Compatiblity Solver Help Library is available on Flexera
Software’s HelpNet site:

http://helpnet.flexerasoftware.com

See Viewing Descriptions of Issues and Available Fixes.

The Compatiblity Solver Help Library is available on Flexera
Software’s HelpNet site:

http://helpnet.flexerasoftware.com
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For instructions on how to fix compatibility issues, see the following help topics:

Table 2-5 « Fix Compatibility Issues

# Step

9 Select Packages to Fix

10 Click Fix to Automatically
Remediate the Selected Issues
by Generating Transform Files

AdminStudio 10.0 User Guide ADS-1000-UG00

Description

See Fixing Application Issues.

The Compatiblity Solver Help Library is available on Flexera
Software’s HelpNet site:

http://helpnet.flexerasoftware.com

See Fixing Application Issues.

The Compatiblity Solver Help Library is available on Flexera
Software’s HelpNet site:

http://helpnet.flexerasoftware.com
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Migrate to Application Virtualization Tab

The flowchart on this tab outlines the steps required to migrate your application portfolio into virtual applications
that are ready for deployment within the enterprise.

E

Note -« Prior to performing these steps, you should have already set up infrastructure as outlined in the Set Up
Infrastructure Tab.

To migrate a Windows Installer or legacy application to a virtual package, perform the following steps:
e Identify Packages to Virtualize
e Convert to Virtual Formats

e Test and Distribute Converted Packages

Identify Packages to Virtualize

For instructions on how to identify the packages to virtualize, see the following help topics:

Table 2-6 * Identify Packages to Virtualize

# Step Description
1 Import Packages into For instructions on how to import Windows Installer and legacy
Application Catalog applications into the Application Catalog, see:

e Importing a Single Windows Installer or Virtual Package

® Importing a Directory of Windows Installer and/or App-V
Packages

e Importing Windows Installer and/or App-V Packages From
Microsoft Configuration Manager

e Importing Other Setup Types

2 View Virtualization Suitability For instructions on how to view the virtualization readiness status
Report of imported packages, see Viewing the Virtualization Readiness
Status of Applications.

3 Identify Candidates for Based upon the virtualization readiness information reported,

Virtualization decide which of the imported applications to select for
virtualization.
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For instructions on how to convert a package to a virtual format, see the following help topics:

Table 2-7 « Convert to Virtual Formats

# Step

4 Import Candidate Packages into
Automated Application
Converter

5 Convert to Virtual Packages

6 Test Launch Virtual Packages

Description

For instructions on how to import candidate packages into
Automated Application Converter, see:

® Selecting Packages from an AdminStudio Application
Catalog or Microsoft Configuration Manager Server

e Selecting Packages from a Local Machine or Network

For instructions on convert selected packages to virtual
packages, see Performing a Conversion Using the Application
Conversion Wizard.

For instructions on how to test the virtual packages that you have
just created, see Launching Packages for Testing.

7 Publish Virtual Packages to

Application Catalog

For instructions on how to publish converted packages to the
Application Catalog, see Publishing Converted Packages.

Test and Distribute Converted Packages

For instructions on how to test and distribute converted virtual packages, see the following help topics:

Table 2-8 * Test and Distribute Converted Packages

# Step

8 Perform Validation Against
Virtualization Best Practices

9 Perform Conflict Analysis
Against Other Packages

10 Edit App-V Packages
(If Necessary)

AdminStudio 10.0 User Guide
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Description

For instructions on how to validate App-V packages against
virtualization Best Practice rules, see Performing Best Practice
Analysis of App-V Packages.

For instructions on how to perform conflict analysis of an App-V
packages other packages, see Performing Conflict Analysis of
App-V Packages.

To resolve any warnings or errors that were found during testing,

you can edit the App-V package in the Virtual Package Editor, as
described in Using the Virtual Package Editor.
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Table 2-8 « Test and Distribute Converted Packages

# Step Description

11 Distribute to Enterprise for User  For instructions on how to distribute an App-V package to your
Acceptance Testing and enterprise, see Preparing Packages for Distribution Using
Production Distribution Wizard.

Migrate to Windows Installer Tab

The flowchart on this tab outlines the steps required to migrate legacy applications to Windows Installer packages
that are ready for deployment within the enterprise.

E

Note -« Prior to performing these steps, you should have already set up infrastructure as outlined in the Set Up
Infrastructure Tab.

To migrate a legacy application to a Windows Installer package, perform the following steps:
® Repackage Legacy Package
e Import Into Application Catalog

e Test and Distribute Repackaged Applications

Repackage Legacy Package

For instructions on how to repackage a legacy package, see the following help topics:

Table 2-9 » Repackage Legacy Package

# Step Description
1 Select legacy packages (.exe) For instructions about how to get started with repackaging, see
About Repackaging.
2 Repackage to Windows Installer = For instructions on how to repackage a Windows Installer
Package (.msi) package, see Repackaging Legacy Installations Using the
Repackaging Wizard.
3 Edit Packages in Repackager For instructions on how to edit a Repackager project, see

Working With Repackager Projects.
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Import Into Application Catalog

For instructions on how to import a package into the Application Catalog, see the following help topics:

Table 2-10 » Repackage Legacy Package

# Step Description

4 Import Windows Installer For instructions on how to import a Windows Installer package
Package Into Application into the Application Catalog, see Importing a Single Windows
Catalog Installer or Virtual Package.

Test and Distribute Repackaged Applications

For instructions on how to test and distribute a repackaged application, see the following help topics:

Table 2-11 - Test and Distribute Repackaged Applications

# Step Description

5 Validate Package Against MSI For instructions on how to validate a package against Microsoft
Best Practices (ICE Rules) ICE rules, see Performing Validation.

6 Check Package Integrity Against = For instructions on how to validate a package against
Best Practices (ACE Rules) AdminStudio Best Practice ACE rules, see Checking for

Conflicts.

7 Perform Conflict Detection and For instructions on how to perform conflict analysis and
Resolution resolution, see Checking for Conflicts and Resolving Conflicts.

8 Distribute Package For instructions on how to distribute a package, see Preparing

Packages for Distribution Using Distribution Wizard.
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Set Up Infrastructure Tab

To get started using AdminStudio, you need to connect to a Microsoft SQL Server Application Catalog database,
and prepare virtual machines for use in automated repackaging and testing. To get started using Compatibility
Solver, you need to create a new database and download the latest report upgrades.

e Create/Connect to an Application Catalog

e Configure Virtual Machines
e Set E-Mail Notification Settings

e Configure Compatibility Solver

Create/Connect to an Application Catalog

For instructions on create a new Application Catalog or connect to an existing one, see the following help topics:

Table 2-12 « Create/Connect to an Application Catalog

Step

Create/Connect to an
Application Catalog

Enable Software Repository

Set Default Application Catalog

82

Description

For instructions on how to create or connect to an Application Catalog,
see Creating and Connecting to Application Catalogs.

For instructions on enabling the Software Repository, see Using the
Software Repository.

For instructions on setting the default Application Catalog, see
Specifying a Default AdminStudio Application Catalog.
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Configure Virtual Machines

For instructions on how to configure virtual machines for use with Automated Application Converter, see the
following help topics:

Table 2-13 « Configure Virtual Machines

Step Description

Run Virtual Machine Preparation @ For instructions on how to run the virtual machine preparation setup,

Setup to Enable Auto Login see Preparing Your Virtual Machines for Use With the Automated
Application Converter and Running the Virtual Machine Preparation
Setup.

Create a Snapshot For instructions on how to create a snapshot on your virtual machine,

see Taking a Snapshot.

Install VMware VIX For instructions on how to install VMware VIX, see VMware VIX API
Requirement.

Test Virtual Machine Setup by For instructions on how to test a virtual machine setup, see Using the
Converting a Simple Package Application Conversion Wizard to Perform Automated Package
Conversion.

Set E-Mail Notification Settings

For instructions on how to set e-mail notification settings, see the following help topics:

Table 2-14 « Set E-Mail Notification Settings

Step Description

Set SMTP Notification Settings For instructions on setting SMTP notification settings, see Setting
E-Mail Notification Settings.
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Configure Compatibility Solver

For instructions on how to configure Compatibility Solver, see the following help topics:

Table 2-15 » Configure Compatibility Solver

Step Description
Create Compatibility Solver See Creating a New Database.
Database

The Compatiblity Solver Help Library is available on Flexera Software’s
HelpNet site:

http://helpnet.flexerasoftware.com

Load Report Upgrades See Downloading and Importing Reports (Plugins).

The Compatiblity Solver Help Library is available on Flexera Software’s
HelpNet site:

http://helpnet.flexerasoftware.com
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Using the AdminStudio Interface

The AdminStudio interface is the central application for AdminStudio. From it, you can launch AdminStudio tools,
launch the Process Assistant, create workflow templates and projects, and connect to and create Application
Catalogs. You can launch the AdminStudio interface from the Windows Start menu.

E

Note * The Process Assistant is a procedure-based alternative interface to the standard AdminStudio interface. For
more information, see Using the Process Assistant.

AdminStudio interface documentation is presented in the following sections:

Table 3-1 « AdminStudio interface Documentation

Section

Configuring the
AdminStudio Interface

Description

Includes information on customizing the AdminStudio Interface, including
setting shared directories.

Working with Tools

Workflows and Projects

Frequently Asked
Questions

Explains how to configure AdminStudio tools and also external tools
necessary to perform workflow tasks.

Explains how to use workflow functionality to define repeatable processes to
accomplish your goals.

A list of questions frequently asked by AdminStudio users, with links to the
appropriate help topics.

AdminStudio Interface
Reference

AdminStudio 10.0 User Guide ADS-1000-UG00

This section contains an exhaustive description of each dialog box, Wizard,
and Ul element in AdminStudio.
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Configuring the AdminStudio Interface

This section explains how to configure and customize the AdminStudio interface. The following topics are

discussed:

Table 3-2 » Topics on AdminStudio Interface Configuration

Category

Launching Applications

Configuring Application
Catalog Settings

Setting Interface
Preferences

Configuring Interactivity
Settings

Topics

® Launching AdminStudio Applications

e Specifying the Shared AdminStudio Application Catalog
® Specifying the AdminStudio Shared Location

e Setting E-Mail Notification Settings

e Setting the Workflow Task Help Page Location

e Configuring How Often AdminStudio Checks for Updates
e Configuring AdminStudio to Stay on Top

® Generating a Debug Log for AdminStudio

® Specifying the AdminStudio Enterprise Server URL
e Specifying the Configuration Manager Web Console URL

Launching AdminStudio Applications

Individual AdminStudio applications, such as ConflictSolver, InstallShield Editor, or Repackager, can be launched
from the Windows Start menu or by double-clicking on the tool icon in the Tools Gallery on the Tools Tab.

86
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Figure 3-1: Tools Gallery on the Tools Tab

E

Note - If a core AdminStudio tool is not in the Tools Gallery or available from the menu, it may mean that either you

are not assigned to a Role that has permission to use that Tool, or that the Tool is not available in your Edition of
AdminStudio.

E

Note ° You can also launch AdminStudio tools from the Process Assistant. See Using the Process Assistant for
more information.
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Specifying the Shared AdminStudio Application Catalog

W

Task:

This field displays the name and location of the shared AdminStudio Application Catalog. Click the Browse button
to connect to another Application Catalog using the Connect to Application Catalog dialog box.

To specify the location of the AdminStudio Shared Location:

1. Launch the AdminStudio interface.
2. From the Tools menu, select Options. The Options dialog box opens.
3. Select the Application Catalog tab.

4. Select the Shared AdminStudio Application Catalog.

5. Click OK to close the Options dialog box.

Specifying the AdminStudio Shared Location

Task:

88

The AdminStudio Shared Directory (also referred to as the AdminStudio Shared Location) contains shared
information for repackaging and conflict identification, and other AdminStudio functions. The AdminStudio Shared
Directory contains the following:

e The Shared AdminStudio.ini file, which specifies default Application Catalog database settings
e Application Manager duplicate package identifier options

® Repackager isrepackager.ini exclusion list

® OS Snapshot issnapshot.ini file

e ConflictSolver user-defined ACEs

e Distribution Wizard Distribution Type templates and .1ini files

If you are working in a team environment, the AdminStudio Shared Directory should be set to a centralized network
location, accessible by all AdminStudio users at your organization, rather than on your local machine. Follow the
steps below to specify the location of the AdminStudio Shared Directory.

E

Note * To maintain consistency when creating workflows, InstallShield recommends that you set the AdminStudio
Shared Directory the same for each AdminStudio user.

To specify the location of the AdminStudio Shared Directory:
1. Launch the AdminStudio Interface.

2. From the Tools menu, select Options. The Options dialog box opens.
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3. Inthe Options dialog box, select the Locations tab.
4. Enter or browse to the directory for the AdminStudio Shared Location.

5. Click OK to close the Options dialog box.

Setting E-Mail Notification Settings

To enable AdminStudio to send you e-mail notifications during various processes, you need to configure your
SMTP notification settings.

E

Note « Currently, e-mail notifications are sent when soft time-outs are encountered while using Automated

Application Converter to repackage an application on a virtual machine.

To set your e-mail notification settings, perform the following steps:

Task: To set e-mail notification settings:
1. Launch the AdminStudio interface.
2. From the Tools menu, select Options. The Options dialog box opens.
3. Select the Notification Settings tab.

4. On the Notification Settings tab, enter the following information:

Option Description

SMTP Server Enter the address of your e-mail server, such as:

smtp.yourcompany .com

Authentication Specify how your e-mail is authenticated by selecting one of the following
options:

e Server Authentication—Select this option if you want to perform server
authentication on your AdminStudio e-mail.

e Anonymous—Select this option if you do not want to perform
authentication on your AdminStudio e-mail.

Domain Enter the Domain of the user account listed in the User Name field.

User Name Enter the name of an existing user account in the Domain specified in the
Domain field. This user must have permission to send e-mail.
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Option Description

Password Enter the password of the user account defined in the User Name and
Domain fields.

E

Note ° If your network domain requires that user passwords are changed periodically, you
will have to open this dialog box again to update this account’s password. To avoid this, try
to obtain a user account that has a password that does not expire.

From E-Mail ID Enter the e-mail address to serve as the identity of AdminStudio. All e-mails sent
by AdminStudio will have this e-mail address in the From field.

To E-Mail ID(s) Enter the e-mail address to serve as the system account for AdminStudio e-
mail. All e-mails sent to AdminStudio will be sent to this address.

SMTP Server Port Enter the port of your SMTP server.
Use SSL Select this option if you want to use SSL security for the AdminStudio e-mail
account.
5. Click OK.

Setting the Workflow Task Help Page Location

The Task Help Page Location is the directory where you want to store all HTML pages that serve as workflow
task instructions.

W

Task: To specify the location of task help pages:
1. Launch the AdminStudio interface.
2. From the Tools menu, select Options.The Options dialog box opens.
3. Select the Locations tab.
4. Enter or browse to the Task Help Page Location, the location where workflow task help pages are stored.

5. Click OK to close the Options dialog box.

Configuring How Often AdminStudio Checks for Updates

You specify how often you want AdminStudio to check for updates on the Updates tab of the Options dialog box.
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Task: To configure how often AdminStudio checks for updates:

1.

2.

Open AdminStudio.

On the Tools menu, click Options. The Options dialog box opens.

On the Updates tab, select the frequency that AdminStudio will check for software updates:
® Once every 15 days

® Once every 30 days

® Once every 60 days

e Never

Click OK to close the Options dialog box.

Configuring AdminStudio to Stay on Top

When you launch AdminStudio tools, you can specify whether they open in front of or behind the AdminStudio
interface. If you select Always on Top from the View menu, application will always open behind the AdminStudio
interface.

Task: To configure AdminStudio to stay on top of other applications:

1.

2.

Launch the AdminStudio interface.

From the View menu, select Always on Top.

Generating a Debug Log for AdminStudio

To create a debug log for AdminStudio, perform the following steps.

W

Task: To generate a debug log for AdminStudio:

Use the following registry value to turn debugging on. Once this debugging is turned on, a log file will be created in
the same location as the .exe file.

[HKLM\Software\Instal1Shield\AdminStudio] DebuglLoglLevel="3"

Levels 0, 1, 2, 3 are supported with 3 being the highest. Default is level 0.
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Specifying the AdminStudio Enterprise Server URL

You specify the Web site URL of AdminStudio Enterprise Server on the Application Catalog tab of the Options
dialog box.

W

Task: To specify the AdminStudio Enterprise Server URL:

-k
.

Launch the AdminStudio interface.

On the Tools menu, click Options. The Options dialog box opens.

@ b

Select the Application Catalog tab.
4. Enter the AdminStudio Enterprise Server URL.

5. If you have more than one AdminStudio Enterprise Servers, select the Make this the default Shared AES
URL to make the URL in the AdminStudio Enterprise Server URL field the default.

6. If you want to Allow automatic authentication by AdminStudio Enterprise Server, select this option.

7. Click OK to close the Options dialog box.

Specifying the Configuration Manager Web Console URL

AdminStudio 10.0

Enter the URL for the Configuration Manager Web Console Web site. You specify the Web site URL of the
Configuration Manager Web Console on the Locations tab of the Options dialog box.

Task: To specify the Configuration Manager Web Console URL:
1. Launch the AdminStudio interface.

On the Tools menu, click Options. The Options Dialog Box opens.

2

3. Select the Locations tab.

4. Enter the Configuration Manager Web Console URL.
5

Click OK to close the Options dialog box.

Working with Tools

Topics in this section involve adding, configuring, and associating tools in the Tools Gallery on the Tools Tab. This
section contains the following topics:

e Adding New Tools to the Tools Gallery

e Editing Properties for an Existing Tool
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e Adding Command-Line Configurations for an Existing Tool
e Modifying Command-Line Configurations for an Existing Tool
® Deleting Command-Line Configurations from an Existing Tool
® Associating Tools with Tasks
® Running Associated Tools in Projects
® Deleting Existing Tools

e Limiting Tool Accessibility
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Adding New Tools to the Tools Gallery

&

Task:

To add a new tool to the Tools Gallery:
1. From the Tools Tab, right-click in the Tools Gallery and select Add Tool. The Add Tool Wizard opens.
2. Onthe Welcome Panel, click Next. The Tool Properties Panel opens.

3. On the Tool Properties Panel, provide the necessary details about the tool. Click Next. The Command-
Line Configuration Panel opens.

4. |If there are command-line options you want associated with the tool, do so from the Command-Line
Configurations Panel. Each tool can have multiple command-line options associated with it for different
purposes.

5. Click Finish.

After using the Add Tool Wizard, the new tool appears in the Tools Gallery and is available for use in workflows
and projects.

E

Note ° In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This
typically is an application, but can be a simple document or batch file necessary to completing the project.

Editing Properties for an Existing Tool

&

Task:

94

To edit the properties of a Tool in the Tools Gallery, perform the following steps.

To edit an existing tool's properties:

1. From the Tools Tab, right-click the tool in the Tools Gallery and select Properties. The Tool Properties
dialog box is displayed.

2. Click the Properties tab.
3. Modify tool properties as necessary.

4. Click OK to apply the changes.

E

Note * In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This
typically is an application, but can be a simple document or batch file necessary to completing the project.
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Adding Command-Line Configurations for an Existing

Tool

To add command-line configurations for an existing Tool, perform the following steps:

W

Task: To add a command-line configuration to an existing tool:

1.

2,
3
4
5.
6

E

From the Tools Tab, right-click the tool to which you want to add a configuration from the Tools Gallery and
select Properties. The Tool Properties dialog box is displayed.

Click the Configuration tab.

Click Add. The Command-Line Properties dialog box is displayed.
Enter a description and the command-line configuration.

Click OK to close the Command-Line Properties dialog box.

Click OK to close the Tool Properties dialog box.

Note ° In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This

typically is an application, but can be a simple document or batch file necessary to completing the project.

Modifying Command-Line Configurations for an Existing

Tool

To modify command-line configurations for an existing Tool, perform the following steps:

W

Task: To edit and existing tool's command-line configurations:

1.

From the Tools Tab, right-click the tool in the Tools Gallery and select Properties. The Tool Properties dialog
box is displayed.

Click the Configuration tab.

Select the command-line configuration you want to edit and click Modify. The Command-Line Properties
dialog box appears.

Modify the description and/or command line.
Click OK to dismiss the Command-Line Properties dialog box.

Click OK in the Tool Properties dialog box to apply the changes.
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E

Note * In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This
typically is an application, but can be a simple document or batch file necessary to completing the project.

Deleting Command-Line Configurations from an Existing

Tool

o

To delete command-line configurations from an existing Tool, perform the following steps.

Task:

To delete a command-line configuration from an existing tool:

1.

E

From the Tools Tab, right-click the tool from which you want to remove the configuration in the Tools Gallery
and select Properties. The Tool Properties dialog box is displayed.

Click the Configuration tab.
Select the configuration you want to remove and click Delete.

Click OK to close the Tool Properties dialog box.

Note * In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This

typically is an application, but can be a simple document or batch file necessary to completing the project.

Associating Tools with Tasks

o

To associate a Tool with a Workflow task, perform the following steps.

Task:

96

To associate a tool with a task:

Open the Process Template Editor.
In the Workflows tree, expand a Workflow to display all of its tasks.

From the Workflows tree, select the task with which you want to associate the tool. The Task Properties are
displayed.

From the Tool list, select the tool you want to associate with the task. If the necessary tool is not listed, select
<New Tool...> from the list to add the tool.

In the Tool Configuration list, select the configuration you want to use with the tool. If the configuration is not
listed, click Configure to create the new configuration.
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E

Note * In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This

typically is an application, but can be a simple document or batch file necessary to completing the project.

Running Associated Tools in Projects

W

Task:

To run associated Tools in Projects, perform the following steps.

To run a tool associated with a task:
1. Select the Process Assistants tab from the Interface.
2. Expand a Project in the Projects tree to display all of its tasks.

3. Right-click the task with which the tool is associated and select Run Task from the context menu.

E

Note * In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This
typically is an application, but can be a simple document or batch file necessary to completing the project.

Deleting Existing Tools

o

To delete a Tool from the Tools Gallery, perform the following steps.

Task:

To delete an existing tool from the Tools Gallery:
1. From the Tools Tab, right-click the tool you want to delete from the Tools Gallery and select Delete.

2. Confirm the deletion.

E

Note * In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This
typically is an application, but can be a simple document or batch file necessary to completing the project.
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Limiting Tool Accessibility

Edition * AdminStudio Enterprise Server is included in AdminStudio Enterprise Edition.
Accessibility of tools is determined by a user’s assigned Roles. If you want to modify an existing Role so that users

assigned to that Role can no longer access a specific tool, see Editing an Existing User Role in the Managing Roles
and Permissions section.

Workflows and Projects

Workflows, which can be created and modified using the Process Template Editor, are the basis for all projects
in AdminStudio. These workflows consist of defined tasks, with which instructions (in the form of HTML files) and

tools can be associated. Users can then create projects based on these workflows, and execute them—following
the specific steps defined in the workflow. This allows you to create specific, repeatable procedures to accomplish
your application migration goals.

7]

Important * In AdminStudio 10.0, the Workflow Templates tab of the AdminStudio interface has been moved into
its own tool named Process Template Editor, which can be launched from the Tools tab or the Tools menu. All
functionality remains the same. Also, the former Projects tab of the AdminStudio interface has been renamed to
Process Assistants.

Tip - If you update a workflow, all projects based on that workflow will reflect the changes made to the workflow.
The following topics relate to workflows and projects:

e Creating and Editing Workflows

e (Creating and Using Projects

e Saving Workflow and Project Changes

o Workflow Project Example: Using the New Workflow Project Wizard

e Workflows, Projects, and Permissions

Creating and Editing Workflows

98

Workflows serve as templates upon which projects are based. Typically, only a few individuals create workflows,
while others create projects and execute the projects to accomplish the workflow goal.

The following topics relate to creating and executing workflows:

e (Creating New Workflows
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® Renaming Workflows
e Filtering Workflows
e Deleting Workflows
® Creating New Tasks
e Modifying Task Properties
e Creating Notes for a Task
® Renaming Tasks
® Reordering Tasks
® Associating Help Files with Tasks
® Deleting Tasks

e Adding New Tools from the Process Template Editor

Creating New Workflows

4

Task: To create a new workflow:

1. Open the Process Template Editor by clicking its icon on the Tools tab. You are prompted to connect to an
Application Catalog.

2. Enter the Application Catalog connection information and click OK. The Process Template Editor interface
opens.

3. Right-click in the Workflows tree pane and select New Workflow. A new Workflow is listed.

4. Provide a name for the workflow.

Renaming Workflows

4

Task: To rename an existing workflow:
1. Open the Process Template Editor.
2. Right-click the workflow you want to rename and select Rename from the context menu.

3. Provide a new name for the workflow.
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Filtering Workflows

%

Task: To display a specific workflow:
1. Open the Process Template Editor.

2. From the drop-down menu above the Workflows tree, select the workflow you want to display.

Deleting Workflows

%

Task: To delete an existing workflow:
1. Open the Process Template Editor.
2. From the Workflows tree, right-click the workflow you want to delete and select Delete from the context menu.

3. Confirm the deletion by clicking Yes in the resulting dialog box.

Creating New Tasks

%

Task: To create a new task:
1. Open the Process Template Editor.

2. Right-click the workflow to which you want to add the task and select New Task. Alternatively, right-click on a
task and select New Task to create a subtask.

A new task appears named NewTasknn, and the Task Properties view for that task is displayed.
3. Enter a name for the new task.

4. Modify properties for the task.

Modifying Task Properties
&

Task: To modify properties for an existing task:
1. Open the Process Template Editor.

2. From the Workflows tree, select the task you want to modify. The Task Properties view for the selected task is
displayed.

3. Change Task Properties as necessary for the task.
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Creating Notes for a Task

o

Task: To create notes for a task:
1. Select the Process Assistants tab in the Interface.

2. From the Projects tree, select the task to which you want to add notes. The Project Task Properties view
appears for the selected task.

3. Enter notes in the Notes field.

Q
Tip * You can also add notes to a task in the Process Template Editor. If you do, all projects based on that
workflow will use the notes you enter as the default notes for the specific task.

E

Note ° There is a 255 character limit on notes.

Renaming Tasks

o

Task: To rename an existing task:
1. Open the Process Template Editor.
2. Right-click the task you want to rename and select Rename from the context menu.

3. Provide a new name for the task.

Reordering Tasks

o

Task: To change the task order:

1. Open the Process Template Editor.
2. Inthe Workflows tree, select the task you want to move.

3. From the toolbar, click Move Up or Move Down to change the order in which tasks are performed. Click Move
Right to make a task a subtask of another task; click Move Left to promote a task.

4. Repeat the previous steps as necessary.
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Associating Help Files with Tasks

%

Task: To associate a help file with a task:
1. Open the Process Template Editor.

2. From the Workflows tree, select the task with which you want to associate the help file. The Task Properties
view appears for the selected task.

3. Inthe Help File field, enter the name and location of the help file, or click Browse and navigate to it.

@ The help file can either be local, or you can use a URL (for example, http://www.mycompany.com/
myURL.htm).

® You can also click the Edit HTML button to the right of the Browse button to open a default HTML page in
an HTML editor as a starting point.

E

Note  Help files must be in HTML format.

Deleting Tasks

%

Task: To delete an existing task:
1. Open the Process Template Editor.
2. In the Workflows tree, right-click the task you want to remove and select Delete.

3. From the resulting dialog box, click Yes to confirm the deletion.

Adding New Tools from the Process Template Editor

%

Task: To add a new tool to the Tools list from the Process Template Editor:
1. Open the Process Template Editor.

2. From the Workflows tree, select the task with which you want to associate the new tool. The Task Properties
view appears for the selected task.

3. From the Tool list in the Task Properties view, select <Add Tool ...>. The Add New Tool dialog box opens.
4. Inthe Add New Tool dialog box, enter properties about the tool.
5. Click OK.
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Creating and Using Projects

Projects, which are based on existing workflows, are the procedures followed to accomplish a set goal. Projects
may include instructions describing what to do, and perhaps links to tools necessary to perform tasks. They also
allow you to provide notes to help document issues that may arise during a project.

Tip - If you update a workflow, all projects based on that workflow will reflect the changes made to the workflow.

The following topics relate to creating and using projects:

Creating Workflows with the New Workflow Project Wizard
Filtering Projects

Executing Projects

Running Associated Tools in Projects

Deleting Projects

Creating Workflows with the New Workflow Project Wizard

o

Task: To create a workflow using the New Workflow Project Wizard:

1. Launch AdminStudio.

2. Click the Process Assistants tab.

3. Right-click in the Projects tree and select New Project. The New Workflow Project Wizard launches.

4. From the Welcome Panel, click Next. The Workflow Selection Panel appears.

5. From the Workflow Selection Panel, select the workflow on which you want to base the new project.

6. Provide a name for the new project and click Next. The Source Package panel appears.

7. From the Source Package Panel, specify the name and location of the source package used in this project.
Alternatively, click Browse to navigate to it.

8. Click Next. The Target Directory and Filename panel appears.

9. From the Target Directory and File Name Panel, specify the Target Directory in which you want to store all
files associated with this project.

10. In the Target File Name field, provide a name for the output file. Depending on the task being executed, the
appropriate extension will be added to the file name.

11. Click Finish. The new Workflow is now listed.
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Filtering Projects

%

Task: To display a specific project:
1. From the Interface, click the Process Assistants tab.

2. From the drop-down menu above the Projects tree, select the project you want to display.

Executing Projects

Task: To execute a project:

1. From the Interface, click the Process Assistants tab.

2. Display the project you want to execute. If you want to only display that project, use the filter above the
Projects tree.

Click the first task in the project.
Perform the task.

When finished with the task, click the box to the left of the task.

o a s o

Repeat for subsequent tasks in the project.

Running Associated Tools in Projects

%

Task: To run a tool associated with a task:
1. Select the Process Assistants tab from the Interface.
2. Expand a Project in the Projects tree to display all of its tasks.

3. Right-click the task with which the tool is associated and select Run Task from the context menu.

E

Note * In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This

typically is an application, but can be a simple document or batch file necessary to completing the project.
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Deleting Projects

W

Task: To delete an existing project:
1. Click the Process Assistants tab in the Interface.

2. From the Projects tree, right-click the project you want to delete and select Delete Project from the context
menu.

3. Confirm the deletion by clicking Yes in the resulting dialog box.

Saving Workflow and Project Changes

Because AdminStudio uses a database (the Application Catalog) to store information involving Workflows and
Projects, all changes are stored immediately. There is no need to “save” your modifications; AdminStudio performs
this automatically.

Workflow Project Example: Using the New Workflow
Project Wizard

The following basic example covers creating a workflow and project which takes advantage of command-line
functionality available in AdminStudio.

Prior to creating projects, you must create a workflow on which to base the project. This workflow might involve few
steps, or it might cover as broad of a task as repackaging a legacy installation, editing it in InstallShield Editor,
customizing it in Tuner, performing application isolation, identifying and resolving conflicts, distributing it, and
entering information about it into a third-party tracking system.

In this example, you are going to create a basic workflow involving two steps: repackaging a legacy installation and
opening the resulting InstallShield Editor project.

Creating a New Workflow

Task: To create a new workflow:

-k
.

Open the Process Template Editor.
Right-click in the Workflows tree pane and select New Workflow. A new Workflow is listed.
Name the workflow My Workflow Example.

Right-click My Workflow Example and select New Task.

g s w b

Name the task Repackage a Legacy Setup.
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10.

11.

With the Repackage a Legacy Setup task selected, from the Task Properties pane, select Repackager from the
Tool menu. This associates Repackager with this task.

Change the Tool Configuration to Repackage a legacy setup. This associates a predefined command line (-
app "[SourcePackage]" -o "[TargetDir]" -pp "[TargetFileName]") with this task.

Right-click My Workflow Example and select New Task.
Name the task Open the Repackaged Setup.

With Open the Repackaged Setup selected, from the Task Properties pane, select Editor from the Tool menu.
This associates InstallShield Editor with this task.

Change the Tool Configuration to Edit an InstallShield Editor project created with Repackager. This associates
a predefined command line (-"[TargetDir]\[TargetFileName].1ism") with this task.

Creating a Project Based on the Workflow

Task:

106

To create a project based on your new workflow:

1.

2
3.
4

4

10.

11.

Click the Process Assistants tab.
Right-click in the Projects tree and select New Project. The New Workflow Project Wizard launches.
From the Welcome Panel, click Next. The Workflow Selection Panel appears.

From the Workflow Selection Panel, select My Workflow Example as the workflow on which you want to
base the new project.

Name the new project My Sample Project and click Next. The Source Package panel appears.
From the Source Package Panel, click Browse and navigate to the following directory:
AdminStudio Installation Directory\Tutorial\Repackager\PackageForTheWeb 3

Select PackageForTheWeb3. exe and click Open. This value (the directory and package name) are stored in the
SourcePackage variable, which is used by the command line in Repackager set when you created the
workflow.

Click Next. The Target Directory and File Name Panel opens.

From the Target Directory and File Name panel, specify the directory where you want to store files associated
with your project. For this example, use C:\AdminStudio Shared\Test\WorkflowExample This value is written
to the TargetDir variable used in the command line set for InstallShield Editor when creating the workflow.

Set the Target File Name to WorkflowProjectEx. This value is written to the TargetFileName variable used in
the command line set for InstallShield Editor when creating the workflow.

Click Finish. The new Workflow Project is now listed.
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Running the Workflow

Task: To run the workflow:

1. Expand the workflow My Sample Project in the Projects tree.
2. Right-click the task Repackage a Legacy Setup and select Run Task.<

When Repackager launches, it reads the value SourcePackage to determine the file to repackage. It also
reads TargetDir and TargetFileName to determine where to place the output and what to call the output file.

3. After completing the steps above, right-click on the second step in the project and run the associated tool.
InstallShield Editor launches, and opens the project file (.1ism) created by Repackager.

Summary

This is just a brief example of how AdminStudio tools can be made aware of each other during a project. When
crafting workflows, create command lines to streamline your projects.

Workflows, Projects, and Permissions

AdminStudio interface functionality (including workflows, projects, and the Tools Gallery) is directly influenced by

user authorization and permissions. For example, Administrators can see all users and projects assigned to those
users in AdminStudio. In the case of NT Groups, Administrators can see individual members of those groups in the
Process Assistants tab. Further, Administrators can assign projects to users when running the New Workflow
Project Wizard.

An example of how permissions affect workflows and projects is the availability of the Process Template Editor,
which requires the View Workflow Tab permission. Likewise, only users with the Create Project permission can
create projects. Even if you have permission to view and create workflows, you can only associate tools which you
are permitted to use with tasks you create. If you are executing projects, you can only launch tools you have
permissions to use, regardless of whether they are associated with a task in the workflow.

For more information, see Managing Roles and Permissions.
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Frequently Asked Questions

108

The following is a list of questions frequently asked by AdminStudio users, including a link to the appropriate help
topic.

General & Workflow

e How do | add a new tool to the Tools Gallery? See Adding New Tools to the Tools Gallery.

e How do | add a command line configuration to a tool? See Adding Command-Line Configurations for an
Existing Tool.

e How do | specify a default Application Catalog? See Specifying a Default AdminStudio Application Catalog.

Application Isolation Wizard

e How do | isolate applications? See Isolating Applications Using Application Isolation Wizard.

e How do | modify the default isolation recommendations? See Modifying the Default Isolation
Recommendations.

ConflictSolver

e What types of conflicts can ConflictSolver detect? See Identifying and Resolving Application Conflicts Using
ConflictSolver.

e How do | change which conflicts are checked? See Changing Default Conflict Types Checked.
e How do | validate a package? See Validating Packages.
e How do | identify conflicts? See Checking for Conflicts Using the Conflict Wizard.

e How do | automatically resolve conflicts? See Automatically Resolving Conflicts.

Tuner
e What should | do If MSI prevalidation fails? See Handling Invalid Windows Installer Packages.
e How do | prevent a feature from displaying during custom installation? See Changing a Feature’s Visibility.

® When should | use the Dialogs View instead of MSI command-line options? See Dialogs View vs. Command-
Line Options.

e How do | create a setup.exe file for my package and transform? Creating a Setup.exe File for the Package and
Transform.

® When do | use Tuner vs. InstallShield Editor? See Customizing Installations Using Tuner.

Repackager
e Why do people use a Repackager? See Repackaging Legacy Installations Using the Repackaging Wizard.
e \Why is a “clean” system important for repackaging? See About Repackaging on Clean Systems.

e Should | repackage a Windows Installer (.msi) setup? See Repackaging Wizard Best Practices.
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How do | repackage a non-Windows Installer setup? Repackaging Legacy Installations Using the
Repackaging Wizard and Converting Legacy Installations Using the Repackager Interface.

How can | speed up repackaging? See Repackaging Wizard Best Practices.

What can | do with a repackaged setup? See Repackaging Legacy Installations Using the Repackaging
Wizard and Converting Legacy Installations Using the Repackager Interface.

Where does Repackager store my repackaged files and the MSI packages it builds? See Set Target Project
Information and Capture Settings Panel.

How do | identify and fix WinINSTALL conversion problems? See Troubleshooting Guidelines for WinINSTALL
Conversion.

How do | identify and fix SMS conversion problems? See Troubleshooting Guidelines for SMS Conversion.

What do | do if | receive a ISDEV: fatal error -5023: Error building table file error while using
Repackager? See Resolving an “Error Building Table File” Error.

Distribution Wizard

How do | create an administrative installation? See Creating Administrative Installations for Packages.

OS Snapshot Wizard

Why do | need an OS Snapshot? See Taking OS Snapshots.

InstallShield Editor

Answers to common questions regarding InstallShield Editor can be found under Frequently Asked Questions
in the InstallShield Editor Help Library.

AdminStudio Interface Reference

The AdminStudio interface reference is organized into the following areas:

AdminStudio Start Page

Tools Tab

Process Template Editor
Process Assistants Tab
Enterprise Server Tab
AdminStudio Menus and Toolbar
Dialog Boxes

Wizards
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AdminStudio Start Page

110

The AdminStudio Start Page provides quick access to product information, to recently opened files, and to
InstallShield resources.

AdminStudio Start Page Tabs

The AdminStudio Start Page, which is designed to help you quickly get started evaluating and using AdminStudio,
provides process information on how to perform key tasks using AdminStudio tools. Information is organized into
the following tabs:

® Getting Started—Describes the main tasks that you can use AdminStudio to accomplish, and provides links
to additional information. See Getting Started Tab.

e Test for Application Compatibility—Provides a flowchart that outlines how to use Compatibility Solver to
test for application readiness on Microsoft Windows 7 32-bit and 64-bit platforms, as well as compatibility with
Internet Explorer 8.0. See Test for Application Compatibility Tab.

e Migrate to Application Virtualization—Provides a flowchart that outlines the steps required to migrate your
application portfolio into virtual applications that are ready for deployment within the enterprise. See Migrate to
Application Virtualization Tab.

e Migrate to Windows Installer—Provides a flowchart that outlines the steps required to migrate legacy
setups (such as .exe files) to deployable Windows Installer packages (.msi). See Migrate to Windows Installer
Tab.

e Set Up Infrastructure—Lists the infrastructure setup steps that you need to perform prior to using
AdminStudio for the first time: connect to an Application Catalog, configure virtual machines, set e-malil
notification settings, and configure Compatibility Solver. See Set Up Infrastructure Tab.

e Help & Support—Provides sources for user documentation, support, and product information.

AdminStudio Views

The AdminStudio interface is organized into the following tabs, which appear across the top of the Start Page:
[ Start Page | 38 Toals @ Process Assistants M Report Center ﬁ Enterprise Server

Figure 3-2: AdminStudio Interface Tabs

Click on these tabs to access the following AdminStudio views:
e Start Page—Initial view of AdminStudio.
e Tools—The Tools Tab includes the Tools Gallery and information on the selected tool.

® Process Assistants—On the Process Assistants Tab, you can create, execute, and delete projects, and
access existing projects, which are the procedures followed to accomplish a set goal.

e Report Center—On the Report Center Tab, you can view the Application Readiness Dashboard. This
dashboard report provides a snapshot of the current status of packages in your Application Catalog including
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deployment type breakdown, virtualization readiness, and package quality and conflict testing summary
information.

e Enterprise Server—On the Enterprise Server Tab, you can use Job Manager to automate tasks and Report
Center to generate reports. You can also manage Users, Roles, and Permissions.

Tools Tab

The Tools tab, which is accessed from the AdminStudio Start Page, includes the Tools Gallery and the Content
Pane.

Tools Gallery

You can launch each tool in the AdminStudio suite by double-clicking on the appropriate icon in the Tools Gallery.
Individual AdminStudio applications can also be launched by clicking on the tool in the Tools Gallery on the Start

Page:
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By right-clicking in the Tools Gallery, you can launch the Add Tool Wizard, from which you can add new tools into
the gallery and make them available for task assignments in workflows and projects.

Content Pane

The first icon in the Tools Gallery, Overview, is selected by default. When selected, the Content Pane lists a
description of each of the AdminStudio tools. If you single-click on an AdminStudio tool icon in the Tools Gallery on
the Tools tab, additional information about the selected tool is displayed in the Content Pane.

Process Assistants Tab

Purpose

From the Process Assistants tab, you can create, execute, and delete projects. You can also access existing
projects. The drop-down filter above the Project pane allows you to view all available projects, or only a specific
project.

Each project must be based on an existing workflow. In this way, projects are similar to photocopies from a master
instruction sheet—all planning and design of the procedure is done to the workflow. The project is a copy of that
workflow, and multiple projects can be based on the same workflow if you are performing the same procedure.

Integration with AdminStudio Workflow Manager

AdminStudio Workflow Manager is a Web-based application that manages the application lifecycle, incorporating
standards (data) and methodologies (process). AdminStudio Workflows and Workflow Manager Workflows can be
integrated, so that an AdminStudio Project can be a Workflow Phase in a Workflow Manager Workflow.

When an AdminStudio Project is linked to a Workflow Manager Workflow, please note the following indications on
the Process Assistants tab:

e When an integrated AdminStudio project is selected on the Process Assistants tab, the name of its associated
Workflow Manager Application is displayed in the Project Properties.

® When an AdminStudio Project is linked to a Workflow Manager Workflow and the workstation is not currently
connected to the Workflow Manager Server, the following icon appears in the bottom right of the Process
Assistants tab view:

E 4

Report Center Tab

112

On the Report Center tab, you can view the Application Readiness Dashboard. This dashboard report provides a
snapshot of the current status of packages in your Application Catalog including deployment type breakdown,
virtualization readiness, and package quality and conflict testing summary information. You can click on any chart
to open more detailed reports.

The Application Readiness Dashboard includes the following information:
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e Deployment Type Breakdown—Provides a graph listing the percentage of packages in the Application
Catalog by deployment type (Windows Installer, App-V, XenApp, ThinApp, or Legacy).

e Error Category Breakdown—Shows the number of AdminStudio Best Practices and Conflict errors that
have been identified in Windows Installer and App-V packages, by category.

e Virtualization Readiness—Shows a summary of the virtualization status of packages in the Application
Catalog, identifying packages as being Ready for Virtualization, Not Suitable for Virtualization, Already
Virtualized, or Not Tested.

e Windows Installer/App-V Package Quality—Shows the Microsoft Validation status of Windows Installer
packages, and the AdminStudio Best Practices test status of Windows Installer and App-V packages.

e Windows Installer/App-V Package Conflicts—Shows the AdminStudio Conflict test status of Windows
Installer and App-V packages.

AdminStudio uses Microsoft SQL Reporting Services to generate this dashboard (which is also visible in
Application Manager). For more information, see Viewing Application Catalog Enhanced Reporting.

Enterprise Server Tab

Edition * The Enterprise Server tab is available in AdminStudio Enterprise Edition.

AdminStudio Enterprise Server is a security console and set of Web tools that are closely integrated with
AdminStudio. The Enterprise Server tools include the Security Console, Job Manager, Report Center, Configuration
Manager Web Console, and Workflow Manager. For more information, see the following topics:

® Generating and Viewing Reports in Report Center

e Automating Tasks Using Job Manager

e Distributing Packages Using Configuration Manager Web Console
e Managing Roles and Permissions

e Managing Users, Directory Services, and User Logins

Workflow Manager Tab

AdminStudio Workflow Manager is a Web-based application that manages the application lifecycle, incorporating
standards (data) and methodologies (process). AdminStudio Workflows and Workflow Manager Workflows can be
integrated, so that an AdminStudio Project can be a Workflow Phase in a Workflow Manager Workflow.

If you have purchased AdminStudio Enterprise Edition and Workflow Manager, the Workflow Manager icon will be
displayed in the AdminStudio Tools Gallery on the AdminStudio Tools tab and will be available as a tab on the
AdminStudio Enterprise Server interface.

AdminStudio 10.0 User Guide ADS-1000-UG00 113



Chapter 3: Using the AdminStudio Interface
AdminStudio Interface Reference

E

Note * For more information on Workflow Manager, see Using Workflow Manager to Manage Enterprise
Software Packaging in the AdminStudio Enterprise Server Help Library.

Process Template Editor

Workflows, which can be created and modified using the Process Template Editor, are the basis for all projects in
AdminStudio. These workflows consist of defined tasks, with which instructions (in the form of HTML files) and
tools can be associated. Users can then create projects based on these workflows, and execute them—following
the specific steps defined in the workflow. This allows you to create specific, repeatable procedures to accomplish
your application migration goals.

Tasks

Once you create a workflow, you can add tasks to it. Tasks are discrete steps in your overall process. Each task
has the following configurable options:

Table 3-3 ¢ Task Options

Option Description

Tool If needed, you can pick a tool to associate with the task. When a user runs the
workflow, the tool can be launched from the workflow step. By default, the
AdminStudio tools are included in this list. If you have added tools to the Tools Gallery,
they also appear in this list. If you want to add a tool directly from the Process
Template Editor, select the <New Tool> option to display the Add New Tool dialog
box. This adds the tool to the Tools Gallery and makes it available for the current task.

E

Note - If, after adding a new tool for a task that is not included in the Tools Gallery, you assign a
different tool or no tool to the task, the tool you added will no longer be available. To avoid this,
when possible, add tools to the Tools Gallery

Tool Configuration This list contains all available command-line configurations for the selected tool. If you
do not need a configuration, select <None>. Click Configure to add new
configurations to the tool, which you can then select from this list.

Help File You can associate a help file (in HTML format) with the task to provide instructions for
performing the task. Enter the path and help file in this field, or use the Browse button
to navigate to it. If you have yet to create an HTML page, click the Edit HTML button to
the right of the Browse button to open a default page in an HTML editor.

Notes Add any notes you want associated with this task. This field can only hold 255
characters, so additional information should be added to your help file.
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The following commands and toolbar buttons are available in the AdminStudio interface.

Table 3-4 « AdminStudio Menus and Toolbar

Menu

Catalog

Catalog

Command

Connect

Create

Shortcut

Ctrl+0

Ctrl+N

Button

=

Description

Displays the Connect Application Catalog Dialog
Box, where you can open an existing SQL Server
Application Catalog or the AdminStudio Enterprise
Server Application Catalog.

Displays the Application Catalog Wizard, where you
can create a new SQL Server Application Catalog
database.

Catalog

Catalog

Catalog

Disconnect

Properties

Change AES
Password

Ctrl+D

Closes the currently open Application Catalog.

Opens the Application Catalog Properties Dialog
Box where you can configure the Software
Repository.

Change the password of the current user to log in
to the AdminStudio Enterprise Server.

Catalog

Catalog

Logout

Replication

Ctrl+R

Log out of the AdminStudio Enterprise Server.

Use to access the SQL Server Application
Catalog Replication feature. These menu items
are selectively enabled depending on whether the
current user is connected to an SQL Server
database and has been assigned sysadmin
privileges in SQL Enterprise Manager on that
database server. If the open database is a
Subscriber database, the Subscription Manager
option will be enabled, and if it is a Publisher
database, the Publication Manager option will be
enabled.

Catalog

View

View

AdminStudio 10.0 User Guide

Exit

Toolbar

Status Bar
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Alt+C+X

Al+V+T

Alt+V+S

Exits AdminStudio and returns you to the Windows
desktop.

Toggles the Toolbar.

Toggles the Status Bar.
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Table 3-4 « AdminStudio Menus and Toolbar (cont.)

Menu Command Shortcut Button @ Description

View Always On Top | Alt+V+A 1 When checked, the AdminStudio Interface remains
on top of all other windows.

View Start Page Select to open the AdminStudio Start Page.

View Process Select to open the Welcome Page of the Process
Assistant Assistant.

View Tools Select to open the Tools tab, which includes the

Tools Gallery and information on the selected tool.

View Report Center Select to open the Report Center tab, which
displays the Application Readiness Dashboard.

Tools Check for Alt+T+U Determine if there any updates or messages
Updates available for AdminStudio.
Tools Options Alt+T+0 Displays the Options dialog box, from which you

can configure the location of shared resources and
the frequency AdminStudio checks for updates.

Help Contents Alt+H+C @ Launches the online Help Library and displays the
Contents tab.
Help Index Alt+H+I B Launches the online Help Library and displays the
- Index tab.
Help Search Alt+H+S 1 Launches the online Help Library and displays the
& Search tab.

Help Support Alt+H+U Connects to the AdminStudio Support Web site.
Central

Help Web Alt+H+M Connects to the AdminStudio Web Community.
Community

Help ReadMe Alt+H+R Displays the AdminStudio Release Notes file.

Help Feedback Alt+H+F Connects to an online form, through which you can

provide feedback about AdminStudio.

Help Flexera Alt+H+W ’ Connects to the Flexera Software Web site.
Software on
the Web
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Menu Command Shortcut Button Description

Help About Alt+H+A Displays the About dialog box with version
AdminStudio information for AdminStudio.

Context New Workflow Create a new Workflow.

Menu

Context New Task Create a new Task.

Menu

Context Rename Rename selected Workflow or Task.

Menu

Context Delete Delete selected Workflow or Task.

Menu

Context New Project Ctrl-P Create a new Project.

Menu

Context Del Project Delete selected Project.

Menu

Context Run Task ] Runs the tool associated with the selected task in

Menu * the project.

Context Move Up + Moves the selected task up in the task order.

Menu

Context Move Down s Moves the selected task down in the task order.

Menu

Context Move Left - Moves the selected task left in the task order.

Menu

Context Move Right - Moves the selected task right in the task order.

Menu

Dialog Boxes

The following dialog boxes can be opened from the AdminStudio Interface:

e About AdminStudio Dialog Box

e Add New Tool Dialog Box

e Command Line Properties Dialog Box
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e Options Dialog Box

® Tool Properties Dialog Box

About AdminStudio Dialog Box

The About AdminStudio dialog box can be opened by selecting About AdminStudio from the Help menu. This
dialog box displays information about the product, including the full version number (essential if you need
technical support). If you have not registered AdminStudio, click the Register button to connect to the
InstallShield Web site to begin the Product Registration process. Registering your product offers you expert
technical support, new product announcements and special offers, plus notification of product upgrades.

Add New Tool Dialog Box

The Add New Tool dialog box is displayed if you select <New Tool> from the Tool list while designing a workflow.
This dialog box allows you to provide information about a tool you want accessible from AdminStudio, particularly
to use in workflow tasks.

This dialog box contains the following options:
Table 3-5 * Add New Tool Dialog Box Options
Option Description

Target Enter the location of the tool or Browse to the application or file you want added
to the tools pane for use in AdminStudio.

Name in Tools Gallery This description is used as the display name for the application in the Tools
Gallery.

Command Line Enter any command-line arguments for the tool. Because you may have different

Arguments uses for applications, you can add the same application multiple times to the

tools pane, with each instance using different command line arguments.

Working Directory If this tool requires a working directory, enter it here or click Browse to locate it.
Comments Enter any comments about this tool in this field.
HTML Explanation File Enter the location and name of an HTML file you want displayed when you

single-click on the tool in the tools pane. Alternatively, click Browse and navigate

to it. If you have yet to create one, click the Edit HTML button ((La]) below the field
to open a default page in an HTML editor:

Add to Tools Gallery When this box is checked, the tool will be added to the Tools Gallery. If
Check Box unchecked, it is only available for the task where it was added.
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Command Line Properties Dialog Box

The Command Line Properties dialog box is displayed when you create or edit a command-line configuration for a

tool.

The Command Line Properties dialog box has two configurable options:

Table 3-6 » Command Line Properties Dialog Box Options

Option Description

Description Provide a description for the configuration. This assists you in differentiating similar

command-line options.

Command Line Provide the actual command-line parameters for the tool. The arrow to the left allows you

Options Dialog Box

to select one of the following variables to include in the command-line:

InstallLocation—The location where AdminStudio is installed.
DevLocation—The location where InstallShield Editor is installed.
SharedPoint—The AdminStudio shared directory.
SourcePackage—The name and location of the source package.
TargetDir—The directory where output from the selected project is stored.
TargetFileName—The name of the outpuit file.

ProjectName—The name of the current project.

From the Options dialog box, you can configure settings including application catalog settings, shared locations
settings, and the frequency AdminStudio checks for updates. The dialog box consists of the following tabs:

e Application Catalog Tab

® |ocations Tab

e Updates Tab

e Quality Tab: Customer Experience Improvement Program

e Virtual Packages Tab

e Notification Settings Tab
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Application Catalog Tab

From this tab, you can configure the following options:

Table 3-7 » Options Dialog Box/Application Catalog Tab Options

Option

Shared AdminStudio
Application Catalog

Description

This field displays the name and location of the shared AdminStudio
Application Catalog. Click the Change button to select another
Application Catalog using the Select Application Catalog Dialog Box.

AdminStudio Enterprise Server | Enter the URL for the AdminStudio Enterprise Server, available in the

URL AdminStudio Enterprise Edition.
Make this the default shared If you have more than one AdminStudio Enterprise Servers, select this
AES URL option to make the URL in the AdminStudio Enterprise Server URL

field the default.

Allow automatic authentication | Select this option to allow automatic authentication by AdminStudio

Install AES

Locations Tab

120

Enterprise Server.

If AdminStudio Enterprise Server is not installed and you want to install it
on this machine, click this button to launch the installation.

From this tab, you can configure the following options:

Table 3-8 * Options Dialog Box/Locations Tab Options

Option

Description

AdminStudio Shared
Location

Task Help Page
Location

Configuration Manager
Web Console URL

Enter or browse to the shared location for AdminStudio. This location will contain
shared information for repackaging and conflict identification. To maintain
consistency when creating workflows, it is recommended that you set this shared
location the same for each AdminStudio seat.

Tip » The AdminStudio Shared Location is defined during installation and normally does
not need to be changed. It is usually assigned to a network folder, preferably a UNC path.

Enter or browse to the directory where you want to store all HTML pages that
serve as workflow task instructions.

Enter the URL for the Configuration Manager Web Console Web site.
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Updates Tab
You can configure the following options from this tab:

Table 3-9 * Options Dialog Box/Updates Tab Options

Option Description
Check for software Specify how often you want AdminStudio to check for updates. Your options are:
updates

® Never

® Once every 15 days
e Once every 30 days (default)

e Once every 60 days

Quality Tab: Customer Experience Improvement Program

The Customer Experience Improvement Program (CEIP) helps AdminStudio improve the quality, reliability and
performance of our software and services.

If you choose to participate in the Customer Experience Improvement Program, we will collect anonymous
information about how you use AdminStudio. This information helps us identify trends and usage patterns.

All information collected is anonymous, and this data collection will not affect the performance of AdminStudio
tools. You will never be prompted to complete a survey, and no one from our company will contact you. You can
continue working with AdminStudio without interruption.

Your membership status in the Customer Experience Improvement Program is specified on the Quality tab of the
AdminStudio Options dialog box. If you initially select to participate but later you change your mind, you can opt-
out of this program by changing the selection on the Quality tab.

Options g|
Application Catalog | Locations | Updates | Quality

Custarmer Experience Improvement Program

Wie invite you to join our Customer Experience Improvement Program to improve the quality,
._-_-i_,) reliability, and performance of Macrovision software and services.

If you accept, we will collect anonwmous information about how you uge our software and
services to identify rends and uzage patterns.

‘wie will not collect your name, address, or any other personally identifiable information. There are
o surveys ko complete, no salesperson will call, and you can continue working without
interruption. [t iz simple, user-friendly, and completely anonymous.

You can leave thiz program at any time by clicking Tools | Options to return to these settings.

ez, | am wiling to participate ananymously in the Customer Experience [mprovement
P

{2 Mo, | don't wish to participate.

Eead more sbout the Customer Ewperience Improvement Program

[ ok ] l Cancel ] l Help

Figure 3-4: Quality Tab of the AdminStudio Options Dialog Box
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Participation in the Customer Experience Improvement Program is not mandatory, but your input is appreciated.

For more information on the Customer Experience Improvement Program, visit the AdminStudio Web Site.

Virtual Packages Tab

On the Virtual Packages tab, you can control which of the available virtual package formats are displayed in the
AdminStudio toolset—Microsoft App-V, VMware ThinApp, and/or Citrix XenApp—and you can choose whether to
include the App-V Application Launcher with App-V applications.

&pplication Catalog | Locations | Updates | Quality | Yirtual Packages

AdminStudio supportz converting Windows Installer packages to the following wirtual package formatz. You
may chooze to hide a particular format throughout the AdminStudio toolzet by unchecking the appropriate
option. “rou may not disable all options.
Shaw the following farmats:

Microzoft Appf

Vidware Thindpp

Citrix #endpp

App Optiohz

Create utility to test launch App applications as part of building App- applications.

I QK H Cancel ][ Help

Figure 3-5: Virtual Packages Tab of the Options Dialog Box
The Virtual Packages tab of the Options dialog box has the following options:
Table 3-10 * Virtual Packages Tab of the Options Dialog Box

Option Description

Microsoft App-V Select to display all Microsoft App-V virtual package format options throughout
AdminStudio and InstallShield Editor. If this check box is not selected, the options for
the virtual package format will be hidden.

VMware ThinApp Select to display all VMware ThinApp virtual package format options throughout
AdminStudio and InstallShield Editor. If this check box is not selected, the options for
the virtual package format will be hidden.

Citrix XenApp Select to display all Citrix XenApp virtual package format options throughout

AdminStudio and InstallShield Editor. If this check box is not selected, the options for
the virtual package format will be hidden.
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Table 3-10 « Virtual Packages Tab of the Options Dialog Box

Option Description

Create utility to test Select this option to include the App-V Application Launcher with each App-V

launch App-V application that you build. You can use the App-V Application Launcher to locally test
applications as part a newly built App-V application before moving it to a deployment server. For more
of building App-V information, see Launching Packages for Testing.

applications.

E

Note < This option is only visible when the Microsoft App-V format is selected.

[

Important  You may not disable all options.

Notification Settings Tab

On the Notification Settings tab, you can configure your SMTP notification settings. This will enable
AdminStudio to send you e-mail notifications during various processes.

Currently, e-mail notifications are sent when soft time-outs are encountered while using Automated Application
Converter to repackage an application on a virtual machine.

Options (23]
Application Catalog | Locations | Updates | Guality | Virtual Packages Motfication Settings

MNoetification Settings
Enterthe SMTF settings for e-mail notifications supported by AdminStudio tools.

SMTP Server: |

Authentication: | Server Authentication ﬂ

Domain: |

User Name

Password:

From E-Mail ID:

To E-Mail idis):

SMTF Server Port: |25

[ Use 55L Test

oK | Cancel | el

Figure 3-6: Notification Settings Tab of the Options Dialog Box
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The Notification Settings tab of the Options dialog box has the following options:

Table 3-11 « Notification Settings Tab of the Options Dialog Box

Option

SMTP Server

Authentication

Domain

User Name

Password

From E-Mail ID

Description

Enter the address of your e-mail server, such as:

smtp.yourcompany .com

Specify how your e-mail is authenticated by selecting one of the following options:
e Server Authentication—Select this option if you want to perform server
authentication on your AdminStudio e-mail.

e Anonymous—Select this option if you do not want to perform authentication on
your AdminStudio e-mail.

Enter the Domain of the user account listed in the User Name field.

Enter the name of an existing user account in the Domain specified in the Domain
field. This user must have permission to send e-mail.

Enter the password of the user account defined in the User Name and Domain
fields.

E

Note - If your network domain requires that user passwords are changed periodically, you will
have to open this dialog box again to update this account’s password. To avoid this, try to obtain
a user account that has a password that does not expire.

Enter the e-mail address to serve as the identity of AdminStudio. All e-mails sent by
AdminStudio will have this e-mail address in the From field.

To E-Mail ID(s)

SMTP Server Port

Use SSL

Enter the e-mail address to serve as the system account for AdminStudio e-mail. All
e-mails sent to AdminStudio will be sent to this address.

Enter the port of your SMTP server.

Select this option if you want to use SSL security for the AdminStudio e-mail
account.

Tool Properties Dialog Box

124

The Tool Properties dialog box is displayed when you right-click on a tool in the Tools gallery and select Properties.
This dialog box contains the following tabs:

Properties Tab

Configuration Tab
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The Properties tab of the Tool Properties dialog box contains information about the tool, including the name
and location of the executable, the name of the tool as it appears in the Tools gallery, and the help file associated

with it (if any).

The following options can be configured:

Table 3-12 « Tool Properties Dialog Box/Properties Tab Options

Option

Target

Name in Tools Gallery

Command Line
Arguments

Working Directory
Comments

HTML Explanation File

Configuration Tab

Description

Enter the location of this tool’s executable. Alternatively, click Browse and
navigate to it.

Provide a name for the tool as it will appear in the Tools gallery.

Enter any default command line arguments for this tool.

If this tool requires a working directory, enter it here or click Browse to locate it.
Provide any comments about this tool.

Enter the location and name of an HTML file you want displayed when you single-
click on the tool in the tools pane. Alternatively, click Browse and navigate to it. If
you have yet to create one, click the Edit HTML button below the field (shown
below) to open a default page in an HTML editor:

From the Configuration tab of the Tool Properties dialog box, you can Add, Modify, or Delete command-line
configurations associated with the tool. Each tool can have multiple configurations associated with it, for different

uses.

Table 3-13 ¢ Tool Properties Dialog Box/Configuration Tab Options

Option

Command Line List

Description

Listing of all command lines defined for this tool.
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Table 3-13 « Tool Properties Dialog Box/Configuration Tab Options (cont.)

Option

Add

Modify

Delete

E

Description

Click to open the Command Line Properties Dialog Box, where you can add a new
command line. In the Description field, you provide a description for the
configuration. This assists you in differentiating similar command-line options. In the
Command Line field, you provide the actual command-line parameters for the tool.
The arrow to the left allows you to select one of the following variables to include in
the command-line:

InstallLocation—The location where AdminStudio is installed.
DevLocation—The location where InstallShield Editor is installed.
SharedPoint—The AdminStudio shared directory.
SourcePackage—The name and location of the source package.
TargetDir—The directory where output from the selected project is stored.
TargetFileName—The name of the outpuit file.

ProjectName—The name of the current project.

Click to open the Command Line Properties Dialog Box, where you can modify the
selected command line.

Click to delete the selected command line.

Note * Most AdminStudio Tools have one or more command-line configurations already defined. Although you can

change or remove these configurations, there is no way to automatically reset them to their default values.

Ways to Assign a Command Line to a Tool

There are three ways a user can assign a command line to a tool:

e Tool Properties Panel of Add Tool Wizard—When you add a tool, you can assign a command line on the
Tool Properties Panel of the Add Tool Wizard.

e Properties Tab of the Tool Properties Dialog Box—When you view the tool’s properties, you can assign a
command line on the Properties Tab of the Tool Properties dialog box.

e Configuration Tab of the Tool Properties Dialog Box—Using the Configuration Tab of the Tool
Properties dialog box, you can create multiple command lines and can use AdminStudio variables in these
command lines. Then, when you go to the Workflow tab and create a new Workflow, you can associate a Tool
with a task and also select which command line configuration they want to use. Once you have done that, you
can go to Project tab and create a new Project. When you create a new Project, you will have to specify the
Source Package and the target directory and file name. Once the Project is created, when you execute the
task, AdminStudio will execute the command line configuration you previously selected by replacing the
AdminStudio variables in the command line.
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E

Note * Acommand Line entered by the user in Properties Tab of the Tool Properties dialog box play no role in
the Workflow and Project tab. This command line is used only when you run the tool from the Tools Tab.
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Wizards

The AdminStudio interface includes the following Wizards:
e Add Tool Wizard

e New Workflow Project Wizard

Add Tool Wizard

The Add Tool Wizard allows you to add new tools that appear in the AdminStudio Tools gallery. You can specify the
tool’s executable, provide command-line options for the tool, and provide a link to information about the tool.

The Add Tool Wizard includes the following panels:
® Welcome Panel
® Tool Properties Panel

e Command-Line Configurations Panel

Welcome Panel

The Add Tool Wizard allows you to add new tools that appear in the AdminStudio Tools gallery. You can specify the
tool’s executable, provide command-line options for the tool, and provide a link to information about the tool.

Click Next to proceed to the Tool Properties Panel.

Tool Properties Panel

From the Tool Properties panel of the Add Tool Wizard, you can enter information about the tool you are adding to
the gallery.

You can configure the following options:

Table 3-14 + Add Tool Wizard/Tool Properties Panel Options

Option Description

Target Enter the location and name of this tool’s executable. Alternately, click Browse and
navigate to it.

Name in Tools Gallery Provide a name for the tool as it will appear in the Tools Gallery.

Command Line Enter any default command line arguments for this tool.
Arguments
Working Directory If this tool requires a working directory, enter it here or click Browse to locate it.
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Table 3-14 + Add Tool Wizard/Tool Properties Panel Options (cont.)

Option Description

Comments Provide any comments about this tool.

HTML Explanation File Enter the location and name of an HTML file you want displayed when you single-
click on the tool in the tools pane. Alternatively, click Browse and navigate to it.

If you have yet to create one, click the Edit HTML button below the field (shown
below) to open a default page in an HTML editor:

Command-Line Configurations Panel

From this panel, you can add command-line configurations for the tool. Each tool can have multiple command-line
configurations for different tool uses.

Click Add to add a new option from the Command-Line Properties dialog box. You can also click Modify to edit
the selected command-line option, or Delete to remove the selected option.

Click Finish to add the tool to the Tools Gallery; click Back to return to the Tool Properties Panel.

New Workflow Project Wizard

The New Workflow Project Wizard assists you in creating a new project based on an existing workflow. The values
you specify in this Wizard are stored in variables that can be accessed from tools, allowing for greater
interoperability in AdminStudio. The New Workflow Project Wizard includes the following panels:

e Welcome Panel
e Workflow Selection Panel
e Source Package Panel

e Target Directory and File Name Panel

Welcome Panel
The New Workflow Project Wizard assists you in creating a new project based on an existing workflow. The values

you specify in this Wizard are stored in variables that can be accessed from tools, allowing for greater
interoperability in AdminStudio.
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Workflow Selection Panel

From the Workflow Selection panel, you can specify the workflow on which you want to base this project. Available
workflows appear in the workflows window.

Select the workflow you want to use, and provide the name for the new project (which is stored in the ProjectName
predefined variable).

Source Package Panel

From the Source Package panel, you can specify the name and location of the source package used in this
workflow. If you are creating a repackaging project, this is usually an executable, such as Setup.exe. The source
package name and location is stored in the predefined variable SourcePackage.

E

Note * You must specify the name and location of a source package if it is required in the workflow (by using the
SourcePackage variable). For example, if the workflow specifies to launch a package with certain command-line
parameters, AdminStudio needs to know what package to launch.

Source packages can also be non-setup files. For example, if you are creating a simple workflow that involves
editing a Notepad file, the source package may be a .ixt file.

Target Directory and File Name Panel

130

From the Target Directory and File Name panel, specify the Target Directory and Target File Name used in
this project.

All output files (such as an INC file from Repackager or an MST file from Tuner) associated with the project will be
stored in the Target Directory, and the value for this directory can include a predefined variable such as
SharedPoint. The Target File Name is the name used for all files created by project tasks in this project, with the
appropriate extension appended to it depending on the file type. The Target Directory is stored in the predefined
variable TargetDir and the output file name is stored in the variable TargetFileName.

E

Note - If any workflow tasks use the TargetDir or TargetFileName variables, you must specify the target directory
and package name. For example, if the workflow specifies to save a task's output, AdminStudio needs to know

where to save it and what to call it.

Click Finish to close the Wizard.
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Log Files
AdminStudio tools generate the following log files:
Table 3-15 « AdminStudio Log Files

Log File Location

AdminStudio.log C:\Program Files\AdminStudio\10.0

predeploytest.log C:\Program Files\AdminStudio\10.0\PreDeployTest\Client

licwrapserver.log C:\Program Files\AdminStudio\10.0\FLEXWrap\Server
debug.log C:\Program Files\AdminStudio\10.0\FLEXWrap\Server
distributer.log C:\Program Files\AdminStudio\10.0\Common

islc.log C:\Program Files\AdminStudio\10.0\Repackager
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Part 2

Managing Users, Roles,
Permissions, Application
Catalogs

This part of the AdminStudio 10.0 User Guide includes the following chapters:
e Managing Users, Directory Services, and User Logins
e Managing Roles and Permissions

e Managing Application Catalog Databases
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Managing Users, Directory Services,
and User Logins

You can create a user account for each person that you want to have access to AdminStudio Enterprise Server, or
you can import users or groups of users from a Windows Active Directory or Novell eDirectory Directory Service.

You can also configure various login methods to best suit your needs: AdminStudio account login, domain account
login, single sign-on login, and guest account login.

Information is presented in the following main sections:
e Managing Users and Groups
® Managing Directory Services Configurations

e Managing User Logins

Managing Users and Groups

There are several methods for creating new users in AdminStudio Enterprise Server:

e Create a user account—Create a user account for each person that you want to have access to
AdminStudio Enterprise Server. See Creating a New User Account.

e Import Directory Service users—Set up a Windows Active Directory or Novell eDirectory Directory Service
Connection and import users from that Directory Service. See Importing Directory Services Users and Groups.

e Import Directory Service group—Set up a Windows Active Directory or Novell eDirectory Directory Service
Connection and import a group from that Directory Service. This allows you to provide dynamic access to all
of the members of that group as the members of that group changes. For more information, see Importing
Directory Services Users and Groups.

E

Note ° For more information on the methods for logging into AdminStudio Enterprise Server, and the how
authentication is performed, see Managing User Logins.

AdminStudio 10.0 User Guide ADS-1000-UG00 135



Chapter 4: Managing Users, Directory Services, and User Logins
Managing Users and Groups

Creating a New User Account

W

Task:

To create a new user account, perform the following steps.

To create a new user account:

P ® N

Open AdminStudio Enterprise Server and open the Administration tab.
Open the Users & Groups tab. The User Administration page opens.
Click Add. The User Details view opens.

Select the new user's Company from the list.

Enter a User Name and a Password, with the User Name in the format of:
username@companyname .com

Optionally, enter the user’s Email address.

Optionally, enter a geographic Location that you can use to group users together, such as New York Office
or Midwest Region, etc. Assigning a geographical location to a user enables you to display this information in
reports.

All of the Roles that have been defined for the selected Company are listed. Select the Roles that you want to
assign to this user.

E

Note * The Roles that a user is assigned to determine what portions of AdminStudio Enterprise Server and
Workflow Manager functionality they will have access to. Therefore, you must assign at least one Role to a user.

Click Update to save your entries and close the User Details view, or click Update and Add New to remain
in the User Details view so you can add another user.

Importing Directory Services Users and Groups

136

If you have defined a Directory Service, as described in Adding a Directory Service Connection, you can choose to
add Users or Groups from that Directory Service into AdminStudio Enterprise Server.

When a user is added from a Directory Service into AdminStudio Enterprise Server, only information that uniquely
identifies the user in the Directory Service is stored in AdminStudio Enterprise Server. Information such as
telephone number and email address will always be queried at run time, so that the most current information is
obtained.

AdminStudio Enterprise Server supports Windows Active Directory and Novell eDirectory directory services.

E

Note * For more information on AdminStudio Enterprise Server support for Directory Services, see Managing

Directory Services Connections and Managing User Logins.
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Task: To import users or groups from a Directory Service into AdminStudio Enterprise Server:

1.  Open AdminStudio Enterprise Server and open the Administration tab.

2. Open the Users & Groups tab. The User Administration page opens.

3. Click Directory Service User/Group Import. The Directory Services User/Group Add view opens.

4. From the Select a Directory Service list, select the Directory Service that you want to import users or groups
from.

5. Next to Select Group or User, select the User or Group option.

6. Next to Filter Directory Service list, select one of the following options:
® Show All—Select this option to include all Users or Groups in the list.

e Filter list by—Select this option, enter text in the box, and click Find to filter the list by the specified
criteria.

For example, to search for all of the users that start with the letter B, use the asterisk wildcard character (*) and

enter P# in the Filter list by box.

7. From the Select Group or User to Add list, select the group or user to import to AdminStudio Enterprise
Server. The User Details view opens, providing a read-only view of the imported user or group’s User Name
and Password.

If you import a User that is a member of a Group that was previously imported, that User inherits the Roles that
are assigned to that Group. You can then assign additional Roles to that User.

8. Click Update to save your entries and close the User Details view, or click Update and Add New to remain

in the User Details view so you can add another user.

Disabling a User or Group Account

User and Group accounts have a status of Active or Inactive. If a User or Group has the status of Inactive, that
User or a member of that Group:

Cannot log into AdminStudio Enterprise Server.

Cannot be assigned any work.

Is not listed on the User Administration page.

Does not get any email notifications.

Cannot be selected as a Customer Contact or Servicer Contact.

Cannot be viewed by Customers.
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Deleting vs. Disabling a User Account

If a user is associated in any way with an open or completed Workflow Manager Application Request, you cannot
delete that user from the system. In that case, you would instead disable that account by setting its Status to
Inactive.

If a user IS NOT associated with an Application Request, you can delete that user. This means that if
you create a user by mistake, before that user has interacted with the application, you can delete it by opening
that user on the User Details view and clicking Delete.

If a user IS associated with an Application Request, However, since AdminStudio Enterprise Server
stores the IDs of users on actions and assignments for historical, tracking and reporting purposes, you cannot
delete a user that is associated with a Workflow Manager Application Request. In this case, you would set the
user’s Status to Inactive on the User Details view.

Task: To disable a user account:

P ® Db

Open AdminStudio Enterprise Server and open the Administration tab.
Open the Users & Groups tab. The User Administration page opens.
Select the User or Group that you want to disable to open its User Details view.

Select Inactive from the Status list and click Update.

Deleting a User Account

You can delete a User or Group account from the User Details view.

&

Task: To delete a user account:

P © Db

138

Open AdminStudio Enterprise Server and open the Administration tab.

Open the Users & Groups tab. The User Administration page opens.
Select the User or Group that you want to delete to open its User Details view.
Click Delete. You are prompted to confirm the deletion.

Click OK. The deleted User or Group is no longer listed on the User Administration page.
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Managing Directory Services Configurations

AdminStudio Enterprise Server can be integrated with Windows Active Directory and Novell eDirectory. This
enables you to set up automatic login with AdminStudio Enterprise Server based upon Directory Services
authentication.

If you import a Group, all members of that group could then login to AdminStudio Enterprise Server without
requiring you to import the individual members of the Group. AdminStudio Enterprise Server can then retrieve user
attributes, such as email address or telephone number, from the Directory Service dynamically.

e Directory Service Connections—Rather than creating a user account for each person who will use
AdminStudio Enterprise Server, you can import users from Windows Active Directory or Novell eDirectory
directory services. For information on integrating AdminStudio Enterprise Server with Directory Service users
and groups, see Managing Directory Services Connections.

e Directory Service Attributes—When creating a Workflow Manager Template, you can set a Data Element’s
Data Type to Directory Service. This means that when a Directory Service authenticated user performs the
Workflow Step that requests that Data Element, information is pulled from the Directory Service to
automatically populate the field, such as that user’s name, email address, or location. For information on
enabling the use of Directory Service Attributes, see Managing Directory Services Attributes.

E

Note * For more information about Directory Services and Lightweight Directory Access Protocol (LDAP), see
Ldp Overview on the Microsoft TechNet Web site.

Managing Directory Services Connections

Rather than creating a user account for each person who will use AdminStudio Enterprise Server, you can import
users from Windows Active Directory or Novell eDirectory directory services. To integrate AdminStudio Enterprise
Server with a Directory Service users and group, you set up a Directory Service Connection.

This section includes the following topics:
e Adding a Directory Service Connection
e Editing an Existing Directory Service Connection

e Deleting a Directory Service Connection

Adding a Directory Service Connection

Directory Services Connections are used to import users and groups into AdminStudio Enterprise Server, and to
authenticate Active Directory or eDirectory users logging into AdminStudio Enterprise Server.

You can choose to have a Directory Service listed in the Domain list on the AdminStudio Enterprise Server login
page. This enables users in this Directory Service to login to AdminStudio Enterprise Server using their enterprise
network credentials.
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&

Task:

140

To add a Directory Service connection, perform the following steps:

To add a Directory Service connection:

1.

2.

@

ol

On the Administration tab, click Directory Services. The Directory Services page opens.

Click Manage Directory Services Connections. The Directory Services List page opens.

Click Add. The Add Directory Service Connection view opens.

Enter the following information:

Option

Use to Authenticate
Users?

Directory Service
Name

Description

Select Yes to include this Directory Service in the Domain list on the
AdminStudio Enterprise Server login page. This enables users to login to
AdminStudio Enterprise Server using their enterprise network credentials.

You can create many Directory Service connections, but only those connections
that have this field checked will be listed in the Domain list on the AdminStudio
Enterprise Server login page.

E

Note -« In an enterprise, there is usually only one Directory Service that is responsible for
authenticating users. However, you can create additional Directory Service connections to
import users and groups.

Enter a name to identify this Directory Service in the Domain list on the
AdminStudio Enterprise Server login page. It is recommended that the Directory
Service Name match the Domain Name.

Description

Enter a description of this Directory Service.

Directory Service
Type

Identify the type of Directory Service that you are adding a connection to:

e Active Directory

® Novell eDirectory

Directory Service
Host

Directory Service
Port

Enter the name or IP address of the Server on which this Directory Service is
running.

Enter the port number of the Server on which this Directory Service is running. By
default, AdminStudio Enterprise Server uses Port 389.

[0

Important » The value for the Directory Service Port should be the port on the given server
to which AdminStudio Enterprise Server should connect to send LDAP queries.
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Base Distinguished
Name

Domain Name

Use Secure Socket
Layer (SSL)?

Connect
Anonymously?

Admin
Distinguished Name
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Description

Enter the Base Distinguished Name (DN) to identify the root node of this Directory
Service.

For example, for MyCompany, the Base DN could be:

dc="MyCompany", dc="com"

Enter the Domain Name of this Directory Service. This Domain Name is used to
create the right credentials, along with the Admin User Name. For example, you

would enter DomainName\AdminUserName to connect to the specified Directory
Service.

E

Note * To upgrade from AMS 2.5, enter the same Domain Name that was used in AMS 2.5.
AdminStudio Enterprise Server will read this Domain Name and then try to authenticate the
User using this Directory Service. For single sign-on to work on an upgrade scenario from
2.5 to 4.0, administrators have to configure at least one Directory Service.

Select Yes if this Directory Service is configured to use Secure Socket Layer
(SSL).
Select No if you do not want to permit anonymous connections.

If you select Yes to permit anonymous connections, AdminStudio Enterprise
Server may not be able to authenticate Directory Service users and may not be
able to add Directory Service users/groups into AdminStudio Enterprise Server.

Enter the Distinguished Name of a user who has permission to retrieve users/
groups information and authenticate any user against this Directory Service.
Enter the Distinguished Name in the format of:

domainname\username
such as:

abcinc\jsmith

AdminStudio 10.0 User Guide

Password

Group Class Name

Group Name
Attribute

Enter the password for the Admin Distinguished Name.
Enter the object class names for groups for this Directory Service. Default values
are:

e Active Directory: group

e eDirectory: groupofnames

Enter an attribute used by this Directory Service to name groups. The default
value for both Active Directory and eDirectory is cn.
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Option

Group Member
Attribute

Description

Enter an attribute used by this Directory Service to define member groups.
Default values are:

e Active Directory: member

e eDirectory: uniquemember

User Class Name

User Name Attribute

Enter the object class name used by this Directory Service for users. Default
values are:

e Active Directory: user

e eDirectory: inetorgperson

Enter the attribute used by this Directory Service to identify users. Default values
are:

® Active Directory: samaccountname

e eDirectory: uid

5. Click Test Connection test to see if the settings that you entered can be used to successfully connect to this

Directory Service.

6. Click Update to save your entries and return to the Directory Services List page or click Update and Import
(User/Group) to save your entries and open the Directory Services User/Group Add view.

Editing an Existing Directory Service Connection

To edit an existing Directory Service connection, perform the following steps:

W

Task: To edit an existing Directory Service connection:

1.  On the Administration tab, click Directory Services. The Directory Services page opens.

2. Click Manage Directory Services Connections. The Directory Services List page opens.

3. Select the Directory Service connection that you want to edit. The Edit Directory Service Connection page

opens.

4. Edit these entries as described in Adding a Directory Service Connection.
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Deleting a Directory Service Connection

You can import a user/group into an AdminStudio Enterprise Server database using a Directory Service
Connection. This will create a reference to this Directory Service Connection in the database. You can then import
a Directory Service Attribute into the database.

In order to delete this Directory Service, user has to delete all the references to this Directory Service Connection. If
there are references left (like users from this directory service or attributes from this directory service) you cannot
delete this Directory Service Connection.

Managing Directory Services Attributes

When creating a Workflow Manager Template, you can assign a Data Element the Data Type of Directory
Service. This means that when a Directory Service authenticated user performs the Workflow Step that requests
that Data Element, information is pulled from the Directory Service to automatically populate the field, such as that
user’s name, email address, location, etc.

# FirstMame
Gregary

» LastMame
Johnson

Figure 4-1: Example of Fields Populated With Directory Services Attributes

E

Note - If the user is not connected using Directory Service authentication, then the fields will be left blank and
enabled.

On the Directory Services Attributes Administration Page, which is accessed by clicking Manage Directory
Services Attributes on the Directory Services page, Administrators can map their customizations for the
directory service.
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Task:

Creating Directory Services Attributes

To add a new Directory Services attribute from the directory server into the AdminStudio Enterprise Server
database, perform the following steps.

To create a new Directory Services attribute:

1.

On the Directory Services page, click Manage Directory Services Attributes. The Directory Services
Attributes Administration page opens.

Click Add. The Add Directory Service Attributes view opens.

Using the current user’s credentials, the Attribute Name list lists all of the Directory Services attributes from
the Directory Services server. Select the Directory Services attribute that you want to add to the AdminStudio
Enterprise Server database. A Directory Services attribute is used in Directory Services protocol to access
information directories, such as employeeNumber or documentAuthor.

In the Attribute Alias text box, enter the name that you want to use to identify the Directory Services attribute
in AdminStudio Enterprise Server, such as Employee ID or Author.

Click Add to add the defined Directory Services attribute. If AdminStudio Enterprise Server is unable to
connect to the server (and no attributes are retrieved), the Add button is disabled.

Deleting Directory Services Attributes

To delete a Directory Services Attribute, open the Directory Services Attributes Administration page and click
Delete next to the attribute that you want to delete.

Managing User Logins

144

This section explains the four methods of logging into AdminStudio Enterprise Server, and how to set the session
timeout value.

Login Methods

Using AdminStudio Enterprise Server Account Login
Using Domain Account Login

Using Single Sign-On Login

Using Guest Account Login

Setting the Session Timeout Value
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Login Methods

There are four methods you can use to login to AdminStudio Enterprise Server:

Table 4-1 « AdminStudio Enterprise Server Login Methods

Method

AdminStudio

Enterprise
Server
Account
Login

Domain
Account
Login

Single Sign-
On Login

AdminStudio 10.0 User Guide

Description

Users login to AdminStudio Enterprise Server using a User
Account (User Name and Password) that was created in
AdminStudio Enterprise Server by clicking Add on the User
Administration page.

Users login to AdminStudio Enterprise Server using their
Domain Account (User Name and Password), the same
account they use to login to their network.

To set this up, you import users or groups from a Directory
Service: Active Directory or Novell eDirectory.

E

Note ° For domain account login, the Anonymous access option
on the IIS Authentication Methods Dialog Box must be selected.

You set up AdminStudio Enterprise Server so that if users
are logged on to your network using their Domain Account
(User Name and Password), they are automatically logged
in to AdminStudio Enterprise Server.

To set this up, you import users or groups from Active
Directory

E

Note ° For Single Sign-On, IIS performs user authentication. For all
other login methods, AdminStudio Enterprise Server performs
authentication.

E

Note « Single Sign-on is not supported for Novell eDirectory users
and groups.

E

Note  For single sign-on login, the Anonymous access option
on the IIS Authentication Methods Dialog Box must not be selected.
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Related Topics

Using AdminStudio
Enterprise Server
Account Login

Creating a New User
Account

Using Domain Account
Login

Adding a Directory
Service Connection

Importing Directory
Services Users and
Groups

Using Single Sign-On
Login

Adding a Directory
Service Connection

Importing Directory
Services Users and
Groups
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Table 4-1 « AdminStudio Enterprise Server Login Methods (cont.)

Related Topics

AdminStudio Enterprise Server login credentials to access

Method Description

Guest You set up a Guest account to permit users without
Account

Login features — such as viewing Reports or searching for an

Application Request — without entering a User ID or

Password.

1S Authentication Methods Dialog Box

To set the Anonymous access option in IS, perform the following steps.

7

Task: To open the IIS Authentication Methods dialog box:

1.

2
3.
a
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Open Internet Information Services (lIS).

Select the AdminStudio Enterprise Server Web site in the tree view.

Using Guest Account
Login

Setting Up a Guest
Account

Logging in as a Guest

On the Action menu, select Properties. The Web Site Properties dialog box opens.

Open the Directory Security tab and click Edit in the Anonymous access and authentication control

area. The Authentication Methods dialog box opens.

Authentication Methods

[#] Arroremons: secess
Ho user name/passwond requied to access this resownce.
Accourt used for anormOus JCCEST

User name: | USER_rZSMITHIOHNP Bt
Password:
[] vt 115 1y cominol passwond

Autherticabed access
o the lcllowng suthentication methods, wer name and passwond
e paquired when

- anOnMoUS accest B deablad, o

- access ik resticbed using MTFS access conbrol ksts
Duwlmm fon "Windows domain serveis

[#] Basic suthentication [password is serk in chear text]

ot e
Reakn ICOMEAn. Com

[#] Irtegated Windows suthenticstiaon

Lok ] [ Comcel | [ Hep |

Figure 4-2: Anonymous Access option on the IIS Authentication Methods Dialog Box
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Using AdminStudio Enterprise Server Account Login

To Set Up

To set up AdminStudio Enterprise Server User Account login, create a user account (User Name and Password)
for each person that you want to have access to AdminStudio Enterprise Server. See Creating a New User
Account.

To Login

Users with AdminStudio Enterprise Server accounts enter their AdminStudio Enterprise Server-generated User
Name and Password on the AdminStudio Enterprise Server Login page. AdminStudio Enterprise Server performs
the authentication.

More Information

For more information, see Creating a New User Account

Using Domain Account Login

To Set Up
To set up Domain Account login, you do the following:

e Set up a Windows Active Directory or Novell eDirectory Directory Service Connection. See Adding a
Directory Service Connection.

e  On your AdminStudio Enterprise Server IS Server, open the IIS Authentication Methods Dialog Box and select
the Anonymous access option. This specifies that AdminStudio Enterprise Server is going to authenticate
the users.

e Import users or groups from that Directory Service. See Importing Directory Services Users and Groups.

To Login

Imported users or users belonging to the imported groups enter their Directory Service User Name and
Password on the AdminStudio Enterprise Server Login page.

AdminStudio Enterprise Server then connects with the Directory Service using the credentials provided on the Add
Directory Service Connection View, and then passes the login User Name and Password to the Directory Service
so that it can authenticate the user.

E

Note » When entering the User Name, it is not necessary to enter the Directory Service domain name.

AdminStudio 10.0 User Guide ADS-1000-UG00 147



Chapter 4: Managing Users, Directory Services, and User Logins
Managing User Logins

More Information

For more information, see:
e Adding a Directory Service Connection
e Importing Directory Services Users and Groups

e IS Authentication Methods Dialog Box

Using Single Sign-On Login

To Set Up
To set up Single Sign-on login, you do the following:

e Set up a Windows Active Directory Directory Service Connection. See Adding a Directory Service
Connection.

e  On your AdminStudio Enterprise Server [IS Web Server, open the IIS Authentication Methods Dialog Box and
clear the Anonymous access option. This specifies that IS is going to authenticate the users.

e Import users or groups from that Active Directory Directory Service. See Importing Directory Services Users
and Groups.

E

Note ° Regarding Single Sign-On, note the following:

e For Single Sign-On, IIS performs user authentication . For all other login methods, AdminStudio Enterprise
Server performs authentication.

e Single Sign-on is not supported for Novell eDirectory users and groups.

To Login

When a user with single sign-on opens AdminStudio Enterprise Server, the IS Web Server checks to see if the
user’'s domain User Name and Password are valid in the Active Directory Domain Server, and then automatically
logs the user in to AdminStudio Enterprise Server. AdminStudio Enterprise Server does not need to connect to the
Active Directory Domain Server.

For More Information

For more information, see:
e Adding a Directory Service Connection
e Importing Directory Services Users and Groups

e IS Authentication Methods Dialog Box
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Using Guest Account Login

This section describes how to setup a Guest Account and how to login using a Guest Account:
e Setting Up a Guest Account

® loggingin as a Guest

Setting Up a Guest Account

When a Guest Account is set up, AdminStudio Enterprise Server users without a User Account are automatically
logged in using a Guest Account.

The AdminStudio Enterprise Server administrator can set up a Guest account to permit users without login
credentials to access features such as viewing a report or searching for an Application Request . By using a Guest
Account, Administrators do not have to add a new user account just to provide access for users who only need
very limited functionality.

AdminStudio Enterprise Server system administrators should configure a Guest Account as follows:

Task: To set up a Guest Account:

1. Create a new user account to use as the Guest Account, and add this user to the web. config file located in the
AdminStudio Enterprise Server Web Application wwroot directory. Enter the user name in the following
location of the web. config file:

<!-- Guest System Access -->
<add key="GuestAccount" value="username@companyname.com" />

2. On the Administration tab, click Users & Groups. The User Administration page opens.

3. Assign the Guest Account user to Roles with limited permissions. See Managing Roles and Permissions for
more information.

Guest System Access Recommendations
When setting up Guest System Access, please follow these guidelines:

e The AdminStudio Enterprise Server Administrator should assign the Guest account user to Roles with limited
privileges. If the Guest account belongs to a Role with high privileges, then every user who logs on as a Guest
will have high privileges.

e If the GuestAccount key does not exist in the web. config file, then the Guest Access option does not appear
on the AdminStudio Enterprise Server Login page.

e |[fthe GuestAccount key exists in the web. config file but the user name specified in the value is empty (such as
value=""), then the Guest Access option does not appear on the AdminStudio Enterprise Server Login page.

e If the GuestAccount key exists in the web. config file, but the user name specified in the value does not exist in
the AdminStudio Enterprise Server database, then AdminStudio Enterprise Server displays an error message
when a user tries to log on as a Guest User.
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Configuring a Guest Account on a Workflow Manager Portal Site

Please note the following regarding configuring a Guest account on a Workflow Manager Portal site:

E

If users are accessing Workflow Manager through a Workflow Manager portal, then the AdminStudio
Enterprise Server administrator should add the GuestAccount key to the web. config file of the Portal site. By
default, Workflow Manager will use the Guest account value configured at the portal site to log on the Guest
user. If the portal site does not have any GuestAccount value configured, then Workflow Manager uses the
GuestAccount value at the Workflow Manager Web Application site to log on the Guest account.

If users are accessing the Workflow Manager site directly (not going through a portal), then Workflow Manager
uses the GuestAccount value configured in the web. config file located in the AdminStudio Enterprise Server
Web Application wwwroot directory to log on the Guest account.

Note * The web.config file installed by AdminStudio Enterprise Server should contain the GuestAccount key with
an empty value. It is the responsibility of the System Administrator to fill in that value in the web. config file of the
Portal site or the AdminStudio Enterprise Server Web Application site.

Logging in as a Guest

150

Before anyone can log on to AdminStudio Enterprise Server as a Guest User, the System Administrator must
configure a Guest Account, following the instructions in Setting Up a Guest Account. Then a user could log on to
your AdminStudio Enterprise Server site as a guest using the appropriate method:

If Directory Service authentication is used at your site, and the user’s Directory Service user name does
not exist in the AdminStudio Enterprise Server database, AdminStudio Enterprise Server automatically logs
this user on using the Guest account.

If Directory Service authentication is not used at your site, AdminStudio Enterprise Server opens the
AdminStudio Enterprise Server Login page by default. The user then selects the Guest Access option and
clicks Login.
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) User Login

User Mare:
Password;

I Forgok my passwiord

Domain:

Database w

Remember my user name

{(*) Guest Access

The AdminStudio Enterprise Server Administrator assigns the Guest account to specific Roles, and the degree of
permissions that the Guest account has depends upon which Roles the account is assigned to.

e When a Role is created, the administrator must indicate whether that Role has permission to create a
Workflow Manager Application Request.

e When Reports are created, the administrator must indicate which Roles have permission to view them.
Guest Users can view all Reports that their assigned Roles have permission to access.

Setting the Session Timeout Value

When AdminStudio Enterprise Server is installed, the session timeout value is set to 20 minutes. This means that
after you login to the AdminStudio Enterprise Server, if your session remains idle for 20 minutes, you are prompted
to login again.

You can change the session timeout value by editing two values in the web. config file: sessionState timeout and
LoginPageTimeOut.

Task: To change the session timeout value:

1. Open the wwroot directory of the AdminStudio Enterprise Server installation and open web.config in a text
editor.

2. Locate the line that contains sessionState timeout:

<sessionState timeout="20" mode="InProc" stateConnectionString= "tcpip=127.0.0.1:42424"
sqlConnectionString="data source=127.0.0.1; Trusted_Connection=yes" cookieless="false" />
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3. Change the value specified for sessionState timeout="nn" to the new timeout value.
4. Locate the following line that contains LoginPageTimeOut:
<add key="LoginPageTimeOut" value="19.5" />

5. Change this value to match the timeout value you specified for the sessionState.

Users/Groups and Directory Services
Reference

This section details the contents of the AdminStudio Enterprise Server pages that are used to manage users and
directory services:

Table 4-2 * Users/Groups and Directory Services Tabs Reference

Page Subpages

User Administration Page e User Details View

e Directory Services User/Group Add View

Directory Services Page e Directory Services List Page
e Add Directory Service Connection View
e Directory Services Attributes Administration Page

e Add Directory Service Attributes View

User Administration Page

This view lists all users defined in the system. From this view, you can add a new User, edit an existing User, or
import a Directory Service User or Group.

Table 4-3 * User Administration Page Options

Option Description

Add Click to access the User Details View, where you can add a new User.

Directory Service Click to access the Directory Services User/Group Add View, where you can import a

User/Group Import User or Group from an Directory Service.

Status To filter the list of users by Status, make a selection from this list: Active, Inactive or
All.
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Table 4-3 » User Administration Page Options (cont.)

Option Description

User Name Name user uses to log onto AdminStudio Enterprise Server, in the format of:
user’name@companyname .com

If a Directory Services Group has been imported, the Group name is listed in this

column.
Roles Lists the roles that this User has been assigned to.
Company Name of user’s Company.

From the User Administration page, you can perform the following tasks:

® Create a AdminStudio Enterprise Server user account—Create a user account for each person that you
want to have access to AdminStudio Enterprise Server. See Creating a New User Account.

e Import Directory Service Users or Groups—Set up a Windows Active Directory or Novell eDirectory
Directory Service Connection and the click Directory Service User/Group Import on the User
Administration page to import Users or Groups from that Directory Service. See Importing Directory Services
Users and Groups. Importing a group allows you to provide dynamic access to all of the members of that
Group as the members of that Group changes.

e Edit a user account—To edit an existing account, click Select next to the User Name to open the User
Details view.

E

Note * For more information on the methods for logging into AdminStudio Enterprise Server and how authentication
is performed, see Managing User Logins.
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User Details View
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On this view, enter or edit user account and imported Directory Services account information. On this page, you
can also delete a user account.

Table 4-4 * User Details View Options

Option Description

Company Select the Company that this user or group belongs to.

User Name Perform one of the following:

e New—When creating a new user, enter the name the user will use to log onto
AdminStudio Enterprise Server in the format of: username@companyname . com.

e Importing—When importing a user group from a Directory Service, the name listed
here will be prepopulated and uneditable.

Password Enter the User’s password.

Note -« This field is not shown when importing a Directory Service Group.

Status Select Active to make this user or group active in the AdminStudio Enterprise Server
system, or select Inactive to disable this account. See Disabling a User or Group
Account.

Email User’s email address.

Note - This field only appears when creating a new user account. For users imported from a Directory
Service, this information is retrieved dynamically from the Directory Service when needed.

Roles Listing of all of the defined Roles at the selected Company. Select the Roles appropriate
for this user or group.

Location Optionally, enter a geographic Location that you can use to group users together, such as
New York Office or Midwest Region, etc. Assigning a geographical location to a user
enables you to display this information in reports.

Update Click to save your entries and close the User Details view.

Update and Add | Click to save your entries and remain in the User Details view, where you can enter

New another new user.

Delete Click to delete this user account.

Cancel Click to exit this view without saving your entries.
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Directory Services User/Group Add View

This view is accessed by clicking Directory Service User/Group Import on the User Administration page.
The following options are included:

Table 4-5 * Directory Services User/Group Add View

Option

Select a Directory
Service

Select Group or
User

Filter Directory
Service List

Select Group or
User to Add

Update

Description
Select the defined Directory Service that you want to import a user or group from.

E

Note « For information on defining a Directory Service Connection, see Adding a Directory
Service Connection.

Specify whether you are importing a User or a Group.

Select Show All to include all Users or Groups in the list, or select Filter list by,
enter text in the box, and click Find to filter the list by the specified criteria.

For example, to search for all of the users that start with the letter P, use the asterisk

wildcard character (*) and enter P* in the Filter list by box.

From the Select Group or User to Add list, select the group or user to import.

E

Note - If you import a User that is a member of a Group that was previously imported, that User
inherits the Roles that are assigned to that Group. You can then assign additional Roles to that
User.

Click to save your entries.

The selected user or group is then opened in the User Details View.
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Directory Services Page

AdminStudio Enterprise Server can be integrated with Windows Active Directory and Novell eDirectory. This
integration enables you to integrate Directory Services Users and Groups and also to use Directory Services
attributes.

Table 4-6 * Directory Services Page Options

Option Description

Manage Directory Click to open the Directory Services List Page where you can set up connections

Service Connections to Active Directory and eDirectory Directory Services.

Manage Directory Click to open the Directory Services Attributes Administration Page where you

Service Attributes can map Directory Service attributes, which can be used when defining Data
Elements.

When a Data Element is defined as a Directory Service attribute, when this Data
Element appears during a data entry step in a Workflow, information about the
logged in user will be pulled from the Directory Service to populate those fields,
such as: Department, Location, Employee Number, etc.

E

Note * For more information about Directory Services and Lightweight Directory Access Protocol (LDAP), see
Ldp Overview on the Microsoft TechNet Web site.

Directory Services List Page

Directory Services Connections are used to import users and groups into AdminStudio Enterprise Server, and to
authenticate Active Directory or Novell eDirectory users logging into AdminStudio Enterprise Server.

You can choose to have a Directory Service listed in the Domain list on the AdminStudio Enterprise Server login
page. This enables users in this Directory Service to login to AdminStudio Enterprise Server using their enterprise
network credentials.

The information and options are included:
Table 4-7 « Directory Services List Page Options
Option Description

Directory Service Name The name that identifies this Directory Service in the Domain list on the
AdminStudio Enterprise Server login page.

Description A description of this Directory Service.
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Table 4-7 - Directory Services List Page Options (cont.)

Option Description

Directory Service Type Identifies this Directory Service as either a Windows Active Directory or Novell
eDirectory type.

Directory Service Host The name or IP address of the Server on which this Directory Service is running.

Add Click to add a new Directory Service connection.

Add Directory Service Connection View

On the Add Directory Service Connection view, which is opened by clicking Add on the Directory Services List
Page, you enter the necessary settings to connect to an Active Directory or Novell eDirectory Directory Service.

Table 4-8 * Add Directory Service Connection View Options

Option Description

Use to Authenticate | Select Yes to include this Directory Service in the Domain list on the AdminStudio
Users? Enterprise Server login page. This enables users to login to AdminStudio Enterprise
Server using their enterprise network credentials.

E

Note « For Single Sign-On, IIS performs user authentication. For all other login methods,
AdminStudio Enterprise Server performs authentication.

Directory Service Enter a name to identify this Directory Service in the Domain list on the AdminStudio
Name Enterprise Server login page. It is recommended that the Directory Service Name
match the Domain Name.

Description Enter a description of this Directory Service.
Directory Service Identify the type of Directory Service that you are adding a connection to:
Type

e Active Directory

® Novell eDirectory

Directory Service Enter the name or IP address of the Server on which this Directory Service is running.
Host

Directory Service Enter the port number of the Server on which this Directory Service is running. By
Port default, AdminStudio Enterprise Server uses Port 389.

7]

Important * The value for the Directory Service Port should be the port on the given server to
which AdminStudio Enterprise Server should connect to send LDAP queries.
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Option

Base Distinguished
Name

Domain Name

Use Secure Socket
Layer (SSL)?

Connect
Anonymously?

Admin
Distinguished Name

Table 4-8 » Add Directory Service Connection View Options (cont.)

Description

Enter the Base Distinguished Name (DN) to identify the root node of this Directory
Service.

For example, for MyCompany, the Base DN could be:
dc="MyCompany", dc="com"
Enter the Domain Name of this Directory Service. This Domain Name is used to create

the right credentials, along with the Admin User Name. For example, you would enter
DomainName\AdminUserName to connect to the specified Directory Service.

E

Note * To upgrade from AMS 2.5, enter the same Domain Name that was used in AMS 2.5.
AdminStudio Enterprise Server will read this Domain Name and then try to authenticate the User
using this Directory Service. For single sign-on to work on an upgrade scenario from 2.5 to 4.0,
administrators have to configure at least one Directory Service.

Select Yes if this Directory Service is configured to use Secure Socket Layer (SSL).

Select No if you do not want to permit anonymous connections.

If you select Yes to permit anonymous connections, AdminStudio Enterprise Server
may not be able to authenticate Directory Service users and may not be able to add
Directory Service users/groups into AdminStudio Enterprise Server.

Enter the Distinguished Name of a user who has permission to retrieve users/groups
information and authenticate any user against this Directory Service. Enter the
Distinguished Name in the format of:

domainname\username

such as:

abcinc\jsmith

Password

Enter the password for the Admin Distinguished Name.

Group Class Name

Enter the object class names for groups for this Directory Service. Default values are:

e Active Directory: group

e eDirectory: groupofnames

Group Name
Attribute

Enter an attribute used by this Directory Service to name groups. The default value for
both Active Directory and eDirectory is cn.
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Table 4-8 » Add Directory Service Connection View Options (cont.)

Option

Group Member
Attribute

User Class Name

Description

Enter an attribute used by this Directory Service to define member groups. Default
values are:

e Active Directory: member

e eDirectory: uniquemember
Enter the object class name used by this Directory Service for users. Default values
are:

e Active Directory: user

e eDirectory: inetorgperson

User Name Attribute

Enter the attribute used by this Directory Service to identify users. Default values are:

® Active Directory: samaccountname

e eDirectory: uid

Update

Update and Import
(User/Group)

Test Connection

Click to save your entries and return to the Directory Services List Page.

Click to save your entries and open the Directory Services User/Group Add View.

Click to test to see if the settings that you entered can be used to successfully connect
to this Directory Service.

Directory Services Attributes Administration Page

On the Directory Services Attributes Administration page, which is accessed by clicking Manage Directory
Services Attributes on the Directory Services page, Administrators can map their customizations for the

directory services.

Directory Service attributes can be used when defining Data Elements. When a Data Element is defined as a
Directory Service attribute, when this Data Element appears during a data entry step in a Workflow, information
about the logged in user will be pulled from the Directory Service to populate those fields, such as: Department,
Location, Employee Number, etc.

The following information is listed:

Table 4-9 - Directory Services Attributes Administration Page Options

Option Description

Directory Name of the LDAP (Lightweight Directory Access Protocol) Directory Service attribute that
Service is used in Directory Services protocol to access information directories, such as
Attribute employeeNumber or documentAuthor.
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Table 4-9 « Directory Services Attributes Administration Page Options (cont.)

Option Description

Attribute Alias Name that you want to use to identify the Directory Service attribute in AdminStudio
Enterprise Server, such as Employee ID or Author.

Delete Click to delete the listed attribute.

Add Directory Service Attributes View

When you click Add on the Directory Services Attributes Administration page to add a new Directory Service
attribute into the AdminStudio Enterprise Server database, the following fields are displayed:

Table 4-10 * Add Directory Service Attributes View Options

Option Description

Directory Select the Directory Service that contains the attribute that you want to add.

Service

Attribute Lists all the attributes from the selected Directory Service server, using the currently logged
Name user’s credentials.

Attribute Alias | Enter the name that you want to use to identify the Directory Service attribute in
AdminStudio Enterprise Server.

Add Click to add the defined Directory Service attribute. If AdminStudio Enterprise Server is
unable to connect to the server (and no attributes are retrieved), the Add button is disabled.

When a Data Element is defined as a Directory Service attribute during Workflow Manager Template creation, when
this Data Element appears in the Workflow, information will be pulled from the Directory Service to populate those
fields, such as:

= FirstMarne
Gregaory

= LastMame
Johnsan

However, if the user is not connected using Directory Service authentication, then the fields will be left blank and
will be enabled.
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All of the AdminStudio and Workflow Manager permissions are related to Roles. The amount of functionality that a
user has is directly related to what Roles they are assigned to.

This section contains information on the following tasks:
e AdminStudio and Workflow Manager Roles and Permissions

e Creating a New Role

e Editing an Existing User Role
e Copying an Existing Role
® Roles Reference

AdminStudio and Workflow Manager Roles
and Permissions

Permissions are assigned to Roles, and Roles are assigned to users. Therefore, all permissions in AdminStudio
and Workflow Manager are controlled by Roles.

This section includes the following topics:

® Role Permission Lists
e AdminStudio Client Tools Permissions
e AdminStudio Enterprise Server Tools Permissions
e  Workflow Manager Permissions

e System Roles
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Role Permission Lists

Permissions to perform all AdminStudio and Workflow Manager functions are assigned using Roles. A user has
permission to perform only those tasks that are explicitly selected in the Role(s) that the user is assigned to.

This section describes all of the AdminStudio and Workflow Manager permissions:
® AdminStudio Client Tools Permissions
e AdminStudio Enterprise Server Tools Permissions

e Workflow Manager Permissions

AdminStudio Client Tools Permissions

The AdminStudio client tools have the following permissions:
Table 5-1 « AdminStudio Client Tools Permissions

Category Permission

AdminStudio e Edit—Permits user to view and edit those Projects on the Process

Process Assistants Tab Assistants tab that are assigned to him.

® Create—Permits user to create new Projects and assign them to users.
Users with the Create permission see a list of all users and their associated
Projects on the Process Assistants tab. Users with only the Edit
permission cannot create new Projects and can only view and edit Projects
that are assigned to him.

o Delete—Permits user to delete a Project from the Process Assistants tab.

AdminStudio ® View—Permits user to view the Process Template Editor and all of the

Process Template Editor existing Workflows.

e Edit—Permits user to edit existing Workflows on the Process Template

Editor
® Create—Permits user to create a new Workflow on the Process Template
Editor
® Delete—Permits user to delete a Workflow from the Process Template
Editor.
AdminStudio ® Add—Permits user to add a new tool to the Tools tab.
Tools Tab e Edit—Permits user to edit the properties of an existing tool on the Tools tab.

o Delete—Permits user to delete an existing tool on the Tools tab.
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Table 5-1 « AdminStudio Client Tools Permissions (cont.)

Category
AdminStudio

General

Permission

Modify Tools Options Dialog—Permits user to set options on the
Locations, Updates and Quality tabs of the AdminStudio Options dialog
box. Users without this permission can view the Options dialog box but
cannot make any changes.

If a user has only the Modify Tools Options Dialog permission but does
not also have the Change Default Application Catalog permission, that
user cannot edit the Shared AdminStudio Application Catalog field on
the Application Catalog tab of the Options dialog box.

Change Default Application Catalog—Permits user to edit the Shared
AdminStudio Application Catalog field on the Application Catalog tab
of the Options dialog box (if that user also has the Modify Tools Options
dialog permission). This permission also permits user to edit the Make this
the default shared Application Catalog option on the Connect
Application Catalog dialog box

Application Manager /
Conflict Solver

Conflicts

Application Manager /
Conflict Solver

Package

Run Analysis—Permits user to perform conflict analysis on a package.

Resolve—Permits user to resolve any automatically resolvable conflicts
found during conflict analysis on a package.

Modify Rules—Permits user to open the Rules Viewer and create and edit
new Rules.

Modify Data—Permits user to create new Groups, rename existing Groups,
and modify Group Properties.

Permits user to Cut and Paste a Group to a new location.

Permits user to Copy/Cut and Paste a package into a new Group.

Permits user to modify options on the Resolution Options dialog box.

Permits user to edit a package Description on the Products View.

Delete—Permits user to delete a package from the Application Catalog.
Import—Permits user to import a package into the Application Catalog.

Modify Extended Attributes—Permits user to modify a package’s
metadata on the Extended Attribute view.

Delete History—Permits user to delete a package’s history log (which
contains a record of any operation that materially changes a software
package or the data associated with it).
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Table 5-1 « AdminStudio Client Tools Permissions (cont.)

Category

Application Manager /
Conflict Solver

Other

Patch Impact Manager

Software Repository

Permission

Modify Tools Options Dialog—Permits user to open the Application
Manager/ConflictSolver Options dialog box and set options.

Change Application Catalog—Permits the user to connect to a different
Application Catalog by selecting Connect on the Catalog menu. Without
this permission, this selection is disabled.

Run Merge Wizard—Permits user to use the Merge Wizard to merge the
application data of a specified Application Catalog into the currently open
Application Catalog.

Run Validation—Permits user to use the Validation Wizard to validate a
Windows Installer package against custom actions written by Microsoft
which can be executed to determine if an installation package is built
according to Windows Installer standards.

Scan for Dependencies—Permits user to generates a list of all of a
package’s files that have dependencies with files used by other products or
operating systems in the Application Catalog.

Run Directory Monitoring—Permits user to use the Network Directory
option of Package Auto Import to monitor a directory location on the
network (or a local directory) and automatically import or re-import packages
in that directory at scheduled intervals.

Run Best Practices—Permits user to use the Conflict Wizard or the
ConflictSolver Process Assistant to evaluate source packages to see if they
meet Windows Installer best practices rules.

Import Patch—Permits user to use OS Security Patch Wizard to import
Windows operating system patches into the Application Catalog.

Run Analysis—Permits user to use the ConflictSolver Patch Impact
Analysis Wizard to analyze the impact of installing an OS Security patch on
user machines.

Overwrite—Permits user to import a duplicate package into the Software
Repository, overwriting the existing version.
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AdminStudio Enterprise Server Tools Permissions

The AdminStudio Enterprise Server tools have the following permissions:

Table 5-2 *+ AdminStudio Enterprise Server Tools Permissions

Category Permission
People e View—Permits user to see the Administration/Users & Groups tab.
e Add—Permits user to add new users and import a users list from Active
Directory.
e Edit—Permits user to modify existing users.
® Delete—Permits user to delete existing or newly created users.
Roles ® View—Permits user to see the Administration/Roles tab.
e Add—Permits user to add new Roles.
e Copy—Permits user to copy an existing Role.
e Edit—Permits user to modify an existing Role.
e Email Notify Enabled—Not currently in use.
Directory Services e View—Permits user to see the Administration/Directory Services tab and
view the Directory Services page, the Directory Services List page, and the
Directory Services Attributes Administration page.
® Add—Permits user to add a new Directory Service.
e Edit—Permits user to edit an existing Directory Service.
e Delete—Permits user to delete existing or newly created Directory Services.
System Settings ® View—Permits user to open the Administration/System Settings tab.
e Edit—Permits user to edit the fields on the Administration/System Settings

tab: AdminStudio Enterprise Server User Account and the Workflow Manager/
AdminStudio Enterprise Server Serial Numbers.
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Table 5-2 « AdminStudio Enterprise Server Tools Permissions (cont.)

Category

Job Manager

Permission

View—Permits user to see the Job Manager tab only if that user also has at
least one of the following Job Manager permissions: Manage Jobs, Manage
Templates, or Configuration.

If you only have the Job Manager View permission (and none of the other Job
Manager permissions), you will not be able to view the Job Manager tab or any
of its subtabs.

Manage Templates—Permits user to see the Job Manager/Manage
Templates tab, view the list of Templates on the Job Template List page, and
view the details of an existing Template on the Edit Template page.

Users with only the View and Manage Templates permission cannot create a
new Template or edit an existing Template.

When a Role is assigned the Manage Templates permission, the View
permission is automatically selected.

Manage Jobs—Permits user to see the Job Manager/Manage Jobs tab,
view the list of Jobs on the Jobs Queue page, and view the details of a Job that
they created on the Edit Job page.

Users with only the View and Manage Jobs permission cannot create a new
Job or edit an existing Job.

When a Role is assigned this permission, the View permission is automatically
selected.

Manage Jobs for All Owners—Adds the Show All Jobs check box option to
the Jobs Queue page, which enables this user to see a list of Jobs created by
all users. For users without this permission, only those Jobs that they created
are listed.

Configuration—Permits the user to view the list of conflict detection rules that
are selected on the Conflict Detection Options page. However, if this user
does not also have the Edit permission, this user will not be able to make any
changes to this list.

When a Role is assigned this permission, the View permission is automatically
selected.

Edit—If a user also has the Manage Templates and/or Manage Jobs
permissions, this permission allows the user to create new Templates and Jobs,
and also to edit existing Templates and Jobs. If this user has this permission and
also has the Configuration permission, this user can modify the selections on
the Conflict Detection Options page.
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Table 5-2 « AdminStudio Enterprise Server Tools Permissions (cont.)

Package Reports

Software Distribution e

Category Permission
Report Center / o Add—Permits user to click Add on the All Reports page and create a new
All Reports Custom Report using the Report Wizard.
e Edit—Permits user to edit an existing Custom Report.
e Delete—Permits user to delete an existing Custom Report.
Report Center / e View—Permits user to see the Package Reports tab and view Package

Reports.

Operate—Permits user to use Configuration Manager Web Console (the
Distribute tab of AdminStudio Enterprise Server) to configure package
distribution options and distribute setup packages without going to
Configuration Manager Server.

Workflow Manager Permissions

Workflow Manager has the following permissions:

Table 5-3 « Workflow Manager Permissions

Application Request °

Category Permission

View—Permits user to view the Properties and Issues tabs on the
Application Progress page of existing Application Requests.

Add—Permits user to create a new Application Request.
Edit—Permits user to edit an existing Application Request.
Copy—Permits user to copy an existing Application Request.
Delete—Permits user to delete an existing Application Request.

Monitor Application Progress—Permits user to see the Application
Progress, Uploaded Files, and Downloadable Files tabs of the
Application Progress page. Also permits user to complete Workflow Steps.

View Related Applications—Permits user to view the Related Applications
tab of the Application Progress page.

Add Related Applications—Permits user to link one Application Request to
another on the Related Applications tab.

Delete Related Application Links—Permits user to delete Related
Application links.

Edit Application Due Period—Permits user to edit the Application Due
Period field on the Properties tab of the Application Progress page.
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Table 5-3 « Workflow Manager Permissions (cont.)

Category Permission
Application Status ® View—Permits user to view the Application Status Administration page and
Management to view (but not update) Application Status details on the Edit Application
Status view.
e Add—Permits user to add a new Application Status.
e Edit—Permits user to update Application Status details on the Edit
Application Status view.
e Delete—Permits user to delete an existing Application Status
Calendar Settings e View—Permits user to view the Calendar Settings Administration page.
e Edit—Permits user to edit the settings on the Calendar Settings
Administration page.
Issues e View—Permits user to view the Issues tab of the Application Progress page
and to view the issue details.
e Add—Permits user to create a new E-mail or Knowledge Base issue .
o Respond—Permits user to respond to an existing issue.
® Close—Permits user to close an E-mail or Knowledge Base issue.
e Add/Close Critical Issue—Permits user to create and close Critical issues.
My Notifications e View—Permits user to view the My Notifications pages: My Default Project
Notifications and My Application Notifications.
e Edit—Permits user to edit the settings on the My Notifications pages: My
Default Project Notifications and My Application Notifications.
Project Permissions e View—Permits user to view (but not edit) the permission and email settings on
the Project Permission and Notification Settings view.
e Edit—Permits user to edit the permission and email settings on the Project
Permission and Notification Settings view.
Projects e View—Permits user to view the Project Administration page and view (but
not update) Project details on the Project Details view.
e Add—Permits user to create a new Project.
e Edit—Permits user to edit the details of an existing Project.
o Delete—Permits user to delete a Project.
Requestor Company e View—Permits user to view a list of existing Requestor companies and view
Requestor company details.
® Add—Permits user to add new Requestor companies.
e Edit—Permits user to update Requestor company details.
® Delete—Permits user to delete an existing Requestor company.
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Table 5-3 « Workflow Manager Permissions (cont.)

Category Permission

Search e Simple Search—Permits user to enter keywords in the Application Search
box on the Workflow Manager Home page to search for an Application
Request by name.

e Advanced Search—Permits user to search for Application Requests by
multiple criteria on the Application Search page.

Servicer Company ® View—Permits user to view a list of existing Servicer companies, view Servicer
company details, and update those details.

e Add—Permits user to create new Servicer companies.

Templates ® View—Permits user to view the Template Administration page and view
Template details on the Template Details page. Also gives you permission to add
an external data source on the External Data Sources subtab of the
Administration tab.

e Add—Permits user to edit an existing Template and create a new Template.
e Copy—Permits user to copy an existing Template.

Terminology ® View—Permits user to view and modify AdminStudio Enterprise Server system
terminology.

Work Assignment ® View—Permits user to view the Working Queue View and Work Assignment
Listing pages to see a list of existing work assignments.

e Assign—Permits user to assign work on the Assignment Details page.

Global Email e View—Permits user to view the Email Settings Administration and External

Administration Email Address Administration pages.

e Edit—Permits user to edit the settings on the Email Settings Administration
and External Email Address Administration pages.

Deployment Sites e View—Permits user to see the Deployment Site Administration page.

e Add—Permits user to add a new Deployment Site.
e Edit—Permits user to edit an existing Deployment Site.
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System Roles

AdminStudio and Workflow Manager come with default System Roles which cannot be modified. These Roles
were created based upon the needs of typical AdminStudio and Workflow Manager users, providing each Role
with only the permissions a user would need to perform their required tasks. You can either assign these System
Roles to users, or you can copy System Roles and then modify them to customize them for your organization.

Copied System Roles or new Roles that you create have a Role Type of User (User Roles), while default Roles
created during installation have a Role Type of System (System Roles). A Role’s Role Type is listed on the Role
Administration page and cannot be changed.

Information about System Roles is organized in the following sections:
® Superuser Role: AMSSuper
® Default System Roles

e Default System Users

Superuser Role: AMSSuper

170

When AdminStudio Enterprise Server and Workflow Manager are installed, the following user is created and is
assigned the AMSSuper Role:

e User Name: suams
e Password: suams

A user assigned the AMSSuper Role can create Servicer companies and customize terminology. All other tasks
should be performed by a Service Company administrator or by accounts created by a Service Company
administrator.

E

Note « The AMSSuper Role is not listed on the Role Administration page unless you are logged on using the
suams account.
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Default System Roles

When AdminStudio Enterprise Server and Workflow Manager are installed, the following System Roles are created:

Role Mame Campary Marme Rale Description

Select  Application User Requester Application User For Requestor Company Sy sbem
Seleck Project Manager Fequester Project Manager for Requeskor Company Swskem
Seleck Project Manager Servicer Project Manager Role Swskem
Select  Repackager Servicer Application Repackager Role System
Select  SCAdmin Servicer Syskem Administrator Role System
Select  Tech Lead SEFvicer Tech Lead Role Sy sbem
Seleck & Tester Requester I=er Acceptance tester for Requestor Company Swskem

Figure 5-1: Default System Roles

E

Note - Ifyou did not purchase Workflow Manager, the Roles associated with the Requester company are not listed:
Application User, Project Manager, and QA Tester.

E

Note - If you are connected to an Application Catalog that has been upgraded from AMS 2.5, all Roles will have a
Role Type of User.

The following table lists the default System Roles:

Table 5-4  Default System Roles

Role Name Company Name @ Description

Project Manager @ Servicer Project Manager for Servicer Company

Repackager Servicer Application Repackager for Servicer Company

SCAdmin Servicer System Administrator for Servicer Company

Tech Lead Servicer Tech Lead for Servicer Company

Application User = Requester (Workflow Manager only) Application User for Requester Company

Project Manager Requester (Workflow Manager only) Project Manager for Requester Company

UA Tester Requester (Workflow Manager only) User Acceptance Tester for Requester
Company
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You can view the permissions of each of these Roles by selecting the Role on the Role Administration page, and
then expanding the Role Permissions list.
Default System Users

When AdminStudio Enterprise Server and Workflow Manager are installed, a User Account is created for each of
these System Roles:

User Marme COmnpan

Select admini@servicer.com SCAdmin SErvicer
Select proi@requesker, com Project Manager Fequester
Select pro@sericer , com Project Manager Servicer
Select  repackageri@servicer.com Repackager Servicer
Select  techlead@servicer,com Tech Lead SErvicer
Select Lester@requester.cam & Tester Fequester
Select User@requesker, com application User Requesker

Figure 5-2: Default System Users

To see what functionality is available for one of these default System users, you could log on as that user and then
observe what features are available. You could also select the System user’s associated Role on the Role
Administration page, and then expand the Role Permissions list.

E

Note ° By default, the password for each of these default System Users is the same as the text prior to the @ sign
(such as techlead for techlead@servicer.com), except the password for pm@requester.com and
pm@servicer.com is projectmanager.
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Creating a New Role

o

Task:

To create a new Role, perform the following steps.

To create a new Role:

o o B 0 DN

On the Administration tab, click Roles. The Role Administration page opens.

Click the Add button. The Role Details View opens.

Enter a name in the Role Name field to uniquely identify this Role.

From the Role Company list, select the name of the Company whose users can be assigned this Role.
In the Role Description text box, describe the purpose of this new Role.

In the Role Permissions list, select the permissions you want to assign to this Role. For a detailed list of the
available permissions, see Role Permission Lists.

Click the Update button. The new Role now appears in the list on the Role Administration page.

Editing an Existing User Role

o

You can edit all Roles with a Role Type of User, but System Roles cannot be modified.

Task:

To edit an existing User Role:

1.

2.

On the Administration tab, click Roles. The Role Administration page opens.
Select the Role that you want to edit. The Role Details View opens.

Make edits to the Role Name and Role Description fields, if desired.

E

Note - It is not recommended that you change a Role’s Role Company.
In the Role Permissions List, edit the permissions assigned to this Role.

Click the Update button. You are returned to the Role Administration page.
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Copying an Existing Role

You can make a copy of an existing User or System Role using a new Role Name. You can then modify it to
customize it for your organization. You cannot modify a System Role. You can also copy an existing Role from one
Company to another.

To copy an existing Role, perform the following steps.

Task: To copy an existing Role:

1.

2
3
4.
5
6

8.

9.

On the Administration tab, click Roles. The Role Administration page opens.

Click the Copy button. The Copy Role View opens.

From the Copy from Company list, select the name of the Company whose Role you want to copy.
From the Copy from Role list, select the Role that you want to copy.

From the Copy to Company list, select the Company that you are creating this new Role for.

Enter a name in the New Role Name field to uniquely identify this Role.

E

Note ° You are not permitted to have two Roles in the same Company with the same name. You are permitted
to use the same Role name in more than one Company.

From the Role Company list, select the name of the Company whose users can be assigned this Role.
In the Role Description text box, enter a description for the Role.

In the Role Permissions List, edit the permissions that were previously assigned to this Role.

10. Click the Update button. The new Role now appears in the Role list on the Role Administration page.

Deleting a Role

You can delete all Roles with a Role Type of User, but System Roles cannot be deleted.

o

Task: To delete an existing User Role:

1.

2
3.
a

174

On the Administration tab, click Roles. The Role Administration page opens.
Select the user-defined Role that you want to delete. The Role Details View opens.
Click Delete. You are prompted to confirm the deletion.

Click OK. The Role Details View closes and the Role you deleted is no longer listed on the Role
Administration page.
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Roles Reference

Reference information for Roles is presented in the following sections:

® Role Administration Page

e Copy Role View

e Role Details View

Role Administration Page

The Role Administration page lists all defined Roles on the system. From this view, you can edit existing Roles or
add new ones. The following options are available:

Table 5-5 * Role Administration Page

Option

Select

Role Name

Description

Click to access the Role Details View, where you can edit this Role.

Name of Role.

Role Company
Role Description

Role Type

Name of company that this Role was defined for.
Description of the purpose of this Role.

Identifies this role as one of the following:

e System—Role was created during installation and cannot be deleted or modified.
However, it can be copied and modified to create a User Role.

e User—Role created by an administrator either by copying an existing System Role
or by creating a new Role.

For more information, see System Roles.

Add

Click to access the Role Details View, where you can add a new Role.

Copy

Click to access the Copy Role View, where you can copy an existing Role.
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Copy Role View

On the Copy Role view of the Role Administration page you can copy an existing System or User Role.

Table 5-6 * Role Administration Page / Copy Role View Options

Option Description

Copy from Select the name of the Company that has a Role that you want to copy.

Company

Copy from Role Select the name of the Role that you want to copy. You can copy either System or User
Roles.

Copy to Company Select the name of the Company that this new Role is being created for.

New Role Name Enter a name to identify this new Role.
Copy Click to create this new Role and close the Copy Role view.
Cancel Click to exit this view without creating a new Role.
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Permissions are assigned to Roles, and Roles are assigned to users. Therefore, all permissions in AdminStudio
and Workflow Manager are controlled by Roles.

On the Role Details view, you can enter or edit information to identify a Role and set the Role Permissions. You can
also delete a user-defined Role.

Table 5-7 * Role Administration Page / Role Details View Options

Option

Role Name
Role Company

Role Description

Description

Enter a name to uniquely identify this Role
Select the Company whose employees can be assigned the Role.

Enter text to identify the purpose of this Role.

Role Permissions
List

Update

Delete

Cancel

Select the specific functionality permissions that you want to assign to this Role. For
more information, see Role Permission Lists and System Roles.

Click to save your entries and close the Role Details view.

Click to delete this user-defined Role.

E

Note - If you are editing a System Role, the Delete button will be disabled.

Click to exit this view without saving your entries.
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Managing Application Catalog
Databases

%

A

Edition * Application Manager is included with AdminStudio Professional and Enterprise Editions.

You use Application Manager to manage your applications and their deployment types in Application Catalog
databases. Tasks you perform using the Application Manager include importing packages, merging application
catalogs, setting up automatic package import, organizing packages into groups, and viewing a package’s
deployment types, extended attributes, files/components, INI file changes, registry entries, shortcuts, merge
modules, history, and tables.

Information about using Application Catalogs is organized into the following sections:

Table 6-1 ¢ Topics Regarding Using Application Catalogs

Section Description
Application Manager Describes the functionality available using Application Manager and how it differs
and ConflictSolver from ConflictSolver.

Managing Application Explains how to create, connect to, search for, organize, view information about,
Catalogs and delete packages from.

Importing Data Explains how to import Windows Installer packages (.msi) with any associated
transforms (.mst) or patches (.msp), merge modules (.msm), OS snapshots (.osc),
Marimba NCP files (.ncp), and other setup types. It also explains how to import
virtual applications in Microsoft App-V, Citrix XenApp, and VMware ThinApp
formats.
Y

Edition * Import support for Marimba Native Channel Packager (.ncp) files is available in
AdminStudio Enterprise Edition.
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Table 6-1 « Topics Regarding Using Application Catalogs (cont.)

Section Description

Viewing Application Explains how to view AdminStudio’s enhanced reporting services—graphical

Catalog Enhanced representations of summary data concerning the readiness of Windows Installer

Reporting and App-V packages for distribution—and how to create your own customizable
reports.

Using the Software Explains how to manage a software package’s associated installation files using

Repository the Software Repository.

Sharing Application Describes the three methods for sharing Application Catalog data in your

Catalog Data enterprise: merge, auto-import, and replication.

Taking OS Snapshots Explains how to create OS Snapshots using the OS Snapshot Wizard.

Reference Describes every view, dialog box, and Wizard available in Application Manager.

Application Manager and ConflictSolver

Application Manager and ConflictSolver are closely related tools. Both provide a comprehensive view of the
Application Catalog. However, the tasks you can perform using each of these tools differ:

e ConflictSolver is used to perform conflict detection and resolution for Windows Installer and App-V
packages.

e Application Manager is used for importing and storing packages in a database, and organizing those
packages.

This section compares these tools and includes the following topics:
e Functionality Comparison

® Accessing the Tools

Displaying ConflictSolver Options in Application Manager

Creating and Connecting to Application Catalogs
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Functionality Comparison

This table compares the functionality included in Application Manager and ConflictSolver.

Table 6-2 « Comparison of ConflictSolver and Application Manager Functionality

View

Application

Manager .

[ .

Major Functionality

Use to perform the following tasks

Import packages—Import packages into the
Application Catalog.

Manage packages—Organize packages into
Groups, rename packages, and delete
packages.

Merge Wizard—Merge data from a source
Application Catalog into the currently open
Application Catalog.

Package Auto Import—Set up the automatic
import of packages.

Software Repository—Import packages into
and check in and check out packages from the
Software Repository.

Associate a package with a Workflow
Manager package

Launch applications—Launch Predeployment
Test Preparation Wizard, InstallShield Editor, and
Distribution Wizard.

Run Virtualization Readiness—Run the
Virtualization Readiness tests and view a
package’s subsequent Virtualization Suitability
report.

Reports—View Package, File, and Registry
reports.

Package Sub-Nodes

Windows Installer Sub-Nodes

App-V

B

Adobe Reader 8 (8,000

R Extended Attributes
] Files/Cormponents
| 8 TMI File Changes

ﬁ Registry

- B Shorcuts

- Igd Wirtualization Suitability
t herge Modules

@ Catalog History

ﬂ Tables

Sub-Nodes

Adobe Reader 8
B Extended Attributes
[ App -y History
,:‘j Dependencies
- |_] Files/Directaries
gl Registry
- Bl Shortcuts
l@ File Type &ssociations
- Environment Yariables
@ Catalog History

ﬂ Tahles
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Table 6-2 « Comparison of ConflictSolver and Application Manager Functionality

View Major Functionality Package Sub-Nodes
ConflictSolver = Use ConflictSolver to perform the following tasks: Windows Installer Sub-Nodes
e Conflict Analysis and Resolution—Check B8 Adobe Reader 8 (v8.0.0)
one or more packages for conflicts against By Conflicts

others in the Application Catalog, and resolve
those conflicts.

e Validation—Validate Windows Installer package
against Microsoft ICEs (Internal Consistency
Evaluators),

o Test Results—View PackageExpert test results.

[ Walidation

[¥] Test Results

JLE Patch Impacts
E Dependencies
Ehj Associated Patches

ﬂ Tahles

e Patch Impact Analysis Wizard—Launch Patch = App-V Sub-Nodes

Impact Analysis Wizard for selected package.

e Dependency Scan—Generate a list of all of a
package’s files that have dependencies with files
used by other products or operating systems in
the Application Catalog.

e Associated Patches—View a list of imported
patches that, if installed, would update the
selected product.

e Reports—View Package, File, and Registry
reports.

For information on using ConflictSolver, see
Identifying and Resolving Application Conflicts Using
ConflictSolver.

Accessing the Tools

182

~ Adobe Reader 8

5%y Conflicts

)&] Dependencies

Both Application Manager and ConflictSolver can be opened from the Start Page, the Tools Gallery, or from a menu

shortcut.
' Application
ConflickSolver Manager

You can toggle between Application Manager and ConflictSolver by clicking a button in the toolbar:
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v

\— ConflickSolyer
Application Manager

When the ConflictSolver or Application Manager is active, ConflictSolver or Application Manager is listed in the
Title bar and also in the top right corner of the interface.

Displaying ConflictSolver Options in Application
Manager

By default, all functionality for interacting with the Application Catalog, including conflict detection and resolution, is
available in Application Manager.

To turn off the display of conflict detection and resolution options in Application Manager, select the check box in
the Application Manager Display Options area of the General tab of the ConflictSolver and Application
Manager Options dialog box.

Application Manager Display Options

Turn off dizplay of conflict detection and resolution options in Application
b anager.

Creating and Connecting to Application Catalogs

You can connect to Application Catalogs from both Application Manager and ConflictSolver as described in
Connecting to an Existing Application Catalog. However, you use the AdminStudio interface to create new
application catalogs. See Creating New Application Catalogs.

Managing Application Catalogs

Package information is stored in Application Catalogs. When you use Application Manager, you will either
automatically be logged into an Application Catalog, or you will have to connect to an existing catalog. Once you
have connected to a catalog, you can manipulate data in Application Manager, including creating and organizing
groups and entering extended attribute data.

The following topics relate to Application Catalog management:
® About AdminStudio Application Catalogs

e Using the AdminStudio Quick Start Evaluation Experience
e Connecting to an Existing Application Catalog

e Creating New Application Catalogs
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® Specifying a Default AdminStudio Application Catalog
e Searching an Application Catalog
e Disconnecting from an Application Catalog
e Upgrading an Existing Application Catalog
e Organizing Your Application Catalog Using Groups
e Viewing and Editing Package Extended Attributes
e Viewing Package History

e Deleting Packages

About AdminStudio Application Catalogs

This section provides the following information:
® Application Manager Organization and Structure
e Overview of Application Catalogs

e Standalone Application Catalog vs. the AdminStudio Enterprise Server Application Catalog
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Application Manager Organization and Structure

In AdminStudio 10,0, Application Manager and ConflictSolver follow a new “application-centric” model. The tree
has been restructured to display multiple deployment formats under a parent Application node. The following
image illustrates how Application Manager’s tree structure has changed.

Application Manager
Moving From a "Package-Centric" to an "Application-Centric" Model

InstallShield MSIDiff (v1.02)

@ iTunes -1 Application Verifier 3.3
iTunes Elﬂ iTunes
LicModInj (v1.00.0000) [ iTunes
MathPlot (v1.20.0000) =] Tuines|
System Test Tracker (v1.0) [ [?p iTunes (w4.5.0.31)
R Messenger
-] Microsoft ActiveSync
=17 Orca
[ QOrca
- e DOrca
[ ¥ Orca
B 1% Orca (w1.50.2600.0000)
-7 Picasa
-] ML Motepad 2007
AdminStudio 9.5 AdminStudio 10.0
"Package-Centric” Model "Application-Centric” Model

Figure 6-1: AdminStudio 10.0’s Application-Centric Model

The restructured Application Manager provides the same full functionality as previous versions:

e Automatic Application node creation—An Application node will be created automatically each time a
package is imported into the Application Catalog, or the user can manually create one in any Application
Manager group.

e Unique subnodes and context menus—The Application node, as well as the various Deployment Type
nodes, have unique subnodes and context menus appropriate for that type.

e Software repository functionality—Software repository functionality (such as check-in, check-out) is
available for Windows Installer and App-V deployment types.

Application Manager’s application-centric structure uses the following icons to represent applications and their

deployment types:
Application Citrix XenApp Profile (.profile)
=] )
Windows Installer Package (.ms1) # VMware ThinApp Package (.exe)
il F
Microsoft App-V Package (.sft) ™ Legacy Application (.exe)

Deployment types are grouped under Application nodes, and Applications are grouped into Groups.
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Creating a New Application in Application Manager

To create a new application in Application Manager, perform the following steps.
&
Task: To create a new Application in Application Manager:
1. Launch Application Manager.
2. Select a group in the tree and select New Application from the context menu. A new application is created.
B3 Application Catalag
{17 &d-fuare SE Personal

H

-0 Application Verifier 3.3
0] iTunes
H
H

o O e O IO o O

+

2]
H

+

T+
s}

3. Enter an appropriate name for the application.

4. Toimport a deployment type for that application, select the application node and, from the context menu, point
to Import and click Package.

5. Proceed with the steps in Importing Data.

Overview of Application Catalogs

To perform enterprise level data checking, it is very efficient if the data can be consolidated into a single database.
The AdminStudio Application Catalog database consolidates data from many installation packages in a single
location.

Application Catalogs can contain the complete contents of Windows Installer (.msi) packages, Merge Module
(.msm) packages, and OS snapshots (.osc), and virtual packages in Microsoft App-V, Citrix XenApp, and VMware
ThinApp formats. Depending upon the import options that are set, an Application Catalog can also include binary
records. Application Catalogs can also store application, workflow, permissions, Predeployment Test, Microsoft
Patch, PackageExpert, and Workflow Manager data.

You can use ConflictSolver and PackageExpert to test packages in the Application Catalog:

e ConflictSolver—You can use ConflictSolver’'s MSI ICEs (internal consistency evaluators) to evaluate specific
packages, and can use ConflictSolver ACEs (application conflict evaluators) to extend the ICEs and evaluate
data across packages.

e PackageExpert—You can use PackageExpert to analyze the integrity of packages in the Application Catalog
and also identify and resolve any issues packages would have when deployed on the Windows Vista
operating system.
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Sharing Application Catalogs

In multi-user environments, the AdminStudio Application Catalog is typically shared. The AdminStudio
Administrator can make a shared catalog the default catalog, which results in all AdminStudio users who use the
same shared location using the same shared Application Catalog. If the shared Application Catalog is changed,
users will automatically open up the new shared Application Catalog. For more information, see Specifying a
Default AdminStudio Application Catalog.

Sharing Application Catalog Data

There are three methods for sharing Application Catalog data in your enterprise:

e Merge Wizard—Use to merge data from a source Application Catalog into the currently open Application
Catalog.

e Package Auto Import Wizard—Offers two methods of automatically importing Windows Installer packages
into your Application Catalog and keeping them updated.

e Application Catalog Replication— Enables you to distribute an Application Catalog database where it is
needed across a large enterprise or multi-national corporation.

See Sharing Application Catalog Data for detailed information.

Standalone Application Catalog vs. the AdminStudio Enterprise Server
Application Catalog

Edition * AdminStudio Enterprise Server Tools are included with AdminStudio Enterprise Edition.

You can connect to any standalone SQL Server Application Catalog, or you can connect to the AdminStudio
Enterprise Server Application Catalog:

e Standalone—A Standalone Application Catalog is not associated with the Enterprise Server tools. The
AdminStudio client tools connect directly to the database server hosting the standalone Application Catalog.

e AdminStudio Enterprise Server—All of the AdminStudio Enterprise Server tools—Security Console, Report
Center, Job Manager, and Workflow Manager—are connected to the AdminStudio Enterprise Server
Application Catalog. AdminStudio client tools can also connect to this Application Catalog, allowing you to
store all data generated on a package in the same location, and to link packages in this Application Catalog to
Workflow Manager Application Requests.

E

Note » AdminStudio Enterprise Tools are always connected to the AdminStudio Enterprise Server database.

For more information on using Application Catalogs, see the following:
e Connecting AdminStudio Client Tools to a Standalone Application Catalog

e Connecting AdminStudio Client Tools to the AdminStudio Enterprise Server Application Catalog

AdminStudio 10.0 User Guide ADS-1000-UG00 187



Chapter 6: Managing Application Catalog Databases
Managing Application Catalogs

Using the AdminStudio Quick Start Evaluation
Experience

When you initially open AdminStudio, because a default Application Catalog has not yet been set, the Default
Application Catalog dialog box opens, prompting you to open an Application Catalog.

Default Application Catalog @

Adminstudio has detected that no default application catalog exists. You can set up a SQL server and create a new default application
catalog, create and connect to a new default application catalog on an existing server, or simply connect ko an existing application
catalag. ¥ou will have the option of including sample application data when creating a new application catalag.

(%) Quick Start
Select this option if no database server exists, Microsoft SQL Server 2005 Express will be installed on this machine then the
Iew Application Catalog 'Wizard will guide you through creating a new application catalog.
Strong password For new 'sa’ account: | |

) Create a new Application Catalog
If vou have access to an existing database server, select this option ko start the process of creating a new AdminStudio
application catalog.

) Connect ko an existing Application Catalog

If an Adminstudio application catalog you want to use already exists, select this option,

Cancel J l Help

Figure 6-2: Default Application Catalog Dialog Box

To quickly get started using AdminStudio, select one of the following options:

e [f you do not have access to a database server, but you want to quickly start using AdminStudio, select
the Quick Start option. Microsoft SQL Server 2005 Express will be installed on your machine first, then you
will have the option to create a new Application Catalog database on that server that is populated with sample

data.

e |f you do have access to a database server, but just do not have any sample data in it, select the Create
a new Application Catalog option, and choose to populate this new Application Catalog with sample data
by selecting the Include Sample Data in New Catalog option on the Create Application Catalog dialog

box.

Connecting to an Existing Application Catalog

188

Edition * AdminStudio Enterprise Server Tools are included with AdminStudio Enterprise Edition.

From AdminStudio and the AdminStudio client tools, you usually connect to an Application Catalog by selecting

Connect on the Catalog menu. AdminStudio supports SQL Server databases.

E

Note - Starting with AdminStudio 9.01, Oracle databases are not supported.
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You can choose to connect to a standalone Application Catalog database or the AdminStudio Enterprise Server
Application Catalog database.

e Connecting AdminStudio Client Tools to a Standalone Application Catalog

e Connecting AdminStudio Client Tools to the AdminStudio Enterprise Server Application Catalog

E

Note * See Standalone Application Catalog vs. the AdminStudio Enterprise Server Application Catalog for more

information.

E

Note * AdminStudio Enterprise Tools are always connected to the AdminStudio Enterprise Server database.

Connecting AdminStudio Client Tools to a Standalone Application
Catalog

To connect to an existing Standalone Application Catalog from an AdminStudio client tool (Application Manager,
ConflictSolver, or PackageExpert), perform the following steps.

o

Task: To connect to an existing Standalone Application Catalog from the AdminStudio client tools:
1. Perform one of the following:
e Application Manager and ConflictSolver—On the Catalog menu, click Connect.
e PackageExpert—Select the Application Catalog node and select Connect from the context menu.

The Connect Application Catalog dialog box opens, displaying three tabs: Enterprise Server,
Standalone, and Recent.

2. Click the Standalone tab. The Standalone tab opens, prompting you to enter database connection
information.

3. If you want this Application Catalog to be the default shared Application Catalog used in your organization,
select the corresponding option at the bottom of the dialog box.

4. Select the Server where the Application Catalog is stored.

5. Specify how the database server should verify the authenticity of the login—either using Windows
Authentication or Server Authentication. If you selected Server Authentication, enter the appropriate
Login ID and Password.

6. Inthe Catalog box, enter the name of the Application Catalog you want to open.
7. Click Test to test the connection to the database.

8. Click OK.
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Connecting AdminStudio Client Tools to the AdminStudio Enterprise
Server Application Catalog

Task:

190

The AdminStudio Enterprise tools (Report Center, Job Manager, and Workflow Manager) are configured during
installation to connect to an Application Catalog, which is referred to as the Enterprise Server Application Catalog.

You can also connect the AdminStudio client tools to the Enterprise Server Application Catalog. This allows you to
have all of the client and enterprise tools reference the same database.

To connect to the AdminStudio Enterprise Server application catalog from an AdminStudio client tool, perform the
following steps.

To connect to the AdminStudio Enterprise Server Application Catalog:

1.

Perform one of the following:
e Application Manager and ConflictSolver—On the Catalog menu, click Connect.
e PackageExpert—Select the Application Catalog node and select Connect from the context menu.

The Connect Application Catalog dialog box opens, displaying three tabs: Enterprise Server,
Standalone, and Recent.

Open the Enterprise Server tab.

The URL to the AdminStudio Enterprise Server is listed above the Authentication field. If the AdminStudio
Enterprise Server has not yet been configured with the AdminStudio client tools (such as when it is set to its
default value of http://Tocalhost), click the URL link to open the Select AdminStudio Enterprise Server
URL dialog box, and enter the URL for location of the AdminStudio Enterprise Server associated with this
installation of AdminStudio.

From the Authentication list, select either AdminStudio Enterprise Server User or Windows
Authentication.

7]

Important = When using AdminStudio Enterprise Server User authentication, if Anonymous
authentication is turned off in IIS, both the user’s machine and the AdminStudio Enterprise Server need to be on
the same domain in order for login to succeed.

If you selected AdminStudio Enterprise Server User, enter your AdminStudio Enterprise Server User
Name and Password (provided by your System Administrator).

Click Login. After a successful login, the Provider, Server, and Catalog name of the Enterprise Server
database is listed.

Click OK.

ADS-1000-UG00 AdminStudio 10.0 User Guide



Chapter 6: Managing Application Catalog Databases
Managing Application Catalogs

Login Troubleshooting

If you are using a Web Portal with custom security zone settings, your AdminStudio Enterprise Server URL is using
an IP address, and you receive Error 0xX800A1518 when you attempt to login, change the AdminStudio Enterprise
Server URL to the NetBios equivalent and then try again. For example, if you are connecting to http://
120.12.1.15, the NetBios equivalent would be http://wfmportal.

Creating New Application Catalogs

You can create new Application Catalogs using the AdminStudio interface, or using scripts. This section includes
the following topics:

Creating New Application Catalogs Using the AdminStudio Interface

Creating New Application Catalogs Using Scripts

Creating New Application Catalogs Using the AdminStudio Interface

To create a new SQL Server application catalog database, perform the following steps.

&

Task: To create a new standalone Application Catalog:

1.

On the AdminStudio Catalog menu, click Create. The Welcome panel of the Application Catalog Wizard
opens.

If you want to include a few sample packages in this new Application Catalog, select the Include Sample
Data in New Catalog option.

Click Next. The Specify Database Information panel opens.
Enter or select the name of the Server where this Application Catalog will be stored.

Specify how the database server should verify the authenticity of the login—either using Windows
Authentication or Server Authentication. If you selected Server Authentication, enter the appropriate
Login ID and Password.

In the Catalog box, enter the name of the Application Catalog you are creating.

If you are creating a new SQL Server database which is intended for use as a Subscriber for Application
Catalog Replication, select the Create catalog as a subscriber option. If you do not intend to use the
Replication functionality that AdminStudio provides for SQL Server, do not select this option. For more
information, see About Creating a Catalog as a Subscriber and Replicating Application Catalogs.

Click Test to test the connection to the database.

Click Next. The Select Software Repository Location panel opens, prompting you to select the location
where the Software Repository will store imported packages and their associated files. For more information,
see Using the Software Repository.
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10. If you want to store data associated with this Application Catalog’s packages in the Software Repository,
choose the Enable the Software Repository option, select a Software Repository Location, and enter a
Login ID and Password of the Proxy Account that must be used to access this Repository.

11. Click Next. The Creating Application Catalog panel opens and reports on the creation progress. When the
Application Catalog has been created, a message appears stating that the creation was successful.

12. Click Finish. The new Application Catalog now opens in AdminStudio.

About Creating a Catalog as a Subscriber

Please note the following about creating a Subscriber Application Catalog for Application Catalog Replication:
® You cannot create a Publication in a Subscriber database.

e [fyou choose the Create catalog as a subscriber option, making it a Subscriber database, the
Subscription Manager option under Replication on the Catalog menu is enabled.

e If you do not choose this option, making it a Publisher database, the Publication Manager option under
Replication on the Catalog menu is enabled.

e Once you have created a database, you cannot go back and edit the choice you made on this option.

e Just because you select this option does not mean that this database must contain subscribed data or that all
of its data must be subscribed. It can contain all local data or both local and subscribed data.

For more information, see Replicating Application Catalogs.

Tip  The first time AdminStudio is run, anyone can create an SQL Server database (providing they have access to
aN SQL Server and database creation rights). However, once an AdminStudio Application catalog has been created,
the database creator becomes the Application Catalog administrator, and security rights are in place in
AdminStudio.

Creating New Application Catalogs Using Scripts

Typically, users with administrative privileges in AdminStudio use Create on the Catalog menu to create a new
Application Catalog.

However, because of security concerns, some Database Administrators may be hesitant to grant the database
creation rights that are necessary to create an Application Catalog database using SQL Server to AdminStudio
users. Consequently, the Database Administrator must manually create the database using scripts and provide the
necessary read and write access for users to that database.
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AdminStudio is shipped with database creation SQL scripts to make it easy for Database Administrators to create
new Application Catalogs:

Table 6-3 * Scripts to Create Application Catalog Databases on SQL Server

Script File Description
AMS_System_Schema. SQL Primary Workflow Manager tables
AMSCreateIndex.SQL Indexes for Workflow Manager tables

AMS_SamplePackagingTemplate.SQL Sample Workflow Manager template data

AS_System_Schema. SQL Primary AdminStudio client tools data
Seed_Data.SQL Seed data required by AdminStudio
CustomReportWizard.SQL Report Center data
Reporting.StoredProcedures.SQL Application Catalog enhanced reporting data

These SQL scripts are located in the following directory:
AdminStudio Installation Directory\Support\SQL_Scripts

To create an Application Catalog database on SQL Server, perform the following steps:

Task: To use scripts to create an AdminStudio Application Catalog on SQL Server
1. Log on to your SQL Server.
2. Launch the Enterprise Manager and Query Analyzer.

3. In Query Analyzer, execute a CREATE DATABASE command to create and identify the new Application Catalog
database.

4. Select the newly created database in Query Analyzer.

5. Execute the following scripts in order:

a. AMS_System_Schema.SQL

b. AMSCreateIndex.SQL

€. AMS_SamplePackagingTemplate.SQL
d. AS_System_Schema.SQL

e. Seed_Data.SQL

f. CustomReportWizard.SQL

d. Reporting.StoredProcedures.SQL
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Specifying a Default AdminStudio Application Catalog

194

You can specify a default Application Catalog so that each time you open AdminStudio, you will be prompted to
login to the same Application Catalog database.

You can also configure your enterprise so that all of the users at your enterprise will be prompted to login to the
same Application Catalog each time they open AdminStudio.

Setting a Default Application Catalog for Yourself

Whenever you connect to an Application Catalog, you can designate it as the default Application Catalog by
selecting the Make this the shared default Application Catalog option on the Connect Application Catalog
dialog box.

Connect Application Catalog !|

Enterprise Server | Standalone | Recent
Provider:

SOL Server e
Dietails:

Server: SCHOLHOWEPRPMSOLERPRESS v
Authentication: | server A ithentication s
Login I0: sa

Password: TTITIT ]

Catalog: hd

[ M ake this the default shared Application Catalog

[ Ok, ][ Cancel ][ Help ]

Figure 6-3: Default Shared Application Catalog Option on the Connect Application Catalog Dialog Box

Setting the Default Application Catalog for Your Enterprise

To configure your enterprise so that all of the users at your enterprise will be prompted to login to the same
Application Catalog each time they open AdminStudio, all users need to be connected to the same AdminStudio
Shared.ini file that is stored in a shared network location that is available to all users.

Methods to Set the Default Application Catalog for Your Enterprise
You can set a default Application Catalog for all AdminStudio users in your enterprise in two ways:
e Using the AdminStudio Interface

or

e Editing the Shared AdminStudio.ini File
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Using the AdminStudio Interface

To use the AdminStudio interface to set a default Application Catalog for all AdminStudio users at your enterprise,
perform the following steps.

o

Task: To specify the default Application Catalog:

1. First, the AdminStudio System Administrator needs to perform the following steps to set the default Application
Catalog for the enterprise:

a.

b.

f.

Locate and copy the following file on the machine where you installed AdminStudio:
C:\AdminStudio Shared\Shared AdminStudio.ini

Copy this file to a shared network location that is accessible to all of the users in your enterprise.
Launch AdminStudio.

On the Tools menu, click Options. The AdminStudio Options dialog box opens.

Open the Locations tab.

Set the AdminStudio Shared Location to the network location where you copied the
Shared AdminStudio.ini file, such as:

\\servername\AdminStudio Shared

Open the Application Catalog tab.

Click Change next to the Shared AdminStudio Application Catalog field. The Select Application
Catalog dialog box opens.

Select the Application Catalog database that you want to be set as the default, following the instructions in
Connecting to an Existing Application Catalog.

After you connect to the database, that database name is listed in the Shared AdminStudio
Application Catalog field.

Click OK to close the Options dialog box.

2. Next, each AdminStudio user in the enterprise needs to perform the following steps to set the location of their
AdminStudio Shared directory to the same shared network directory that the System Administrator
configured.

a.

b.

Launch AdminStudio.
On the Tools menu, click Options. The AdminStudio Options dialog box opens.
Open the Locations tab.

Set the AdminStudio Shared Location to the shared network location provided by your System
Administrator.
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AN

Caution - If a user is not assigned to a Role that has the Modify AdminStudio Tools Options Dialog

permission, they cannot change the location of the AdminStudio Shared directory on the Options dialog. In
this situation, the location of the AdminStudio Shared directory would be set during installation.

Editing the Shared AdminStudio.ini File

W

Task:

196

To set a default Application Catalog for all AdminStudio users at your enterprise by editing the Shared
AdminStudio.ini file, perform the following steps.

To specify the default Application Catalog by editing the Shared AdminStudio.ini file:

1.

E

First, the AdminStudio System Administrator needs to perform the following steps to set the default Application
Catalog for the enterprise:

a. Locate and copy the following file on the machine where you installed AdminStudio:
C:\AdminStudio Shared\Shared AdminStudio.ini

b. Copy this file to a shared network location that is accessible to all of the users in your enterprise.

c. Open the Shared AdminStudio.ini file that you just copied to a shared network location.

Insert the following in the [Database Settings] section of the Shared AdminStudio.ini file:

[Database Settings]
DefaultDatabase=Provider=SQLOLEDB.1;User ID=userid; PWD=password;Initial
Catalog=nameofdatabase;Data Source=nameofsqiserver;

Next, each AdminStudio user in the enterprise needs to perform the following steps to set the location of their
AdminStudio Shared Location directory to the same shared network directory that the System
Administrator configured.

a. Launch AdminStudio.
b. On the Tools menu, click Options. The AdminStudio Options dialog box opens.
a. Open the Locations tab.

b. Setthe AdminStudio Shared Location to the shared network location provided by your System
Administrator.

AN

Caution - If a user is not assigned to a Role that has the Modify AdminStudio Tools Options Dialog

permission, they cannot change the location of the AdminStudio Shared folder on the Options dialog. In
this situation, the location of the AdminStudio Shared location would be set during installation.

Note * The Roles assigned to a user determine that user’s permissions:
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e The Create and Connect options on the Catalog menu on the AdminStudio Interface are disabled for users

that are not assigned to a Role that has permission to perform those actions.

® Users that are assigned to Roles that have the Modify AdminStudio Tools Options Dialog permission can

change the location of the AdminStudio Shared folder on the Options dialog (accessed by selecting

Options on the Tools menu from the AdminStudio Interface). For those users who do not have that permission,

Options on the Tools menu is disabled, so they are unable to change the location of the AdminStudio
Shared folder.

Searching an Application Catalog

You can search for data in Application Catalog tables by using Find on the Edit menu. You can search all tables in

all packages in a group, or just search one column in one table of one package.

E

Note - This search is limited to string type columns.

The tables that are searched depend upon what is selected when the Find dialog box is opened:

Table 6-4 » Application Catalog Search Options

If you select... and specify these options... this will be searched
Application All Tables and All Columns All tables and all columns in all of the packages in
Catalog the Application Catalog.
Group All Tables and All Columns All tables and all columns in all of the packages in

the selected group.

Package All Tables and All Columns All tables and all columns in the selected package.

Package A table and All Columns All columns of a specific table in the selected
package.

Package A table and a column A specific column in a specific table in the selected
package.

To search the Application Catalog:
1. Open an Application Catalog in Application Manager or ConflictSolver.

2. Select the node in the tree (Application Catalog, Groups, a specific group, a specific package, an OS
shapshot, etc.) that you want to search.

3. On the Edit menu, click Find. The Find dialog box opens.
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You could also click the Find button ( .,~|) on the toolbar, use Ctrl + F, or choose Find from the selected
package or group’s context menu.

In the Find What text box, enter the text that you want to search for.

E

Note - This search is limited to string type columns.

On the Look In Table list, select the table that you would like to search, or select <All Tables>. When you
select a table from this list, the Look In Columns list is populated with all of the columns in that table.

If you selected a table from the Look in Table list, all of the columns in that table are listed. Select the column
that you would like to search, or select <All Columns>.

If you want to search for a partial match rather than an exact match, select the Partial Match option.

e If this option is not selected, Application Manager will search for an exact match of the text you
entered in the Find What text box. The search will be case sensitive.

o If this option is selected, then Application Manager will use appropriate wild card characters so that a
partial data match is performed. The search will be case insensitive

Click Find to initiate the search.

The Find dialog box will close, and the data that is found is displayed in the Search Results tab of the Output
Window, in the following format:

= Package Mame Table Name Column Mame | Column Data 25
DemnPlayer camsifctionText Action AppSearch
Morton Antivirus Corporate Edition  csmsifctionText Action AppSearch
Micrasoft Carporation_Orca csmsifckionText Action AppSearch
DemaPlayer csmsisys_Yalidation Table AppSearch
DemaPlayer csmsisys_Yalidation Table AppSearch
Morton Antivirus Corporate Edition  csmsisys_Yalidation Table AppSearch
MNorton Ankivirus Corporate Edition  csmsisys_Yalidation Table AappSearch v
[ATFTPT output Ay Import A validate A Conflicts A Patch Impact ji Package Auto Impart Ay Search Resuks /
15 occurrenceds) of 'AppSearch’ have been Found.

If you double click on the data displayed in the Output Window, Application Manager will navigate to the
appropriate record in the Tables View, and that record will be highlighted in red.

Disconnecting from an Application Catalog

198

To disconnect from the currently open Application Catalog, select Disconnect from the Catalog menu. You can
disconnect from an Application Catalog while you are in ConflictSolver, Application Manager, PackageExpert, and
also when you are in the AdminStudio Interface.

When you have disconnected from an Application Catalog in ConflictSolver or Application Manager, the following
message appears:

ConflictSolver requires a connection to the AdminStudio Application Catalog. Select Connect from the

Catalog menu to establish a connection.
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Upgrading an Existing Application Catalog
When you attempt to open an AdminStudio 5.x to 9.x Application Catalog in AdminStudio 10.0, you are prompted
to upgrade it to use the AdminStudio 10.0 schema.
Log files for the upgrade are created in the following directory:

AdminStudio Shared Directory\ConflictSolver\Logs

E

Note * Note the following regarding upgrading an existing Application Catalog:

The upgrade of AdminStudio 3.0, 3.01, and 3.5 databases is not supported by AdminStudio 7.0 or later.
Starting with AdminStudio 8.0, Microsoft Access databases are not supported.
Starting with AdminStudio 9.01, Oracle databases are not supported.

When an SQL Server Application Catalog database is upgraded, the old tables are not dropped from the
Application Catalog.

Upgrading Pre-AdminStudio 5.0 Application Catalogs

Pre-AdminStudio 5.0 Application Catalogs cannot be upgraded automatically by AdminStudio 7.0 or later.
However, you can upgrade them using the Legacy Upgrade Wizard, a standalone utility that was included with
AdminStudio 7.0 and 7.5. The Legacy Upgrade Wizard utility is installed in the following directory:

C:\Program Files\InstallShield\AdminStudio\7.x\Common\LegacyUpgradeWizard.exe

If you do not have a copy of AdminStudio 7.0 or 7.5 available to you, contact Technical Support.

Organizing Your Application Catalog Using Groups

Within Application Manager and ConflictSolver, you can create groups to organize your applications, patches, and
OS Snapshot images in the Application Catalog. This is especially useful for organizing your Application Catalog in
ways consistent with how your company is organized.

For example, you could create a group representing a certain department’s base image including the proper
operating system and necessary applications. When you perform conflict analysis on new packages you are
integrating into your environment, you can run only the relevant comparisons—saving you the time it would take to
run the analysis against all packages in the Application Catalog, or the effort of manually determining the set of
packages against which you want to run the analysis each time.
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Tasks relating to groups include:
e Adding Groups
e Organizing Applications in Application Manager
e Deleting Application Manager Groups
e Editing Group Properties
e Copying Packages to Multiple Groups

e Moving Applications, OS Snapshots, and Groups

Adding Groups

To add additional groups or subgroups to an Application Catalog, perform the following steps.

4

Task: To add a group to Application Manager:

1. Inthe Application Manager tree, right-click on the group to which the new group should belong and select
New Group.

2. Provide a name for the new group.

3. Press Enter.

Organizing Applications in Application Manager

To move applications or groups into different groups, perform the following steps:
Task: To organize individual packages and groups of packages in Application Manager:

1. Inthe Application Manager tree, select an application or group you want to move.

2. Drag the application or group onto a new group.

E

Note - The following rules apply to drag and drop operations in the Application Manager Product View:

® You cannot drop a node on itself.
® You cannot drop a node on its parent. It is already a child of the parent.
® You cannot drop a group on its child groups.
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Deleting Application Manager Groups

To delete a group from an Application Catalog, perform the following steps:
Task: To delete a Application Manager group:

1. Right-click the group you want to delete in the Application Manager tree and select Delete from the context
menu.

2. From the resulting message box, confirm the deletion.

AN

Caution * When you delete a group, all subgroups and applications within that group are also removed from the
Application Manager.

Editing Group Properties

For each group, you can modify its name, and add a description or other comments. To edit this information,
perform the following steps.

Task: To edit group properties:

1. Right-click on the group in the Application Manager tree and select Properties from the context menu. The
Group Properties dialog box opens, displaying the group Name, Description, and Comments.

2. Make any desired edits.

3. Click OK.

Copying Packages to Multiple Groups

More than one copy of the same application can exist in an Application Catalog. You can copy an application from
one group into another group.

Task: To copy a package to multiple groups:

1. Select the application from the Application Manager tree.

2. While holding down the Ctrl key, drag the application to the group into which you want it copied.

E

Note ° You can also right-click on a application or a package deployment type and use the copy and paste

commands to copy the item.
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Moving Applications, OS Snapshots, and Groups

o

In addition to copying OS Snapshots or applications to multiple groups, you can also move OS Snapshots,
applications, or groups into other groups.

Task:

To move an application, OS Snapshot, or group:
1. Select the application, OS Snapshot, or group you want to move in the Application Manager tree.

2. Drag the item into a new group.

E

Note * You can also right-click on an application, OS Snapshot, or group and use the cut, copy, and paste
commands to move or copy the item.

Viewing and Editing Package Extended Attributes

202

Extended attributes are optional attributes for packages, defined by an Extended Attribute Description File (in XML
format). Because you can manually create the description file, you have the flexibility to include information about
each package that may be specific to your organization—such as the users or business groups that receive the
package.

Extended attributes can be edited in the Extended Attributes view on a package-by-package basis.
The following tasks and concepts relate to extended attributes:

e Using Extended Attributes

e Extended Attribute Description File

e |Integrating Package Extended Attribute Data with an Application Request

E

Note ° You can also edit a package’s extended attributes in the ConflictSolver Process Assistant. See Extended
Attributes Page.
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Using Extended Attributes

Assuming you have created an extended attribute description file (or are using the default provided file), you can
configure Application Manager to use it with the current Application Catalog.

o

Task: To use extended attributes in Application Manager:

1. With Application Manager open, click Options on the Tools menu. The ConflictSolver and Application
Manager Options Dialog Box opens.

2. Click the Extended Attributes tab.

3. Specify or browse to the extended attribute description file (.xm1) containing the extended attributes you want
to use for Application Manager.

4. Click OK.

The Extended Attributes View is available under each package in Application Manager.

AN

Caution « The default Extended Attribute description file is named EA_Default.xml, and is installed in the
AdminStudio Shared folder. You can modify the data displayed in the Extended Attributes view, but to do this, do
not edit the EA_Default.xml file. Instead, copy the EA_Default.xml file, rename it, make your edits to the new file, and
then enter the new file name and location in the Extended Attribute Description File field on the Extended
Attributes tab of the ConflictSolver and Application Manager Options dialog box.

Extended Attribute Description File

Application Manager uses an XML file to describe the data that appears in the Extended Attributes view. The
name and location of this XML file can be specified from the Extended Attributes tab in the ConflictSolver and
Application Manager Options dialog box.

AN

Caution + The default Extended Attribute description file is named EA_Default.xml, and is installed in the
AdminStudio Shared folder. You can modify the data displayed in the Extended Attributes view, but to do this, do
not edit the EA_Default.xml file. Instead, copy the EA_Default.xml file, rename it, make your edits to the new file, and
then enter the new file name and location in the Extended Attribute Description File field on the Extended
Attributes tab of the ConflictSolver and Application Manager Options dialog box.
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Description File Properties

The description file, which is in XML format, contains tags for each extended attribute (up to a limit of 400
attributes). It supports text or file values. The following list explains each tag available in the description file.

Table 6-5 ¢ Description File Tags

Attribute Description

Uniqueldentifier This value, which Application Manager uses to validate that the XML file is for
extended attributes, must be set to ISASEA40.

Name The name of the attribute as it appears in the Extended Attributes view. This cannot
exceed 255 characters.

Type The extended attribute type. This can be Text, File, or Selection. If no type is
specified, then Application Manager defaults the attribute to text.

DefaultValue This tag, available only for Text types, provides the default value for the attribute.
This optional value cannot exceed 512 characters.

DefaultFileExtension This tag, available only for File types, provides the default file extension when you
browse for the file. Examples of this could be *.txt, *.bmp, *.doc, or *.*
(representing all files).

FileFilter Provide the file types to populate the File type filter in the Browse dialog box. These
must be in pairs, and in the format Longname (*.ext) | *.ext. Before the closing </
FileFilter> tag, you must have two pipe symbols (| |).

For example, to include filters for text files, bitmaps, and all files, use the following
line:

<FileFilter>Text Document (*.txt)|*.txt|Bitmap (*.bmp)|*.bmp|AlT Files
CF) | *0% | |</FileFilters

This value cannot exceed 255 characters.

Caption The caption for the Browse dialog box when using File types. This cannot exceed
255 characters.

Values Used only for Selection types, this is a semicolon-delimited list of possible values
for the selection. These will appear in a drop-down list for the extended attribute.
The first value is used as the default. The total number of characters of all the
values and necessary semicolons cannot exceed 255 characters.

HelpText Text that appears below the value field for either Text or Selection attributes. You
can use it to provide additional information to help users know what to input. This
cannot exceed 512 characters.
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Description File Format
An example of an extended attribute description file follows:

<Extended_Attribute Uniqueldentifier="ISASEA40">

<AttributeDetails>
<Name>Owner</Name>
<Type>Text</Type>
<DefaultValue></DefaultValue>
<HelpText>Provide the name of the package's owner.
</HelpText>

</AttributeDetails>

<AttributeDetails>
<Name>Test Script</Name>
<Type>File</Type>
<DefaultFileExtension>*.*</DefaultFileExtension>
<FileFiTter>A11 Files (*.*)|*.*||</FileFilter>
<Caption>Test Script Files</Caption>

</AttributeDetails>

<AttributeDetails>
<Name>Program Type</Name>
<Type>Selection</Type>
<Values>0ffice Application;Utility;
Graphic Application;Programming Application;Game;Other
</Values>
<HelpText>Select the type of application from the
above Tist.
</HelpText>

</AttributeDetails>

</Extended_Attribute>

Integrating Package Extended Attribute Data with an Application Request

E

Note * AdminStudio Workflow Manager is a Web-based application management system that has integrated
functionality with AdminStudio.

Application Manager allows you to integrate extended attributes with AdminStudio Workflow Manager. This option
is enabled by selecting the Integrate with Workflow Manager option on the Extended Attributes of the
ConflictSolver and Application Manager Options dialog box.

When the Integrate with Workflow Manager option is selected, you can associate extended attribute data for
packages in Application Manager with Application Requests in Workflow Manager. This is accomplished by right-
clicking on the package name in the Application Manager Product View and selecting Associate with Workflow
Manager Application from the context menu.
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W

Task:

To associate a package with a Workflow Manager Application Request:

1. Open Application Manager.

2. Connect to the AdminStudio Enterprise Server Application Catalog. See Connecting AdminStudio Client Tools
to the AdminStudio Enterprise Server Application Catalog.

3. On the Tools menu, click Options. The Options dialog box opens.
4. On the Extended Attributes tab, confirm that the Integrate with Workflow Manager option is selected.

5. Inthe Application Manager Product View, select the product that you want to link to Workflow Manager and
select Associate with Workflow Manager Application from the context menu.

The Associate with Workflow Manager Application dialog box opens.
6. Pick the application in Workflow Manager with which you want to associate this product.

Assuming that Workflow Manager is configured to use the same extended attributes file, if you enter new data into
the Extended Attributes view in Application Manager, Workflow Manager automatically detects it; if changes are
made in Workflow Manager, they are automatically reflected in Application Manager.

By design, extended attributes data in Application Manager and Workflow Manager data have a one-to-one
relationship. You can only associate one Workflow Manager application with a product in Application Manager;
once the application is associated, it is no longer available for association with other Application Manager
products.

E

Note ° Another integration feature between AdminStudio and Workflow Manager is that when you associate a
package with a Workflow Manager Application Request and then view that Application Request’s Application
Report, there is a link to open the Package Report of its associated package. There is also a link on the Package
Report to open the Application Report of its associated Application Request.

Viewing Package History

206

The tracking of change history is a critical operation within the Enterprise environment. Maintaining this
information, displaying it, and allowing it to be a filter will gives you the information you need to monitor and
maintain the integrity of your software packages.

In AdminStudio, any operation that materially changes a software package or the data associated with the package
is tracked, and can be viewed in the Application Manager Catalog History view.
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Task: To view a package’s history:

1. Open Application Manager.

2. Inthe tree, expand a deployment type node and select the Catalog History node. The Catalog History view
opens, displaying the following information:

Item

Maximum History
Log Per Package

Action

Date

Description

Enter the maximum number of History Log entries you want to store for each
package. When the number of log entries exceeds this amount, the oldest entry
will be deleted.

Name of the event which was logged:

® Import/Reimport

e Validation

e Conflict Detection

e Conflict Resolution

e Extended Attribute Modification

e Package Description Modification
e Package Move/Copy

e Patch Impact Analysis

Note ° You can specify which events you want to be listed on the Catalog History view by
making selections on the History Tab of the ConflictSolver and Application Manager Options
Dialog Box. You can choose which events you want to log and which events you want to
display in the Catalog History view.

Date and time logged event occurred.

User

User who performed the logged event.

Description

E

Description providing details of the logged event.

Note ° If a package was replicated into another Application Catalog, its history data would not be replicated.

AdminStudio 10.0 User Guide ADS-1000-UG00 207



Chapter 6: Managing Application Catalog Databases
Importing Data

Deleting Package History

To delete all of the entries in a package’s History Log File, perform the following steps:

Task: To delete package history:
1. Open Application Manager.
2. Select the package and right-click to open the context menu.

3. On the context menu, point to Delete and click History Log Information.

Deleting Packages

You can delete packages that have been imported into the Application Catalog.

%

Task: To delete a package from Application Manager:

1. Right-click on the package in the Application Manager Product View, point to Delete on the context menu,
and click Package (to delete the package from the selected Group) or Package from all Groups (to delete
the package from all Groups in the Application Catalog).

2. Confirm the deletion.

Importing Data

You can use the Import Wizard to import multiple application deployment types either one at a time, all of the
packages in a directory, or one or multiple packages directly from Microsoft System Center Configuration Manager.

e Data Types Supported By the Import Wizard

e Package Sources Supported by the Import Wizard
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Data Types Supported By the Import Wizard

You can use the Import Wizard to import the following types of data into the Application Catalog:

Table 6-6 » Data Types Supported By the Import Wizard

Data Type

Windows Installer
Packages,
Transforms, and
Patches

Description

You use the Application Manager Import Wizard to import Windows Installer
packages (.msi) with any associated transforms (.mst) and patches (.msp) into the
Application Catalog. See the following topics:

Importing a Single Windows Installer or Virtual Package
Importing a Directory of Windows Installer and/or App-V Packages

Importing Windows Installer and/or App-V Packages From Microsoft
Configuration Manager

Microsoft App-V
Package

AdminStudio 10.0 User Guide ADS-1000-UG00

You have several available options when importing Microsoft App-V packages into
the Application Catalog. See the following topics:

Importing a Single Windows Installer or Virtual Package
Importing a Directory of Windows Installer and/or App-V Packages

Importing Windows Installer and/or App-V Packages From Microsoft
Configuration Manager

App-V Packages Created By AdminStudio

Also, for App-V packages created by AdminStudio, you have several additional
options:

E

During the import of the Windows Installer package—During the import of
a Windows Installer package, if the Import Wizard searches for and finds a
virtual package created by AdminStudio in a subdirectory of the directory
containing that Windows Installer package, you are prompted to also import that
virtual package. See Importing a Virtual Package During the Import of its Source
Windows Installer Package.

After the import of the Windows Installer package—If you import an
AdminStudio-created virtual package into an Application Catalog that already
contains the virtual package’s source Windows Installer package, you are
prompted to associate the virtual package with the Windows Installer package.
See Importing a Virtual Package After the Import of its Source Windows Installer
Package.

Note - If you use the Import Wizard to import an App-V package directly into the Application
Catalog, you can then use the Associate Package function to associate that App-V package
with its source Windows Installer package. See Importing a Virtual Package Without Its Source
Windows Installer Package and Manually Associating a Virtual Package with a Windows Installer
Package.
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Table 6-6 » Data Types Supported By the Import Wizard (cont.)

Data Type

Citrix XenApp and
VMware ThinApp
Packages

Ad-Hoc Import

Merge Modules

Description

You have several options when importing VMware ThinApp and Citrix XenApp virtual
packages into the Application Catalog:

® During the import of the Windows Installer package—During the import of
a Windows Installer package, if the Import Wizard searches for and finds a
virtual package created by AdminStudio, you are prompted to also import that
virtual package. See Importing a Virtual Package During the Import of its Source
Windows Installer Package.

e After the import of the Windows Installer package—If you import an
AdminStudio-created virtual package into an Application Catalog that already
contains the virtual package’s source Windows Installer package, you are
prompted to associate the virtual package with the Windows Installer package.
See Importing a Virtual Package After the Import of its Source Windows Installer
Package.

e By itself—You can use the Import Wizard to import a virtual package directly
into the Application Catalog. Then you can use the Associate Package
function to associate the virtual package with its source package. See Importing
a Virtual Package Without Its Source Windows Installer Package and Manually
Associating a Virtual Package with a Windows Installer Package.

You can also import transform files and patch files after the Windows Installer
package that they are associated with has already been imported into the
Application Catalog. This is referred to as an ad-hoc import. The imported transform
or patch file is then stored in the Software Repository along with the rest of the
imported package’s associated files. See Using the Software Repository and
Performing an Ad-Hoc Import of Transform Files or Patch Files.

E

Note * You can only perform an ad-hoc import if you are connected to a Software Repository-
enabled Application Catalog.

A merge module (.msm) is a package containing all of the logic and files needed to
install distinct pieces of application functionality such as run-time .d11 files and
virtual machines. Merge modules are built once and can be added to any installation
project. Merge modules, which are imported into the Application Catalog using the
Import Wizard, are used primarily during conflict detection.

For optimal performance, Merge modules should be imported into an Application
Catalog database prior to importing Windows Installer packages. This ensures that
conflicts resulting from not using available merge modules are correctly identified.
For more information, see Importing Merge Modules.
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Table 6-6 * Data Types Supported By the Import Wizard (cont.)

Data Type Description

Additional Data Additionally, you can use the Import Wizard to import OS snapshots (.osc), Marimba
Native Channel Packager (.ncp) files and other non-MSI based setup programs. See
Importing OS Snapshots, Importing Marimba NCP Files, and Importing Other Setup

Types.

Package Sources Supported by the Import Wizard

You specify the source of the package(s) that you want to import by making a selection on the Select Package

Source panel of the Import Wizard:

Table 6-7 » Package Sources Supported by the Import Wizard

Source

Description

Local Machine or Network
(Single Package)

Local Machine or Network
(Directory of Packages)

Microsoft System Center
Configuration Manager

Select to import a single installation package into the Application Catalog. If
you select this option and click Next, the File Selection panel opens,
prompting you to browse for the file.

Select to import a directory of packages (containing both Windows Installer
and App-V packages, if desired) into the Application Catalog.

If you select this option and click Next, the Folder Selection panel opens,
prompting you to select the directory containing the packages you want to
import.

Select to import applications from a Microsoft System Center Configuration
Manager server.

If you select this option and click Next, the Connect to a Microsoft
Configuration Manager Server panel opens, prompting you to connect to
a server. Next, the Select Packages panel opens, listing all of the packages
in the connected Configuration Manager server and prompting you to select
the packages you want to import.

Importing a Single Windows Installer or Virtual Package

You can import a Windows Installer package with all of its associated transform files and patches into the
Application Catalog at the same time. The transform files and patches are immediately associated with the
Windows Installer package. You can also import a single Microsoft App-V, Citrix XenApp, or VMware ThinApp

package.

Tasks associated with importing Windows Installer packages, transforms, and patches include:

e Importing a Single Package

® Using Duplicate Package Identifiers
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e Performing an Ad-Hoc Import of Transform Files or Patch Files

Once you import these files, they become available for conflict identification.

E

Note  Although you can identify conflicts between an external package and packages already in the Application
Catalog, it is strongly recommended you import the package first and perform conflict identification after import.
Conflict information is only persisted for the last conflict identification performed between an external package and
packages in the Application Catalog, and performance is better when performing conflict identification between
internal packages. See Conflict Persistence for more information.

Importing a Single Package

You can use the Import Wizard to import a single Windows Installer or virtual package. For a Windows Installer
package, you can also import all of its associated transform and patch files at the same time.

E

Note * Application Manager stores imported Windows Installer and Microsoft App-V packages for further conflict
analysis. When you import a package into an Application Catalog, you can automatically run validation and conflict
identification features, if configured through the ConflictSolver and Application Manager Options dialog box.

Task:

212

To import a single Windows Installer or virtual package into an Application Catalog:

1. On the Catalog menu, click Import Package. The Import Wizard Welcome panel opens.

Click Next. The Select Package Source panel opens.

Select Browse Local Machine or Network for Package and click Next. The File Selection panel opens.

2
3.
4. Click Browse and select the package that you want to import.

5. If you want to add the selected package to the Software Repository, select Add the file(s) to the Software
Repository option. After you select this option, if AdminStudio determines that there are other files in that
directory that could be associated with the selected file, the Additional Dependencies of the Import File

list appears, enabling you to select any additional files to be managed by the Software Repository.

6. When you are finished making selections on the File Selection panel, click Next. The MST Source
Information panel opens, where you may optionally select any additional transform (.mst) files to be
imported along with the Windows Installer package.

E

Note - When the MST Source Information panel opens, all of the .mst files that are in the same directory as
the Windows Installer file you are importing are automatically listed in the Transform Files (.mst) list, but only
those .mst files that AdminStudio determines are probably applicable to this Windows Installer package are
selected to be included in the import. If you do not want to import a selected .mst file, clear the selection.
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Should the Windows Installer package require transforms, click the New button (i) in the Transforms area
to browse to the location of the transform. If the package requires multiple transforms, you can repeat the
procedure as necessary. The order in which transforms are applied can be changed by selecting a transform
and clicking the Move Up and Move Down buttons. If you need to delete a transform you have added, select
the transform and click the Delete button.

When you have finished adding transforms, click Next. The MSP Source Information panel opens, where
you may optionally select any additional patch (.msp or .exe) files to be imported along with the Windows
Installer package.

Should the package require patches, click the New button (1)) in the Patches area to browse to the location
of the patch. If the package requires multiple patches, you can repeat the procedure as necessary. The order
in which patches are applied can be changed by selecting a patch and clicking the Move Up and Move

Down buttons. If you need to delete a patch you have added, select the patch and click the Delete button.

When you have finished adding patches, click Next. If the package that you are importing includes some
custom tables, the Import Options panel opens, prompting you to specify whether you want to import these
tables.

To add one of the listed tables to the Ignore Tables list on the Import tab of the ConflictSolver and
Application Manager Options dialog box (so that it will not be imported into the Application Catalog during
any import), select the table name and click Add to Ignore List.

Click Next. The Destination Group panel opens.

E

Note - If you opened the Import Wizard by selecting a Group in the Application Catalog and then selecting
Import Package from the context menu, the package will be imported into the selected group, and this panel
will not appear.

Select one or more destination groups into which your package will be imported. You can also click New to
create a new Group. When you click Next, the Summary panel opens.

Review the information in the Summary panel. If you are satisfied with the import options, click Finish to start
the import.

A report of the import process appears on the Import tab of the Output window. Depending on whether
options have been set from the General tab of the ConflictSolver and Application Manager Options dialog
box (available from the Tools menu), validation and conflict checking may be performed during import.

The package appears under an Application node in the Application Manager tree:

(w4.5.5096.0)

About Importing Windows Installer Packages

Regarding importing Windows Installer packages, note the following:
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e If you specify an update.exe patch file that was created by Developer/DevStudio/InstallShield Editor,
Application Manager will extract the .msp file in the Temp folder and then perform the import.

e For patches to be applied to an MSI package, it is necessary to perform an Administrative install of the MSI
package and then perform an Administrative install of each patch package one by one. This way, the content
of each patch package is appended to the MSI package at the Administrative install location.

e You can also import a Windows Installer package by right-clicking the group into which you want to import the
package and selecting Import Package from the context menu. The MSI Source Information panel is
displayed in the Import Wizard, and you can proceed with the steps above. However, since you have already
specified the group into which you want to import the package, the Destination Group panel does not
appear.

e Although not required, it is recommended that you import only Windows Installer packages that have passed
the Full MSI Validation Suite validation into the Application Catalog.

About Windows Installer Packages (.msi)

Application Manager supports the import of Windows Installer packages (.msi). A Windows Installer package
contains all of the information that the Windows Installer requires to install or uninstall an application or product
and to run the setup user interface. The .ms1 file can also contain one or more transform files (.mst) and one or
more patches (.msp).

A Windows Installer package is organized around the concepts of components and features:
e Afeature is a part of the application’s total functionality that a user may decide to install independently.
e A componentis a piece of the application or product to be installed.

The Windows Installer always installs or removes a component from a user’s computer as a coherent piece.
Components are usually hidden from the user. When a user selects a feature for installation, the installer
determines which components must be installed to provide that feature.

Performing an Ad-Hoc Import of Transform Files or Patch Files

214

Edition * You can only perform an ad-hoc import if you are connected to a Software Repository-enabled
Application Catalog. The Software Repository feature is included in AdminStudio Enterprise Edition.

In a large enterprise, transform and patch files are created frequently to modify packages for different situations in
their organization. For example, to localize a software application, a transform file is often created for each
language supported by that application. Systems Administrators in these large enterprises have to keep track of
which software package each file is supposed to be applied to.

You cannot tell which package a transform or patch file is associated with by just looking at the file. However, you
can use the Import Wizard to perform an ad-hoc import of these loose transform and patch files into your
Application Catalog. Then, Application Manager will:

e Determine which of the packages in the Application Catalog the transform or patch file is associated with, and
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e Store the files in the Software Repository along with that package’s other associated files.

E

Note * You can only perform an ad-hoc import if you are connected to a Software Repository-enabled Application
Catalog. See Using the Software Repository for more information.

E

Note * To perform an ad-hoc import of a transform file or patch file, the package that the file is associated with must

exist in the Application Catalog. If no associated package exists, the file cannot be imported.

Task: To perform an ad-hoc import of a transform or patch file:
1. Open Application Manager.
2. Connect to a Software Repository-enabled Application Catalog.
3. Onthe Catalog menu, click Import Package. The Welcome panel opens.
4. Click Next. The File Selection panel opens.
5. Select the transform or patch file that you want to import.
6. Select the Add the file(s) to the Software Repository option.

After you select this option, the Additional Dependencies of the Import File list appears, enabling you to
select any dependencies of the file you are importing. For example, a dependency might be a file that the
transform file references that is stored externally in a separate CAB file.

7. Select dependencies, if desired, and click Next.

8. The Target Package Information panel opens and lists the package that Application Manager has
determined is associated with this file.

E

Note - For transforms and patches, if Application Manager determines that there are no packages associated
with this file, you cannot proceed with the import.

9. Select the file’s associated package.

10. If you want to reimport a new version of this package along with the file you are importing, select the
Reimport new version of the package with this file change option. If you do not select this option, the
package will not be reimported.

11. Click Next. The Summary panel opens, listing the Adhoc file to import, the Destination Packages for
the file, and whether you chose to reimport the package.

12. Review the information in the Summary panel. If you are satisfied with the import options, click Finish to start
the import. Progress messages appear in the Output Window.
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About Transforms (.mst)

Application Manager supports the import of Windows Installer packages (.ms1i) with associated transforms (.mst).
A transform is a collection of changes applied to an installation. By applying a transform to a base installation
package, the installer can add or replace data in the installation database. The installer can only apply transforms
during an installation.

The installer registers a list of transforms required by the product during the installation. The installer must apply
these transforms to the product’s installation package when configuring or installing the product.

A transform can modify information that is in any persistent table in the installer database. A transform can also add
or remove persistent tables in the installer database. Transforms cannot modify any part of an installation package
that is not in a database table, such as information in the summary information stream, information in substorages,
information in nested installations, or files in embedded cabinets.

About Patches (.msp)

AdminStudio supports the import of Windows Installer packages (.ms1i) with associated patches (.msp). A Windows
Installer patch (.msp file) is a file used to deliver updates to Windows Installer applications. A patch is a self-
contained package that contains all the information required to update an application.

A patch package contains the actual updates to the application and describes which versions of the application
can receive the patch. A patch package does not include a database like a regular installation package (.ms1 file).
Patches contain at minimum two database transforms. One transform updates the information in the installation
database of the application. The other transform adds information that the installer uses for patching files.

Importing a Directory of Windows Installer and/or App-V
Packages

W

Task:

216

You can import a directory of packages (containing both Windows Installer and App-V packages, if desired) into
the Application Catalog.

To import a directory of Windows Installer and/or App-V packages:

1. Open Application Manager.

2. On the Catalog menu, click Import Package. The Import Wizard Welcome panel opens.
3. Click Next. The Select Package Source panel opens.

4. Select Browse a Local Machine or Network for Directory of Packages and click Next. The Folder
Selection panel opens, prompting you to select the directory containing the packages you want to import.

5. Select Browse Local Machine or Network for Package and click Next. The File Selection panel opens.

6. Click Browse and select the directory containing the packages that you want to import.
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7. To import the Windows Installer packages in the selected directory, select the Import Windows Installer
packages (.msi) option.

8. To import the transform files that are located in the same directory as an .msi package, select the Apply
transform files (.mst) located in the same folder as an MSiI file option.

9. To import the Microsoft App-V (.sft) packages in the selected directory, select the Import App-V packages
(-sft) option.

10. If you want to add these package to the Software Repository, select Add the file(s) to the Software
Repository option. After you select this option, if AdminStudio determines that there are other files in that
directory that could be associated with the selected file, the Additional Dependencies of the Import File
list appears, enabling you to select any additional files to be managed by the Software Repository.

11. Click Next. The Summary panel opens.

12. Click Finish. Packages are imported into the Application Catalog. For information on how the Import Wizard
decides which packages to import, see Import Wizard’s Selection Rules When Importing Packages from a
Directory.
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Importing Windows Installer and/or App-V Packages
From Microsoft Configuration Manager

o

You can use the Import Wizard to import Windows Installer and Microsoft App-V packages from a Microsoft System
Center Configuration Manager server into the Application Catalog.

Task:

218

To import Windows Installer and/or App-V packages from Microsoft Configuration Manager:

1.

2.

Open Application Manager.
On the Catalog menu, click Import Package. The Import Wizard Welcome panel opens.
Click Next. The Select Package Source panel opens.

Select Browse Microsoft System Center Configuration Manager and click Next. The Connect to a
Microsoft Configuration Manager Server panel opens.

Specify the connection information for a Microsoft Configuration Manager Server:

Option Description

Server Enter the name of the Microsoft Configuration Manager Server that you want to
connect to.

Authentication Choose one of the following options:

e Server Authentication—Choose this option if you want to use Microsoft
Configuration Manager Server login identification to log into this server.
Then enter the appropriate User name and Password.

e Windows Authentication—Choose this option if you want to use
Windows network authentication (your network login ID) to log into this
Microsoft Configuration Manager Server.

E

Note ° After you successfully connect to a Microsoft Configuration Manager Server, the
next time you open this panel, those previously-entered values (except the Password) will
pre-populate this panel.

Click Next. The Select Packages panel opens, listing all of the packages in the connected Configuration
Manager server and prompting you to select the packages you want to import.

Select the packages that you want to import and click Next. The Summary panel opens.
Click Finish to begin the import. The selected packages are imported into the Application Catalog.

A report of the import process appears on the Import tab of the Output window. Depending on whether
options have been set from the General tab of the ConflictSolver and Application Manager Options dialog
box (available from the Tools menu), validation and conflict checking may be performed during import.
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When the import is complete, the packages each appear under an Application node in the Application
Manager tree:

eSync (v4.5.5096.0)

Importing Virtual Packages

Edition * Support for importing Microsoft App-V applications, ThinApp applications, and Citrix profiles into the
Application Catalog is included in the AdminStudio Virtualization Pack.

You can import Microsoft App-V, VMware ThinApp, and Citrix virtual packages into the Application Catalog and
associate them with their source Windows Installer package.

Virtual packages are self-contained entities which ordinarily cannot be modified after they are created. By
associating a virtual package with the Windows Installer package which originated it, you have the convenience of
being able to easily locate the virtual package’s originating Windows Installer package, modify the original
Windows Installer package, and then regenerate the virtual package.

You have several options in how to import a virtual package:

e By itself—You can use the Import Wizard to import a virtual package directly into the Application Catalog.
Then you can use the Associate Package function to associate the virtual package with its source package.
See Importing a Virtual Package Without Its Source Windows Installer Package and Manually Associating a
Virtual Package with a Windows Installer Package.

e During the import of the Windows Installer package—During the import of a Windows Installer package,
if the Import Wizard searches for and finds a virtual package created by AdminStudio, you are prompted to
also import that virtual package. See Importing a Virtual Package During the Import of its Source Windows
Installer Package.

e After the import of the Windows Installer package—If you import an AdminStudio-created virtual
package into an Application Catalog that already contains the virtual package’s source Windows Installer
package, you are prompted to associate the virtual package with the Windows Installer package. See
Importing a Virtual Package After the Import of its Source Windows Installer Package.

Importing a Virtual Package Without Its Source Windows Installer
Package

You can import a virtual package into the Application Catalog even if you have not yet imported its source Windows

Installer package. If you then import the virtual package’s source Windows Installer package at a later date, you
can use the Associate Package function in Application Manager to manually associate them.
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o

Task: To import a virtual package by itself:

-k
.

g P w0 b

Open Application Manager.

On the Catalog menu, select Import Package. The Welcome panel of the Import Wizard opens.

Click Next. The Select Package Source panel opens.

Select Browse Local Machine or Network for Package and click Next. The File Selection panel opens.
Click Browse and select the virtual package that you want to import:

e Microsoft App-V application—Select the App-V file with an .osd extension, such as MyApp.osd.

e VMware ThinApp application—Select the ThinApp file with an .exe extension, such as MyApp.exe.

e Citrix XenApp profile—Select the Citrix XenApp file with a .profile extension, such as MyApp.profile.
Click Next. The Summary panel opens.

Click Finish to begin the import. The virtual package is imported and will be listed under its own Application
node in the tree.

Importing a Virtual Package During the Import of its Source Windows
Installer Package

When you are importing a Windows Installer package, if the Import Wizard finds a virtual package in a subdirectory
of the directory containing that Windows Installer package, you are prompted to also import that virtual package.

o

Task: To import a virtual package during the import of a Windows Installer package:

1.

2
3.
4
5

220

Open Application Manager.

On the Catalog menu, select Import Package. The Welcome panel of the Import Wizard opens.

Click Next. The Select Package Source panel opens.

Select Browse Local Machine or Network for Package and click Next. The File Selection panel opens.

Click Browse and select the Windows Installer package that has associated virtual packages that you want to
import.

[]

Important * The Import Wizard will only prompt you to import a Windows Installer package’s associated virtual
packages if those virtual packages are in a subdirectory of the directory containing the Windows Installer
package.

Click Next. The MST Source Information panel opens.
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7. Include any desired transform files, as described in Importing a Single Package, and click Next. The MSP
Source Information panel opens.

8. Include any desired patch files, as described in Importing a Single Package, and click Next. The Virtual
Package Import panel opens.

Import Wizard @

¥irtual Package Import
Choose additional virtual packages to import. """ﬂ

The ‘Windows Installer Package [.msi] appears to have associated wirtual packages. Specify
whether you want to include these virual packages in the import process.

¥ Import Microsoft AppY package from:

|E:\Admin8 tudio Shared\Packages\Orcat\dppYPackagehOrca_v14Orca.sft

-

¥ |mpart Citrix package from:
|E:\Admin8 tudio Shared\PackageshOrca\CitrizProfile\0rcahOrca. profile

< Back | Mext > | Cancel Help

E

Note -« This panel only opens if the Import Wizard finds a virtual package in a subdirectory of the directory
containing the Windows Installer package you have selected to import.

If a Windows Installer package’s virtual package is not in that location, you can use the Import Wizard to import
the virtual package separately, as described in Importing a Virtual Package After the Import of its Source
Windows Installer Package, and then manually associate the two packages in Application Manager, as
described in Manually Associating a Virtual Package with a Windows Installer Package.

9. Select the virtual package(s) you want to import and click Next. The Destination Group panel opens.

E

Note - If you opened the Import Wizard by selecting a group folder and then selecting Import from the context
menu, the Destination Group panel will not open.

10. Select the group or groups where you want to import this package, as described in Importing a Single
Package, and click Next. The Summary panel opens.

11. Click Finish to begin the import. The packages are imported. When import is complete, both the Windows
Installer and the virtual package(s) are listed in the Application Catalog under the same Application node in the
tree.
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L Application Manager - AUGUSTA6MSQLEXPRESS (AdminStudio Sample Catalag) - sa =n o<
Catalog  Edit  ‘iew Conflicts  Reports  Tools  Help

D=8 58 LIBEREGHS HO

Products s
g 1# Lpplication Catalag pp- Pack
B = Groups Type  App-y
E| cl Engineering File CihadminStudio Shared\Packages\OrcalApp-YPackage\Orca_w1Orca,sft

----- 277 InstallShield MSIDiff Imported On  Saturday, February 12, 2011 - 10:33

- LichModlnj Applications Only the current Application references this product,
B MathPlat ated
Associated MSI Marme Descripkion
Packages
#Forca Contact: Your local administrator
Description

ﬂproducts ‘ kerge Modules %ﬁpatches

Importing a Virtual Package After the Import of its Source Windows
Installer Package

222

During the import of an AdminStudio-created virtual package into an Application Catalog that already contains the
virtual package’s source Windows Installer package, the Associate Virtual to MSI Packages panel opens and
you are prompted to associate the virtual package with the Windows Installer package.

If this source Windows Installer package has been imported into more than one location in the Application Catalog,
multiple packages are listed.

[]

Important « During virtual package conversion, AdminStudio 9.0 and later creates a file, metadata.ami, that
contains metadata that identifies the original Windows Installer package that was used to create the virtual package.
If a virtual package was created by a method other than the AdminStudio 9.x conversion process, this metadata file
will not have been created. Therefore, when importing this type of virtual package, the Import Wizard will not prompt
you to associate it with a Windows Installer package in the Application Catalog. Instead, you can perform the steps
in Manually Associating a Virtual Package with a Windows Installer Package.
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To import a virtual package after the import of its source Windows Installer package:

-k
.

g P w0 b

Open Application Manager.

On the Catalog menu, select Import Package. The Welcome panel of the Import Wizard opens.

Click Next. The Select Package Source panel opens.

Select Browse Local Machine or Network for Package and click Next. The File Selection panel opens.
Click Browse and select the virtual package that you want to import:

e Microsoft App-V application—Select the App-V file with an .osd extension, such as MyApp.osd.

e VMware ThinApp application—Select the ThinApp file with an .exe extension, such as MyApp.exe.

e Citrix profile—Select the Citrix file with a .profile extension, such as MyApp.profile.

Click Next. The Associate Virtual to MSI Packages panel opens, prompting you to associate this virtual
package with its source Windows Installer package.

Select the Windows Installer package and click Next. The Summary panel opens.

Click Finish to begin the import. The virtual package is imported. When import is complete, both the Windows
Installer and the virtual package is listed in the Application Catalog under the same Application node in the
tree.

L Application Manager - AUGUSTA6MSQLEXPRESS (AdminStudio Sample Catalag) - sa =n o<
Catalog  Edit  ‘iew Conflicts  Reports  Tools  Help

D=8 58 LIBEREGHS HO

Products s

= £ Groups Type App-y
E| """ cl Engineering File CihadminStudio Shared\Packages\OrcalApp-YPackage\Orca_w1Orca,sft

{57 InstallShield MSIDiff Imported On Saturday, February 12, 2011 - 10:33
B Lichoding

[87 MathPlot

Applications Only the current Application references this product,
Associated MSI

: B Systern Test Tracker Packages Mame | Description
E| 5 Marketing 'f,"v‘Orca Contact: Your local administrator

v [0 Adobe Reader 8
Orca

..... Orca

e Orca Description
7 Orca (v1.50.2600.0000)

ﬂproducts 5 kerge Modules %ﬁpatches
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Manually Associating a Virtual Package with a Windows Installer Package

You can use the Import Wizard to import a virtual package directly into the Application Catalog even if you have not
yet imported its source Windows Installer package. If you then import the virtual package’s source Windows
Installer package at a later date, you can use the Associate Package function in Application Manager to manually
associate the virtual package with its source package.

AN

Caution < After you have imported a virtual package into the Application Catalog, you are permitted to use the
Associate Package function to associate it with any Windows Installer package in the Application Catalog, even
one that is not its source package. Therefore, it is preferable to use the Import Wizard to import both the Windows
Installer and virtual packages at the same time so that AdminStudio can create the proper associations.

Task:

To manually associate a virtual package with a Windows Installer package:
1. Open Application Manager

2. Click on the virtual package you want to make an association for, and select Associate Package from the
context menu. The Virtual Package Association dialog box opens, listing Windows Installer packages in the
Application Catalog.

3. Select a Windows Installer package and click OK. The virtual package is now associated with the selected
Windows Installer package.

Deleting a Virtual Package Association

7

Task:

You can delete a virtual package’s association with a Windows Installer package by performing the following steps:

To delete a virtual package association:
1. Open Application Manager.

2. Right-click on a virtual package, point to Delete and click Package Association on the context menu. The
Delete Virtual Package Association dialog box opens, prompting you to confirm the deletion.

3. Select the association that you want to delete and click OK. The association is deleted.

Importing Merge Modules

224

For optimal performance, Merge Modules should be imported into an Application Catalog database prior to
importing Windows Installer packages. This ensures that conflicts resulting from not using available merge
modules are correctly identified.
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Task: To import Merge Modules:
1. Open Application Manager.
2. Open the Merge Modules tab.

3. Select the root Merge Module or one of the imported Merge Modules and select Import Merge Module from
the context menu. The MSM Source Information panel of the Import Wizard opens.

4. Click the Browse (|#
import.

) button in the Merge Modules area and select the merge module file that you want to

5. To import multiple patches, you can repeat the procedure as necessary.

6. The order in which merge modules are applied can be changed by selecting a merge module in the list and
clicking the Move Up and Move Down arrows.

7. If you need to delete a merge module you have added, clear its check box.

8. If you want to store this merge module in the Software Repository, select the Add the file(s) to the Software
Repository option.

9. Click Next. The Summary panel opens.
10. Click Finish to accept these options and begin the import.

A report of the import process appears on the Import tab in the Output window.

E

Note ° You can also import a Merge Module into the Application Catalog by selecting Import Package on the
Catalog menu. However, using that method, only one Merge Module can be imported at a time.

About Merge Modules (.msm)

Application Manager supports the import of merge modules (.msm). Merge modules are essentially simplified
Windows Installer .msi files.

A merge module cannot be installed alone because its lacks some vital database tables that are present in an
installation database. Merge modules also contain additional tables that are unique to themselves. To install the
information delivered by a merge module with an application, the module must first be merged into the
application’s .msi file.

Importing OS Snapshots

You can import OS Snapshot (.osc) files into the Application Catalog to use to determine conflicts between an
operating system and a package. OS Snapshot files are files representing a particular computer system’s contents.
To generate an OS snapshot file, use the OS Snapshot Wizard to scan a computer’s operating system and record
the files, INI files, shortcuts, and registry entries present.
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Caution « The OS Snapshot Wizard saves OS Snapshot information in two files: an .osc file (a collection of file type
information) and an associated .nir file (registry information). The .nir file must be present in the same directory as
the .osc file in order for import to be successful.

Task:

To import an OS Snapshot into an Application Catalog:

-k
.

Open Application Manager.

On the Catalog menu, select Import Package. The Welcome panel of the Import Wizard opens.

Click Next. The Select Package Source panel opens.

Select Browse Local Machine or Network for Package and click Next. The File Selection panel opens.
Select the OS Snapshot (.osc) file that you want to import

Click Browse and select the file that you want to import.

N o o 2 0 DN

If you want to add this OS Snapshot to the Software Repository, so that it stores the OS Snapshot’s associated
.nir file, select Add the file(s) to the Software Repository option.

8. Click Next. The Destination Group panel opens.

E

Note - If you opened the Import Wizard by selecting a Group in the Application Catalog and then selecting
Import Package from the context menu, the OS Snapshot will be imported into the selected group, and this
panel will not appear.

9. Select one or more destination groups into which your OS snapshot will be imported. Click Next. The
Summary panel opens.

10. Click Finish to accept these options and begin the import.

A report of the import process appears on the Import tab in the Output window.

About OS Snapshots (.osc)

226

Application Manager supports the import of OS Snapshot (.osc) files, which are files representing a particular
computer system’s contents. To generate an OS snapshot file, use the OS Snapshot Wizard to scan a computer’s
operating system and record the files, INI files, shortcuts, and registry entries present. The Wizard saves this
information in an .osc file (a collection of file type information) and an associated .nir file (registry information).

When an OS Snapshot file is imported into Application Manager, it can be used as a reference point for conflict
identification. See Taking OS Snapshots for more information.
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To provide maximum flexibility during the OS Snapshot process, you can use the Exclusions Editor to create an
exclusion list that identifies files, INI files, shortcuts, and registry entries that the OS Snapshot Wizard should
disregard during the scan. Using this list, you can eliminate unnecessary files, shortcuts, or registry entries, and
reduce the time it takes to perform the OS Snapshot. See Configuring Exclusions Using the Exclusions Editor for
more information.

AN

Caution * OS Snapshots should only be used for comparison in Application Manager. You should never attempt to
convert an OS Snapshot into an MSI package.

Importing Marimba NCP Files

Edition * Import support for Marimba Native Channel Packager (.ncp) files is available in AdminStudio Enterprise
Edition.

You can import Marimba NCP files into the Application Catalog. See About Marimba Native Channel Packager Files
(.ncp) for more information.

To import Marimba NCP files into an Application Catalog, perform the following steps.

Task:

To import a Marimba NCP file into an Application Catalog:

1. Open Application Manager.

2. Onthe Catalog menu, select Import Package. The Welcome panel of the Import Wizard opens.

3. Click Next. The Select Package Source panel opens.

4. Select Browse Local Machine or Network for Package and click Next. The File Selection panel opens.
5. Select a Marimba NCP File (.ncp) and click Next. The Destination Group panel opens.

E

Note - If you opened the Import Wizard by selecting a Group in the Application Catalog and then selecting
Import Package from the context menu, the NCP File will be imported into the selected group, and this panel
will not appear.

6. Select one or more destination groups into which your package will be imported and click Next. The
Summary panel opens.

7. Review the information in the Summary panel . If you are satisfied with the import options, click Finish to start
the import.

A report of the import process appears on the Import tab of the Output window. The Marimba NCP file
package appears under the specified group in the Application Manager Product View.
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Caution * The Marimba NCP file that should be imported into an Application Catalog is always named

manifest.ncp. If you attempt to import another file with an .ncp extension into an Application Catalog, the import will
fail.

About Marimba Native Channel Packager Files (.ncp)

228

Marimba NCP (Native Channel Packager) files are used to describe software components, their versions, their
underlying structures, and their dependence on other components. Marimba’s NCP file is derived from an OSD
(Open Software Description) file and is currently used by Marimba’s Castanet family of products.

Clients, such as Marimba Castanet Tuners, can use an NCP file to learn what files constitute a software package for
particular software for a particular client platform and particular user preferences. Just as an HTML file can contain
links to other HTML or media files, so can an OSD file contain links to other NCP files. These linked NCP files
represent sub-packages or dependencies.

The following is an example of a very simple NCP file:

<SOFTPKG NAME=com.Installshield.www.AdminStudio"
VERSION="1,0,0,0">

<TITLE>Solitaire></TITLE>

<ABSTRACT>AdminStudio by InstallShield Corporation</ABSTRACT>

<LICENSE HREF=http://www.installshield.com/AdminStudio
Ticense.html/>

<IMPLEMENTATION>

<0S VALUE-"WinNT">

<OSVERSION VALUE-"4,0,0,0"/></0S>

<0S VALUE-"Win95">

<PROCESSOR VALUE="x86"/>

<LANGUAGE VALUE="en"/>

<CODEBASE HREF=http://www.installshield.com/AdminStudio.cab/>

</IMPLEMENTATION>

</SOFTPKG>

Application Manager supports the import of Marimba NCP Version 4.7.2 files into the AdminStudio Application
Catalog, making them available for conflict identification and resolution. Please note the following:

e The Marimba NCP file that should be imported into Application Manager is always named manifest.ncp. If you
attempt to import another file with an .NCP extension into Application Manager, the import will fail.

e Information from NCP files is stored in OS Snapshot specific tables within the Application Catalog.

® An NCP file can be selected as a source and a target package for Conflict detection, using ACE23 and ACE24.
However, reporting, validation, and conflict resolution are not supported for the NCP package type.

e Extended attributes are supported for NCP packages.

e You can import NCP files from the command line.

ADS-1000-UG00 AdminStudio 10.0 User Guide



Chapter 6: Managing Application Catalog Databases
Importing Data

Importing Other Setup Types

AdminStudio supports the import of wide variety of other (i.e., non-MSlI) setup formats into the Application Catalog.
See About Other Setup Types for a description of those setup types.

To import a setup in one of these formats into an Application Catalog, perform the following steps:

AN

Caution * Package Auto Import, Application Catalog Replication, reporting, validation, conflict detection, and thus

conflict persistence are not supported by the Other Setup Types package type. However, the Merge process does
support this package type. See Merging Application Catalogs Using the Merge Wizard for more information.

Task: To import Other Setup Types into an Application Catalog:

1. Open Application Manager.

2. Onthe Catalog menu, select Import Package. The Welcome panel of the Import Wizard opens.
Click Next. The Select Package Source panel opens.

Select Browse Local Machine or Network for Package and click Next. The File Selection panel opens.

a » w

Select the non-MSI package that you want to import and click Next. The Additional non-MSI Import
Options panel opens, where you can enter a name for the package and the base directory for the package
(where all of its installation files are located).

6. Enter a Product Name to identify this package.

7. Click the Explore button and select the base Directory of this package where all of its associated files can be
found.

8. If you want to import all the files in the specified directory folder and all of its subfolders, select the Include
entire directory hierarchy check box. If you want to import only the files in the root of the specified directory
folder, do not select this option.

9. Click Next. The Destination Group panel opens.

E

Note - If you opened the Import Wizard by selecting a Group in the Application Catalog and then selecting
Import Package from the context menu, the file will be imported into the selected group, and this panel will
not appear.

10. Select one or more destination groups into which this package will be imported and click Next. The
Summary panel opens.

11. Review the information in the Summary panel. If you are satisfied with the import options, click Finish to start
the import.

A report of the import process appears on the Import tab of the Output window. The Other Setup Type
package appears under the specified group in the Application Manager Product View.
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230

A wide variety of other (i.e., non-MSI) setup formats exist. Application Manager supports the import of non-MSI
setup types (such as InstallShield Professional or ISMP installations) into the Application Catalog. By importing
these other setup formats, you allow AdminStudio to manage these setups in a manner consistent with other MSI
based packages.

When importing one of these setup formats using the Import Wizard, you specify a directory or a directory
hierarchy, and Application Manager will scan any setup.exe or isetup.exe files for pertinent setup information.

E

Note * Package Auto Import, Application Catalog Replication, reporting, validation, conflict detection, and thus
conflict persistence are not supported by the Other Setup Types package type. However, the Merge process does
support this package type. See Merging Application Catalogs Using the Merge Wizard for more information.

Duplicate Package Identifiers

When you import a package into an Application Catalog database, Application Manager checks specific identifiers
that are selected on the Duplicate Package tab of the ConflictSolver and Application Manager Options dialog
box to determine if that package has already been imported.

e For Windows Installer files, the following identifiers are listed on the Duplicate Package tab:

PackageCode

® ProductCode

® Product Language

®  ProductVersion

e List of Transform Files

If none of these identifiers are selected, Application Manager will use the Product Name identifier to perform a
Duplicate Package check.

e For App-V packages, the following identifiers are listed on the Duplicate Package tab:
e PackageGUID
e \VersionGUID

If neither of these identifiers are selected, Application Manager will use the Product Name identifier to
perform a Duplicate Package check.

If Application Manager determines that you are attempting to import a duplicate package (based upon the selected
identifiers), you are given the opportunity to enter a name of your choosing to identify the duplicate package before
the package is imported. If the package is stored in the Software Repository, you can also choose to overwrite the
existing version or treat it as a new version of an existing package.
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Business Case for Importing a Package Multiple Times

You might encounter this situation if you are importing the same package into the same Application Catalog
database multiple times, each time with a different set of transforms. One common reason why you might want to
import the same package into your Application Catalog database more than once would be if you wanted to use
Tuner to create custom installation SKUs of a common MSI package to distribute to different departments in your
organization, each installation including certain features that are appropriate for the department and excluding
certain features that are not appropriate. For example, if you were distributing a copy of Microsoft Office, you could
add transforms to the Microsoft Office MSI package so that:

® Accounting’s installation would include only Word and Excel
e Marketing’s installation would include only Word and PowerPoint, and
e Development’s installation would include only Word and Access.

Therefore, you might want to import the same package into your database more than once, each time with a
different set of transformations. What happens when you import the package the second time depends upon the
identifiers you selected on the Duplicate Package Tab. In this example:

e If you select the List of Transform Files and ProductCode identifiers on the Duplicate Package tab of the
ConflictSolver and Application Manager Options dialog box, Application Manager will not identify these two
packages as duplicate, even though they have the same ProductCode, because they have a different set of
transformations. Therefore, the package will be imported with the same display name as the first package.

e [fyou only select the ProductCode identifier on the Duplicate Package tab of the ConflictSolver and
Application Manager Options dialog box, Application Manager will identify the second package as a duplicate
because the two packages have the same ProductCode.

Duplicate Product Name Conventions

When it identifies a duplicate package, by default Application Manager generates a new name for that package by
pre-pending the Product Name with the Manufacturer’s name and, if necessary, appending the Product Name with
numbers:

e 1st Package: PowerPoint
e 2nd Package: Microsoft Corporation_PowerPoint

You can edit the Duplicate Package Naming Syntax on the Duplicate Package tab of the Options dialog box.

When Duplicate Packages are Identified During Bulk Import

If Application Manager is performing a bulk import or reimport, it still identifies duplicate packages using the user-
specified criterion. Application Manager will generate a unique displayed product name and allow the import to
proceed without prompting the user.

Application Manager identifies duplicate packages based upon the identifiers that you selected on the Duplicate
Package tab of the ConflictSolver and Application Manager Options dialog box. See Using Duplicate Package
Identifiers for more information.

Identifying Duplicate Package Identifiers

To identify duplicate package identifiers, perform the following steps.
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Task:

232

To identify duplicate package identifiers:

1.

2.

6.

E

Select Options from the Tools menu. The ConflictSolver and Application Manager Options dialog box opens
Click the Duplicate Package tab.

Under Duplicate Package Identification Options, select the identifiers that you would like to use for
Windows Installer package imports by selecting one or more of the following options:

e PackageCode Property— Identifier of the package the product was installed from. No two non-identical
.msi files should ever have the same package code.

e ProductCode Property—Unique identifier for the particular product release, represented as a string
GUID, for example:

{12345678-1234-1234-1234-123456789012}

e Product Language—The language the installer should use for any strings in the user interface that are
not authored into the database.

e ProductVersion—Version of the product in string format. The format of the string is: major.minor.build.
e List of Transform Files—A list of the transformations associated with this package.

e [None Selected]—If you do not select any of these five identifiers, Application Manager checks the
Product Name identifier to determine if a package is a duplicate.

Under Duplicate Virtual Package Identification Options, select the identifiers that you would like to use
for App-V package imports by selecting one or more of the following options:

e PackageGUID—Unique identifier of App-V package.
e VersionGUID—Unique identifier of App-V package version.

e [None Selected]—If you do not select either of these identifiers, Application Manager checks the
Product Name identifier to determine if a package is a duplicate.

Click OK to save your changes and exit the Options dialog box

Proceed with the package import, as described in Importing a Single Package or Importing Virtual Packages.

Note - If Application Manager is performing a bulk import or reimport, it still identifies duplicate packages using the

user-specified criterion. Application Manager will generate a unique displayed product name and allow the import to
proceed without prompting the user.

E

Note * The options that you select on the Duplicate Package tab of the ConflictSolver and Application Manager
Options dialog box apply globally to all packages that you attempt to import; you cannot apply different identifiers
to different packages. Also, since these options are saved in the AdminStudio Shared Directory, everyone using
AdminStudio at your organization will share the same Duplicate Package options.
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Viewing Virtualization Data and Reports

In Application Manager, you can view the virtualization readiness status of the Windows Installer packages in your
Application Catalog, as well as detailed information on the App-V packages.

® Viewing the Virtualization Readiness Status of Applications

e Viewing App-V Package Data
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Viewing the Virtualization Readiness Status of
Applications

AdminStudio now uses Microsoft SQL Reporting Services to generate an Application Readiness Dashboard. This
dashboard report provides a snapshot of the current status of packages in your Application Catalog including

virtualization readiness. You can click on this chart to open more detailed reports.

Task: To view the virtualization readiness status of applications:

1. Open Application Manager and select the Application Catalog node. The Application Readiness

Dashboard opens.

L

Tip * The Application Readiness Dashboard is also available on the Report Center tab of the AdminStudio

interface.

2. On the right side of the dashboard, locate the Virtualization Readiness report:

Virtualization Readiness
Shows the virtualization status
of Applications in the Application
Cakalog.

43.75%
@

6.25%(1)

50.00%
@)

. Already virtualized

Mot Tested
. Mot Suitable For Virtualization
. Ready For Virtualization

This report lists the percentage of applications in the Application Catalog that fall into the following categories:

Status Description

Already Virtualized The number of applications in the Application Catalog that contain at least one
of the following virtual deployment types: Microsoft App-V, Citrix XenApp,

VMware ThinApp.

If you click on this category, a detail report showing a list of these virtual

applications opens.
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Description

The number of applications in the Application Catalog that contain a Windows
Installer package which has not yet been tested for virtualization readiness.

If you click on this category, a detail report showing a list of these packages
opens.

Tip * Packages are automatically tested for virtualization readiness during import into the
Application Catalog or when you upgrade an existing Application Catalog.To manually
retest a package or group of packages for virtualization readiness, select a package,
application, or group in the Application Manager tree and select Run Virtualization
Readiness from the context menu. See also Virtualization Suitability View.

The number of applications in the Application Catalog that contain a Windows
Installer package that may not be suitable for virtualization by Automated
Application Converter. For more information, see Virtualization Not Supported
and Virtualization Not Recommended.

If you click on this category, a detail report showing a list of these packages
opens.

Tip * Packages are automatically tested for virtualization readiness during import into the
Application Catalog or when you upgrade an existing Application Catalog.To manually
retest a package or group of packages for virtualization readiness, select a package,
application, or group in the Application Manager tree and select Run Virtualization
Readiness from the context menu. See also Virtualization Suitability View.

The number of applications in the Application Catalog that contain a Windows
Installer package that is ready for virtualization using the Automated
Application Converter. Any issues discovered during virtualization readiness
testing will be handled automatically during conversion.

Viewing App-V Package Data

In AdminStudio 9.5, you could import App-V packages into the Application Catalog, but the amount of information
that you could view in Application Manager for that package was very limited.

In AdminStudio 10, AdminStudio now uses Microsoft SQL Reporting Services to provide comprehensive
application data reports for App-V packages, including the following information:

Many of these reports offer drill-down functionality, enabling you to view even more detailed information, and can
be printed separately, or saved in PDF, Microsoft Excel, or Microsoft Word format.

® Viewing App-V History

e Viewing App-V Package Dependencies
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e Viewing App-V Package Files and Directories
e Viewing App-V Package File Type Associations

e Viewing App-V Package Environment Variables

Viewing App-V History

To view App-V package history, perform the following steps.

o

Task: To view App-V package history:
1. Open Application Manager.

2. Inthe tree, expand an App-V node and select the App-V History node. The App-V History View opens,
listing an entry for each time this App-V package has been saved. For each entry, the following information is
displayed:

e Version GUID

® Sequencer Version
e Sequenced By

® Sequencing Station
®  OSDetails

e System Folder

e Windows Folder

e User Folder

o .Net Framework Version

IEVersion

Viewing App-V Package Dependencies

To view App-V package dependencies, perform the following steps.
Task: To view App-V package dependencies:

1. Open Application Manager.

2. Inthe tree, expand an App-V node and select the Dependencies node. The Dependencies View opens,
listing both the applications this package is dependent on and the applications dependent upon this
application. For each dependency, the following information is listed:

e Application
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e In Catalog? (Yes / No)
e DSC Server URL
e Server URL

e Mandatory? (Yes / No)

Viewing App-V Package Files and Directories

To view App-V package files and directories, perform the following steps.
Task: To view App-V package files and directories:

1. Open Application Manager.

2. Inthe tree, expand an App-V node and select the Files/Directories node. The Files/Directories View
opens, listing the following information for each file/directory:

e Directory

® Short Name

® App-V Override (True / False)
e Short Name

e File

e File Size

® App-V VFS Path

® App-V Feature Block 1

® App-V Version

® App-V Data Type

Viewing App-V Package File Type Associations

To view App-V package file type associations, perform the following steps.
Task: To view App-V package file type associations:

1. Open Application Manager.

2. Inthe tree, expand an App-V node and select the File Type Associations node. The File Type
Associations View opens, listing the following information for each file type association:

e Extension
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e Target
e ProglD
e MIME

® Description
e \Verb

® Arguments

Viewing App-V Package Environment Variables

To view App-V package environment variables, perform the following steps.

o

Task: To view App-V package file type associations:
1. Open Application Manager.

2. Inthe tree, expand an App-V node and select the Environment Variables node. The Environment
Variables View opens, listing the following information for each variable:

e Name

e Value

Viewing Application Catalog Enhanced
Reporting

AdminStudio 10.0 provides an enhanced reporting infrastructure. AdminStudio has incorporated Microsoft SQL
Reporting Services to provide a summary dashboard of Application Catalog readiness data and to enable you to
create customizable reports.

e Viewing the Application Readiness Dashboard
e Exporting a Report in PDF, Excel, or Word Format

e (Creating Customizable Reports

Viewing the Application Readiness Dashboard

The Application Readiness Dashboard, which is opened by selecting the Application Catalog node in
Application Manager or by opening the Report Center tab in the AdminStudio interface, provides graphical
representations of summary data concerning the readiness of Windows Installer and App-V packages for
distribution.
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The Application Readiness Dashboard includes the following information:

Table 6-8 » Application Readiness Dashboard

Description Chart

Deployment Type Breakdown Provides a graph listing the percentage of packages in the Application
Catalog by deployment type (Windows Installer, App-V, XenApp, ThinApp,
or Legacy).

Error Category Breakdown Shows the number of AdminStudio Best Practices and Conflict errors that
have been identified in Windows Installer and App-V packages, by
category.

Virtualization Readiness Shows a summary of the virtualization status of packages in the

Application Catalog, identifying packages as being Ready for
Virtualization, Not Suitable for Virtualization, Already Virtualized, or Not

Tested.
Windows Installer / App-V Shows the Microsoft Validation status of Windows Installer packages, and
Package Quality the AdminStudio Best Practices test status of Windows Installer and
App-V packages.
Windows Installer / App-V Shows the AdminStudio Conflict test status of Windows Installer and
Package Conflicts App-V packages.

Tip * Click on specific categories of these charts to open more detailed reports.

Exporting a Report in PDF, Excel, or Word Format

You can save the Application Readiness Dashboard report, or any of the drill-through reports, in PDF, Microsoft
Excel, or Microsoft Word format.

W

Task: Saving a report:
1. View the report that you want to save.

2. Inthe toolbar, click the Save icon.
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Select Report |Dashboard j

=TI R = R

Excel

AdminStudio | rr ]

1 of 1

{-

From the menu, select either Excel, PDF, or Word. The report is exported and you are prompted for a location
to store the report.

Specify a location and click Save.

Note - You can also print the currently viewed report by clicking the Print icon in the toolbar.

Creating Customizable Reports

In AdminStudio 10.0, you can create your own custom reports that are generated using Microsoft SQL Reporting
Services.

To create a custom report, you need to first create an . rd1c file (using either Microsoft SQL Server Business
Intelligence Development Studio or Visual Studio 2010), copy that file to the AdminStudio installation directory, and
then edit the AdminStudio Report Definition file (AdminStudio.Reports.xm1) to add a reference to your custom

report.
o
Task: To create a custom Microsoft SQL Reporting Services report:
1. Create an .rd1cfile.
2. Copy that file to the following directory on the machine where AdminStudio is installed:
[AdminStudio Installation Directory]\ConflictSolver\ReportDefinition\RDLC
3. Open the AdminStudio.Reports.xml file, found in the following location, in a text editor:
[AdminStudio Installation Directory]\ConflictSolver\ReportDefinition
4. Inthe AdminStudio.Reports.xml file, copy an existing <Report> element under the <Reports> element. Below

are the <Report> elements for the Shared Extensions report and the Shared Extensions By Product drill-
through report:

<Report Name="Shared Extensions" Rd1cPathType="Relative"
Rd1cPath="RDLC\SharedExtensions.rdlc" IsView="">
<DataSources>
<DataSource DataSourceName="ds_asrpt_SharedExtensions"
SqlCommandType="StoredProcedure” SqlCommandString="sp_asrpt_SharedExtensions">
<SqlParameters>
<SqTParameter />
</SqlParameters>
</DataSource>
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</DataSources>
<Report Name="Shared Extensions By Product" RdlcPathType="Relative"
Rd1cPath="RDLC\SharedExtensionsByProduct.rdlc">
<DataSources>
<DataSource DataSourceName="ds_asrpt_SharedExtensionsByProduct"
Sq1CommandType="StoredProcedure"
SqlCommandString="sp_asrpt_SharedExtensionsByProduct">
<SqlParameters>
<Sq1Parameter DrillThroughParameterName="Extension"

SqlParameterName="@extension" SqlParameterValue="" />
</Sq1Parameters>
</DataSource>
</DataSources>
</Report>
</Report>

5. Replace the highlighted text above with the correct information for your new custom report: the data source
and the parameters that are required for any drill through reports that you include.

In this XML file, note the following parameter values:

Parameter Values

Rd1cPathType Valid values are Relative or Absolute.
SqlCommandType Valid values are StoredProcedure or SQL.
SqlCommandString Enter the stored procedure name or an SQL string.

6. To view your custom report in Application Manager, select the name of your custom report from the Select
Report drop down list on the Application Catalog View.

Select Report |Dashboard ﬂ

1 of 1 @ | B A1 |-

Adrinid

Using the Software Repository

Edition * The Software Repository feature is available in AdminStudio Enterprise Edition.

A Windows Installer package is made up of many files that are executed when the setup is run. However, only the
.ms1 file is imported into the Application Catalog database. Also, an App-V package is made up of many files that
are used when the virtual application is run. However, only the .sft file is imported into the Application Catalog
database.
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To safeguard these additional files against alteration or being misplaced, you can choose to manage Windows
Installer and Microsoft App-V packages using the Software Repository. The Software Repository gives you a
secure, transparent storage system for your AdminStudio data, especially Windows Installer and App-V packages
used in the enterprise.

The AdminStudio tools are tightly integrated into the Software Repository, particularly Application Manager and
InstallShield Editor. Certain concepts within AdminStudio itself require the Software Repository in order to operate:

e Package version management and history—You can store multiple versions of a package in the Software
Repository. Instead of reimporting a package that has changed, you can check out a package and then check
it back in either as a new package version or you can overwrite the existing version. When a package is
checked out, it cannot be modified by another user. You can also view version history and include it in reports.
See Using Version Management Features and Viewing Package History for more information.

e Ad-hoc import of transform and patch files—You can perform an ad-hoc import of transform and patch
files into the Application Catalog and Application manager will determine which software package in the
Application Catalog the transform or patch file is associated with. The file will then be stored in the Software
Repository along with that package’s other associated files. See Performing an Ad-Hoc Import of Transform
Files or Patch Files for more information.

When a Windows Installer or App-V package is managed within the Software Repository, its .msi or .sft file and all
of its other associated files and subfolders are imported into a subfolder of the Software Repository location
identified for that Application Catalog.

Information on the AdminStudio Software Repository is presented in the following sections:
e Enabling the Software Repository in Application Catalogs

e Methods to Import Packages into the Software Repository

e |dentifying Software Repository Packages in Application Manager

® Using Version Management Features

e Software Repository Integration into Other AdminStudio Tools

Enabling the Software Repository in Application
Catalogs

To be able to import packages into the Software Repository of an Application Catalog, the Application Catalog
must first have the Software Repository enabled. You can choose to enable the Software Repository feature when
you are creating a new Application Catalog, and you can also enable it in existing Application Catalogs.

When an Application Catalog is enabled for the Software Repository, a Software Repository directory location must
be specified.

When an Application Catalog has the Software Repository feature enabled, that does not mean that all of its
existing packages and all newly imported packages will be automatically added to the Software Repository. Each
time you import a package, you can choose whether you want to add it to the Software Repository.
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E

Note ° If a package is not added to the Software Repository when it is imported, the only way to add it to the
Software Repository after that is to import it again, and to choose to overwrite the existing package version.
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Enabling the Software Repository in a New Application Catalog

To enable the Software Repository in a new Application Catalog, perform the following steps.

&

Task: To enable the Software Repository in a new Application Catalog:

Create the new Application Catalog as described in Creating New Application Catalogs, but on the Select Software
Repository Location Panel, do the following:

1. Choose the Enable the Software Repository option.
2. Select a Software Repository Location.

3. Enter a Login ID and Password of the Proxy Account that will be used to access this location.

Application Catalog Wizard

Select Software Hepository Location
Select the location where the software repositary should store imported packages. E’ﬂ

Define a Software Fepository to allow AdminStudio to manage the files associated with the
inztallation of an application. Software Fepository requires a prosy account with the ability o
make modifications to the path specified az the Software Repository Location.

Enable Software Repositon

Software Repository Location;

|_\;;;ér-ve-r\so-ftw-arerepositol_l,l\marketing | D
Prowy Accout
Lagin ID: i.-f;-:ljl.:ompany\]oh_rﬁ_n:li.th |
Password: !..............l |
¢ Back “ Mest » ] [ Cancel ] [ Help

Enabling the Software Repository in an Existing Application Catalog

To enable the Software Repository feature in an existing Application Catalog, perform the following steps.

&

Task: To enable the Software Repository in an existing Application Catalog:

1. Open the Application Catalog to which you want add Software Repository support in AdminStudio,
ConflictSolver, or Application Manager.

2. Onthe Catalog menu, click Properties. The Application Catalog Properties dialog box opens.
3. Open the Software Repository tab.

4. Select the Enable Software Repository check box. The Software Repository Location option is enabled.
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5. Browse to the location where you want to store the Software Repository for this Application Catalog.

6. Under Proxy Account, specify a Login ID and Password that will be used to access this location.

7. Click OK.

Methods to Import Packages into the Software
Repository

You can import packages into the Software Repository using the following methods:

e Importing a Package into the Software Repository Using the Import Wizard

e Adding a Package to the Software Repository Using the ConflictSolver Process Assistant
e Adding a Package to the Software Repository by Overwriting Original Package

e Software Repository Auto Import Method

Importing a Package into the Software Repository Using the Import
Wizard

When you import a package into the Software Repository, all of its associated installation files are stored in the
Software Repository location, not just the installation package itself.

To have the package and its associated files managed within the Software Repository, launch the Import Wizard as
described in Importing Data, and when the File Selection panel opens, select the Add the file(s) to the
Software Repository option. If you are importing Merge Modules on the Merge Modules tab, this option is on
the MSM Source Information panel.

File Selection

S pecify the file to import, IE’E

Select a MS1, MSH, MST, MSP, 05 Snapshot [05C), Marimba [MCP). or Exe file to import.

C:AI0AdminGtudio Shared OLDmsiAccessd7.msi :

Add the file(z] to the Software Repositony

<Back || Mest> |[ Cancel ] [ Help
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When you click Finish on the Import Wizard, the selected package is imported into the Application Catalog, and all
of that package’s associated files and subfolders are copied into the Software Repository location specified for the

Application Catalog. Progress messages are displayed in the Output Window stating that each file is being copied
into the Software Repository.

Adding a Package to the Software Repository Using the ConflictSolver
Process Assistant

When using the ConflictSolver Process Assistant to import a package, to add the package to the Software
Repository, select the Add package to the Software Repository option on the Organize Package page.

In order to select this option, you must be connected to an Application Catalog that has the Software Repository
enabled.

Adding a Package to the Software Repository by Overwriting Original
Package

If a package is not added to the Software Repository when it is imported, the only way to add it to the Software
Repository after that is to reimport it and overwrite the original package (assuming that the Application Catalog is
Software Repository-enabled).

Task: To add a package to the Software Repository by overwriting the original package:

Reimport the package again by following the instructions in Importing a Single Package, but this time:

1. Choose the Add the file to the Software Repository option on the File Selection panel

2. Choose the The package should overwrite the existing package version option on the Target
Package Information panel:

Import Wizard P§|

Target Package Information

Specify the target packages. m’ﬂ

The zelected package appears to be already imported into the Application Catalog. S pecify how
you want to handle the import of this package.

Fackage Handling Options

() The package should be treated as a new version of an existing package:
() The package should be treated as a new package named:

(%) The package should ovenwite the existing package version:

Package Mame:

=) Q-Groups
Crystal Enterprise B

< Back ” Mext > ][ Cancel ][ Help ]
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E

Note * For more information on managing multiple versions of a package in the Software Repository, see Using
Version Management Features.

Software Repository Auto Import Method

Use the following command line options to perform a bulk import of Windows Installer packages into the Software
Repository:
[General]

ImportIntoTheSoftwareRepository=Y
SuppressDuplicatePackageImport=N

Identifying Software Repository Packages in Application
Manager

In Application Manager, packages that are managed within the Software Repository have a different icon than
those that are not:

Table 6-9  Application Manager Product View Icons Identifying Software Repository

Icon Description

ﬂfl‘l Package is not managed within the Software Repository.

ﬂ Package is managed within the Software Repository.

ﬁ Package is managed within the Software Repository and is checked out.
& Merge Module is managed within the Software Repository.

E

Note - Similar overlays are displayed on App-V package icons that are listed under the Application node.

E

Note ° These icons are not displayed in when viewing these packages in ConflictSolver.
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Also, when a Software Repository package is selected in the Application Manager Product View, the statement
Managed within the Software Repository is listed for the File and Original File fields. Below is an example of a
Software Repository package in the Application Manager Product View:

Catalog  Edit  “iew Conflicts  Reports  Tool
> (ZR 8 & 85 LI EE
Products X
=14 Application Catalag

B3 Groups

-5 Engineering
- m-{E7 InstallShield MSIDiff
+ (87 LichodInj

7] bathPlot

C System Test Tracker
E]j Marketing

Elﬂ Adobe Reader 8

Adobe Reader §

Software Repositary Icon

ﬂproducts i Merge Modules ﬁPatches

5 Help

2 e

w. Application Manager - AUGLSTAMSOLEXPRESS (AdminStudio Sample Catalog) - sa

_JE[ Adobe Reader

i'ﬁ" Prog,

Manufacturer
Subscribed
Conflick Results
Package Code
Product Code

Upgrade Code
Language:
File:

Imported On
Criginal File
Transfarms
Patches
Applications
Assaciations

Description

Adobe Systems Incorparated

Mot associated with any subscribed database,

There is no conflict infarmation persisted for this product.
{BFF4D496-557 1-451C-8AA0-FEF 102B00A04}
{ACTEBASE-7ADT-1033-7B44-A50000000002
{ABEADESG-0000-0000-454E-7EGA45000000}+

English {United States)

|Managed within the Software Repositary |

Saturday, February 12, 2011 - 11:09

|Managed within the Software Repositary |

Click here ko view the 1 transformis) associabed with this product,
Mo patches are associated with this product,
Cnly the current Application references this product.

Click here ko view the 1 virtual packages associated with this product,

m

Corkact: Your local adrministrabor

I

Figure 6-5: MS| Package Managed Within the Software Repository

Using Version Management Features

For those packages which are part of the Software Repository, you can store multiple versions of a package.
Instead of reimporting a package that has changed, you can check out a package and then check it back in either
as a New Package Version or you can Overwrite Existing Version.

The Software Repository version management features are described in the following topics:

® Checking-Out and Checking-In Packages

® (Cancel Check Out

e Getting a Copy of the Latest Version of a Package
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Checking-Out and Checking-In Packages

For those packages which are part of the Software Repository, you can store multiple versions of a package.
Instead of reimporting a package that has changed, you can check out a package and then check it back in either
as a New Package Version or you can Overwrite Existing Version.

& ﬁm Impork ]

Check In As
Cancel Check Out
(aet Latest Yersion

Find... Ctrl+F
Cut Chrl
Copy k-

Edit with Installshield Editar ...
Distribute Package. ..
Perform Pre-Deployment Testing. ..

Renarne Fz
Delete 3
Reparts 3

When you check out a package, AdminStudio makes a local copy of the package files into the following directory:
C:\Documents and Settings\UserName\My Documents\AdminStudio\PackageName_PackageVersion

When a package is checked out, an icon is displayed on the Application Manager Product View to indicate that the
package is checked out. If the current user is not the user who checked out the package, then the path portion of
the property is not displayed.

@ Checked  adminuser
Ok Monday, August 22, 2005 - 1925
C:\Documents and Settings) Johnsmith My Documents | adminStudiofathPlok

When you check in a package, it will be imported into the Application Catalog and either the new package will be
added as a new version of an existing package or the old package will be overwritten.

Cancel Check Out

250

If you checked out a package and then decide that you do not want to modify it, you can choose to cancel the
check out by selecting the package, and then selecting Cancel Check Out from the context menu.

Unless a user is assigned to a Role with advanced Software Repository permissions, only the user who checked
out the package will have the Cancel Check Out enabled. After the user confirms the operation, the local
package files are deleted.
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Getting a Copy of the Latest Version of a Package

If you want to get a copy of a package that is in the Software Repository, but you do not want to check it out, you
can get a copy of that package by selecting the package, and then selecting Get Latest Version from the context
menu. The package and all of its associated files will then be copied to the user’s profile directory:

C:\Documents and Settings\UserName\My Documents\AdminStudio\PackageName
For example:

C:\Documents and Settings\JohnSmith\My Documents\AdminStudio\Adobe Reader

E

Note ° The location where Software Repository files are copied to when you select Get Latest Version cannot be
changed. The files are always copied to a subdirectory of the current user’s My Documents directory.

Software Repository Integration into Other AdminStudio

Tools

The Software Repository feature is integrated into several other AdminStudio tools:

InstallShield Editor
e ConflictSolver

® PackageExpert

e Distribution Wizard

® Predeployment Test Preparation Wizard

InstallShield Editor
The Software Repository feature is integrated with InstallShield Editor in the following ways:
® You can launch InstallShield Editor from the Application Manager.

e From InstallShield Editor, you can browse for packages that are stored in the Software Repository and select
them for edit. You can either check a file out for edit or simply get the latest version of the file to edit. You can
also undo a check out from InstallShield Editor.

e From the InstallShield Editor, you can add a package to the Software Repository.
e You can add a package to the Software Repository via the InstallShield Editor build process.

For more information on InstallShield Editor’s integration with AdminStudio, see InstallShield Editor Integration with
Application Manager and the Software Repository.
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ConflictSolver

If you are performing conflict analysis on packages that are a part of the Software Repository, the resolution
process will only operate against Checked Out packages by the current user. If a package is not checked out, you
will be unable to automatically resolve any conflicts that are found or to modify the package in any way.

PackageExpert

If you are testing packages that are a part of the Software Repository, the resolution process will only operate
against Checked Out packages by the current user. If a package is not checked out, you will be unable to
automatically resolve any errors that are found or to modify the package in any way.

Distribution Wizard

You can launch the Distribution Wizard from Application Manager by selecting the package and then selecting
Distribute Package from the context menu. When you do this, the package name in the Windows Installer
Package (.msi) field of the Installation Package Information panel is already entered. The ability to edit this
entry depends upon whether the package you are distributing is managed by the Software Repository:

e Not in the Software Repository—The full name and path of the Windows Installer file is displayed, and you
can edit this entry or click Browse and select a different package.

e In the Software Repository—Only the name of the Windows Installer file is displayed (not the full path) and
this entry cannot be edited or changed.

Predeployment Test Preparation Wizard

You can launch the Predeployment Test Preparation Wizard from Application Manager by selecting the package
and then selecting Perform Predeployment Testing from the context menu. When you do this, the name in the
Source .MSI Package field of the Windows Installer File Selection panel is already entered. The ability to edit
this entry depends upon whether the package you are distributing is managed by the Software Repository:

® Not in the Software Repository—The full name and path of the Windows Installer file is displayed, and you
can edit this entry or click Browse and select a different package.

e In the Software Repository—Only the name of the Windows Installer file is displayed (not the full path) and
this entry cannot be edited or changed.

The Target .MSI Package field on the same panel is automatically populated with the name of the package
specified in the Source .MSI Package field with _analysis appended to the end of the name. You can edit the
name of this file, if desired. If the package is not in the Software Repository, the full name and path of the Target
.MSI Package is displayed, but if the package is in the Software Repository, only the name of the Target .MSI
Package is displayed (not the full path).
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Sharing Application Catalog Data

The section describes the three methods for sharing Application Catalog data in your enterprise: merge, auto-

import, and replication.

Table 6-10 « Sharing Application Catalog Data Help Topics

Section

Merging Application
Catalogs Using the
Merge Wizard

Automatically
Importing Packages

Replicating
Application Catalogs

Using Microsoft SQL
Server to Perform

Merge Replication of
Application Catalogs

Description

You can use the Merge Wizard to merge data from a source Application Catalog
into the currently open Application Catalog.

You can use the Package Auto Import feature to link to MSI packages in a Remote
Application Catalog, import the data into your local Application Catalog, and
maintain consistency between the packages.

Using Application Catalog Replication simplifies software management by allowing
you to selectively distribute subsets of data from a master Application Catalog to
multiple IT groups at your organization.

AdminStudio supports merge replication of Application Catalog databases using
Microsoft SQL Server 2005. You can use merge replication to synchronize
Application Catalog databases distributed in multiple locations across a large
enterprise, ensuring that all databases are kept up-to-date.

AdminStudio provides three options for sharing Application Catalog Data:

e Merging Application Catalog Information—Use the Merge Wizard to merge the source Application
Catalog’s data into the currently open Application Catalog. The merged data is not linked in any way to the
source Application Catalog.

e Automatically Importing Packages—The Package Auto Import Wizard offers two methods of
automatically importing Windows Installer packages into your Application Catalog:

e Linking to Packages in a Remote Application Catalog—Using the Remote Application Catalog
option of the Package Auto Import Wizard, you can monitor Windows Installer packages in a Remote
Application Catalog, and automatically import or re-import those packages at scheduled intervals.
Application Manager can link to one or multiple Application Catalogs, and can link to one or multiple
packages within those Application Catalogs.

e Automatically Importing Packages from a Network Directory—Using the Network Directory option
of the Package Auto Import Wizard, you can automatically import or re-import all Windows Installer
packages in a specific folder into your Application Catalog at scheduled intervals.

e Replicating Application Catalogs—Use Application Catalog Replication’s Publication and Subscription
Wizards to distribute an Application Catalog database where it is needed across a large enterprise or multi-
national corporation. Data is replicated between a Publisher Database Server and a Subscriber Database
Server, which do not need to be available on the same network.
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Comparison Chart

The following chart compares the three methods of sharing Application Catalog data:

Table 6-11 ¢ Sharing Application Catalog Data Comparison Chart

Topic

AdminStudio
Edition

Configuration

How It Works

254

Merging (Merge Wizard)

Professional Edition

Connection between two
Application Catalog databases
on the same network/domain.

The source Application
Catalog’s data is merged into the
currently open Application
Catalog. This is a one-time-only
database merge. The merged
data is not linked in any way to
the source Application Catalog.

Auto Import
Package Auto Import)

Professional Edition

Connection between two
Application Catalogs Databases
on the same network/domain or
between an Application Catalog
and a directory on the same
network/domain.

With the Remote Application
Catalog option, you link to
individual packages in a remote
Application Catalog, and these
packages are imported into your
local Application Catalog. When
the remote packages are
modified, the packages in your
local Application Catalog are
automatically re-imported.

When using the Network
Directory option, if a modified
version of a previously imported
package is placed in the
monitored Network Directory, the
package is automatically re-
imported.

ADS-1000-UG00

Replicating
(Subscription and
Publication)

Enterprise Edition

Connection between: Publisher
and Publisher Database Server,
Publisher Database Server and
Subscriber Database Server, and
Subscriber and Subscriber
Database Server

An Application Catalog database
is distributed across a large
enterprise. Data is replicated
between the Publisher Database
Server and Subscriber Database
Server, which do not need to be
available on the same network.
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Table 6-11 « Sharing Application Catalog Data Comparison Chart (cont.)

Topic

Customers
Who Would
Use This

AdminStudio 10.0 User Guide

Merging (Merge Wizard)

Merging could be used in an
organization where multiple
people test packages. After the
packages have been tested, all
of the “tested” applications could
be consolidated into one
centralized Application Catalog.

ADS-1000-UG00

Auto Import
Package Auto Import)

Package Auto Import could be
used to maintain consistency
between applications in various
Application Catalogs in
organizations where they are
satisfied with domain security
and have both source and target
Application Catalog databases
(or source directory and target
Application Catalog database)
on an accessible domain.

Sharing Application Catalog Data

Replicating
(Subscription and
Publication)

Replication could be used at
large enterprises that want to
maintain a central Application
Catalog, with smaller Application
Catalogs at individual offices
(such as New York, London,
etc.).

This method moves the data
closer to the user (which
improves performance), and
allows the user to subscribe to
only the data that they need
(which makes it easier to work
with).
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Table 6-11 ¢ Sharing Application Catalog Data Comparison Chart (cont.)

Auto Import
Topic Merging (Merge Wizard) Package Auto Import)

Advantages Very simple. Can select the packages you

i in wi link to.
Data is merged in with the data want to link to

in the local Application Catalog. Linked applications can be
updated to match the source.

Automatically imported data
coexists with data in local
Application Catalog.

Replicating
(Subscription and
Publication)

Replication provides optimal
security. Publisher Database
Server and Subscriber Database
Server do not need to be
available on the same network.
Operates within the SQL Server
Security Model, making it a very
secure way to replicate data—
because the subscriber need not
have access to the remote
database.

AdminStudio encapsulates
functionality from SQL Server to
support “Snapshot” type
replication. Using AdminStudio
to perform Snapshot replication
is easier than trying to perform it
using SQL Server Enterprise
Manager.

Can select individual packages
in a Publication to subscribe to.

Replication is very efficient. It
operates within the SQL Server
Job Refresh Model, which
means that the replication/
subscription process is run
automatically.

Automatically imported data
coexists with data in the local
Application Catalog.
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e 6-11 * Sharing Application Catalog Data Comparison Chart (cont.)
Replicating
Auto Import (Subscription and
Merging (Merge Wizard) Package Auto Import) Publication)
Local user needs a physical When using the Remote You can subscribe to multiple
connection to the database and Application Catalog option, the subscriptions, but only one
has to have permissions on that local user needs a physical subscription can be active at any
remote database. This could connection to the database and one time.
allow the user performing the has to have permissions on that
merge to modify the source remote database. This could
database. This could cause a allow the user performing the
Security issue. link to modify the source

database. This could cause a

This is a one time merge with no o
Security issue.

link to the source data and no
updating.

Merging Application Catalogs Using the Merge Wizard

In some circumstances, you may need to merge data from two Application Catalogs. The reasons for this can vary,
but usually involve increasing the number of packages available for conflict identification or the necessity of having
the same data available in multiple geographic locations. You can merge data from two different Application
Catalogs using the Merge Wizard.

E

Note ° You can use the Merge Wizard to merge Windows Installer packages (.msi), legacy applications (.exe), and

Microsoft App-V applications (.sft). However, the Merge Wizard does not support merging Citrix XenApp profiles or

VMware ThinApp applications.

Task: To merge data from two Application Catalogs:

1.

2.

AdminStudio 10.0 U

Open Application Manager and connect to the Application Catalog that is to contain the combined data.
On the Catalog menu, click Merge to open the Merge Wizard. The Welcome panel opens.

Click Next. The Source Application Catalog panel opens.

Select the Application Catalog that contains the data that you want to merge.

If the Application Catalog that you select requires additional authentication, the Select Application Catalog
dialog box opens. Connect to that catalog as described in Connecting to an Existing Application Catalog.

Click Next to advance to the Groups panel.

Select the Windows Installer packages, legacy applications, and App-V applications that you want to merge.
Selecting a Group icon selects all of the applications in that group. You can also select to Replace duplicate
application data.
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7. Click Next. The Progress panel opens, where you can view the merge progress.

8. Click Finish to exit the Wizard.

E

Note ° For a comparison of the three methods for sharing Application Catalog Data in AdminStudio, see Sharing
Application Catalog Data.

Automatically Importing Packages

258

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other

users, the Package Auto Import options will be disabled.

For a large distributed enterprise, accurate and synchronized data is required for shared Windows Installer and
Microsoft App-V packages. If a corporate level team maintains a database of packages used throughout the
corporation in New York, then all the regional offices should be able to link to the corporate level packages and get
the different pieces of data.

Package Auto Import offers two methods of automatically importing Windows Installer and Microsoft App-V
packages into your Application Catalog and keeping them updated:

Table 6-12 « Package Auto Import Methods

Method Description

Automatically Importing Using the Remote Application Catalog option of the Package Auto Import
Packages in a Remote Wizard, you can monitor Windows Installer and App-V packages in a Remote
Application Catalog Application Catalog, and automatically import or re-import those packages at
scheduled intervals. Application Manager can link to one or multiple Application
Catalogs, and can link to one or multiple packages within those Application
Catalogs.

Automatically Importing Using the Network Directory option of the Package Auto Import Wizard, you

Packages from a can automatically import or re-import all Windows Installer and App-V packages
Network Directory in a specific Network Directory into your Application Catalog at scheduled
intervals.

AN

Caution » When automatically importing or re-importing packages from a Remote Application Catalog or a Network
Directory using Package Auto Import, validation will not be performed even if the Check for Validation Errors option
on the Import tab of the ConflictSolver or Application Manager Options dialog box is selected. If validation was
performed during automatic import and if a package failed validation, it would not be imported into the Application
Catalog, which would disrupt the automatic import process. Instead, you can perform validation after the package
has been imported. See Validating After Import.
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Tip » When you link to a Windows Installer or App-V package in a Remote Application Catalog, Application Manager
connects to the Remote Application Catalog and imports that package into the local Application Catalog. In order for
Package Auto Import to work properly, both the Remote Application Catalog and the Remote package file must be
accessible to the linked users at all times. In other words, both the Remote Application Catalog and all of the
package files that have been imported into it must be able to be accessed by linked users via a shared network
drive.

E

Note - You can use the Package Auto Import Wizard to automatically import Windows Installer packages (.msi) and

Microsoft App-V applications (.sft). However, the Package Auto Import Wizard does not support the automatic import
of Citrix XenApp profiles or VMware ThinApp applications.

E

Note * For a comparison of the different methods for sharing Application Catalog Data in AdminStudio, see Sharing
Application Catalog Data.

Automatically Importing Packages in a Remote Application Catalog

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

Using the Remote Application Catalog option of Package Auto Import, you can monitor Windows Installer and
App-V packages in a Remote Application Catalog, and automatically import or re-import those packages at
scheduled intervals.

The following topics are included in this section:
e Linking to a Remote Application Catalog
e Editing a Link to a Remote Application Catalog

e Manually Updating a Linked Package

Deleting a Link to a Remote Application Catalog

Viewing Remote Package Links on the Application Manager Product View

Linking to a Remote Application Catalog

Using the Remote Application Catalog option of Package Auto Import, you can monitor Windows Installer
and App-V packages in a Remote Application Catalog, and automatically import or re-import those packages at
scheduled intervals. Follow these procedures to configure a link to a Remote Application Catalog.
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Task:

260

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

To link to a Remote Application Catalog:

1.

2.

10.

11.

12.

13.

14.

15.

Open Application Manager.
On the Catalog menu, select Package Auto Import. The Package Auto Import dialog box opens.
Click Add. The Package Auto Import Wizard Welcome panel opens.

Click Next. The Package Auto Import Type Selection panel opens, prompting you to specify whether you
want to monitor packages in a Remote Application Catalog or monitor a Network Directory.

Select Remote Application Catalog and click Next. The Remote Link Application Catalog panel opens
and lists Application Catalogs that you have recently accessed.

From the Catalogs list, select the Application Catalog you want to link to or click Browse to open the Select
Application Catalog dialog box.

Connect to the selected catalog as described in Connecting to an Existing Application Catalog.

Click Next. The Groups panel opens, listing all of the applications in the selected Application Catalog.
Select the Windows Installer and App-V packages within the Application Catalog that you want to link to.
Click Next. The Schedule panel opens.

To enable automatic import of the linked packages at scheduled intervals, select the Schedule AdminStudio
to update the changed packages option. The scheduling fields are enabled.

From the Run the process list, select Daily or Weekly.

Select the time of day that you want the automatic import to occur by selecting the hour, minutes, seconds, or
AM/PM setting and then clicking the up and down arrows to adjust the setting.

From the Starting on list, click on the arrow to open the Calendar and then select the first day that you want
automatic importing to begin.

Click Next. The Summary panel opens.

Review the summary of the options that were selected in the previous panels of the Wizard and click Finish.
You are returned to the Package Auto Import dialog box and the new Remote Application Catalog link is
now listed.

E

Note * Note that on the Package Auto Import dialog box, the Start button is disabled when this new
Remote Application Catalog link is selected. This button is disabled until the linked packages have been
imported into the local Application Catalog for the first time. The first automatic import of linked packages in a

Remote Application Catalog is initiated when you click the Close button to exit the Package Auto Import dialog
box.

ADS-1000-UG00 AdminStudio 10.0 User Guide



Chapter 6: Managing Application Catalog Databases
Sharing Application Catalog Data

16. Click Close to close the Package Auto Import dialog box.

Initial and Subsequent Automatic Imports

Import is initiated automatically when you set up the Remote Application Catalog connection, and then subsequent
imports occur automatically at the scheduled date and time.

Initial Automatic Import

When you initially set up a connection to a Remote Application Catalog, automatic import is initiated when you
click Close to exit the Package Auto Import dialog box. Import results are displayed in the Output window. The
packages are imported into the Package Auto Import Group of the Application Catalog.

Subsequent Automatic Imports

After a package has been imported into the Application Catalog, an update check will be performed:

e Atthe scheduled interval (if the Schedule AdminStudio to update the changed packages option is
selected), and

® Whenever you click Start on the Package Auto Import dialog box.

Preferred Authentication Modes

AdminStudio has preferred authentication modes when connecting to SQL Server Application Catalogs.

When you open AdminStudio, by default AdminStudio will attempt to connect to your SQL Server Application
Catalog using NT authentication mode. If that fails, AdminStudio will display a login dialog box with the Server,
Login ID, and Database fields pre-populated with your last selection.

If you use SQL Server Authentication Mode to login to your SQL Server Application Catalog, AdminStudio will not
save SQL login information. Therefore, each time you want to refresh the data from this Application Catalog, you
will have to supply AdminStudio with the login information. Therefore, it is recommended that you use NT
authentication mode to login to SQL Server Application Catalogs.

Editing a Link to a Remote Application Catalog

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

On the Groups tab of the Package Auto Import Properties (Remote Application Catalog) Dialog Box, you can link or
unlink to different packages within an Application Catalog, and on the Options tab, you can modify update options
and adjust the scheduled update interval.
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W

Task: To edit a Remote Application Catalog link:

1.

2.

10.

On the Catalog menu, select Package Auto Import. The Package Auto Import dialog box opens.
Select the Remote Application Catalog link that you would like to edit and click Properties.

The Groups tab of the Package Auto Import Properties (Remote Application Catalog) dialog box
opens, displaying all of the groups, applications, and deployment type packages in the selected Remote
Application Catalog that you can link to. Any package that you have already linked to is already selected.

Select or deselect check boxes to link or unlink to packages within this Remote Application Catalog.

If you want to specify options that directly affect the way the linked packages will be updated, select the
Options tab.

On the Options tab, select one or more of the following Refresh Options:

e Update package when its source is modified

e Delete package when the source package is deleted

See Manually Updating a Linked Package for a detailed explanation of these two options.

To enable automatic import of the linked packages at scheduled intervals, select the Schedule option. The
scheduling fields are enabled.

If you want to disable automatic importing of this package if it is modified in its Remote Application Catalog,
leave the Schedule option unselected. With this option unselected, the only way that this package can be
updated is to select the Application Catalog link on the Package Auto Import dialog box and then click
Start to force an update.

From the Run the process list, select Daily or Weekly.

Select the time of day that you want the automatic import to occur by selecting the hour, minutes, seconds, or
AM/PM setting and then clicking the up and down arrows to adjust the setting.

From the Starting on list, click on the arrow to open the Calendar and then select the first day that you want
automatic importing to begin.

Click OK to close the Package Auto Import Properties dialog box and then click Close to close the
Package Auto Import dialog box.

Manually Updating a Linked Package

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other

users, the Package Auto Import options will be disabled.

262
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If you select the Remote Application Catalog link on the Package Auto Import dialog box and then click the Start
button, the linked packages in the local Application Catalog are updated with the same packages in the remote
Application Catalog. When you click on Start, how the packages are refreshed depends upon which options you
have selected on the Package Auto Import Properties (Remote Application Catalog) Dialog Box:

Table 6-13 * Import Options

Option

Description

Update package when its
source is modified

Delete package when the
source package is
deleted

If you have selected this option:

Application Manager will go and check if any of the linked packages have been
modified in the Application Catalog.

e [f the linked package has been modified, then the local Application
Catalog database is updated to reflect the changes.

e [f the linked package has not been modified, you receive a message
stating that “No refresh is necessary”.

If you have not selected this option:

Application Manager will still check to see if any of the linked packages have
been modified:

e [f the linked package has been modified, Application Manager will
inform you that the source package has been modified but that it will not
update the local Application Catalog database because this option is not
selected.

e If the linked package has not been modified, you receive a message
stating that “No refresh is necessary”.

If you have selected this option, Application Manager will delete any linked
data in the local database if the data is deleted from the remote database.

If you have not selected this option, even if the source package is deleted in
the remote database, your copy of the package will not be deleted.

As the linked packages are being re-imported, output messages will be displayed in the Package Auto Import tab
of the Application Manager Output window.

Deleting a Link to a Remote Application Catalog

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.
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%

Task:

To delete a link to a Remote Application Catalog:

1. On the Catalog menu, select Package Auto Import. The Package Auto Import dialog box appears.

2. Select the Remote Application Catalog link that you would like to delete and click Remove.

Viewing Remote Package Links on the Application Manager Product View

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

The Application Manager Product View shows all the groups and packages present in an Application Catalog. The
groups and packages that have been linked to using the Remote Application Catalog method of the Package Auto
Import Wizard are displayed using a special icon:

#
4

If a linked product in the local Application Catalog has been updated in the Remote Application Catalog and needs
to be re-imported, an exclamation point is displayed on the icon:

#
N

LA

Automatically Importing Packages from a Network Directory

264

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

Using the Network Directory option of Package Auto Import, you can monitor a directory location on the network
(or a local directory) and automatically import or re-import packages in that directory at scheduled intervals.

The following topics are included in this section:

® Linking to a Network Directory

e Editing a Link to a Network Directory

e Forcing an Import of Packages in a Network Directory
e Deleting a Link to a Network Directory
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Linking to a Network Directory

Using the Network Directory option of Package Auto Import, you can monitor a directory location on the
network (or a local directory) and automatically import or re-import packages in that directory at scheduled
intervals. Follow these procedures to configure a link to a network directory.

Task: To link to a network directory:

1.

2.

10.

11.

On the Catalog menu, select Package Auto Import. The Package Auto Import dialog box opens.
Click Add. The Package Auto Import Wizard Welcome panel opens.

Click Next. The Package Auto Import Type Selection panel opens, prompting you to specify whether you
want to monitor packages in a Remote Application Catalog or monitor a Network Directory.

Select Network Directory and click Next. The Folder panel opens.

Use the Browse button to select the network directory Folder that you want to monitor.

E

Note * While you are permitted to enter a local directory (rather than a network directory) as the monitored

directory, this might cause problems if a person monitoring this directory has the same directory on his local
machine. For example, if a directory named C: \MyAppCatalogs is chosen to be the monitored directory, and a
person who choose to monitor this directory also has a directory on his local machine named
C:\MyAppCatalogs, Application Manager would monitor that person's local directory rather than the directory
that was chosen to be the monitored directory.

To also monitor the selected directory’s sub-directories, select the Also include sub-directories option.

If you select this option, when packages in subdirectories are imported into your Application Catalog, they will
be placed in groups that maintain the directory hierarchy. For example, if you are monitoring a directory
named Marketing, and that directory has a subdirectory named Graphics that contains packages, when
those packages are imported into your Application Catalog, they will be placed in the Graphics subgroup of
the destination group.

Click Next. The Destination Group panel opens, prompting you to select the Application Catalog group into
which the packages will be imported.

Select a destination group and click Next. The Schedule panel opens.

To enable automatic import of the linked packages at scheduled intervals, select the Schedule AdminStudio
to update the changed packages option. The scheduling fields are enabled.

If you do not select this option, packages will only be imported when you select this entry on the Package Auto
Import dialog box and then click Start.

From the Run the process list, select Daily or Weekly.

Select the time of day that you want the automatic import to occur by selecting the hour, minutes, seconds, or
AM/PM setting and then clicking the up and down arrows to adjust the setting.
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12. From the Starting on list, click on the arrow to open the Calendar and then select the first day that you want
automatic importing to begin.

13. Click Next. The Summary panel opens.

14. Review the summary of the options that were selected in the previous panels of the Wizard and click Finish.
You are returned to the Package Auto Import dialog box and the new Network Directory link is now listed
as a monitored activity.

15. To force an import of the packages in the monitored Network Directory, select the Network Directory entry
and click Start. Import results will be displayed in the Output window. The packages will be imported into the
specified Group in the Application Catalog:

E

Note ° If you do not choose to perform a forced import, packages in the monitored Network Directory will be
imported at the next scheduled interval.

E

Note - To modify Network Directory link settings, select the link on the Package Auto Import Dialog Box and click
Properties. See Editing a Link to a Remote Application Catalog.

Editing a Link to a Network Directory

Task:

266

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

On the Groups tab of the Package Auto Import Properties (Network Directory) dialog box, you can choose
to monitor subdirectories and can adjust the scheduled update interval.

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

To edit a link to a Network Directory:
1. On the Catalog menu, select Package Auto Import. The Package Auto Import dialog box opens.

2. Select the Network Directory link that you would like to edit and click Properties. The Package Auto
Import Properties (Network Directory) dialog box opens.

3. To choose to monitor the selected folder’s subfolders, select the Also include sub-directories option.

ADS-1000-UG00 AdminStudio 10.0 User Guide



Chapter 6: Managing Application Catalog Databases
Sharing Application Catalog Data

If you select this option, when packages in subdirectories are imported into your Application Catalog, they will
be placed in groups that maintain the directory hierarchy. For example, if you are monitoring a directory
named Marketing, and that directory has a subdirectory named Graphics that contains packages, when those
packages are imported into your Application Catalog, they will be placed in the Graphics subgroup of the
destination group.

4. Click Next. The Destination Group panel opens, prompting you to select the Application Catalog group into
which the packages will be imported.

5. Select a destination group and click Next. The Schedule panel opens.

6. To enable automatic import of the packages in the Network Directory at scheduled intervals, select the
Schedule option. The scheduling fields are enabled.

If you want to disable automatic importing of packages in the Network Directory, leave the Schedule option
unselected. With this option unselected, the only way that packages in that directory will be imported into the
Application Catalog is to select the Network Directory link on the Package Auto Import dialog box and
then click Start to force an import.

7. From the Run the process list, select Daily or Weekly.

8. Select the time of day that you want the automatic import to occur by selecting the hour, minutes, seconds, or
AM/PM setting and then clicking the up and down arrows to adjust the setting.

9. From the Starting on list, click on the arrow to open the Calendar and then select the first day that you want
automatic importing to begin.

10. Click OK to close the Package Auto Import Properties dialog box and then click Close to close the
Package Auto Import dialog box.

Forcing an Import of Packages in a Network Directory

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

Select a monitored Network Directory on the Package Auto Import dialog box and then click the Start button to
force an import of the packages in that Network Directory. As the packages are being imported (or re-imported if
they have been modified), output messages are displayed in the Package Auto Import tab of the Application
Manager Output Window.

Deleting a Link to a Network Directory

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.
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W

Task:

To delete a link to a remote package:
1. On the Catalog menu, click Package Auto Import. The Package Auto Import dialog box appears.
2. Select the monitored Network Directory that you would like to delete and click Remove.

The packages that have already been imported into your Application Catalog from this Network Directory will
remain, but they will no longer be updated if a modified version of the package is placed in the Network
Directory that they were imported from.

Package Auto Import and Duplicate Package Names

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

During manual importing of packages, if you are attempting to import a package that has been identified as a
duplicate to a package already in the Application Catalog—based upon the identifiers you have selected on the
Duplicate Package tab of the ConflictSolver and Application Manager Options Dialog Box (PackageCode,
ProductCode, Product Language, ProductVersion or List of Transform Files), the Target Package Information Panel
opens, proposing an automatically generated new name for the package and prompting you to accept the new
name or enter one of your choosing.

However, if AdminStudio encounters a duplicate package name during auto import, the package you are importing
will be automatically renamed by pre-pending the Product Name with the Manufacturer’s name and, if necessary,
appending the Product Name with numbers:

e 1st Package: Application 2004
e 2nd Package: ABC Corporation_Application 2004
The import is allowed to proceed without prompting the user.

You can edit the Duplicate Package Naming Syntax on the Duplicate Package tab of the Options dialog box.

Replicating Application Catalogs

268

Edition * Application Catalog replication is available in AdminStudio Enterprise Edition.
AdminStudio Application Catalog Replication makes it possible to distribute an AdminStudio Application Catalog
database where it is needed across a large enterprise or multi-national corporation. One location can publish

software packages to IT teams at other sites, keeping all teams current while enabling each to manage their
software independently.
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The following topics are included in this section:

Table 6-14 « Application Catalog Replication Topics

Topic

About Application Catalog
Replication

Description

The benefits of using Replication, an overview of creating and managing
Publisher and Subscriber Application Catalogs, and how to configure the
AdminStudio Shared Location for Replication.

Publication/Subscription
Lifecycle

Specialized User
Scenarios

Creating and Managing
Publications

Creating and Managing
Subscriptions

E

Diagram illustrating how Application Catalogs are replicated.

Describes how to subscribe to more than one Publication at a time, override
the scheduled update day and time, and replicate Application Catalogs in
controlled SQL database environments.

Describes how to create, edit, publish, and delete a Publication. This section
also explains how to set a Publication schedule and how to edit a Publication
access list.

Describes how to create, enable/disable, manually update, and delete a
Subscription.

Note * Only AdminStudio users who have been assigned sysadmin privileges to the currently connected SQL
database server through the SQL Enterprise Manager can create Publications or set up Subscriptions using that
database. For all other users, the Application Catalog Replication options are disabled.

About Application Catalog Replication

This section lists the benefits of using Replication, provides an overview of creating and managing Publisher and
Subscriber Application Catalogs, and explains how to configure the AdminStudio Shared Location for Replication.

e Benefits of Using Application Catalog Replication

e Creating and Managing Publisher and Subscriber Application Catalogs

e Configuring the AdminStudio Shared Location for Replication

Initial Configuration Checklist

Benefits of Using Application Catalog Replication

The benefits of using Application Catalog replication include the following:

e Simplifies Software Package Management
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e Allows You to Distribute Work Geographically Across the World
® Provides Optimal Security

e Automatically Performs SQL Server Snapshot Replication

Simplifies Software Package Management

Using Application Catalog Replication simplifies software management by allowing you to selectively distribute
subsets of data from a master Application Catalog to multiple IT groups at your organization.

One organization could have hundreds of applications, which would require multiple IT groups using AdminStudio
to perform conflict detection, customization, repackaging, and testing. It would be unwieldy and confusing for all of
those AdminStudio users to connect to the same Application Catalog.

In this situation, it would be very beneficial for one AdminStudio user to maintain a master Application Catalog in a
central location, and then to replicate (distribute) subsets of the data to the other IT groups. By allowing an IT
group to work with just the data that they need, performance and efficiency is improved.

Allows You to Distribute Work Geographically Across the World

For large multi-national enterprises, using Application Catalog Replication allows you to distribute work
geographically across the world. A large enterprise could maintain a central Application Catalog that is updated as
applications are generated and verified by multiple remote IT groups on local Application Catalogs. The verified
applications could then be distributed globally from the master Application Catalog to all the distributed work
groups of the enterprise.

Provides Optimal Security

Because the Publisher Database Server and Subscriber Database Server do not need to be available on the same
network, Application Catalog Replication provides optimal security. Replication operates within the SQL Server
Security Model, making it a very secure way to replicate data—because the Subscriber need not have any access
to the remote database. To configure the Replication feature, the user must be assigned (using SQL Enterprise
Manager) sysadmin privileges to the database server.

Automatically Performs SQL Server Snapshot Replication

AdminStudio Application Catalog Replication uses SQL Server Snapshot replication method. Snapshot replication
operates within the SQL Server Job Refresh model, which means that the replication/refresh process is run
automatically. Using AdminStudio to perform Snapshot replication is much easier than performing it using SQL
Server Enterprise Manager.

E

Note * For more information on Snapshot Replication, see the Snapshot Replication topic on the Microsoft MSDN
Web site.

Creating and Managing Publisher and Subscriber Application Catalogs

When you create an Application Catalog, it is designated as either a Publisher or a Subscriber catalog, and
Application Manager is used to manage those subscriptions and publications.
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e Creating Publisher and Subscriber Application Catalogs

e Managing Publisher and Subscriber Application Catalogs

Creating Publisher and Subscriber Application Catalogs

When creating a new SQL Server Application Catalog, you must choose (by selecting a check box) whether to
define the Application Catalog as a Subscriber.

Application Catalog Wizard g|

Specify Database Information
=3

Specify databasze information for the new application catalog.

Provider:
SGL Server =

D etailz:
Server: ACTIVATIONSOL b
Authentication: | Geapver Authentication ™
Lagin 1D admin25
Password: -
Catalog: REFLICATIO N|

[ ¢ Back “ Mexst > ][ Cancel ][ Help ]

Figure 6-6: Create Database as a Subscriber Option

When this option is not selected, or when an existing database is upgraded, the Application Catalog is defined as a
Publisher. The AdminStudio interface selectively enables/disables the Replication menu items based upon the type
of Application Catalog that is currently opened.

E

Note ° You can review your distributor properties in SQL Server Enterprise Manager on the Replication tab of the
SQL Server Properties dialog box.

Managing Publisher and Subscriber Application Catalogs

In AdminStudio Application Catalog Replication, data is replicated between Publisher and Subscriber databases.
You manage the Publisher and Subscriber databases using the following two dialog boxes:

e Publication Manager dialog box—Use to create and manage publications created on an AdminStudio
Application Catalog database that is configured as a Publisher. See Managing Publications.

e Subscription Manager dialog box—Use to create and manage Subscriptions to Publications on an
AdminStudio Application Catalog configured as a Subscriber. See Managing Subscriptions.

To see a diagram illustrating how data is replicated from the Publisher database to the Subscriber database, see
Publication/Subscription Lifecycle.
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E

Note * The Publication Manager and Subscription Manager options under Replication on the AdminStudio
Catalog menu are only enabled when a user with sysadmin privileges on an SQL Server database server connects
to a database on that server.

® [fthat database was defined as a Publisher when it was created, the Publication Manager option is
enabled.

® [fthat database was defined as a Subscriber when it was created, the Subscription Manager option is
enabled.

See Application Catalog Wizard for information on how to identify databases as Subscribers or Publishers.

AN

Caution « You can create as many Subscriptions or Publications as you want to, but because any previously
replicated data is deleted whenever new Subscription data is received, the Subscriber should have only one
Subscription active at any one time. If you want to have more than one Subscription set up at one time and switch
between them, see Using the “Disable” Feature to Subscribe to More Than One Publication for more information.

Configuring the AdminStudio Shared Location for Replication

When Publishing data using Application Catalog Replication, the Publication Server needs access to two script
files that are installed in the AdminStudio Shared Directory Location. Therefore, the AdminStudio Shared directory
location should refer to a network folder, making it accessible to the Publication Server. See Specifying the Shared
AdminStudio Application Catalog.

Initial Configuration Checklist

Task:

272

Before you can use Application Catalog Replication, you need to perform the following steps to configure the
Subscriber and Distributor databases at your organization. If the Subscriber and Distributor databases are not
configured in this manner, Replication will fail.

E

Note * The Publisher server is often configured as its own Distributor server.

To configure the Subscriber and Distributor servers:

1. Check the SQL Server Agent logins configured on the Subscriber and Distributor databases, and make sure
that the SQL Server Agent on the Subscriber database can login to the Distributor database via the Distributor
SQL Server Agent using the distributor_admin login.

2. Configure a Distributor database for the servers that are publishing data.
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Publication/Subscription Lifecycle

The Application Catalog database replication process is detailed in the diagram and notes below, including
creating and publishing a Publication, and subscribing to that Publication.

¥Rt Publication Schedule
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—® Create Define Update  Publish

Publication

\
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Figure 6-7: Application Catalog Database Replication Process

The following steps are included in the Application Catalog Database Replication Process:

Table 6-15 * Application Catalog Database Replication Process

Step

Publisher Steps

Step 1: Create Publication

Step 2: Define Update
Schedule

Description

The Publisher—an AdminStudio user who wants to make part of his
Application Catalog available for Publication—creates a Publication on
the local Publisher Database Server. The Publisher must have been
assigned sysadmin privileges in SQL Enterprise Manager on the Publisher
Database Server.

The Publisher defines the automatic update schedule for the Publication.
At the specified date and time, the Publisher Database Server will check
the Application Catalog to see if any published data has changed. If
newer data exists, the Publication will be updated.

Step 3: Publish Publication
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The Publisher generates the initial Publication by clicking the Run button
on the Publication Manager dialog box. The Publication is now available
for Subscription.
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Table 6-15 « Application Catalog Database Replication Process (cont.)

Step Description

Subscriber Steps

Step 4: Subscribe to The Subscriber—an AdminStudio user who wants to receive data from
Publication the Publisher’s Application Catalog—creates a Subscription to that

Publication. The Subscriber must have been assigned sysadmin
privileges in SQL Enterprise Manager on the Subscriber Database Server.

Step 5: Define Update The Subscriber defines the automatic update schedule for the
Schedule Subscription. At the specified date and time, the Subscriber Database
Server will check to see if the Subscription on the Publisher Database
Server has been updated. If it has been updated, the Subscription on the
Subscriber Database Server will be updated.

Step 6: Data is Copied to The subscribed Publication is copied to the Subscriber Database Server,
Application Catalog and is listed under the Replication group in the Subscriber’s Application
Catalog (when viewed in the Application Manager Product View).

Terminology Review

The following terminology was used in this diagram and is used throughout the Application Catalog Replication
help topics:

Table 6-16 * Application Catalog Replication Terminology
Term Definition

Publisher Person who creates the Publication.

Local Publisher Database Server A Database Server making data available for replication.

Publication The actual data made available for replication.
Subscriber Person who subscribes to a publication.
Subscriber Database Server A Database Server that receives the replicated data.
Subscription A request to receive a Publication from a Distributor.
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Specialized User Scenarios

The following topics explain how to use the Application Catalog Database Replication feature to best meet your
organization’s needs. The following topics are included:

® Using the “Disable” Feature to Subscribe to More Than One Publication
e Overriding the Scheduled Update Day and Time

® Replicating Application Catalogs in Controlled SQL Database Environments

Using the “Disable” Feature to Subscribe to More Than One Publication

At your organization, it could be beneficial to have more than one Subscription configured in the Subscription
Manager, allowing you to switch from one Subscription to another, even though only one Subscription can be
active and listed in your Application Catalog at any one time: the one that has been executed (updated) the most
recently.

You might want to set up multiple Subscriptions in a situation where an IT group wants to work on a specific group
of applications at a time. For example, an IT group might want to perform conflict analysis on Accounting
applications one week and on Marketing applications the next week. When the IT group finishes work on the
Accounting applications, the “Accounting” Subscription would be disabled and the “Marketing” Subscription
would be enabled. By having multiple Subscriptions configured, local users can quickly switch between tasks.

On the Subscription Manager dialog box, Subscriptions that are enabled are preceded by a check mark (v),
while disabled Subscriptions are preceded by a red X (x).

E

Note - You use the Enable/Disable button on the Subscription Manager dialog box to set the status of each
Subscription to be either Enabled or Disabled. When you disable a Subscription, you are turning off its automatic
update feature. Since Subscriptions are updated automatically, and since all of the currently active Subscription's
data is replaced when a Subscription is updated, if you have multiple Subscriptions, it is to your advantage to
disable all except the one you are currently using. This allows you to work on one set of data and control when that
data is changed. If you have more than one Subscription enabled at a time, when the second enabled Subscription
is automatically updated at its scheduled time, it will replace the data of the Subscription you were currently using.

Overriding the Scheduled Update Day and Time

If you want to manually update either Publication data or Subscription data before its scheduled update time, you
can use the Run button on the Subscription Manager and Publication Manager dialog boxes. Using the Run button
forces the selected Publication or Subscription to refresh itself.

Replicating Application Catalogs in Controlled SQL Database Environments

Some companies that have a controlled SQL database environment prefer to have their database administrators
make major changes to their databases. In this case, you could select the Generate publication as script option on
the Publication Summary Panel of the Publication Wizard or the Generate subscription as script option on the
Subscription Summary Panel of the Subscription Wizard so that the Wizard would generate an SQL script of the
code necessary to create this Publication or Subscription rather than actually create it.
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Task:

When this option is selected, the script is the only output of the Wizard and the new item is not listed on the
Publication Manager or Subscription Manager. The Database Administrator could then run this script to create the
Publication or Subscription.

To create Publications and Subscriptions using SQL Server Enterprise Manager, perform the following steps:

To create publications and subscriptions using SQL Server Enterprise Manager:

1. Use the Publication Wizard or Subscription Wizard to generate an SQL script by selecting the Generate
as script option on the Summary panel.

Copy the script to your server.
Open Query Analyzer.

Select the database you want to work with.

@ w0 b

Open the script file that was generated, and examine the sp_addpublication stored procedure to make sure
that the PreReplication.sql and PostReplication.sql scripts are accessible from the system running
Enterprise Manager. If they are not accessible, copy the scripts to an accessible location, and update the
sp_addpubTlication stored procedure with the revised path names.

6. Execute the script.
7. Return to SQL Server Enterprise Manager.

8. If you created a Publication, open the database that you just generated the publication for and publish it.

Creating and Managing Publications

276

A Publication describes a subset of a database that you want to copy to a specific location to make it available to
Subscribers. When a Publication is published, the data is copied to that accessible location. You create
Publications to meet the needs of your subscribers. The Publication can be a partial Application Catalog—perhaps
containing only 10 out of the 200 applications in your Application Catalog—or it can be an exact replica of your
Application Catalog.

This section describes how to create, edit, publish, and delete a Publication, and also how to set a Publication
schedule and edit a Publication access list. This section covers the following tasks:

e Managing Publications

e (Creating a New Publication

® Publishing a Publication

® Setting a Publication Schedule
e Editing a Publication

e Editing a Publication Access List

e Deleting a Publication
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Managing Publications

You create, publish, edit, and delete Publications using the Publication Manager dialog box.

The Publication Manager, which lists all Publications in the SQL Server database you are currently connected to, is
accessed by pointing at Replication on the Catalog menu and selecting Publication Manager.

E

Note * The Publication Manager option under Replication on the AdminStudio Catalog menu is only enabled
if the current user is connected to an SQL Server database, has been assigned sysadmin privileges in SQL
Enterprise Manager on that database server, and the database was identified when it was created as being intended
for use as a Publisher. See Application Catalog Wizard for information on how to identify databases as Subscribers
or Publishers.

The Publication Manager lists the last time that each of the Publications was updated (published to the Publisher
Database Server) and the next scheduled update time for that Publication. From the Publication Manager, you can
perform the following tasks:

® Create a New Publication—Click the New button to create a new Publication using the Publication
Wizard.

e Edit an Existing Publication—Select a Publication and click Edit to access the Publication Properties
dialog box, where you can edit the selected Publication’s description, update schedule, user access list, and
the packages included in the Publication.

e Publish a Publication—Select a Publication and click Run to manually update the selected Publication. The
Publication data is replicated from your Application Catalog to the Publisher Database Server, making it
available to Subscribers.

e Delete a Publication—Select a Publication and click Delete to delete the Publication data from the Publisher
Database Server, making it no longer available for Subscription. When the list on the Publication Manager is
refreshed, the Publication will no longer be listed.
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Creating a New Publication

Task:

278

To create a Publication, you use the Publication Wizard to select the packages that you want to include in the
Publication, specify the users that you want to be able to access the Publication, and schedule how often you want
the Publication to be automatically updated. When the Publication Wizard is complete, the SQL Server is
configured for this Publication, and the name of the Publication is listed on the Publication Manager dialog box.

To create a new Publication:

1.

On the Catalog menu, point to Replication and select Publication Manager. The Publication Manager
dialog box appears.

E

Note ° The Publication Manager option under Replication on the AdminStudio Catalog menu is only
enabled if the current user is connected to an SQL Server database, has been assigned sysadmin privileges in
SQL Enterprise Manager on that database server, and the database was identified when it was created as being
intended for use as a Publisher. See Application Catalog Wizard for information on how to identify
databases as Subscribers or Publishers.

Click New. The Welcome panel of the Publication Wizard appears.
Click Next. The Publication Details panel appears.

In the Name text box, enter a name to identify this new Publication. This name will be listed on the Publication
Manager dialog box.

AN

Caution * The Publication Name cannot be a T-SQL reserved word.

In the Description text box, enter text to describe the purpose of this new Publication. This description will be
listed on the Publication Manager dialog box.

Click Change next to the Schedule text box. The Task Scheduling dialog box appears.

In the Run the process every list, select how frequently you want this Publication to be automatically
updated on the Publisher Database Server: Day, Week, or Month.

e If you selected Week, select the day of the week that you want to update this Publication.
e If you selected Month, select the day of the month that you want to update this Publication.

From the Starting on list, select the day or date that you want this Publication to begin being automatically
updated on the day or date you selected from the Run the process every list.

For example, if you want the Publication to be automatically updated on the 15th of each month, you would
select the first day of the first month that you want the automatic updates to begin, not the first day that the
Publication should be updated. If it is Monday and you want the Publication to be updated every Friday, to
have the Publication begin being updated on the upcoming Friday, you would select the current day of the
week (Monday), but if you didn’t want the Publication to be updated until the Friday after next, you would
select Saturday.
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9. Click OK to exit the Task Scheduling dialog box.
10. Click Next. The Publication Data Options panel appears.
11. Select the types of data you want to include in the Publication:

e Groups and Package Data—Select this option if you want to select a specific set of packages from the
various Groups in the Application Catalog to include in the Publication. If you select this option, the
Publication Packages panel will appear, prompting you to select which packages you want to include in
the Publication. If you do not select this option, all Groups and all packages within those Groups will be
included in the Publication.

e Merge Module Data—Select this option if you would also like to include all Merge Modules associated
with the packages you have selected in the Publication. If you do not select this option, the Merge Module
data will not be included in the Publication.

12. Click Next. The Publication Access List panel appears.

13. On this panel, specify the list of users allowed to access this Publication. It initially shows a list of users who
have the necessary privileges to access the Publication: those users who have been assigned sysadmin
privileges to this database server through the SQL Enterprise Manager. To remove a user, select it and click
Remove.

AN

Caution * Only users that have been assigned sysadmin privileges in SQL Enterprise Manager to the
connected database server can establish the Publisher-Subscriber relationship between the databases and are
therefore listed on this panel. You can remove a user from this list (so that they will not be able to access this
Publication), but you cannot add additional users to this list using AdminStudio. To add new users, you must
use SQL Enterprise Manager.

14. Click Next. If you selected the Groups and Package Data option, the Publication Packages panel
appears.

15. On the Publication Packages panel, the Groups and Packages in the Publisher Application Catalog
database you are connected to are listed. Select the Groups and packages that you want to include in this
new Publication and click Next.

The Publication Summary panel appears, providing a detailed summary of the options that were selected in
previous panels of the Wizard.

16. If you would like to generate an SQL script of the code necessary to create this Publication rather than actually
create it, select the Generate publication as script option, and enter a path name for the script file.

E

Note ° You might want to use this option if your organization has a controlled SQL database environment that
prefers to have their database administrators make major changes to their databases. See Replicating
Application Catalogs in Controlled SQL Database Environments for more information.

17. To choose to publish this Publication immediately upon completion of the Publication Wizard (instead of
publishing it manually or waiting until its scheduled update), select the Publish the publication
immediately after creation option.
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18. Click Finish to complete the creation of this Publication.

e If you did not select the Generate publication as script option, the new Publication is listed on the
Publication Manager.

e If you selected the Generate publication as script option, you will receive a message that the script
was generated properly. When you close that message, you will see that this Publication is not listed on
the Publication Manager. Request that your Database Administrator run the SQL script that you just
generated in order to create this Publication.

19. Proceed with steps under Publishing a Publication.

Publishing a Publication

When you publish a Publication, you are initiating a manual replication of the Publication data from your
Application Catalog to the Publisher Database Server, making it available for Subscription. After its initial
Publication, the Publication is also automatically “re-published” (updated) according to the schedule specified
when the Publication was created.

Task: To publish a Publication:

1. On the Publication Manager, select the Publication that you want to publish.

E

Note - If you did not select the Generate publication as script option on the Publication Summary panel of

the Publication Wizard, the Publication should be listed on the Publication Manager as soon as the Publication
Wizard finishes. If the Publication you want to publish is not listed here, make sure that the Publication Wizard
was completed and, if the Generate publication as script option was selected, check with your Database
Administrator to see if the script has been run.

2. Click Run.

The Publication data is replicated from your Application Catalog to the Publisher Database Server, making it
available for Subscription.
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Setting a Publication Schedule

When you create a Publication, you specify how frequently you want this Publication to be automatically updated
on the Publisher Database Server. If you would like to change this frequency, you can edit the Publication from the
Publication Manager dialog box.

Task: To set a Publication schedule:

1.

On the Publication Manager, select the Publication that you want to edit and click Edit. The Publication
Properties dialog box appears.

Click the Details tab.
Click Change next to the Schedule text box. The Task Scheduling dialog box appears.

In the Run the process every list, select how frequently you want this Publication to be automatically updated
on the Publisher Database Server: Day, Week, or Month.

e If you selected Week, select the day of the week that you want to update this Publication.
e If you selected Month, select the day of the month that you want to update this Publication.

From the Starting on list, select the day or date that you want this Publication to begin being automatically
updated on the day or date you selected from the Run the process every list.

For example, if you want the Publication to be automatically updated on the 15th of each month, you would
select the first day of the first month that you want the automatic updates to begin, not the first day that the
Publication should be updated. If it is Monday and you want the Publication to be updated every Friday, to
have the Publication begin being updated on the upcoming Friday, you would select the current day of the
week (Monday), but if you didn’t want the Publication to be updated until the Friday after next, you would
select Saturday.

Click OK to exit the Task Scheduling dialog box.

Click OK to exit the Publication Properties dialog box.

Editing a Publication

You can edit an existing Publication from the Publication Manager dialog box.

W

Task: To edit a Publication:

1.

On the Publication Manager, select the Publication that you want to edit and click Edit. The Publication
Properties dialog box appears.

Click the Details tab.

In the Description text box, enter text to describe the purpose of this Publication. This description will be listed
on the Publication Manager and Subscription Manager dialog boxes.
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4. Inthe Schedule field, specify how often you would like this Publication to be automatically updated. Click the
Change button to access the Task Scheduling dialog box, where you can edit how frequently this Publication
will be automatically updated.

5. If the Groups and Package Data option was selected on the Publication Data Options panel when this
Publication was created, you can click the Packages tab and select or unselect packages for inclusion in the
Publication.

6. Click OKto exit the Publication Properties dialog box.

Editing a Publication Access List

When you create a Publication, you specify the list of users allowed to access this Publication. If you would like to
alter this list, you can edit the Publication from the Publication Manager dialog box.

W

Task: To edit a Publication Access List:
1. On the Publication Manager, select the Publication that you want to edit and click Edit.
The Publication Properties dialog box appears.

2. Click the Access List tab. The Access List tab lists users who have the necessary privileges to access the
Publication: those users who have been assigned sysadmin privileges to this database server through the SQL
Enterprise Manager.

3. Select the users allowed to access this Publication. To remove a user, select it and click Remove.

E

Note ° Only users that have been assigned sysadmin privileges in SQL Enterprise Manager to the connected
database server can establish the Publisher-Subscriber relationship between the databases and are therefore
listed on this panel. You can remove a user from this list (so that they will not be able to access this Publication),
but you cannot add additional users to this list using AdminStudio. To add new users, you must use SQL
Enterprise Manager.

4. Click OKto exit the Publication Properties dialog box.

Deleting a Publication

When you no longer want to have a Publication available for Subscription, you can delete it using the Delete button
on the Publication Manager dialog box.

o

Task: To delete a Publication:

1. On the Publication Manager dialog box, select the Publication that you want to delete.

2. Click Delete. A dialog box opens asking you to confirm the deletion.
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3. Click OK.

The Publication data is deleted from the Publisher Database Server, and when the list on the Publication
Manager is refreshed, the Publication will no longer be listed.

Creating and Managing Subscriptions

The topics in this section explain how to create a Subscription, edit its update schedule, enable or disable it, and
update it manually. Please note the following about Subscriptions:

e Subscribed data can co-exist with local data—A Subscriber’s Application Catalog can contain its own
packages and can also contain subscribed Publications containing packages. The subscribed Publication is
listed under the Replication group in the Subscriber’s Application Catalog (when viewed in the Application
Manager Product View).

e Subscribed data is effectively read-only—You should consider a Subscription as read-only data. Each
time Subscription data is updated, it is completely replaced, so all changes that were made on a local copy of
the Subscription data would be lost.

This section covers the following tasks:
e Managing Subscriptions

e Creating a New Subscription

e Enabling/Disabling a Subscription
e Manually Updating a Subscription

e Deleting a Subscription

Managing Subscriptions

You use the Subscription Manager dialog box to view Subscription information, create new Subscriptions,
disable a Subscription so that it is not automatically updated, manually update a Subscription, and delete a
Subscription.

The Subscription Manager, which lists all Publications that are currently subscribed to, is accessed by pointing at
Replication on the Catalog menu and selecting Subscription Manager.

E

Note ° The Subscription Manager option under Replication on the AdminStudio Catalog menu is only
enabled if the current user is connected to an SQL Server database, has been assigned sysadmin privileges in SQL
Enterprise Manager on that database server, and the database was identified when it was created as being intended
for use as a Subscriber. See Application Catalog Wizard for information on how to identify databases as
Subscribers or Publishers.

The Subscription Manager lists the last time that each of the Subscriptions was updated, the next scheduled
update time for that Subscription, and whether the Subscription is enabled (active) or disabled. From the
Subscription Manager, you can perform the following tasks:
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Create a New Subscription—Click the New button to create a new Subscription using the Subscription
Wizard.

Enable or Disable a Subscription—Click the Enable/Disable button to toggle the selected Subscription’s
status between Enabled and Disabled. When you disable a Subscription, you are turning off its automatic
update feature.

E

Note * While you can subscribe to multiple Subscriptions, only one Subscription can be active and listed in

your Application Catalog at any one time: the one that has been executed (updated) the most recently. For
information on how to use the Disable feature to subscribe to more than one Application Catalog, see
Specialized User Scenarios.

Manually Update a Subscription—Click Run to manually update the selected Subscription. The
Subscription Manager will then replace the data of the Application Catalog’s currently active Subscription with
the most recent version of the selected Subscription’s data.

Delete a Subscription—Click Delete to delete the selected Subscription from the Subscription Manager.
When the list on the Subscription Manager is refreshed, the Subscription will no longer be listed.

Creating a New Subscription

To create a Subscription, use the Subscription Wizard to select the Publisher database that you want to subscribe
to, and schedule how often you want the Subscription to be automatically updated. When the Subscription Wizard
is complete, the replicated Publication data is copied into your Application Catalog, and the name of the
Subscription is listed in the Subscription Manager dialog box.

Task:

284

To create a new Subscription:

1.

On the Catalog menu, point to Replication and select Subscription Manager. The Subscription Manager
Dialog Box opens.

E

Note * The Subscription Manager option under Replication on the AdminStudio Catalog menu is only

enabled if the current user is connected to an SQL Server database, has been assigned sysadmin privileges in
SQL Enterprise Manager on that database server, and the database was identified when it was created as being
intended for use as a Subscriber. See Application Catalog Wizard for information on how to identify databases
as Subscribers or Publishers.

Click New. The Welcome Panel of the Subscription Wizard opens.

Click Next. The Subscription Details Panel opens, listing Application Catalogs that you have recently
accessed.
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E

Note - If you are connected to a standalone Application Catalog and you are not logged on to AdminStudio
Enterprise Server, the Login Required Dialog Box opens before the Subscription Details panel opens,
prompting you to log in.

4. From the Catalogs list, select the Publisher Application Catalog you want to subscribe to, or click Browse to
open the Select Application Catalog Dialog Box and connect to an existing Publisher Application Catalog as
described in Connecting to an Existing Application Catalog.

5. To schedule how often the data will be updated, click Change next to the Schedule box. The Task Scheduling
Dialog Box appears.

6. Inthe Run the process every list, select how frequently you want this Subscription to be automatically
updated: Day, Week, or Month.

e If you selected Week, select the day of the week that you want to update this Publication.
e If you selected Month, select the day of the month that you want to update this Publication.

7. From the Starting on list, select the day or date that you want this Publication to begin being automatically
updated on the day or date you selected from the Run the process every list.

For example, if you want the Publication to be automatically updated on the 15th of each month, you would
select the first day of the first month that you want the automatic updates to begin, not the first day that the
Publication should be updated. If it is Monday and you want the Publication to be updated every Friday, to
have the Publication begin being updated on the upcoming Friday, you would select the current day of the
week (Monday), but if you didn’t want the Publication to be updated until the Friday after next, you would
select Saturday.

8. Click OK to exit the Task Scheduling dialog box. You are returned to the Subscription Details panel, and
the schedule you specified is now listed in the Schedule field.

9. Click Next. The Subscription Selection Panel appears, which displays the Publications available from the
selected Publisher database that satisfy the Publication Access List Panel requirements for this user. In other
words, it lists the Publications that you have permission to subscribe to.

10. Select one Publication from this list to subscribe to and click Next. The Subscription Summary Panel appears,
providing a detailed summary of the options that were selected in previous panels of the Wizard.

11. If you would like to generate an SQL script of the code necessary to create this Subscription rather than
actually create it, select the Generate subscription as script option, and enter a path name for the script
file.

E

Note ° You might want to use this option if your organization has a controlled SQL database environment that
prefers to have their database administrators make major changes to their databases. See Replicating
Application Catalogs in Controlled SQL Database Environments for more information.

12. Click Finish to complete the creation of this Subscription.
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Enabling/Disabling a Subscription

Task:
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You can use the Enable/Disable button on the Subscription Manager dialog box to set the status of each
Subscription to be either Enabled or Disabled. When you disable a Subscription, you are turning off its automatic
update feature. Subscriptions that are enabled are preceded by a check mark, while disabled Subscriptions are
preceded by a red X.

E

Note ° For information on how you can use the Disable feature to subscribe to more than one Publication, see

Specialized User Scenarios.

To enable or disable a Subscription:

1.

On the Catalog menu, point to Replication and select Subscription Manager. The Subscription Manager
dialog box appears, listing all of your Subscriptions. Each Subscription’s status (Enabled or Disabled) is
displayed in the Last Run Status column.

E

Note * The Subscription Manager option under Replication on the AdminStudio Catalog menu is only
enabled if the current user is connected to an SQL Server database, has been assigned sysadmin privileges in
SQL Enterprise Manager on that database server, and the database was identified when it was created as being
intended for use as a Subscriber. See Application Catalog Wizard for information on how to identify databases
as Subscribers or Publishers.

To disable an enabled Subscription, select it and click Disable.

The Subscription’s status in the Last Run Status column is changed to Disabled, meaning that the
Subscription will still be listed in the Subscription Manager, but will not be automatically updated.

To enable a disabled Subscription, select it and click Enable.

E

Note - This button toggles between Enable and Disable, depending upon the Status of the selected
Subscription.
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Manually Updating a Subscription

If you want to update a subscribed Publication to match the Publication on the Publisher Database Server and you
do not want to wait until the next scheduled automatic update is performed, you can use the Run button on the
Subscription Manager dialog box to manually update a Publication.

Task: To delete a Subscription:
1. On the Subscription Manager, select the Publication that you want to update.

2. Click Run. The Publication is replicated from the Publisher Database Server, replacing the earlier version.

E

Note * You can only update a subscribed Publication that has already been published at least once. If the
Publication has never been published, the update will fail.

Deleting a Subscription

When you no longer want to subscribe to a Publication, you can Delete it from the Subscription Manager dialog
box.

W

Task: To delete a Subscription:
1. On the Subscription Manager, select the Subscription that you want to delete.
2. Click Delete. A dialog box opens asking you to confirm the deletion.

3. Click OK. The Subscription’s name is deleted from the Subscription Manager List.
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Using Microsoft SQL Server to Perform Merge
Replication of Application Catalogs

Task:

288

AdminStudio supports merge replication of Application Catalog databases using Microsoft SQL Server 2005. You
can use merge replication to synchronize Application Catalog databases distributed in multiple locations across a
large enterprise, ensuring that all databases are kept up-to-date. One location can publish software packages to IT
teams at other sites, keeping all teams current while enabling each to manage their software independently.

To set up merge replication, first you use the AdminStudio interface to create an Application Catalog to serve as a
Publisher database. You then use SQL Server Management Studio to configure this database as a Publisher, by
creating a Publication. Lastly, you use SQL Server Management Studio to create one or more Subscriptions (and
Subscriber databases).

Perform the following steps to implement merge replication of AdminStudio Application Catalogs:
e Step 1: Creating the Publisher Database

e Step 2: Generating the Publication Script for the Publisher Database

e Step 3: Creating the Publication (Running the Script)

e Step 4: Creating a Subscription and a Subscribing Database

e Step 5: Starting the Snapshot Agent

e Step 6: Verifying the Existence and Integrity of the Subscriber Database:

Step 1: Creating the Publisher Database

To create the Publisher database, perform the following steps;

To create the Publisher database:

1. Open AdminStudio and create a new AdminStudio Application Catalog on an SQL Server 2005 database
server, such as the AdminStudio Application Catalog database server).

2. Close AdminStudio, and verify in SQL Server Explorer/Management Studio the existence of the newly created
database.
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Step 2: Generating the Publication Script for the Publisher Database

To generate the Publication script for the Publisher database (Wizard), perform the following steps:

Task: To generate the Publication script for the Publisher database:
1. Locate the Replication node in Management Studio for the given database server.

2. Expand Replication, right-click on Local Publications, and select New Publication Wizard from the
context menu:

= [[3 Replication
B o icator-] _
3 Local Subscripti
# 3 Management MNew Oradle Publication. ..
# [ Motification Service

= Launch Replication Monitor
Jb SQL Server Agent (

Generate Scripts...

Publisher Properties...
Distributer Properties...

Refresh

3. When prompted to select the Publication Database, select the database you created in Step 1: Creating the
Publisher Database.

4. When prompted to select Publication Type, select Merge Replication.

5. When prompted to select Subscriber Types, verify that SQL Server 2005 is the only option selected. (This
document is targeted for SQL 2005 users only.)

6. On the Articles panel, select Tables, Stored Procedures, and Views, and click Next.
7. Continue by clicking Next on the Article Issues panel.
8. Continue by clicking Filter Table Rows on the Article Issues panel.

9. Configure the Snapshot agent as per your requirement. Leave defaults for default scheduling. (this setting can
be changed later.)

10. On the Agent Security panel, click Security Settings, select Run under the SQL Server Agent Service
Account option, and click OK.

11. Click Next on the Wizard.

12. On the Wizard Actions panel, clear the Create the Publication option and select the Generate a script
file option.

13. Click Next.
14. Under Script File Properties, enter a valid path to store the script generated by this Wizard.

15. On the Complete the Wizard panel, enter a name for the Publication that you are creating (such as
ASPublication), and click Finish.
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16. Verify that the operation is reported as successful, as shown below:

Creating Publication o
Click Stop to interupt the operation.
@ 1 Total 0 Emor
Success 1 Success 0 Waming
Details:
Action Status Message
& Generating a script file Success

Step 3: Creating the Publication (Running the Script)

To create the Publication, run the Publication script by performing the following steps:

Task: To create the Publication:
1. Open the script created in Step 2: Generating the Publication Script for the Publisher Database in a text editor.

2. Replace this code:

@identityrangemanagementoption = N'auto', @pub_identity_range = 10000,
@identity_range = 1000, @threshold = 80

with this code:

@identityrangemanagementoption = N'auto', @pub_identity_range = 5000000,

@identity_range = 5000000, @threshold = 80
Save the changes. There should be approximately 281 changes.
Run the script against the Publisher Database (created in Step 1: Creating the Publisher Database)

Verify that the script runs without any errors or warnings.

o g » o

Verify that a new publication is listed under Replication/Local Publications, as shown below. If no
publication is listed, then refresh the Replication node.

= L3 Replication
= 3
F #% [AS]: AS- Publication
% [ Local Subscriptions
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Step 4: Creating a Subscription and a Subscribing Database

To create a subscription and a subscribing database, perform the following steps:

Task: To create a subscription and a subscribing database:

1.

2.

10.

11.

12.

Right-click on Local Subscriptions and select New Subscription Wizard from the context menu.

When prompted to select a Publication, choose the publication we created in Step 3: Creating the
Publication (Running the Script).

Under Merge Agent Location, choose Run all agents at the Distributor . This setting can be the default,
and can be changed by an Administrator to manage the server load.

When prompted to select Subscribers and subscription databases, select the server under Subscriber
on the left side, and select <New database...> under Subscription Database on the right side, as shown
below:

Subscribers and subscription databases:
Subscriber Subscription Database
SCHO2GREWALRXP

<New database...>
<Refresh database list:
AS

When prompted, enter a name for the new database (such as AS-Subs 01) and continue the wizard.

Under Merge Agent Security, provide the settings so that the Merge Agent runs under the default SQL
Server Agent service account.

Under Synchronization Schedule, select Run Continuously under Agent Schedule. An administrator
can modify this and provide a scheduling option instead of continuous.

Verify that Initialize is selected, and that At first Synchronization under Initialize When is selected. Click
Next

Click Next. Under Wizard Actions, select the Create the subscription option and then finish the Wizard.
Verify that there are no errors or warnings in the report.
Close the Wizard.

Refresh the Publication node under Local Publications and expand it. There should be a new
Subscription listed under the AS-Publication publication.

AdminStudio 10.0 User Guide ADS-1000-UG00 291



Chapter 6: Managing Application Catalog Databases
Sharing Application Catalog Data

Step 5: Starting the Snapshot Agent

To start the Snapshot Agent, perform the following steps:

Task: To start the Snapshot Agent:

1. Right-click on AS-Publication and select View Snapshot Agent Status from the context menu.

= L3 Replication
[= [[3 Local Publications
=2 a [AS]: AS- Publication
=] [SCHOR2GREWALF
(3 Local Subscriptions

New Subscriptions. ..
New Publication...

3 Management Launch Replication Monitor
L3 Motification Services Generate Scripts...
= [ 5L Server Agent View Conflicts

= (3@ Jobs vValidate All Subscriptions

Agent history deanL  peinitialize All Subscriptions
Distribution dleanupt  configure Web Synchronization...
Expired subscription
Reinitialize subscripti [ napshot Agent Status
Replication agents ot
Replication monitorin
SCHOZGREWALRXP+  Delste
SCHO2GREWALRXP-
0] Job Activity Monitor Refresh

Properties

The Snapshot Agent opens:

View Snapshot Agent Status - AS- Publication

Agent type: Snapshot Agent
Publication: AS- Publication
Publication database: [As]

Duration: =

Last status message:

|
T— ——
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2. Wait until the Snapshot Agent is done taking the initial snapshot.

vﬁ View Snapshot Agent Status - AS- Publication : = W

Agert type: Snapshot Agent
Publication: AS- Publication
Publication database: [A5]
Duration: 00:06:54
Statys:
@ [100%] A snapshot of 377 aicle(s) was generated.

|

The agert is not running,

l Monitor

3. Right-click on Local Publications and select Launch Replication Monitor from the context menu. Verify in
the monitor that for the AS-Publication publication, there is one Subscriber and it is in Synchronizing state,

as shown below:

- Replication Monitor
=1 My Publishers
--F* SCHO2GREWALRXP

] [AS]: AS- Publication

All Subscriptions l Wamings and Agents ]

| Status | Subsc... | Frient

,_[‘ﬂ Synchronizing  [SCH...

Step 6: Verifying the Existence and Integrity of the Subscriber Database:

To verify the existence and integrity of the Subscriber database, perform the following steps:

Task: To verify the existence and integrity of the Subscriber database:

1. Refresh and expand the Database node in Management Studio.

2. Verify that a new database (created in Step 1: Creating the Publisher Database) is created. Expand the Tables
under this database and verify that a list of AdminStudio tables appears.

3. Launch AdminStudio and try to connect to this catalog.

4. Launch Application Manager and try to import a package in this catalog.

E

Note ° To create more subscribers, repeat Step 4: Creating a Subscription and a Subscribing Database.
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Taking OS Snapshots

The OS Snapshot Wizard provides a simple way to capture your basic operating system configuration. Using the
OS Snapshot Wizard, you can scan your computer’s operating system and record the files, INI files, shortcuts, and
registry entries present. The Wizard then creates an .osc file representing the system contents. You can import this
snapshot file into the an Application Catalog database to identify potential conflicts between Windows Installer-
based setups and your operating system.

To provide maximum flexibility during the OS Snapshot process, you can create an exclusion list (similar to the
Repackager exclusion list) that identifies files, INI files, shortcuts, and registry entries that the OS Snapshot Wizard
should disregard during the scan. Using this list, you can eliminate unnecessary files, shortcuts, or registry entries,
and reduce the time it takes to perform the OS Snapshot.

The following topics are included in this section:
e (OS Snapshot Best Practices
e Configuring OS Snapshot Analysis Options

e (Capturing an OS Snapshot

AN

Caution * OS Snapshots should only be used for comparison in ConflictSolver. You should never attempt to
convert an OS Snapshot into an MSI package.

OS Snapshot Best Practices

294

Before capturing OS Snapshots, consider the following:

Table 6-17 « OS Snapshot Best Practices

Guideline Description
Capture on a Clean For optimal OS Snapshots, you should only capture on a clean system. This
System ensures an accurate baseline of files necessary for the operating system. This also

means that you should never attempt to capture other packages in addition to the
operating system. Use Repackager when you need to capture applications.

Exit Other Shut down all other applications besides OS Snapshot prior to capture. Ideally, this

Applications should be done from the Windows Task Manager. This ensures that files are not
locked during capture, and unnecessary temporary files are not inadvertently
captured.

Only Use OS Never attempt to convert an OS Snapshot file into a Windows Installer package to

Snapshot for Import install an operating system. AdminStudio does not support this use of OS

into Application Snapshots.

Manager
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Table 6-17 « OS Snapshot Best Practices (cont.)

Guideline

OS Snapshots Take
Time

Take Multiple OS
Snapshots

OS Snapshots and
Repackaging Are Not
the Same

Description

Depending on the operating system configuration, OS Snapshot often takes a
significant amount of time to capture the base OS state. Consider that many typical
OS installations exceed 500MB and contain tens of thousands of files, translating
into a lengthy operation of cataloging and converting the files into an OS Snapshot
file.

If your environment contains either multiple operating systems, or variations on the
same operating system, take snapshots of each OS or variation. You can store all of
these in your Application Catalog, allowing you to make comparisons between MSI
packages and each OS.

OS Snapshots, as the name implies, is for snapshots of the operating system only.
Repackaging is only for traditional installation packages. These operations,
although similar, are still very specialized and should only be used for their
respective purposes.

Configuring OS Snapshot Analysis Options

o

Task: To configure analysis options for OS snapshot captures:
1. Launch the OS Snapshot Wizard by clicking on its icon in the AdminStudio Tools Gallery. The Welcome
panel opens.
2. Click Next. The Project Information panel opens.
3. Click Edit. The Analysis Options dialog box opens.
4. Configure the types of data you want to capture (Files, INI files, Shortcuts, and/or Registry data), and specify if
you want to restrict the snapshot to a specific drive.
5. Click OK to return to the Project Information panel.
6. Click Start.
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Capturing an OS Snapshot

You use the OS Snapshot Wizard to capture an OS Snapshots.

W

Task: To perform an OS Snapshot:

1. Launch the OS Snapshot Wizard by clicking on its icon in the AdminStudio Tools Gallery. The Welcome
panel opens.

2. Click Next. The Project Information panel opens.

3. Provide the OS Snapshot project name and OS Snapshot project folder for the OS Snapshot file.

4. Optionally, click Edit to configure analysis options. See Configuring OS Snapshot Analysis Options.
5. Click Start to perform the OS Snapshot.

6. On completion of the OS Snapshot, review the results in the Summary panel.

7. Click Finish.

E

Note « The OS Snapshot is stored as an OSC file in the folder defined in the Project Information panel.

Reference

This section contains information on the all of the dialog boxes and wizards that are used when managing,
connecting to, import data into, or sharing application catalogs.

e Application Manager Views

e Dialog Boxes

e Wizards

® Database Server Permissions

e Application Manager Command-Line Functionality
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Application Manager Interface

The Application Manager user interface consists of three areas: the Navigation window, the Details pane, and the
Output Window. Both the Navigation window and the Output Window are dockable.

Navigation window—The Navigation window consists of three tabs: Products, Merge Modules, and
Patches.

Details pane—When you select different items in these tabs, the Details pane displays corresponding
information about that item.

Output window—The Output Window consists of tabs where output is displayed during different Application
Manager processes.

Application Manager also supports many context menus in addition to the menu bar and toolbar functionality.

This section details the Application Manager interface and includes the following topics:

E

Menus and Toolbar
Product View Icons

Merge Modules View Icons
Context Menus

Output Window

Note * By default, Application Manager displays all conflict detection and resolution options. The display of the
conflict detection and resolution options can be turned off by selecting the Turn off display of conflict
detection and resolution options in Application Manager option on the General tab of the ConflictSolver
and Application Manager Options dialog box. This section of the documentation describes Application Manager
functionality. For information on ConflictSolver functionality, see ConflictSolver Interface.

Menus and Toolbar

The following commands and toolbar buttons are available in Application Manager. Additionally, several
commands can be accessed through Context Menus.

Table 6-18 * Menus & Toolbars

Menu Command Shortcut Button Description

Catalog Connect Ctrl+O Displays the Connect Application Catalog

= dialog box, where you can open an existing

Application Catalog.
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Table 6-18 ¢ Menus & Toolbars (cont.)

Menu Command
Catalog Refresh
Catalog Disconnect
Catalog Properties
Catalog Change AES
Password
Catalog Logout
Catalog Package Auto
Import
Catalog Merge
Catalog Import Package
Catalog Exit
Edit Find

298

Shortcut Button
Ctrl+R
Ctrl+E .

¥
Alt+M

|
Ctrl+1

L
Ctrl+F )

“/'_

Description

Refreshes the current Product and Merge
Module views. This is particularly useful if
multiple people are working on the same
Application Catalog.

Closes the currently open Application Catalog.

Open the Application Catalog Properties dialog
box.

Change the password of the current user to log
in to the AdminStudio Enterprise Server.

Log out of AdminStudio Enterprise Server.

Link/unlink to one or multiple Application
Catalogs. This allows you to copy packages
between various Application Catalogs to
maintain consistency between the copied
packages. You can also choose to manually
refresh the Application Catalog so that it
remains consistent with other linked Application
Catalogs.

Launches the Merge Wizard, which you can use
to select a different Application Catalog and
import its contents into the current Application
Catalog.

Launches the Import Wizard, allowing you to
import Windows Installer packages, transforms,
patches, merge modules, OS snapshots,
Marimba NCP files, and virtual packages
(Microsoft App-V, VMware ThinApp, and Citrix).
You can also select Other Setup Types to import
other non-MSI based setups.

Closes Application Manager.

Use to search for data in various tables in the
Application Catalog.
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Menu Command Shortcut Button Description
View Toolbar Ctrl+0 Toggles the Toolbar.
Status Bar Ctrl+1 Toggles the Status Bar.
Output Window Ctrl+2 Toggles the Output Window.
Application Ctrl+3 Select to switch to Application Manager.
Manager
ConflictSolver Ctrl+4 Select to switch to the ConflictSolver.
Process Ctrl+5 Select to switch to the ConflictSolver (Process
Assistant Assistant).
Conflicts Rules Viewer e Displays the Rules Viewer dialog box, from
= which you can create new ACE rules.
Reports Package Creates the Package Report.
Files Creates the Files Report.
Registry Creates the Registry Report.
Crystal Reports Creates the pre-defined Crystal Reports
Conflicts Conflicts Report.
Crystal Reports Creates the pre-defined Crystal Reports Files
Files Report.
Crystal Reports Creates the pre-defined Crystal Reports
Registry Reqgistry Report.
Tools Customize Alt+0 Opens the Customize dialog box, where you
can customize toolbar settings.
Options Alt+N Opens the ConflictSolver and Application
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Windows Installer packages, report locations,
the default validation file, and duplicate
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299



Chapter 6: Managing Application Catalog Databases

Reference

Table 6-18 ¢ Menus & Toolbars (cont.)

Menu Command Shortcut Button Description
Help Contents Launches the online Help Library and displays
the Contents tab.
Index Launches the online Help Library and displays
the Index tab.
Search Launches the online Help Library and displays
the Search tab.
Support Central Connects to the AdminStudio Support Web site.
Web Community Connects to the AdminStudio Web Community.
ReadMe Displays the AdminStudio ReadMe file.
Feedback Connects to an online form, through which you
can provide feedback about AdminStudio.
Flexera Software Connects to the Flexera Software Web site.
on the Web
About Displays the About dialog box with version
Application information.
Manager
Help Library ) Launches the online Help Library.

Product View Icons

These icons are used on the ConflictSolver and Application Manager Product Views:

Table 6-19 * ConflictSolver and Application Manager Product View Icons

Name Icon Description
Application 3 The Application Catalog that you are connected to. When you select it, the
Catalog Application Catalog View: Application Readiness Dashboard opens and displays
detailed summary information.
Group A group, which is used to organize your data.
fiv-1 A group containing a product with unresolved conflicts. See Resolving Conflicts.

300
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Table 6-19 « ConflictSolver and Application Manager Product View Icons (cont.)

Name

Product

AdminStudio 10.0 User Guide

Ilcon

Description

A product that has been imported into the Application Catalog database. The
product could be an MSiI file, an Other Setup Type package, or a Marimba NCP
File.

A product with unresolved conflicts.

A product that has an unresolved question with its associated files. One or more
files, transforms, or patch files associated with a product is either missing from
the original import directory or its last modified date does not match the last
modified date stored in the Application Catalog. When this icon is selected, a
message appears in the Application Manager Product View identifying the files in
question and prompting you to take action to resolve the problem.

Package is managed within the Software Repository. This icon is only displayed
in Application Manager.

Package is managed within the Software Repository and is checked out. This
icon is only displayed in Application Manager.

A product with unresolved conflicts that also has an unresolved question with its
associated files. One or more files, transforms, or patch files associated with a
product is either missing from the original import directory or its last modified
date does not match the last modified date stored in the Application Catalog.
When this icon is selected, a message appears in the Product View describing
the missing files and prompting you to locate the missing files. When this icon is
selected, a message appears in the Product View identifying the files in question
and prompting you to take action to resolve the problem. Also, see Resolving
Conflicts.

A product linked to a Remote Application Catalog. See Automatically Importing
Packages.

A linked product in a local Application Catalog that has been updated on the
Remote Server and needs to be refreshed in order to update its data with the data
on the Remote Server. See Manually Updating a Linked Package.

A virtual package (Microsoft App-V, VMware ThinApp, or Citrix) that has been
imported into the Application Catalog.

Virtual package is managed within the Software Repository. This icon is only
displayed in Application Manager.

Virtual package is managed within the Software Repository and is checked out.
This icon is only displayed in Application Manager.
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Table 6-19 « ConflictSolver and Application Manager Product View Icons (cont.)

Name Icon Description
Transforms Q A transform.

_{ﬂ A transform that has an unresolved question. It is either missing from the original
import directory or its last modified date does not match the last modified date
stored in the Application Catalog. When this icon is selected, a message appears
in the Application Manager Product View prompting you to take action to resolve
the problem.

OS Snapshot 2] An OS snapshot, which is a file representing a particular computer system’s

' contents.

Conflicts % Click to access the product’s Conflicts View, where you can access information
pertaining to the last execution of the Conflict Wizard.
Validation Click to access the product’s Validation View, which lists all ICE Errors and

Warnings that were generated the last time the selected package was validated.

Patch Impacts

Dependencies
Extended
Attributes

Files or Files/
Components

INI File
Changes

Merge
Modules

Click to access the product’s Patch Impacts Analysis View, which lists patches for
which there is patch impact data persisted against the product, and identifies the
patch that caused the impact.

Click to display the Dependencies associated with the package. See
Dependencies View for more information.

Click to display the optional Extended Attributes associated with the package.
See Extended Attributes View for more information.

Click to display the Files View or the Files and Components View, listing all of the
files and components in the MSI package, merge module, OS snapshot, or NCP
file.

Click to display the Files View or the Files and Components View, listing all of the
files and components in the MSI package, merge module, OS snapshot, or NCP
file. The question mark icon indicates that a file is missing from the original import
directory. When this icon is selected, a message appears in the Files View
describing the missing files and prompting you to locate the missing files.

Click to display the INI File Changes View, listing any INI file changes made by
the product.

Click to display any merge modules included the product.
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Table 6-19 « ConflictSolver and Application Manager Product View Icons (cont.)

Name Icon Description

Associated .@ Click to display the product’s Associated Patches View, which displays a list of
Patches imported patches that, if installed, would update the selected product.
Registry ﬁ Click to display any registry entries created or changed by the product.
Shortcuts H Click to display any shortcuts created by the product.

Tables D]

Merge Modules View Icons

Click to view the data for a given package in the Application Catalog.

The following icons are used on the Merge Modules tab:

Table 6-20 < Merge Modules View Icons

Name

Merge Modules

Icon

%

Description

Indicates both the All Merge Modules view, the root node of the merge
modules explorer containing a list of all merge modules in the Application
Catalog, and an individual Merge Module.

Merge Module
Managed Within the
Software Repository

A Merge Module managed within in the Software Repository.

Select to display any components created or changed by the merge

Components i)
module.
Dependency ':E' Select to display any dependencies in the merge module.
Exclusion Q Select to display any exclusions in the merge module.
Files |_~| Select to display any files in the merge module
Products Select to display any products in the Application Catalog that use the

[

merge module.
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Context Menus
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Application Manager includes several context menus which can be accessed by right-clicking on nodes on the
Products, Merge Modules, and Patches tabs. These menus provide specific functionality in relation to what is

clicked.

e Groups

e Packages

e Merge Modules Node

e Individual Merge Modules

e Patch View on the Patches Tab

Groups

When you right-click on a group in the Application Manager Product View, the following commands are available
through the context menu:

Table 6-21 * Group Context Menu Commands

Command Description
Import Allows you to import a package or an operating system patch into the Application Catalog.
You have two options:
e Package—Select this option to launch the Import Wizard to import Windows Installer
packages, transform files, merge modules or patch files (.msp) into the Application
Catalog.
e Patches—Select this option to launch OS Security Patch Wizard so that you can
import Windows operating system and Microsoft application patches into the
Application Catalog.
New Group Creates a new group within the selected group.
Rename Allows you to rename the selected group.
Delete Removes the selected group from the Application Catalog, including any groups, products,
or OS Snapshots contained within it.
Find Select to perform a search for data in the various tables of the Application Catalog. See
Searching an Application Catalog for more information.
Cut Cuts the selected group from the Application Catalog. You can then paste it using the Paste
command.
Paste Pastes a cut group from Application Manager.
Properties Opens the Group Properties dialog box.
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Packages

When you right-click on a package in the Application Manager Product View, the following commands are available
through the context menu:

Table 6-22 » Package Context Menu Commands

AdminStudio 10.0 User Guide

Command

Description

Import

Reimport the

Allows you to import a package or an operating system patch into the Application
Catalog. You have two options:

e Package—Select this option to launch the Import Wizard to import Windows
Installer packages, transform files, merge modules or patch files (.msp) into the
Application Catalog.

e Patches—Select this option to launch OS Security Patch Wizard so that you can
import Windows operating system and Microsoft application patches into the
Application Catalog.

Reimports the package from its source location (if known and present).

package m
Note * Supported for Windows Installer packages only.

Find Select to perform a search for data in the various tables of the Application Catalog. See
Searching an Application Catalog for more information.

Cut Cuts the selected package from the Application Catalog. You can use the paste
command to paste it to a new location.

Copy Copies the selected package. You can use the paste command to paste it to a new
location.

Paste Allows you to paste a package that has been cut or copied.

Edit with Open this package in InstallShield Editor, where you can directly edit the package or

InstallShield create a transform.

Editor

Edit with Virtual
Package Editor

E

Note * Supported for Windows Installer packages only.

(App-V packages only) Open this App-V package in Virtual Package Editor, where you
can view and edit package data.

Distribute
Package

Launch the Distribution Wizard.

E

Note * Supported for Windows Installer packages only.
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Command

Perform
Predeployment
Testing

Refresh Package
Auto Import

Rename

Delete

Table 6-22 « Package Context Menu Commands (cont.)

Description

Launch the Predeployment Test Preparation Wizard.

E

Note * Supported for Windows Installer packages only.

Rather than waiting until the next scheduled automatic update is performed, select this
option to manually re-import a Windows Installer package that is being monitored in a
Remote Application Catalog.

E

Note * Supported for Windows Installer packages only.
Select to rename the selected package.

Select one of the following:

e Package—Removes the product from the current group.

e Package from all Groups—Removes the product from all groups and removes it
from the Application Catalog.

e All Extended Attributes—Removes all extended attributes from the selected
package.

e Persisted Conflict Information—Removes persisted conflict information for the
selected package.

e Persisted Validation Information—Removes persisted validation information for
the selected package.

e History Log Information—Removes all change history data for the selected
package.

Associate with
Workflow
Manager
Application

Launches the Associate with Workflow Manager Application dialog box, from
which you can pick a package in Workflow Manager with which to associate the
extended attribute data for the selected product.

E

Note * Supported for Windows Installer packages only.

E

Note * AdminStudio Workflow Manager is a Web-based application management system that has
integrated functionality with AdminStudio.

ADS-1000-UG00

AdminStudio 10.0 User Guide



Chapter 6: Managing Application Catalog Databases
Reference

Table 6-22 « Package Context Menu Commands (cont.)

Command Description

Reports Select one of the following:

e Package—Creates the Package Report.
® Files—Creates the Files Report.
e Registry—Creates the Registry Report.

e Crystal Reports Conflicts—Creates the pre-defined Crystal Reports Conflicts
Report.

e Crystal Reports Files—Creates the pre-defined Crystal Reports Files Report.
e Crystal Reports Registry—Creates the pre-defined Crystal Reports Registry

Report.
E

Note * Supported for Windows Installer packages only.

Merge Modules Node

When you right-click on the root-level Merge Modules node in the merge modules explorer, the following command
is available through the context menu:

Table 6-23 * Merge Modules Node Context Menus

Command Description

Import Merge Module Launches the Import Wizard directly to the MSM Source Information panel.

Individual Merge Modules

When you click on an individual merge module in the merge modules explorer, the following commands are
available through the context menu:

Table 6-24 « Individual Merge Modules Context Menus

Command Description
Import Merge Module Launches the Import Wizard directly to the MSM Source Information panel.
Delete Removes the selected merge module from the Application Catalog.
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Patch View on the Patches Tab
When you click on an individual patch in the Patch View, the following commands are available through the context
menu:
Table 6-25 * Patch View Context Menus
Command Description
Rename Rename the selected patch.
Delete Removes the selected patch from the Application Catalog.
Cut Cuts the selected patch from the Application Catalog. You can use the paste
command to paste it to a new location.
Copy Copies the selected patch. You can use the paste command to paste it to a new
location.
Paste Allows you to paste a patch that has been cut or copied.
Generate Report Select to generate a Patch Report for that patch.
Properties Launch the Patch Properties dialog box for that patch.
Output Window

When the Import and Package Auto Import Wizards are run, and when a Search is performed, the output
messages and results of those wizards are displayed in the various tabs of the Output Window.

Table 6-26 « Output Window Context Menus

Tab Description

Import Tab When the Import Wizard is run to import a package into the Application Catalog,
messages about the Import process are displayed in this tab.

Package Auto Import When the Package Auto Import Wizard is run to automatically import packages in a

Tab Remote Application Catalog or Network Directory, messages about the import
process are displayed in this tab.
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Table 6-26 « Output Window Context Menus (cont.)
Tab Description
Search Results Tab When Find is used to search for data in Application Catalog tables, the data that is

found is displayed in this tab, in the following format:

= package Name Table Name Column Mame  Column Data
DemoPlayer csmsifictionText Action AppSearch
Morton Antivirus Corporate Edition  csmsictionText Action AppSearch
Microsaft Corparation_Orca csmsictionText Action AppSearch
DemoPlayer csmsisys_validation Table appSearch
DemoPlayer csmsisys_validation Table appsearch
Morton Antivirus Corporate Edition  csmsisys_Yalidation Table AppSearch
Morkan Ankivirus Corporate Edition  csmsisys_Validation Table AppSearch )

[“TF T output A Import A validate A, Corficts A Patch Impact &, Package Auto Import A\ Search Results /

15 nccurrenced(s; of ‘AppSearch’ have been Found,

If you double click on this data, Application Manager will navigate to the
appropriate record in the Tables View, and that record will be highlighted.

User Permissions in Application Manager

Security and permissions can be assigned to Application Manager users to restrict the tasks that can be performed
in Application Manager. The following table describes the various Application Manager permissions.

Table 6-27  Application Manager Permissions

Permission Explanation

Import Applications | Can import packages or merge modules into an Application Catalog, including re-
importing packages resulting from unlinked data or conflict resolution

Delete Can delete individual packages from the Application Catalog
Merge Database Can merge information from two different Application Catalogs
Change Data Can write to the Application Catalog. Without this permission, any Application

Manager permission that allows users to write to the Application Catalog will not
function; Application Manager is essentially read-only for roles without this
permission.

Change Extended Can change the XML file used to configure the extended attribute definition
Attributes

Change Database Can open another Application Catalog

Additionally, AdminStudio Administrators can restrict access to the Application Manager completely by disabling
the Application Manager tool permission.
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E

Note -« Typically only AdminStudio Administrators and a few select users will have access to create new Application

Catalogs, upgrade Application Catalogs, or otherwise affect multiple users.

Application Manager Views

The following views are associated with the Application Manager Products tab:

Application Catalog View: Application Readiness Dashboard
Group View

Product View

OS Snapshot View

Other Setup Types View

Marimba NCP Files Views

Patches Tab Views

Merge Module Views

Application Catalog View: Application Readiness Dashboard

The Application Readiness Dashboard, which is opened by selecting the Application Catalog node in
Application Manager, provides graphical representations of summary data concerning the readiness of Windows
Installer and App-V packages for distribution.

310
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The Application Readiness Dashboard includes the following information:

Table 6-28 - Application Readiness Dashboard

Description Chart

Deployment Type Breakdown Provides a graph listing the percentage of packages in the Application
Catalog by deployment type (Windows Installer, App-V, XenApp, ThinApp,
or Legacy).

Error Category Breakdown Shows the number of AdminStudio Best Practices and Conflict errors that
have been identified in Windows Installer and App-V packages, by
category.

Virtualization Readiness Shows a summary of the virtualization status of packages in the

Application Catalog, identifying packages as being Ready for
Virtualization, Not Suitable for Virtualization, Already Virtualized, or Not

Tested.
Windows Installer / App-V Shows the Microsoft Validation status of Windows Installer packages, and
Package Quality the AdminStudio Best Practices test status of Windows Installer and
App-V packages.
Windows Installer / App-V Shows the AdminStudio Conflict test status of Windows Installer and
Package Conflicts App-V packages.

Tip * Click on specific categories of these charts to open more detailed reports.

Group View

The Group view is displayed on the right side of Application Manager whenever a group is selected.
If you select a group or product in a group, properties for that group or product are displayed in the Group View.

Additionally, if you double-click an item in the Group View, the corresponding item in the Application Manager
Product View is selected. You can sort the products by either Name or Description by clicking on the column title.

Product View

When you select a Windows Installer Package (.msi) in the tree, details about that product are displayed in the right
pane of the user interface.
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The following information is included:

Table 6-29 « Application Manager Product View

Field

Manufacturer

Subscribed Database

Conflict Results

Package Code
Product Code

Upgrade Code

Description

The manufacturer of the package.

If this package is associated with a subscribed database, the name of that
database is listed here. If it is not, the following statement appears:

Not associated with any subscribed database.

If any persisted conflict data exists, this is a hyperlink to the package’s Conflicts
View.

The globally unique identifier (GUID) for the setup package.
A string that uniquely identifies the product.

A string used to upgrade the application. The upgrade code for a package
groups that package into a specific product family.

Language The language of this package.

File Identifies the location of this package. It can be either a hard-coded path or a
UNC path.
If the package is part of the Software Repository, the following statement appears:
Managed within the Software Repository

Original File When a user selects a Windows Installer package (.msi) along with one or more
patch files (.msp) to import, AdminStudio first performs an administrative
installation to merge the .msi and .msp files into one .msi file, and then imports
the merged .msi file into the Application Catalog. In this instance, the Original
File field lists the name and path of the original Windows Installer package that
the patches were applied to, while the File field lists the name and path of the
merged .msi file that was imported.
If the package is part of the Software Repository, the following statement appears:
Managed within the Software Repository
Note * When a Windows Installer package that was imported without a patch is selected,
the entry of the Original File and File fields is identical.

Imported On The date and time the package was imported.

Transforms This can be either a hard-coded path or a UNC path.
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Table 6-29 « Application Manager Product View

Field Description

Patches The patch files that were used to get to the final imported MSI package.
Groups Any groups to which the package belongs.

Description You can edit this with additional information about the product.

E

Note - If the package and/or transforms are no longer in their original import directory, you can locate the file(s)
from the provided hyperlink. You are also informed if the last modified date for the package in the Application
Catalog does not match the last modified date of the package in its external location. You are given the opportunity
to reimport the package to keep it synchronized in the Application Catalog.

If you click on the plus sign to expand a package in the Application Manager Product View, a node is listed for each
available constituent view. For example, for a Windows Installer package, the following nodes are listed:

....... D Files/Cornpanents

------- % INIFile Changes

....... #f Registry

....... El Shortouts

------- i Virtualization Suitability
------- t Merge Modules

....... @ Catalog History

Figure 6-9: Application Manager Product View Nodes

When you select one of these nodes, a constituent view opens in the right pane:
e Extended Attributes View

e Files/Components View

e INI File Changes View

® Registry View

e Shortcuts View

e Merge Modules View

e (Catalog History View

e Tables View
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E

Note ¢ The Only Display View Nodes With Data option on the General tab of the ConflictSolver and
Application Manager Options Dialog Box controls whether product nodes (constituent views) appear if no data is
contained in that view. If you select the option, products containing views without data will not display those views.
For example, if a product has no Dependencies, then the Dependencies node is not displayed for that product.

Extended Attributes View

The Application Manager Extended Attributes View displays the optional extended attributes associated with the
package. To open a package’s Extended Attributes View, select the Extended Attributes node under that
package in the package tree.

These attributes are dynamically populated based on an external Extended Attribute Description File (in XML
format). You can specify the name and location of this file from the Extended Attributes Tab of the ConflictSolver
and Application Manager Options Dialog Box.

On the left side of the view, the name for each attribute is displayed; the right side displays the value for the
attribute. These values are in read-only fields, from which you can highlight and copy text, or, in the case of file
links, launch the linked file. The file location displayed represents the location from which the file was originally
imported; the file is actually stored within the Application Catalog and extracted into a temp directory when you
click on the file link. This temp directory is purged when Application Manager closes, as long as the file is not
locked by another application or process.

If you click on the attribute name, you can either provide the value in the Group Properties Dialog Box (for Text
attributes) or browse for a file in a Browse dialog (for File attributes).

E

Note - You can also view and edit a package’s extended attributes on the Extended Attributes Page of the
ConflictSolver Process Assistant.

Files/Components View

When you expand a product in the Application Manager Product View, you can click on Files/Components to
display the files and components in the product.

The following information is displayed:

Table 6-30 ¢ File/Components View Information

Column Description

Component Name of component that the file listed in the FileName column is associated with.
FileName Name of file.

FileSize Size of the file listed in the FileName column.
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Table 6-30 ¢ File/Components View Information

Column Description
Version Version of the file listed in the FileName column.
Path Installation location of the file listed in the FileName column.
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INI File Changes View

When you expand a product in the Application Manager Product View, you can click on INI File Changes to display
any INI file changes made by the product.

The following information is displayed:

Table 6-31 ¢ INI File Changes View Information

Column Description
Component Name of component that makes an entry in the INI File.
FileName Name of INI File that the component listed in the Component column makes an entry in.
DirProperty The directory location where the INI File will be installed.
Section The section of the INI file where this entry is made.
Key The Key used in the INI File entry
Value The Value used in the INI File entry.
Registry View

When you expand a product in the Application Manager Product View, you can click on Registry to display any
registry entries created or changed by the product.

The following information is displayed:

Table 6-32 * Registry View Information

Column Description

Component The name of the component that is creating a Registry entry.
Root Default value of Key.

Key Key of the Registry Entry that this component is making.
Name Name of the Registry Entry that this component is making.
Value Value of the Registry Entry that this component is making.
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Shortcuts View

When you expand a product in the Application Manager Product View, you can click on Shortcuts to display any
shortcuts created by the product.

The following information is displayed:

Table 6-33 ¢ Shortcuts View Information

Column Description

Component Name of the component that the shortcut listed in the Name column is associated with.
Name Name of the shortcut.

Directory_ Directory where the shortcut will exist.

Target Directory and executable that the shortcut invokes.

Virtualization Suitability View

When you expand a Windows Installer package in the Application Manager tree, you can click on Virtualization
Suitability to the view results of a Virtualization Readiness analysis of that package.

Tip * Packages are automatically tested for virtualization readiness during import into the Application Catalog or
when you upgrade an existing Application Catalog. To manually retest a package or group of packages for
virtualization readiness, select a package, application, or group in the Application Manager tree and select Run
Virtualization Readiness from the context menu.

The following information is displayed:

Table 6-34 - Virtualization Suitability View Information

Property Description

[Package Name]: Status The heading of this view lists the package name and identifies that package’s
current Virtualization Readiness status as one of the following:

o Not Tested—Package has not been tested for Virtualization Readiness.

o Not Suitable for Virtualization—Due to the results of the testing,
package may not be suitable for virtualization by Automated Application
Converter. For more information, see Virtualization Not Supported and
Virtualization Not Recommended.

e Ready for Virtualization—Package is ready for virtualization using the
Automated Application Converter. The issues listed below (if any) will be
handled automatically during conversion.
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Table 6-34 - Virtualization Suitability View Information

Property Description

Suitability Issue Lists an issue that was found during testing that may require this package to be
repackaged prior to virtualization or which prevents this package from being
virtualized.

Suitability Issue Detailed description of the suitability issue.

Description

Extended Suitability Lists the number of instances that this suitability issue occured in the selected

Information package.

Merge Modules View

When you expand a product in the Application Manager Product View, you can click on Merge Modules to display
any merge modules included the product.

The following information is displayed:

Table 6-35 « Merge Modules View Information

Column Description

Title The title of the Merge Module included with this package.

ModulelD The number which uniquely identifies the Merge Module listed in the Title column.
Version The version of the Merge Module listed in the Title column.

Language The language that the Merge Module listed in the Title column was written for.
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Catalog History View

When you expand a product in the Application Manager Product View, you can click on the Catalog History node
to display a list of logged events for the selected package.

The following information is included:

Table 6-36 * Information Displayed in the Catalog History View

Item Description

Action Name of the event which was logged:

® Import/Reimport

e Validation

e Conflict Detection

e Conflict Resolution

e Extended Attribute Modification

e Package Description Modification
e Package Move/Copy

e Patch Analysis

Note * You can specify which events you want to be listed on the Catalog History view by making
selections on the History Tab of the ConflictSolver and Application Manager Options Dialog Box. You
can choose which events you want to log and which events you want to display in the Catalog History

view.
Date Date and time logged event occurred.
User User who performed the logged event.
Description Description providing details of the logged event.

Tables View

The Tables view provides a way to view the data for a given package in the Application Catalog. Select the specific
table you want to view from the Tables list at the top of the view.

Most tables are derived directly from standard MSI tables, as described in the Windows Installer SDK online help.

When building your own ACE rules to use for conflict identification, it is important to understand the data available
for packages so you can construct the necessary rule.
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OS Snapshot View

When you click on an OS Snapshot in the Application Manager Product View, details about the snapshot appear in
the right pane of the user interface.

The following information is displayed:

Table 6-37 < OS Snapshot View Information

Field Description

Version Version of the operating system of the OS Snapshot, such as Windows XP - 5.1.2600.
Language The language the operating system was written for.

File This can be either a hard-coded path or a UNC path.

Imported On The date and time the OS Snapshot was imported.

Description You can edit this with additional information about the OS Snapshot.

Click the plus sign next to the OS Snapshot icon to view these OS Snapshot constituent views:

Extended Attributes View for OS Snapshots
e Files View for OS Snapshots

e NI File Changes View for OS Snapshots

® Registry View for OS Snapshots

e Shortcuts View for OS Snapshots

Extended Attributes View for OS Snapshots

The Extended Attributes View for an OS Snapshot is identical to the Extended Attributes View shown when a
Product is selected. See Extended Attributes View in the Application Manager Product View section.

Files View for OS Snapshots

When you expand an OS Snapshot in the Application Manager Product View, you can click on Files to display a list
of the files included in the OS Snapshot.

The following information is displayed for each of the files included in the OS Snapshot:
Table 6-38 « Files View Information

Column Description

FileName Name of the file.
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Table 6-38 ¢ Files View Information

Column

csFilePath

FileSize

Description

Path

Size of the OS Snapshot file.

Version

Language

Attributes

Version of the OS Snapshot file.
Language that the OS Snapshot file was written for.

Any attributes associated with the file.

INI File Changes View for OS Snapshots

When you expand an OS Snapshot in the Application Manager Product View, you can click on INI File Changes to
display any INI file changes made by the snapshot.

The following information is displayed for each change to the INI file that is made by the snapshot:

Table 6-39 ¢ INI File Changes View Information

Column

FileName

csFilePath

Section

Description

Name of INI File that the OS Snapshot makes an entry in.
Path

The section of the INI File where this entry is made.

Key

Value

The Key used in the INI File entry

The Value used in the INI File entry.

Registry View for OS Snapshots

When you expand an OS Snapshot in the Application Manager Product View, you can click on Registry to display
any registry entries created or changed by the product.

The following information is displayed for each Registry Entry:

Table 6-40 * Registry View Information

Column

Description

Root

Key

322

Default value of Key.

Key of the Registry Entry that this component is making.
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Table 6-40 * Registry View Information

Column Description
Name Name of the Registry Entry that this component is making.
Value Value of the Registry Entry that this component is making.

Shortcuts View for OS Snapshots

When you expand an OS Snapshot in the Application Manager Product View, you can click on Shortcuts to display
any shortcuts that were found on this OS Snapshot’s operating system.

The following information is displayed:

Table 6-41 ¢ Shortcuts View Information

Column Description

Name Name of shortcut.

Directory Location of shortcut.

Target The application executable that the shortcut points to.

Tables View for OS Snapshots

The Tables View for an OS Snapshot is identical to the Tables View shown when a Product is selected. See Tables
View in the Application Manager Product View section.

Other Setup Types View

When you click on an Other Setup Types package (a package containing non-MSI based setup files) in the
Application Manager Product View, details about that setup are displayed in the right pane of the user interface.

The following information is included:
Table 6-42 - Other Setup Types View Information
Field Description

Main Directory The original location of the non-MSI based setup files when they were imported into the
Application Catalog.

Imported On The date and time the setup was imported.
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Table 6-42 - Other Setup Types View Information

Field Description

Files A listing of the individual files making up the setup are listed, allowing you to view or delete
files by making a selection from the context menu.

e To view the contents of a file, select View from the context menu. You can only view
files supported by applications installed on your workstation. If you attempt to view a
non-supported file, no View window will appear. If you attempt to view an executable,
that executable will be launched.

e To delete a file from this setup, select Delete from the context menu.

If you expand an Other Setup Type, you can view its constituent view, the Extended Attributes View for Marimba
NCP Files.

Extended Attributes View for Other Setup Types

The Extended Attributes View for an Other Setup Types package is identical to the Extended Attributes View shown
when a Product is selected. See Extended Attributes View in the Application Manager Product View section.

Marimba NCP Files Views

Edition * Import support for Marimba Native Channel Packager (.ncp) files is available in AdminStudio Enterprise
Edition.

When you select a Marimba NCP file (.ncp) from the Application Manager Product View, details about that file are
displayed in the right pane of the user interface.

The following information is included:
Table 6-43 « NCP Views Information

Column Description

Conflict Results Date that this package was last checked for conflicts. Click the link to jump to the
Conflicts View for Marimba NCP Files.

Version Version of the software package

File Name and path of the NCP file that was imported

Imported On Date when the file was imported

Description After the NCP file is imported, you can edit this with additional information.
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If you expand an NCP file, you can view its constituent views:

Extended Attributes View for Marimba NCP Files

Files View for Marimba NCP Files

INI File Changes View for Marimba NCP Files

Registry View for Marimba NCP Files

Shortcuts View for Marimba NCP Files

Tables View for Marimba NCP Files

Extended Attributes View for Marimba NCP Files

Reference

The Extended Attributes View for an NCP File is identical to the Extended Attributes View shown when a Product is

selected. See Extended Attributes View in the Application Manager Product View section.

Files View for Marimba NCP Files

When you expand a Marimba NCP File in the Application Manager Product View, you can click on Files to display
the files included in the NCP File.

The following information is displayed for each file:

Table 6-44 ¢ Files View Information

Column Description

FileName Name of the file.

csFilePath Path

FileSize Size of the NCP file.

Version Version of the NCP file.

Language Language that the NCP file was written for.
Attributes Any attributes associated with the file.

INI File Changes View for Marimba NCP Files

When you expand an Marimba NCP File in the Application Manager Product View, you can click on INI File

Changes to display any INI file changes made by the NCP file.
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The following information is displayed for each change that is made to the INI file by the NCP file:

Table 6-45 ¢ INI File Changes View Information

Column Description

FileName Name of the file.

csFullPath Path

Section Section of INI file that is changed.
Key Key that is changed.

Value Value that is changed.

Registry View for Marimba NCP Files

When you expand a Marimba NCP File in the Application Manager Product View, you can click on Registry to
display any registry entries created or changed by the NCP file.

The following information is displayed for each registry entry:

Table 6-46 * Registry View Information

Column Description

Root Default value of Key.

Key Key of the Registry Entry that this NCP file is making.
Name Name of the Registry Entry that this NCP file is making.
Value Value of the Registry Entry that this NCP file is making.
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Shortcuts View for Marimba NCP Files

When you expand a Marimba NCP file in the Application Manager Product View, you can click on Shortcuts to
display any shortcuts created by the NCP file.

The following information is displayed for each shortcut created by the NCP file:

Table 6-47 * Shortcuts View Information

Field Description

Name Name of the shortcut.

Directory Directory where the shortcut will exist.

Target Directory and executable that the shortcut invokes.

Tables View for Marimba NCP Files

The Tables View for an NCP file is identical to the Tables View shown when a Product is selected. See Tables View
in the Application Manager Product View section.

App-V Package View

When you select an App-V package in the Application Catalog, the App-V Package View opens. The following
information is displayed:

Table 6-48 * App-V Package View

Option Description
Type Identifies the virtual package type as App-V.
File Identifies the location of this package. It can be either a hard-coded path or a UNC path.

If the package is part of the Software Repository, the following statement appears:

Managed within the Software Repository
Imported On Date and time the virtual package was imported into the Application Catalog.

Applications Lists the Applications that reference this App-V package.
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Table 6-48 * App-V Package View

Option

Associated MSI
Packages

Description

Description

Lists the App-V package’s source Windows Installer package.

By associating a virtual package with the Windows Installer package which originated it,
you have the convenience of being able to easily locate the virtual package’s originating
Windows Installer package, modify the original Windows Installer package, and then
regenerate the virtual package.

E

Note « To quickly locate one of these listed Windows Installer packages in the Application Catalog,
double-click on it.

In order to be listed here, the Windows Installer package has to have already been
imported into the Application Catalog and must be associated with this virtual package.
There are several ways to associate a virtual package with its source Windows Installer
package:

e Importing a Virtual Package During the Import of its Source Windows Installer Package
e Importing a Virtual Package After the Import of its Source Windows Installer Package

e Manually Associating a Virtual Package with a Windows Installer Package

You can edit this field and add additional information about the virtual package.

If you expand the App-V node in the tree, you can view its constituent views:

o Conflicts View—See App-V Conflicts View.

e Extended Attributes—The Extended Attributes view for an App-V package is identical to the Extended
Attributes View shown when a Windows Installer package is selected. See Extended Attributes View in the
Application Manager Product View section.

® App-V History—See App-V History View.

e Dependencies—See App-V Dependencies View.

® Files/Directories—See App-V Files/Directories View.

® Registry—See App-V Registry View.

e Shortcuts—See App-V Shortcuts View.

e File Type Associations—See App-V File Type Associations View.

e Environment Variables—See App-V Environment Variables View.

e Catalog History—The Catalog History view for a Citrix or ThinApp virtual package is identical to the Catalog
History view shown when a Windows Installer package is selected. See Catalog History View in the Application
Manager Product View section.

e Tables—See App-V Tables View.
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App-V Conflicts View

When you expand an App-V node in the Application Manager tree, you can click on Conflicts to display the
Conflicts View for an App-V package. On this view, you can access information pertaining to the last execution of
the Conflict Wizard. This persisted conflict data allows you to view when the last execution was performed, the
packages that it was run against, the ACE rules used and conflicts discovered. The view also provides a list of
updated, deleted, or added packages that may necessitate performing conflict identification again.

The information displayed on this view is the similar to the Conflicts view for Windows Installer packages. See
Conflicts View.

App-V History View

When you expand an App-V node in the Application Manager tree, you can click on App-V History to open the
App-V History view, which lists an entry for each time this App-V package has been saved. For each entry, the
following information is displayed:

e Version Guid

® Sequencer Version

® Sequenced By

® Sequencing Station

®  OSDetails

e System Folder

e Windows Folder

® User Folder

® .Net Framework Version

e |EVersion

App-V Dependencies View

When you expand an App-V node in the Application Manager tree, you can click on Dependencies to display a
listing of both the applications this package is dependent on and the applications dependent upon this application.
For each dependency, the following information is listed:

® Application

e In Catalog? (Yes / No)
e DSC Server URL

® Server URL

e Mandatory? (Yes / No)

AdminStudio 10.0 User Guide ADS-1000-UG00 329



Chapter 6: Managing Application Catalog Databases
Reference

App-V Files/Directories View

When you expand an App-V node in the Application Manager tree, you can click on Files/Directories to display a
listing of the files and directories in this package. For each file/directory, the following information is listed:

® Directory

e Short Name

® App-V Override (True / False)
e Short Name

e File

e File Size

® App-V VFS Path

® App-V Feature Block 1

® App-V Version

® App-V Data Type

App-V Registry View

When you expand an App-V node in the Application Manager tree, you can click on Registry to display the
Registry View for an App-V package. This view lists any registry entries created or changed by the package.

The information displayed on this view is the similar to the Registry view for Windows Installer packages. See
Registry View.

App-V Shortcuts View

When you expand an App-V node in the Application Manager tree, you can click on Shortcuts to display any
shortcuts created by the product.

The information displayed on this view is the similar to the Shortcuts view for Windows Installer packages. See
Shortcuts View.

App-V File Type Associations View

When you expand an App-V node in the Application Manager tree, you can click on File Type Associations to
view a list of this package’s file type associations. For each file type association, the following information is listed:

e Extension

® Target
e ProglID
e MIME
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® Description
e \Verb

® Arguments

App-V Environment Variables View

When you expand an App-V node in the Application Manager tree, you can click on Environment Variables to
display the environment variables used in this App-V package. For each environment variable, the following
information is listed:

e Name
e Value
App-V Tables View

When you expand an App-V node in the Application Manager tree, you can click on Tables to display the Tables
View, which provides a way to view the data for this specific App-V package. Select the specific table you want to
view from the Tables list at the top of the view.

When building your own ACE rules to use for conflict identification, it is important to understand the data available
for App-V packages so you can construct the necessary rule.
Citrix / ThinApp Package View

When you select a Citrix XenApp or VMware ThinApp package in the Application Catalog, the its Package view
opens. The following information is displayed:

Table 6-49 - Citrix / ThinApp Package View

Option Description
Type Identifies the virtual package type as Citrix or ThinApp.
File Identifies the location of this package. It can be either a hard-coded path or a UNC path.

If the package is part of the Software Repository, the following statement appears:

Managed within the Software Repository

Imported On Date and time the virtual package was imported into the Application Catalog.
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Table 6-49 - Citrix / ThinApp Package View

Option Description

Associated MSI Lists the virtual package’s source Windows Installer package.

Packages By associating a virtual package with the Windows Installer package which originated it,

you have the convenience of being able to easily locate the virtual package’s originating
Windows Installer package, modify the original Windows Installer package, and then
regenerate the virtual package.

E

Note « To quickly locate one of these listed Windows Installer packages in the Application Catalog,
double-click on it.

In order to be listed here, the Windows Installer package has to have already been
imported into the Application Catalog and must be associated with this virtual package.
There are several ways to associate a virtual package with its source Windows Installer
package:

e Importing a Virtual Package During the Import of its Source Windows Installer Package
e Importing a Virtual Package After the Import of its Source Windows Installer Package

e Manually Associating a Virtual Package with a Windows Installer Package

Description You can edit this field and add additional information about the virtual package.

If you expand the Citrix or ThinApp node in the tree, you can view its constituent views:

e Extended Attributes—The Extended Attributes view for a Citrix or ThinApp virtual package is identical to the
Extended Attributes View shown when a Windows Installer package is selected. See Extended Attributes View
in the Application Manager Product View section.

e Catalog History—The Catalog History View for a Citrix or ThinApp virtual package is identical to the Catalog
History View shown when a Windows Installer package is selected. See Catalog History View in the
Application Manager Product View section.
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Patches Tab Views

The Patches tab includes the following views which provide content and impact information about Microsoft
patches that have been imported into the Application Catalog.

Table 6-50 * Patches Tab Views

View

Patches Group
View

New Patches
Group View

Description

Opens when the root group in the Patches tab is selected, and lists all of the groups that
have been created in the Patches tab.

All new patches are imported into the New Patches group, and this view lists all of the
patches in that group.

Group View of a
Selected Group

Patch View

Patches Group View

Opens when a group other than the root group in the Patches tab is selected. For each
selected group, a list of all of the patches in that group is displayed.

Lists general content information on a selected patch.

The Patches Group View opens when the root group in the Patches tab is selected. The Patches Group View lists
all groups that have been created in the Patches tab.

All new patches are imported into the New Patches group, and then you can organize the patches into other
groups according to your business needs. See Organizing Your Application Catalog Using Groups.

The New Patches group is automatically created during installation. While it can be renamed, it cannot be
deleted.

Context Menu Options

When the root group in the Patches Tab is selected, the following items are available on the context menu:

Refresh—Refresh the patch listing to reflect the most recent modifications.

Import Patches—Opens the OS Security Patch Wizard so that you can import patches into the Application

Catalog.

New Group—Create a new group.

Rename—Rename the selected group.

Properties—Open the Group Properties dialog box.
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New Patches Group View
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The New Patches Group View opens when the New Patches group on the Application Manager or ConflictSolver
Patches tab is selected. All new patches are imported into the New Patches group. You can then organize the
patches into other groups according to your business needs. See Organizing Your Application Catalog Using
Groups.

The New Patches group is automatically created during installation. While it can be renamed, it cannot be
deleted.

The New Patches Group View displays a list of all of the patches in that group, including the following information:
Table 6-51 « New Patches Group View Information

Option Description

Name Name of patch file.
Description Description of the patch file.
Release Date @ Date the patch was released by Microsoft.

Import Date Date the patch was imported into the Application Catalog.

If you select a patch in this list, detailed patch properties are displayed in the area to the left of the list, including the
Title, Summary, and Release Date of the patch.

Context Menu Options

When the New Patches group in the Patches Tab is selected, the following items are available on the context
menu:

e New Group—Create a new group.
e Rename—Rename the selected group.

e Properties—Open the Group Properties dialog box.
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Group View of a Selected Group

The Group View of a selected group opens when a group other than the root group or the New Patches group in
the Patches tab is selected. For each selected group, a list of all of the patches in that group is displayed,
including the following information:

Table 6-52 * Group View of a Selected Group Information

Option Description

Name Name of patch file.

Description Description of the patch file.

Release Date Date the patch was released by Microsoft.

Import Date Date the patch was imported into the Application Catalog.

If you select a patch in this list, detailed patch properties are displayed in the area to the left of the list, including the
Title, Summary, and Release Date of the patch.
Context Menu Options

When a group other than the root group or the New Patches group in the Patches Tab is selected, the following
items are available on the context menu:

e New Group—Create a new group.
e Rename—Rename the selected group.
e Delete—Delete the selected group.

e Cut—Copy the selected group to the clipboard so that you can remove it from its current location and paste it
into another location.

e Paste—lInsert the patch or the group on the clipboard into the selected location.

e Properties—Open the Group Properties dialog box.

Patch View

The Patch View, which is displayed when a patch is selected on the Patches tab, lists general information on the
selected patch. The following information is included:

Table 6-53 ¢ Patch View Information

Option Description
ID Microsoft Security Bulletin ID. Click this link to view this bulletin on the Microsoft Web site.
Title Title of patch.
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Table 6-53 ¢ Patch View Information

Option

Release Date

KB Article

Imported On
Groups

Description

Description

Date the patch was released by Microsoft.

Microsoft Knowledge Base article ID. Click this link to view this article on the Microsoft
Web site.

Date patch was imported into the Application Catalog
List of all of the groups that this patch is included in.

You can enter a description of the patch in this field.

In the Application Manager, you can view additional detailed patch information by selecting a patch and then
selecting Properties from the context menu.

Context Menu Options

When a patch in the Patches Tab is selected, the following items are available on the context menu:

Rename—Rename the selected patch.

Delete—Delete the selected patch.

Cut—Copy the selected patch to the clipboard so that you can remove it from its current location and paste it
into another location.

Copy—Copy the selected patch to the clipboard so that you can paste a copy of it into another location.

Paste—Insert the patch on the clipboard into the selected location.

Generate Report—Generate a Patch Impact Analysis Report for that patch. See Generating the Patch

Report.

Properties—Open the Patch Properties dialog box for that patch.
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Merge Module Views

From the Merge Modules tab, you can access the following views:

e All Merge Modules View—Select this option to view a list of all of the Merge Modules in your catalog. See All
Merge Modules View.

e Merge Module View—Select an individual Merge Module to see detailed information on that module. See
Merge Module View.
All Merge Modules View

The All Merge Modules view is the root node of the merge modules explorer. It contains a list of all merge modules
in the Application Catalog, including titles, versions, languages, and identifiers for each module.

Double-click on a merge module to see information about it in the Merge Module View.

Merge Module View

When you select a merge module in the merge modules explorer, details are displayed in this view.

These details include:

Table 6-54 < Merge Module View Information

Field Description

Version The version of the Merge Module.

Language The language that the Merge Module was written for.

Identifier String that uniquely identifies the Merge Module.

File The path and file name of the Merge Module file that was imported.
Imported On The date and time the Merge Module was imported.

Click the plus sign next to the Merge Module to view these Merge Module constituent views:
e Merge Module / Components View

e Merge Module / Dependency View

e Merge Module / Exclusion View

e Merge Module / Files View

e Merge Module / Products View
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Merge Module / Components View

When you expand a merge module in the merge modules explorer, you can click on Components to display any
components created or changed by the merge module.

The following information is displayed for each component included in this merge module:
e Component

e Componentld

e Directory_

e csFullPath

Merge Module / Dependency View

When you expand a merge module in the merge modules explorer, you can click on Dependency to display any
dependencies in the merge module.

The following information is displayed for each dependency included in this merge module:
® ModuleLanguage

® RequiredID

® RequiredLanguage

® RequiredVersion

Merge Module / Exclusion View

When you expand a merge module in the merge modules explorer, you can click on Exclusion to display any
exclusions in the merge module.

The following information is displayed for each exclusion included in this merge module:
e ModuleLanguage

e ExcludedID

® ExcludedLanguage

® ExcludedMaxVersion

e ExcludedMinVersion
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Merge Module / Files View

When you expand a merge module in the merge modules explorer, you can click on Files to display any files in the
merge module.

The following information is displayed:

Table 6-55 * Merge Module Files View Information

Column Description

Component_ Name of component that this Merge Module file is associated with.
File Name of this Merge Module file.

FileName File name of this Merge Module file.

FileSize Size of this Merge Module file.

Version Version of this Merge Module file.

Merge Module / Products View

When you expand a merge module in the merge modules explorer, you can click on Products to display any
products in the Application Catalog that use the merge module.

The following information is displayed:

Table 6-56 « Merge Module Products View Information

Column Description

ProductName Name of product associated with this Merge Module.
ProductVersion Version of product associated with this Merge Module.
Manufacturer Manufacturer of the product associated with this Merge Module.

Dialog Boxes

Application Manager includes the following dialog boxes:

e Application Catalog Properties Dialog Box

e Associate with Workflow Manager Application Dialog Box
e Command-Line Parameters Dialog Box

e Command-Line Parameters Dialog Box
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e Connect Application Catalog Dialog Box
e Extended Attribute Property Dialog Box
e Find Dialog Box

® |ogin Required Dialog Box

e Group Properties Dialog Box

e Package Auto Import Dialog Box

e Publication Manager Dialog Box

e Publication Processing Dialog Box

e Publication Properties Dialog Box

e Select AdminStudio Enterprise Server URL Dialog Box
® Subscription Manager Dialog Box

® Task Scheduling Dialog Box

Application Catalog Properties Dialog Box

340

The Application Catalog Properties Dialog box, which is opened by selecting Properties on the Catalog menu, is
used to enable the Software Repository, select its location, and create a Proxy Account that AdminStudio can use
to make modifications to the Software Repository.

Software Repository Tab

A Windows Installer package is made up of many files that are executed when the setup is run. You only import the
.msi file into the Application Catalog, not all of the files necessary for installation. With the Software Repository,
when you import an installation package into the Application Catalog, all of the files associated with that package
are copied into the Software Repository location, a directory that you specify. This allows you to manage those
files, preventing them from getting modified or lost.

On the Software Repository tab, you can choose to Enable the Software Repository for the new Application
Catalog, and specify a Proxy Account for AdminStudio to use to make modifications to the directory path
selected as the Software Repository Location.

This tab includes the following options:

Table 6-57 * Application Catalog Properties / Software Repository Tab Options

Option Description

Enable Software Select this option to enable the Software Repository feature for this
Repository Application Catalog.

Software Repository Specify the directory location of the Software Repository for this Application
Location Catalog.
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Table 6-57  Application Catalog Properties / Software Repository Tab Options (cont.)
Option Description
Proxy Account Specify a Login ID and Password for AdminStudio to use when modifying

the Software Repository Location directory.

Proxy Account Tab

For SQL Server Application Catalogs, you need to specify a Proxy Account for AdminStudio to use to access the
Application Catalog on the database server. You cannot use Windows Authentication for this Proxy Account.

Enter a valid Login ID and Password to log on to the database server that contains this Application Catalog.

Associate with Workflow Manager Application Dialog Box

E

Note * AdminStudio Workflow Manager is a Web-based application management system that has integrated
functionality with AdminStudio.

The Associate with Workflow Manager Application dialog box is displayed when you select the corresponding
command from the context menu when right-clicking on a product. It allows you to associate extended attribute
data for a product with an application already in an AdminStudio Workflow Manager application catalog. You can
select the available packages from the list in the dialog box.

E

Note - This dialog (and its corresponding command) are only available if you select the Integrate with Workflow
Manager option on the Extended Attributes Tab of the ConflictSolver and Application Manager Options Dialog
Box.

E

Note -« Be sure to select a Workflow Manager application that uses a template containing at least one major data
group that was specified with the group's extended attribute description file, as described in the AdminStudio
Workflow Manager user documentation.

Change Enterprise Server Password Dialog Box
This dialog box, which is opened by selecting Change AES Password on the Catalog menu, allows you to
change your password to connect to the AdminStudio Enterprise Server Application Catalog (which is the same

password you use to log in to the AdminStudio Enterprise Server). The Change AES Password selection is
enabled when you are connected to the AdminStudio Enterprise Server Application Catalog.
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E

Note - If you are not connected to the AdminStudio Enterprise Server Application Catalog, the Change AES
Password selection on the Catalog menu is disabled.

Table 6-58 < Change Enterprise Server Password Dialog Box

Option Description

User Name (Read Only) User name of user who is connected to the AdminStudio Enterprise
Server Application Catalog.

Old Password Enter the existing password for current user.
New Password Enter the new password.

Confirm New Password Enter the new password a second time.

Command-Line Parameters Dialog Box

This dialog box is displayed when running Application Manager from the command line using the -? parameter.
Information in this dialog box is covered in the Application Manager Command-Line Functionality topic.

Connect Application Catalog Dialog Box

342

The Connect Application Catalog dialog box opens when you choose to open an existing Application Catalog. This
dialog box has three tabs:

e Enterprise Server—Select this tab to open the AdminStudio Enterprise Server Application Catalog
database. See Enterprise Server Tab.

e Standalone—Select this tab to open an Application Catalog database other than the AdminStudio Enterprise
Server Application Catalog. See Standalone Tab.

e Recent—Provides a list of recently opened Application Catalogs. When you select an Application Catalog and
click OK, either the Application Catalog opens or you are prompted for login information (if you need
authentication to the Application Catalog). See Recent Tab.

Making this the Default Shared Application Catalog

If you select the Make this the default shared Application Catalog option, the Application Catalog you are
opening will become the default Application Catalog (and be recorded as such in the AdminStudio Shared
directory).

If the Application Catalog is made the default, all other AdminStudio users that use the same shared directory will
automatically connect to the default Application Catalog when AdminStudio is launched. Therefore, you should
only set this option if you want to affect all AdminStudio users who access that shared directory.
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Note - In the AdminStudio Enterprise Edition, only the AdminStudio Administrator or users with the Change Default
Database permission will see the Make this the default shared Application Catalog option. This allows the
AdminStudio Administrator to configure the default Application Catalog, and then subsequent installations of
AdminStudio will automatically connect to the default Application Catalog if they use the same shared directory.

Enterprise Server Tab

To connect to the AdminStudio Enterprise Server Application Catalog, you log in on the Enterprise Server tab of
the Connect Application Catalog dialog box.

Table 6-59 * Connect Application Catalog / Enterprise Server Tab Options

Option

URL

Authentication

User Name and
Password

Description

Location of the AdminStudio Enterprise Server associated with this installation of
AdminStudio.

If the AdminStudio Enterprise Server has not yet been configured with the
AdminStudio client tools (such as when it is set to its default value of http://
Tocalhost), click the URL link to open the Select AdminStudio Enterprise Server
URL dialog box, and enter the URL for location of the AdminStudio Enterprise Server
associated with this installation of AdminStudio.

Select one of the following options:

e Windows Authentication

e AdminStudio Enterprise Server User

E

Note * When using AdminStudio Enterprise Server User authentication, if Anonymous
authentication is turned off in IIS, both the user’s machine and the AdminStudio Enterprise
Server need to be on the same domain in order for login to succeed.

If you selected AdminStudio Enterprise Server User, enter your AdminStudio
Enterprise Server User Name and Password (provided by your System
Administrator).

Login Troubleshooting

If you are using a Web Portal with custom security zone settings, your AdminStudio Enterprise Server URL is using
an IP address, and you receive Error 0x800A1518 when you attempt to login, change the AdminStudio Enterprise
Server URL to the NetBios equivalent and then try again. For example, if you are connecting to http://
120.12.1.15, the NetBios equivalent would be http://wfmportal.
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Standalone Tab

On the Standalone tab of the Connect Application Catalog dialog box and the Specify Database
Information panel of the Application Catalog Wizard, enter the information required to login to the specified
Application Catalog or enter the name of the Application Catalog that you are creating.

Table 6-60 « Connect Application Catalog / Standalone Tab Options

Option

Description

Server

Authentication

Catalog

Test

Select one of the available SQL Servers on the network from this list. You can also
manually enter the name of the SQL Server to which you want to connect.

Select one of the following options:
e Windows Authentication—Choose to use Windows network authentication
(your network login ID) to log into this Application Catalog.

e Server Authentication—Choose to use SQL Server login identification for
authentication.

e Login ID and Password—If you chose Server Authentication, enter the
appropriate Login ID and Password.
Do one of the following:

e If you are connecting to an existing Application Catalog, select the catalog from
those available on the Server.

e If you are creating a new Application Catalog, enter a name for this new catalog.

Click this button to test whether a connection can be made to the database.

Make this the
default shared
Application Catalog

Connect Application
Catalog Dialog Box
Only

When this option is selected, the Application Catalog you are trying to open or create
will become the default Application Catalog (and be recorded as such in the
AdminStudio Shared directory).

If the Application Catalog is made the default, all other AdminStudio users that use the
same shared directory will automatically connect to the default Application Catalog
when AdminStudio is launched. Therefore, you should only set this option if you want
to affect all AdminStudio users who access that shared directory.

344
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Table 6-60 « Connect Application Catalog / Standalone Tab Options (cont.)

Option Description

Create database as | Select this check box to designate this new Application Catalog as a Subscriber

a subscriber database in Application Catalog Replication (a database that receives replicated data).
When this option is not selected, or when an existing database is upgraded, the
Application Catalog is defined as a Publisher database in Application Catalog
Replication (a database that makes data available for replication).

Create Application
Catalog Wizard Only

The AdminStudio interface selectively enables/disables the Replication menu items on
the Catalog menu based upon the type of Application Catalog that is currently opened.

Edition * Application Catalog Replication is included with the AdminStudio Enterprise Edition. If
you have AdminStudio Standard or Professional Editions, this check box is disabled. Contact your
AdminStudio Sales Representative for more information.

E

Note ° This check box only appears when creating a new Application Catalog, not when logging
in to an existing Application Catalog.

Recent Tab

The Recent tab displays a list of all Application Catalogs that have recently been open. To login to one of these
Application Catalogs, select it and click OK.

e [fyou are opening a standalone SQL Server Application Catalog, you will be prompted for login information.

e If you are opening the AdminStudio Enterprise Server Application Catalog, you are prompted for AdminStudio
Enterprise Server login information before the Application Catalog will open.
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Default Application Catalog Dialog Box
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When you initially open AdminStudio, because a default Application Catalog has not yet been set, the Default
Application Catalog dialog box opens, prompting you to open an Application Catalog.

Default Application Catalog m

Adminstudio has detected that no default application catalog exists. You can set up a SQL server and create a new default application
catalog, create and connect to a new default application catalog on an existing server, or simply connect ko an existing application
catalag. ¥ou will have the option of including sample application data when creating a new application catalag.

(%) Quick Start
Select this option if no database server exists, Microsoft SQL Server 2005 Express will be installed on this machine then the
Iew Application Catalog 'Wizard will guide you through creating a new application catalog.
Strong password For new 'sa’ account: | |

) Create a new Application Catalog
If vou have access to an existing database server, select this option ko start the process of creating a new AdminStudio
application catalog.

) Connect ko an existing Application Catalog

If an Adminstudio application catalog you want to use already exists, select this option,

Cancel | [ Help
Figure 6-10: Default Application Catalog Dialog Box
You can select any of the following options:
Table 6-61 * Default Application Catalog Dialog Box Options
Option Description
Quick Start Select this option if you do not have access to a database server. Microsoft SQL

populated with sample data.

e must be at least 7 characters long,

system user name

e must not contain any of the following characters:

[1{3CH),2*1e

Server 2005 Express will be installed on your machine first, then you will have the
option to create a new Application Catalog database on that server that is

When Microsoft SQL Server 2005 Express is installed, a user named sa is
automatically created. Therefore, you need to enter a password for this account in
the Strong password for new ‘sa’ account box. A strong password:

e must be a combination of letters, numbers, and symbol characters,

e must not be a dictionary word, a command name, a person’s name, or a
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Table 6-61 « Default Application Catalog Dialog Box Options
Option Description
Create a new Select this option to create a new, empty Application Catalog on an existing SQL
Application Catalog Server database server that you have access to. You will have the option of

populating this new Application Catalog with sample data.

Connect to an existing Select this option to connect to an existing Application Catalog on an SQL Server
Application Catalog database server.

Extended Attribute Property Dialog Box

If you use extended attributes, and you click on a text extended attribute label, this dialog box opens.

Within it, you can provide the value for the extended attribute. When you click OK, the value is automatically
displayed in the Extended Attributes View next to the corresponding label.

Find Dialog Box

You can use the Find dialog box, which is accessed by selecting Find from the Edit menu, to search for data in
Application Catalog tables.

E

Note - This search is limited to string type columns.
The tables that are searched depend upon what is selected when the Find dialog box is opened:
Table 6-62 « Search Options

If you select... and specify these options... | this will be searched

Group All Tables and All Columns All tables and all columns in all of the Packages in the
selected Group

Package All Tables and All Columns All tables and all columns in the selected Package

Package A Table and All Columns All columns of a specific table in the selected Package

Package A Table and a Column A specific column in a specific table in the selected
Package

Also, if you want to search for a partial match rather than an exact match, you can use the Partial Match option on
the Find dialog box.
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The Find dialog box can be accessed in four ways:

e Select Find on the Edit menu.

® PressCtrl + F.

e Click the Find button ( ~~|)on the toolbar.

e Select the node in the tree (Group, MSI Package, OS Snapshot, Other Setup, etc.) that you want to search,
and select Find from the context menu.

The Find dialog box contains the following fields and buttons:

Table 6-63 ¢ Find Dialog Box Properties

Properties

Find What

Look In Table

Description

Enter the text that you want to search for.

e If a package was selected when the Find dialog box was opened, all of the
tables in that package are listed. Select the table that you would like to search,
or select <All Tables>. When you select a table from this list, the Look In
Columns list is populated with all of the columns in that table.

e If agroup is selected when you opened the Find dialog box, <All Tables> is
the only option listed.

Look In Columns

Partial Match

e If you selected a table from the Look in Table list, all of the columns in that
table are listed. Select the column that you would like to search, or select <All
Columns>.

e If a group was selected when you opened the Find dialog box, <All
Columns> is the only option listed.

e If this option is not selected, Application Manager will search for an exact
match of the text you entered in the Find What text box. The search will be
case sensitive.

e |[f this option is selected, then Application Manager will use appropriate wild
card characters so that a partial data match is performed. The search will be
case insensitive.
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Table 6-63 ¢ Find Dialog Box Properties
Properties Description
Find Button Click to initiate the search. The Find dialog box will close, and the data that is

found is displayed in the Search Results tab of the Output Window, in the
following format:

[ package Name Table Name Column Name | Column Data ~
DemoPlayer csmsiActionText Action AppSearch
Marton Antivirus Corporate Edition  csmsidetionText Action Appsearch
Micrasaft Corporation_Orca csmsifctionText Action AppSearch
DemoPlayer cemsisys _Validation Table AppSearch
DemoPlayer csmsisys_Validation Table AppSearch
Morkon Antiirus Corporate Edition  csmsisys_Validation Table AppSearch
Marton Antiirus Corporate Edition  csmsisys_Validation Table AppSearch 9

[<TF TP Output J Import A validate A Conflicts i Patch Impact & Package Auto Import & Search Results [/

15 nccurrencel(s) of ‘AppSearch’ have been found,

If you double click on this data, Application Manager will navigate to the
appropriate record in the Tables View, and that record will be highlighted in red.

Login Required Dialog Box

If you chose to open an existing Application Catalog that was listed on the Recent tab of the Connect Application
Catalog Dialog Box, and you are not currently logged in to that database, this dialog box opens prompting you to
log in.

Group Properties Dialog Box

The Group Properties dialog box opens when you right-click a group in the Groups tree and select Properties from
the context menu.

You can provide both a name and description for the group, as well as any comments. Information provided in this
dialog box is displayed in the Properties area of the Group view (displayed whenever a group is selected in the
main Application Manager Product View).

Table 6-64 * Group Properties Dialog Box Properties

Option Description

Name Provide a name for the group. This name cannot exceed 40 characters.

Description Enter any descriptive information about the group. This cannot exceed 80 characters.

Comments Provide any comments about the group. Comments cannot exceed 255 characters in
length.
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Package Auto Import Dialog Box

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other

users, the Package Auto Import options will be disabled.

The Package Auto Import dialog box lists the Application Catalogs and Network Directories that are being

monitored.

The Package Auto Import dialog box includes the following options:

Table 6-65 * Package Auto Import Dialog Box Options

Option

Monitored
Activities

Occurrence

Description

List of all Remote Application Catalogs and Network Directories that are being monitored for
new or updated packages. Only those items linked to the currently open Application
Catalog will be listed.

E

Note * When you initially set up a connection to a Remote Application Catalog, until the linked
packages have been imported into the local Application Catalog for the first time, the Start button is
disabled when that link is selected on the Package Auto Import dialog box. The first automatic import of
linked packages in a Remote Application Catalog is initiated when you click the Close button to exit the
Package Auto Import dialog box.

Lists how often the Application Catalog or Network Directory is going to be checked for
updated or new packages. This corresponds to the current selection made on the Options
tab of the Package Auto Import Properties dialog box for that item.

Update On

Add

Remove

Properties

Lists the last time the Remote Application Catalog or Network Directory was checked for
new or updated packages.

Click to access the Package Auto Import Wizard, where you can set up a connection to a
Remote Application Catalog or Network Directory.

Click to remove the selected Remote Application Catalog or Network Directory connection.
The packages that have already been imported into your Application Catalog will remain,
but they will no longer be automatically updated.

Click to access the Package Auto Import Properties (Remote Application Catalog)

Dialog Box or the Package Auto Import Properties (Network Directory) Dialog Box, where
you can change the update schedule interval and other options for the selected link. This
button is disabled for Remote Application Catalog entries until the linked packages have
been imported into the Application Catalog for the first time.
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Table 6-65 * Package Auto Import Dialog Box Options (cont.)
Option Description
Start Click to force an update of the selected link. Package Auto Import checks the monitored

Remote Application Catalog or Network Directory to see if there were any updated or new
packages, and then initiates an auto-import of those packages. This button is disabled for
Remote Application Catalog entries until the linked packages have been imported into the
Application Catalog for the first time.

Close Click to exit this dialog box. When you initially set up a connection to a Remote Application
Catalog or Network Directory, automatic import will be initiated when you click the Close
button.

E

Note -« If you first use the Package Auto Import Wizard to set up a connection to a package, and then use the
Package Auto Import Wizard to set up a connection to another package in the same Application Catalog, those
connections will be listed as two separate entries on the Package Auto Import dialog box. However, after the
packages have been imported into the Application Catalog, only one entry will appear for that Application Catalog.

Package Auto Import Properties (Remote Application Catalog) Dialog Box

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

The Package Auto Import Properties (Remote Application Catalog) dialog box is accessed by selecting an
Application Catalog on the Package Auto Import Dialog Box and clicking Properties.

E

Note * See also the Package Auto Import Properties (Network Directory) Dialog Box.

Groups Tab

The Groups tab displays the packages within a Remote Application Catalog that you can link to. Select or deselect
the check boxes to link/unlink to the packages. Any package that is already linked to will display the check box as
selected.
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Options Tab

The settings on the Options tab directly affect the way linked packages will be refreshed (update the contents of
packages on your local Application Catalog with packages on Remote Application Catalogs).

Table 6-66 ¢ Options Tab Properties

Properties Description

Update package when If you have selected this option:

its source is modified o
When the scheduled automatic import occurs or when you select Start on the

Package Auto Import dialog box, Application Manager will go and check if any of
the linked packages have been modified in the Application Catalog.

e If the linked package has been modified, then the local Application
Catalog database is updated to reflect the changes.

e If the linked package has not been modified, you receive a message
stating that no refresh is necessary.

If you have not selected this option:

When the scheduled automatic import occurs or when you select Start on the
Package Auto Import dialog box, Application Manager will still check to see if any of
the linked packages have been modified:

e If the linked package has been modified, Application Manager will inform
you that the source package has been modified but that it will not update the
local Application Catalog database because this option is not selected.

e |f the linked package has not been modified, you receive a message
stating that no refresh is necessary.

Delete package when  If you have selected this option, when the scheduled automatic import occurs
the source packageis | or when you select Start on the Package Auto Import dialog box, Application
deleted Manager will delete any linked data in the local database if the data is deleted from
the remote database.

If you have not selected this option, when the scheduled automatic import
occurs or when you select Start on the Package Auto Import dialog box, even if the
source package is deleted in the remote database, your copy of the package will
not be deleted.

Schedule Select this option to enable automatic import of the linked packages at scheduled
intervals. To disable automatic import, leave this option unselected. When this
option is selected, the scheduling fields are enabled.

Run the Process From this list, select Daily or Weekly to specify how often you want automatic import
to be performed.
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Table 6-66 * Options Tab Properties (cont.)
Properties Description
At Select the time of day that you want the automatic import to occur by selecting the

hour, minutes, seconds, or AM/PM setting and then clicking the up and down
arrows to adjust the setting.

Starting on Click on the arrow to open the Calendar and then select the first day that you want
automatic importing to begin.

Package Auto Import Properties (Network Directory) Dialog Box

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

The Package Auto Import Properties (Network Directory) dialog box is accessed by selecting a network directory
on the Package Auto Import Dialog Box and clicking Properties. On this dialog you can choose to monitor sub-
directories of the selected directory, and can schedule the monitor interval for this directory.

E

Note * See also the Package Auto Import Properties (Remote Application Catalog) Dialog Box .

This dialog box contains the following options:

Table 6-67 * Package Auto Import Properties (Remote Catalog)

Option Description

Folder Displays a read-only view of the network directory that is being monitored.

Monitor sub- Select this option if you want to check sub-directories of the selected directory for Windows

directories Installer packages to import.
also
Schedule Select this option to turn on automatic monitoring of the selected directory. If you do not

select this option, the network directory will only be monitored when Start is clicked on the
Package Auto Import dialog box. When the Schedule option is selected, the following fields
are activated, where you can specify the monitor interval for this directory.

® Run the process—Select whether you want to run the monitoring process Daily or
Weekly.
® At—Specify the time that you want to run the monitoring process.

e Starting on—Select the initial day that you want to begin the monitoring process.
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Publication Manager Dialog Box
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The Publication Manager lists all Publications in the SQL Server database you are currently connected to. Use this
dialog box to create, edit, publish, or delete a Publication.

E

Note * The Publication Manager option under Replication on the AdminStudio Catalog menu is only enabled

if the current user is connected to an SQL Server database, has been assigned sysadmin privileges in SQL

Enterprise Manager on that database server, and the database was identified when it was created as being intended

for use as a Publisher. See Application Catalog Wizard for information on how to identify databases as Subscribers

or Publishers.

Table 6-68 * Publication Manager Dialog Box Properties

Properties Description

Name Name of the Publication.

Description Description of the Publication.

Status The status of the last attempted update of the Publication: Succeeded or Failed. If the
update is currently being executed, Executing appears in this column.

Last Action Text describing the last action that was performed on this Publication.

Last Run The date and time that the Publication was last updated.

Next Run The next scheduled update time of that Publication.

New Click to create a new Publication using the Publication Wizard.

Edit Click to access the Publication Properties dialog box, where you can edit the selected
Publication’s name, description, scheduled update day and time, the type of data you
want to include in the Publication, the list of users allowed to access the Publication, and
the packages included in the Publication.

Run Click to manually update the selected Publication. The Publication data is replicated from
your Application Catalog to the Publisher Database Server, making it available for
Subscription.

Delete Click to delete the selected Publication from the Publication Manager.

AN

Caution -« If an attempt to create a Publication fails, it could be because your Publication server does not have a

Distributor server configured. For more information, see Initial Configuration Checklist.
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Publication Processing Dialog Box

The Publication Processing dialog box opens after you click Finish on the Publication Summary panel of the
Publication Wizard.

The Publication Processing dialog box tracks the progress of the Publication Wizard as the Publication is created,
the snapshot agent is created, the permissions are added to the Publication Access List, and articles are added to
the Publication.

When processing is finished, the new Publication is listed on the Publication Manager dialog box.

Publication Properties Dialog Box

The Publication Properties dialog box, which is accessed by clicking Edit on the Publication Manager dialog
box, allows you to edit the selected Publication’s name, description, scheduled update day and time, the type of
data you want to include in the Publication, the list of users allowed to access the Publication, and the packages
included in the Publication.

The Publication Properties dialog box contains the following tabs:
Table 6-69 * Publication Properties Dialog Box Tabs

Tab Properties

Details Tab This tab contains the following properties:

e Name—Name that identifies this Publication. This field is read-only.

e Description—Enter a description of the purpose or intended subscribers to this
Publication. This description will be listed on the Publication Manager.

e Schedule—In this field, you specify how often you would like this Publication to be
automatically updated. Click the Change button to access the Task Scheduling
dialog box, where you can specify how frequently the Subscription will be automatically
updated.

Options Tab Specify the following Publication data type options:

e Groups and Package Data—Select this option if you want to select a specific set of
packages from the various groups in the Application Catalog to include in the
Publication. If you select this option, the Publication Packages panel will appear,
prompting you to select packages to include in the Publication. If you do not select this
option, all groups and all packages within those groups will be included in the
Publication. This field is read-only.

e Merge Module Data—Select this option if you would also like to include all Merge
Modules associated with the packages you have selected in the Publication.

Access List Specify the list of users allowed to access this Publication. It initially shows a list of users

Tab who have the necessary privileges to access the Publication: those users who have been
assigned sysadmin privileges to this database server through the SQL Enterprise Manager.
You can remove users from the list. See Publication Access List Panel for more information.
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Table 6-69 * Publication Properties Dialog Box Tabs (cont.)

Tab Properties

Packages Tab If Groups and Package Data is selected on the Options tab, this tab lists the Groups and
Packages in the SQL database you are connected to. Select the packages that you want to
include in this Publication. See Publication Packages Panel for more information.

Select Application Catalog Dialog Box

The Select Application Catalog dialog box opens when you are attempting to connect to an existing Standalone
Application Catalog that requires database authentication by selecting it from a list of recently used Application
Catalogs.

e Enterprise Server—Select this tab to open the AdminStudio Enterprise Server Application Catalog
database. See Enterprise Server Tab.

e Standalone—Select this tab to open an Application Catalog other than the AdminStudio Enterprise Server
database. See Standalone Tab.

e Recent—Provides a list of recently opened Application Catalogs. When you select an Application Catalog and
click OK, either the Application Catalog opens or you are prompted for login information (if you need
authentication to the Application Catalog). See Recent Tab.

Select AdminStudio Enterprise Server URL Dialog Box

If you click the HTTP link on an AdminStudio Enterprise Server Login dialog, this dialog box opens prompting you
to identify the AdminStudio Enterprise Server URL that you would like to connect to.

Select AdminStudio Enterprise Server, URL

Select ar type the AdminStudio Enterprize Server URL that vou would like to
connect tao.

AdminStudio Enterprize Server URL:
hitp: /A172.17.5.148 v

[ ok ][ cance | [ Bep )

Subscription Manager Dialog Box

356

The Subscription Manager lists all Publications that you are subscribed to in the SQL Server database you are
currently connected to, and displays their Enable/Disable status.

Use this dialog box to view Subscription information, create a new Subscription, disable a Subscription so that it is
not automatically updated, manually update a Subscription, and delete a Subscription.

While you can subscribe to multiple Subscriptions, only one Subscription can be active and listed in your
Application Catalog at any one time: the one that has been executed (updated) the most recently. For information
on how to use the Disable feature on the Subscription Manager to subscribe to more than one Application Catalog,
see Specialized User Scenarios.
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Note * The Subscription Manager option under Replication on the AdminStudio Catalog menu is only
enabled if the current user is connected to an SQL Server database, has been assigned sysadmin privileges in SQL
Enterprise Manager on that database server, and the database was identified when it was created as being intended

for use as a Subscriber. See Application Catalog Wizard for information on how to identify databases as
Subscribers or Publishers.

The Subscription Manager dialog box contains the following properties:

Table 6-70 * Subscription Manager Dialog Box Properties

Properties Description

Publisher Name of the Publisher Database Server.

Publisher Name of the database on the Publisher Database Server containing the Publication.

Database

Publication Name of the subscribed Publication.

Description Description of the subscribed Publication that was entered by the creator of the
Publication.

Status The status of the last attempted update of the Publication: Succeeded or Failed. If the
update is currently being executed, Executing appears in this column.

Last Action Text describing the last action that was performed on this Subscription.

Last Run The date and time that the Subscription was last updated.

Next Run The next scheduled update time of that Subscription.

New Click to create a new Subscription using the Subscription Wizard.

Enable/Disable

Click to toggle the selected Subscription’s status between Enabled and Disabled. When
you disable a Subscription, you are turning off its automatic update feature.

Subscriptions that are enabled are preceded by a check mark, while disabled
Subscriptions are preceded by a red X. For more information, see Specialized User
Scenarios.

Click to manually update the selected Subscription. The Subscription Manager will then
replace the data of the Application Catalog’s currently active Subscription with the most
recent version of the selected Subscription’s data. When a disabled Subscription is
selected, the Run button is disabled. For more information, see Specialized User
Scenarios.

Delete

AdminStudio 10.0 User Guide

Click to delete the selected Subscription from the Subscription Manager.
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AN

Caution < If you are unable to receive a Subscription, the most likely cause is that the Publication has not been
published. Check to find out if the Publication has been published.

Task Scheduling Dialog Box

This dialog box is used to specify how frequently a Publication or Subscription will be automatically updated. Both
the Publication Manager and Subscription Manager require schedule information. This dialog box is invoked by
clicking the Change button on the Details panel of the Publication and Subscription Wizards, and the Details
tab of the Publication Properties dialog box.

E

Note * A Publication's update frequency can be changed after the Publication is created by accessing the Details
tab of the Publication Properties dialog box. However, a Subscription's update frequency is specified when the
Subscription is created and cannot be changed.

Table 6-71 « Task Scheduling Dialog Box Properties

Properties

Run the process every:

on

At:

Starting on:

Description

Select how frequently you want this Publication or Subscription to be
automatically updated: Day, Week, or Month.

This list offers different selections depending upon the choice you made in the
Run the process every field:

e Day—Only one selection is listed: Every Day.

e Week—Select the day of the week that you want to update this Publication or
Subscription.

e Month—Select the day of the month that you want to update this Publication
or Subscription.

Enter the time of day that you want the update to occur.

Select the day or date that you want this Publication to begin being automatically
updated on the day or date you selected from the Run the process every list.

For example, if you want the Publication to be automatically updated on the 15th
of each month, you would select the first day of the first month that you want the
automatic updates to begin, not the first day that the Publication should be
updated. If it is Monday and you want the Publication to be updated every Friday,
to have the Publication begin being updated on the upcoming Friday, you would
select the current day of the week (Monday), but if you didn’t want the Publication
to be updated until the Friday after next, you would select Saturday.

Click OK to exit the Task Scheduling dialog box.
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Test Connection Dialog Box

When you are creating a new Application Catalog using the Application Catalog Wizard, a Test button is provided
on the Specify Database Information Panel to allow you to test the connection to the selected database server
before completing the rest of the Wizard panels. When you click Test, this dialog box opens and informs you if the
connection was successful.

Virtual Package Association Dialog Box

You can choose to use the Associate Package function in Application Manager to manually associate a virtual
package with its source Windows Installer package after both packages have been imported into the Application
Catalog.

* Yirtual Package Association g|

Select a package and click 'OK' to associate the ‘Adobe Photoshop' virbual
package with an existing \Windows Installer {.msi) package in the
Application Catalog,

‘Windows Installer {.msi) Packages

=Wl Groups
[ Micrasoft Corporation_Orca +3.0,3790.0000

Cancel ] [ Help

Figure 6-11: Virtual Package Association Dialog Box

If you select a virtual package in the Application Manager tree and then select Associate Package from the
context menu, the Virtual Package Association dialog box opens, listing all of the Windows Installer packages
in the Application Catalog. Select the virtual package’s source Windows Installer package and click OK. The
Windows Installer package will now be listed in the Associated Packages list in the Application Manager Virtual
Packages view.

[

Important  After you have imported a virtual package into the Application Catalog, you can use the Associate
Package function to associate it with any Windows Installer package in the Application Catalog, even one that is not
its source package. Therefore, it is preferable to use the Import Wizard to import both the Windows Installer and
virtual packages at the same time so that AdminStudio can create the proper associations.
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Wizards
Application Manager includes the following Wizards:
® Application Catalog Wizard
e Import Wizard
e Package Auto Import Wizard
® Merge Wizard
e Publication Wizard
® Subscription Wizard
® Upgrade Wizard

Application Catalog Wizard

Welcome

360

You use the Application Catalog Wizard to create a new SQL Server Application Catalog database. This Wizard
includes the following panels:

e Welcome Panel

e Specify Database Information Panel

e Select Software Repository Location Panel
e Creating Application Catalog Panel
Panel

The first panel of the Application Catalog Wizard welcomes you to the Wizard.

This panel, and others in the Wizard, have four buttons located at the bottom of the Wizard. Depending on where
you are in the Wizard, certain buttons may be disabled.

Table 6-72 « Welcome Panel Options and Buttons

Button Description

Include Select this option to automatically populate the new Application Catalog with sample
Sample Data package data. This allows you to immediately test AdminStudio features using the packages
in New that have already been imported.

Catalog

Next Advances you to the next panel in the Wizard.

Back Moves you to the previous panel in the Wizard.

Cancel Terminates the Wizard.
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Table 6-72 « Welcome Panel Options and Buttons

Button Description

Help Brings up help specific to the Import Wizard panel currently displayed.

Specify Database Information Panel

On the Specify Database Information panel of the Application Catalog Wizard and the Standalone tab of the
Connect Application Catalog Dialog Box, enter the information required to login to the specified Application
Catalog.

Table 6-73 « Application Catalog Wizard / Specify Database Information Panel Options

Option Description

Server The list of available SQL Servers on the network. You can also manually enter the
name of the SQL Server to which you want to connect.

Authentication Select one of the following options:

e Windows Authentication—Choose to use Windows network
authentication (your network login ID) to log into this Application Catalog.

e Server Authentication—Choose to use SQL Server login identification for
authentication.

e Login ID and Password—If you chose Server Authentication, enter the
appropriate Login ID and Password.

Catalog Select the catalog from those available on the Server.

Test Click this button to test whether a connection can be made to the database.
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Table 6-73 « Application Catalog Wizard / Specify Database Information Panel Options (cont.)

Option Description
Create database as a Select this check box to designate this new Application Catalog as a Subscriber
subscriber database in Application Catalog Replication (a database that receives replicated

data). When this option is not selected, or when an existing database is
upgraded, the Application Catalog is defined as a Publisher database in
Application Catalog Replication (a database that makes data available for
replication).

The AdminStudio interface selectively enables/disables the Replication menu
items on the Catalog menu based upon the type of Application Catalog that is
currently opened.

A

Edition * Application Catalog Replication is included with the AdminStudio Enterprise
Edition. If you have AdminStudio Standard or Professional Editions, this check box is
disabled. Contact your AdminStudio Sales Representative for more information.

E

Note * This check box only appears when creating a new Application Catalog, not when
logging in to an existing Application Catalog.

Select Software Repository Location Panel

A Windows Installer package is made up of many files that are executed when the setup is run. You only import the
.msi file into the Application Catalog, not all of the files necessary for installation. With the Software Repository,
when you import an installation package into the Application Catalog, all of the files associated with that package
are copied into the Software Repository location, a directory that you specify. This allows you to manage those
files, preventing them from getting modified or lost.

On the Select Software Repository Location panel, you can choose to Enable the Software Repository for
the new Application Catalog, and specify a Proxy Account for AdminStudio to use to make modifications to the
directory path selected as the Software Repository Location.

This panel includes the following options:
Table 6-74 « Select Software Repository Location Panel Options
Option Description

Enable Software Repository Select this option to enable the Software Repository feature for this
new Application Catalog.

Software Repository Location Specify the directory location of the Software Repository for this
Application Catalog.
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Table 6-74 - Select Software Repository Location Panel Options (cont.)

Proxy Account

Option Description

Specify a Login ID and Password for AdminStudio to use when

modifying the Software Repository Location directory.

Creating Application Catalog Panel

This panel displays the progress while your new Application Catalog is being created. If the Application Catalog
cannot be created, an error message will be displayed.

Import Wizard

The Import Wizard allows you to import the following installation package types into the Application Catalog:
Windows Installer packages and associated transform and patch files, virtual packages (Microsoft App-V, VMware
ThinApp, and Citrix), merge modules, OS snapshots, Marimba Native Channel Packager files, and other non-MSI
setup formats (such as InstallShield Professional or ISMP installations).

The Import Wizard consists of the following panels:

Welcome Panel

Select Package Source Panel

Connect to a Microsoft Configuration Manager Server
Select Packages Panel

File Selection Panel

Folder Selection Panel

Associate Virtual to MSI Packages Panel

MST Source Information Panel

MSP Source Information Panel

MSM Source Information Panel

Virtual Package Import Panel

Target Package Information Panel

Target Package Information Panel (Software Repository)
Target Package Information Panel (Transforms/Patches)
Import Options Panel

Additional non-MSI Import Options Panel

Destination Group Panel
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e Summary Panel

When run, Application Manager displays its progress messages in the Import tab of the Output Window.

E

Note  Depending on configurations set in the ConflictSolver and Application Manager Options dialog box,
validation and conflict identification may take place during import. See Validating During Import and Checking for
Conflicts During Import.

Welcome Panel

You can use the Import Wizard to import the following installation package types into the Application Catalog:
e Windows Installer packages (.msi)

e Merge modules

e Marimba Native Channel Packager files (.ncp)

e Microsoft App-V applications (.sft)

e  Citrix profiles (.profile)

e ThinApp applications (.exe)

® OS snapshots (.osc)

® Other setup types

This panel, and others in the Wizard, have four buttons located at the bottom of the panel. Depending on where
you are in the Wizard, certain buttons may be disabled. The buttons are:

Table 6-75 * Welcome Panel Buttons

Button Description

Next Advances you to the next panel in the Wizard.

Back Moves you to the previous panel in the Wizard.

Cancel Terminates the Wizard.

Help Brings up help specific to the Import Wizard panel currently displayed.

Select Package Source Panel

On the Select Package Source panel of the Import Wizard, select the source that contains the applications that
you want to import.

364 ADS-1000-UG00 AdminStudio 10.0 User Guide



Chapter 6: Managing Application Catalog Databases

Reference
Import Wizard 2
Select Package Source
Select the source pou would like to browse for packages m"ﬂ
" Browse Local Machine or Mebwork for Package
&+ Browse Microsoft Syster Center Configuration Manager
" Browse a Local Machine or Metwork, for Directory of Packages
¢ Back | Mest > Cancel Help
Figure 6-12: Import Wizard / Select Package Source Panel
On the Select Package Source panel, select one of the following options:
Table 6-76 * Select Package Source Panel
Option Description
Browse Local Select this option to import a single installation package into the Application Catalog.

Machine or Network

If you select this option and click Next, the File Selection panel opens, prompting
for Package

you to browse for the file.

Browse Microsoft Select this option if you want to import applications from a Microsoft System Center
System Center Configuration Manager server.
nfiguration . . . . .
::n‘;nag:rat ° If you select this option and click Next, the Connect to a Microsoft Configuration
9 Manager Server panel opens, prompting you to connect to a server.
Browse a Local Select this option to import a directory of packages into the Application Catalog.

Machine or Network
Directory for
Packages

If you select this option and click Next, the Folder Selection panel opens,
prompting you to select the folder containing the Windows Installer and/or App-V
packages to import.
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Connect to a Microsoft Configuration Manager Server

On the Connect to a Microsoft Configuration Manager Server panel, which opens if you select Browse
Microsoft System Center Configuration Manager on the Select Package Source panel, you enter

connection information to connect to the Microsoft System Center Configuration Manager server that you want to
import applications from.

Irnport Wiizard @

Connect to a Microsoft Configuration Manager Server
Specify the connection infarmation far a Micrazoft Canfiguration Manager Server ""‘E

Server

Authentication: |Server Authentication ﬂ
Uleen REm: |testlab\testlab

Pazsword: |

< Back | Mest » | Cancel Help

Figure 6-13: Import Wizard / Connect to a Microsoft Configuration Manager Server Panel
On the Connect to a Microsoft Configuration Manager Server panel, enter the following information:

Table 6-77 « Connect to a Microsoft Configuration Manager Server Panel

Option Description
Server Enter the name of the Microsoft Configuration Manager Server that you want to
connect to.
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Table 6-77 « Connect to a Microsoft Configuration Manager Server Panel

Option Description

Authentication Choose one of the following options:

e Server Authentication—Choose this option if you want to use Microsoft
Configuration Manager Server login identification to log into this server. Then
enter the appropriate User name and Password.

e Windows Authentication—Choose this option if you want to use Windows
network authentication (your network login ID) to log into this Microsoft
Configuration Manager Server.

E

Note ° After you successfully connect to a Microsoft Configuration Manager Server, the next
time you open this panel, those previously-entered values (except the Password) will pre-
populate this panel.

After you successfully connect to a Configuration Manager Server and click Next, the Select Package panel
opens, where you will be prompted to select the packages on the server that you want to import into the
Application Catalog.

Select Packages Panel

The Select Packages panel, which opens after you successfully connect to a Configuration Manager server, lists
all of the packages in the connected Configuration Manager server, in a tree format.

Import Wizard @
Select Packages
Select the packages you want to import bo Application Catalog ""‘E
=5

SR (=] Pack.ages
Apple Computer, Inc. iTunes 45031
Microgoft Corporation Orca 1.50.2600.0000
Microzaft Corparation Orea 1.50.2600.0000
Microgoft Corporation Orca 1.50.2600.0000

o000

< Back | Mest > | Cancel Help

Figure 6-14: Import Wizard / Select Packages Panel

Select the packages that you want to import and click Next to continue. The Summary panel opens.
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File Selection Panel

On the File Selection panel, select the package file to import, and click Next. The following types of packages
can be imported:

Table 6-78 « Import Package Types

Package Type

Windows Installer Files
(*.msi)

Windows Installer Merge
Module Files (*.msm)

OS Snapshot Files (*.osc)

Native Channel Packager
Files (*.ncp)

Description

File that contains all of the information that the Windows Installer requires to
install or uninstall an application or product and to run the setup user
interface. The .ms1 file can also contain one or more transform files (.mst)
and one or more patches (.msp).

Simplified Windows Installer .msi files. A merge module cannot be installed
alone because its lacks some vital database tables that are present in an
installation database. Merge modules also contain additional tables that are
unique to themselves. To install the information delivered by a merge module
with an application, the module must first be merged into the application’s
.msi file.

Files representing a particular computer system’s contents. To generate an
OS snapshot file, use the OS Snapshot Wizard to scan a computer’s
operating system and record the files, INI files, shortcuts, and registry entries
present.

Files that are used to describe software components, their versions, their
underlying structures, and their dependence on other components.
Marimba’s NCP file is derived from an OSD (Open Software Description) file
and is currently used by Marimba’s Castanet family of products.

Microsoft App-V (*.sft)

Citrix Profiles (*.profile)

An application that runs within the Microsoft App-V virtual environment. When
a Microsoft App-V application is created, the installation data from the original
Windows Installer package is converted into an . sft file that is compatible
with Microsoft App-V version 4.5. The installation shortcuts are converted into
.osd files, which provide access to programs within the . sft file.

An application that runs within a Citrix virtual environment, which prevents it
from interfering with other software running on the same machine.

ThinApp Applications (.exe)

Other Non-MSI Setup Types

A virtual application that runs within a ThinApp virtual environment.

Non-MSI setup types (such as InstallShield Professional or ISMP
installations).
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Adding a File to the Software Repository

A Windows Installer package is made up of many files that are executed when the setup is run. However, only the
.msi file is imported into the Application Catalog database. To safeguard these additional files against alteration or
being misplaced, you can choose to manage these files using the Software Repository.

If you want to add the file to the Software Repository, select Add the file(s) to the Software Repository option
on the File Selection Panel.

E

Note - The Add the file(s) to the Software Repository option is only displayed if you are connected to an
Application Catalog that has the Software Repository enabled. See Enabling the Software Repository in an Existing
Application Catalog.

After you select this option, if AdminStudio determines that there are other files in that directory that could be
associated with the selected file, the Additional Dependencies of the Import File list appears, enabling you to
select any additional files to be managed by the Software Repository.

See Using the Software Repository for more information.

Folder Selection Panel

On the Folder Selection panel of the Import Wizard, which opens if you select Browse a Local Machine or
Network for Directory of Packages on the Select Package Source panel, you are prompted to select the
directory that contains the Windows Installer and/or Microsoft App-V packages that you want to import into the
Application Catalog.

Irnport Wizard @

Folder Selection
Specify the folder containing the packages o import, "I I'E

Select a folder containing “indows Installer or App packages to import.

|| Browse...

[ Import wWindows [nstaller packages [ms)

[ Apply Transfarm fles [ mst) located in the zame folder az an M5 file

[ Import Appy packages [ sf)

< Back | Cancel Help

Figure 6-15: Import Wizard / Folder Selection Panel
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On the Folder Selection panel, enter the following information:

Table 6-79 * Folder Selection Panel

Option

Select a folder
containing Windows
Installer or App-V
packages to import

Import Windows
Installer packages
(-msi)

Apply Transform files
(.mst) located in the
same folder as an
MSI file

Import App-V
packages (.sft)

Description

Click Browse and select the directory that contains the Windows Installer and/or
App-V packages that you want to import.

Select this option to import all of the Windows Installer packages in the selected
directory.

Select this option to also import all of the transform (.mst) files that are located in the
same directory as a Windows Installer (.msi) file.

Select this option to import all of the Microsoft App-V (sft) applications in the selected
directory.

The Import Wizard then searches the selected directory and its subdirectories to locate the packages to import.

Import Wizard’s Selection Rules When Importing Packages from a Directory

When importing packages from a directory, it is recommended that you organize the packages you want to import
in one root directory, with each package in its own first level subdirectory, such as:

= ) MyPackagesTolmport

|Z) Packagel
|0 Packanez
|0 Packane3
|20 Packane4

Figure 6-16: Recommended Directory Structure When Adding Packages from a Directory

When you select a folder (such as MyPackagesToImport), the Import Wizard scans that folder’s first-level subfolders
(such as Packagel, Package?2, Package3, etc.) and uses specific rules to determine which packages it will select for
import:

All .msi, and .sft files are selected for import—All .msi and .sft files files in the first-level subfolders are

selected for import.

If a first-level subfolder does not contain any .msi or .sft files, its subfolders are scanned —If a first-
level subfolder does not contain any .msi or .sft files, the Import Wizard will scan its child subfolders to locate
package files. However, if a first-level subfolder does contain an .msi or .sft file, its subfolders are not

scanned.
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E

Note * Once a Windows Installer or Microsoft App-V package is found, further descent through that subfolder tree
is blocked. Therefore, no other packages in that subfolder tree are imported.

Associate Virtual to MSI Packages Panel

This panel opens if you are importing a virtual package and its source Windows Installer package exists in the
Application Catalog. If this Windows Installer package has been imported into more than one location in the
Application Catalog, multiple packages are listed.

Virtual packages are self-contained entities which ordinarily cannot be modified after they are created. By
associating a virtual package with the Windows Installer package which originated it, you have the convenience of
being able to easily locate the virtual package’s originating Windows Installer package, modify the original
Windows Installer package, and then regenerate the virtual package.

Select the package that you want to associate with the virtual package you are importing and click Next to
continue.

Import Wizard @
Aszociate Yirtual to M51 Packages
E stablizh azzociation among related packages. m‘a

The wirtual package includes zome meta data which can be uzed to optionally azzociate the
wirtual package with a MSI package in the Application Catalog. Y'ou may optionally select a
best-fit b5 package from the list shown to establish this azzociation.

Mame, Yersion:  Or'ca, 3.0.3730.0000

M anufacturer: Microzoft C'orporation

PackageCode:  {4BD34312-7889-4192-4204-076223B8CECC)
Matching Application Catalog Packages

Group Mame “ersion M anufacturer
Sample Group Orca 3.0.3790.0000  Microzoft Corporation

< Back " Mext » ][ Cancel ][ Help

0

Important « During virtual package conversion, AdminStudio 9.0 and later creates a file, metadata.ami, that

contains metadata identifying the original Windows Installer package that was used to create the virtual package.
However, if the virtual package was created by a method other than the AdminStudio 9.0+ conversion process, this
metadata file will not have been created and this Associate Virtual to MSI Packages panel will not be displayed.

MST Source Information Panel

If you are importing a Windows Installer package, you can include additional transforms to be imported along with
it.
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When the MST Source Information panel opens, all of the .mst files that are in the same directory as the
Windows Installer file you are importing are automatically listed in the Transform Files (.mst) list, but only those
.mst files that AdminStudio determines are probably applicable to this Windows Installer package are selected to
be included in the import. If you do not want to import a selected .mst file, clear the selection.

You can also add additional transform files:

Task:

To add transform files:

1. Click the Browse (|5

) button in the Transforms area and select the transform file that you want to import.
2. If the package requires multiple transforms, you can repeat the procedure as necessary.

3. The order in which transforms are applied can be changed by selecting a transform and clicking the up and
down arrows.

4. If you need to delete a transform you have added, clear the check box.

5. Click Next to continue.

MSP Source Information Panel

Task:

372

If you are importing a Windows Installer package, you can include additional patches to be imported along with it.
If a patch file was already in the same directory as the Windows Installer file you are importing, that patch file will
automatically appear in the Patches (.msp or .exe) list. If you do not want to import it, clear the selection.

E

Note - If you specify an update.exe patch file that was created by Developer/DevStudio/InstallShield Editor,
Application Manager will extract the .msp file in the Temp folder and then perform the import.

You can also add additional patch files:

To add patch files:

1. Click the Browse ([#"1]) button in the Patches area and select the patch file that you want to import.
2. If the package requires multiple patches, you can repeat the procedure as necessary.

3. The order in which patches are applied can be changed by selecting a patch and clicking the up and down
arrows.

4. If you need to delete a patch you have added, clear the check boxes.

5. For patches to be applied to a Windows Installer package, it is necessary to perform an Administrative install
of the Windows Installer package and then perform an Administrative install of each patch package one by
one. This way, the content of each patch package is appended to the Windows Installer package at the
Administrative install location.
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Therefore, next to the Specify the location for Administrative install box, click the Browse button and
specify a directory to provide Application Manager with the location where an Administrative Install of selected
Windows Installer package will be performed.

Click Next to continue.

MSM Source Information Panel

If you are importing a Merge Module by selecting a Merge Module on the Merge Modules tab and selecting
Import Merge Module from the context menu, this panel opens, allowing you to import multiple Merge Modules
into the Application Catalog at one time.

Task: To import merge modules from the Merge Modules tab:

1.

2.

10.

E

Open Application Manager.
Open the Merge Modules tab.

Select the root Merge Module or one of the imported Merge Modules and select Import Merge Module from
the context menu. The MSM Source Information panel of the Import Wizard opens.

Click the Browse ([#"%
import.

) button in the Merge Modules area and select the merge module file that you want to

To import multiple patches, you can repeat the procedure as necessary.

The order in which merge modules are applied can be changed by selecting a merge module in the list and
clicking the Move Up and Move Down arrows.

If you need to delete a merge module you have added, clear its check box.

If you want to store this merge module in the Software Repository, select the Add the file(s) to the Software
Repository option.

Click Next. The Summary panel opens.
Click Finish to accept these options and begin the import.

A report of the import process appears on the Import tab in the Output window.

Note ° You can also import a Merge Module into the Application Catalog by selecting Import Package on the
Catalog menu. However, using that method, only one Merge Module can be imported at a time.

Virtual Package Import Panel

This panel opens if the Import Wizard finds a virtual package in the same directory as the Windows Installer
package you have selected to import.
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The Import Wizard searches the selected package’s folder and subfolders for virtual packages created by
AdminStudio. If a virtual package is found that appears to have been created by AdminStudio, then it will be listed
on this panel.

Import Yifizard @
¥irtual Package Import
Chooze additional wirtual packages to import, """E

The ‘Windows |nstaller Package [.msi] appears to have azsociated virtual packages. Specify
whether you want to include theze virual packages in the import process.

¥ Impart Microzoft AppY package from:
|EI:\AdminStudio Shared\Packages\DrcaiippPackagehDrca_v14\Orca.sft

-

¥ Impart Citris: package: from:
|EI:\AdminStudio Shared\Packages\DrcatCitrixProfilehOrca\0rca. profile

< Back | Mext » | Cancel | Help |

Figure 6-17: Import Wizard / Virtual Package Import Panel

Select the package or packages you want to import into the Application Catalog and click Next to continue.

E

Note - If a virtual package created by AdminStudio exists in a directory other than the one that contains the
selected Windows Installer package, it will not be listed on this panel. After the import of the selected Windows
Installer package is complete, you can use the Import Wizard to import virtual packages separately, as described in
Importing Virtual Packages. You would then be prompted to associate the virtual package with its already-imported
source Windows Installer package.

Target Package Information Panel

374

This panel opens if you are attempting to import a package that has been identified as a duplicate to a package
that is already in the Application Catalog (and is not stored in the Software Repository). The identification of a
duplicate package is based upon the identifiers selected on the Duplicate Package tab of the ConflictSolver and
Application Manager Options Dialog Box.

An automatically generated new name is displayed in the Package Name field. You can either accept this
generated name or enter a name of your choosing to identify the duplicate package before the package is
imported.

E

Note * The name that is entered on the Package Name field is the name that will be displayed in the product tree
on the left side of the ConflictSolver and Application Manager views. However, changing this “display” name does
not change the Product Name that appears in the title bar of the ConflictSolver and Application Manager Product
Views.
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Target Package Information Panel (Software Repository)

This panel opens if you are attempting to import a package that has been identified as a duplicate to a package
that is already in the Application Catalog (and is stored in the Software Repository). The identification of a duplicate
package is based upon the identifiers selected on the Duplicate Package tab of the ConflictSolver and
Application Manager Options Dialog Box.

An automatically generated new name is displayed in the Package Name field. Because this package is part of
the Software Repository, you have several options:

® The package should be treated as a new version of the existing package

® The package should be treated as a new package named [the name entered in the Package Name field]
® The package should overwrite the existing package version

Make your selection and click Next.

For more information, see Using the Software Repository.

E

Note * The name that is entered on the Package Name field is the name that will be displayed in the product tree
on the left side of the ConflictSolver and Application Manager views. However, changing this “display” name does
not change the Product Name that appears in the title bar of the ConflictSolver and Application Manager Product
Views.

Target Package Information Panel (Transforms/Patches)

This panel opens if you are attempting to import a transform or patch file that has been identified as a duplicate to
a file that is already in the Application Catalog (and is stored in the Software Repository).

e Updated file—If this file is an updated version of a transform or patch file that has already been imported into
the Application Catalog, select the Reimport new version of the package with this file change option.

o File associated with a different package—If this file has the same name as a transform or patch file that
has already been imported into the Application Catalog, but is not associated with the same Windows Installer
package as the existing file, select the group that contains the Windows Installer package that this file is
associated with.

Import Options Panel

The Import Options panel allows you to select custom tables that are not part of a standard Windows Installer
package, and direct Application Manager to import them. Indicate which custom tables you want to import by
selecting the check box next to the table name. You can also use the Select All and Clear All buttons to make
selections.

To add one of the listed tables to the Ignore Tables list on the Import tab of the ConflictSolver and Application
Manager Options Dialog Box (so that it will not be imported into the Application Catalog during any import), select
the table name and click Add to Ignore List.
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Additional non-MSI Import Options Panel

If you are importing a non-Windows Installer package, it is necessary to enter a name for the package and the base
directory for the package (where all of its installation files are located).

Table 6-80 * Import Wizard / Additional non-MSI Import Options

Options Description
Product Name Enter a name to identify this package in AdminStudio.
Directory Click the Explore button to select the base directory of this package where all of its

associated files can be found.

Include entire Select this option to include the selected directory and all of its subdirectories.
directory hierarchy

Destination Group Panel

The Destination Group panel allows you to specify the group (or groups) into which you want to import the MSI
package.

You also have the option of selecting all groups by clicking the Select All button, or deselecting groups by clicking
the Clear All button. If a group you want to import the package into does not exist, click the New button to create
and configure it in the Group Properties dialog box.

E

Note ° This panel is only displayed when launching the Import Wizard from the Catalog menu. If you right-click on a
group in the Application Manager Product View and import a package or snapshot, the destination group will be
group on which you right-clicked.

Summary Panel

Before executing the import, review the information in the Summary panel about the options selected in the
previous panels.

Depending on the import type and how the Import Wizard was invoked, clicking Back returns you to the
Destination Group panel, MSM Source Information panel, OS Snapshot Information panel, or Other Setup
Installation Files panel. Click Finish to begin import.

Package Auto Import Wizard

E

Note * To use the Package Auto Import feature, you must have AdminStudio 10.0 Administrator permission. For all
other users, the Package Auto Import options will be disabled.
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The Package Auto Import feature allows you to copy packages between various Application Catalogs and maintain
consistency between the copied packages. This allows you to maintain multiple Application Catalogs that match
your corporate organization and optimize the performance of AdminStudio.

The Package Auto Import Wizard consists of the following panels:
e Welcome Panel

e Package Auto Import Type Selection Panel

e Remote Link Application Catalog Panel

e Folder Panel

e Groups Panel

® Schedule Panel

® Summary Panel

When run, Application Manager displays the output report in the Package Auto Import tab of the Output Window.

E

Note ° You can use the Package Auto Import Wizard to copy Windows Installer packages (.msi), legacy
applications (.exe), and Microsoft App-V applications (.sft) between various Application Catalogs. However, the
Package Auto Import Wizard does not support copying Citrix XenApp profiles or VMware ThinApp applications.

Tip * When you link to a package in a remote Application Catalog, Application Manager connects to the remote
Application Catalog and imports a package into the local Application Catalog. In order for Package Auto Import to
work properly, both the remote Application Catalog and the remote package file must be accessible to the linked
users at all times. In other words, both the remote Application Catalog and all of the package files that have been
imported into it must be able to be accessed by linked users via a shared network drive.

Welcome Panel

The first panel of the Package Auto Import Wizard welcomes you to the Wizard.

This panel, and others in the Wizard, have four buttons located at the bottom of the Wizard. Depending on where
you are in the Wizard, certain buttons may be disabled. The buttons are:

Table 6-81 * Welcome Panel Buttons

Button Description

Next Advances you to the next panel in the Wizard.
Back Moves you to the previous panel in the Wizard.
Cancel Terminates the Wizard.
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Table 6-81 * Welcome Panel Buttons

Button Description

Help Brings up help about the specific Package Auto Import Wizard panel.

Package Auto Import Type Selection Panel

On this panel, select the type of monitoring process that you want to configure. Select one of the following options:

e Remote Application Catalog—Monitor packages in a Remote Application Catalog and automatically
import/re-import those packages at scheduled intervals. Application Manager can link to one or multiple
Application Catalogs, and can link to one or multiple packages within those Application Catalogs.

e Network Directory—Automatically import or re-import all packages in a monitored network directory into
your Application Catalog at scheduled intervals.

E

Note ° You can use the Package Auto Import Wizard to copy Windows Installer packages (.msi), legacy
applications (.exe), and Microsoft App-V applications (.sft) between various Application Catalogs. However, the
Package Auto Import Wizard does not support copying Citrix XenApp profiles or VMware ThinApp applications.

Remote Link Application Catalog Panel

The Remote Link Application Catalog panel of the Package Auto Import Wizard lists Application Catalogs that you
have recently accessed.

To select the Application Catalog that you want to link to, you can perform either of these options:
® Select the Application Catalog you want to link to from the Catalogs list.

e (Click Browse to open the Select Application Catalog Dialog Box and connect to an existing Application
Catalog as described in Connecting to an Existing Application Catalog.

During the linking process of an SQL Server Application Catalog, Application Manager will save the name of the
database server, authentication mode, and name of the Application Catalog. Passwords are not saved.

Folder Panel

378

On the Folder panel, use the Browse button to select the network directory folder that you want to monitor.

To also monitor the selected folder’s subfolders, select the Also include sub-directories option.

E

Note * While you are permitted to enter a local directory (rather than a network directory) as the monitored
directory, this might cause problems if a person monitoring this directory has the same directory on his local
machine. For example, if a directory named C: \MyAppCatalogs is chosen to be the monitored directory, and a
person who choose to monitor this directory also has a directory on his local machine named C: \MyAppCatalogs,
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Application Manager would monitor that person's local directory rather than the directory that was chosen to be the
monitored directory.

E

Note - If you select this option, when packages in subdirectories are imported into your Application Catalog, they
will be placed in groups that maintain the folder hierarchy. For example, if you are monitoring a directory named
Marketing, and that directory has a subdirectory named Graphics that contains packages, when those packages
are imported into your Application Catalog, they will be placed in the Graphics subgroup of the destination group.

Groups Panel

The Groups panel of the Package Auto Import Wizard lists the group structure and the packages that are in the
specified Remote Application Catalog. Choose the packages that you want to link to by selecting the check box
next to the package name.

Click Next to continue.

E

Note - You can use the Package Auto Import Wizard to copy Windows Installer packages (.msi), legacy
applications (.exe), and Microsoft App-V applications (.sft) between various Application Catalogs. However, the
Package Auto Import Wizard does not support copying Citrix XenApp profiles or VMware ThinApp applications.

Destination Group Panel

When you are setting up Network Directory monitoring, the Destination Group panel opens, prompting you to
select the Application Catalog group into which the packages will be imported.

Select the group in the Application Catalog where you want these packages to be imported, and click Next.

E

Note ° Packages that are imported using Remote Application Catalog monitoring are imported into the Package
Auto Import group in the Application Catalog.

Schedule Panel
On the Schedule panel of the Package Auto Import Wizard you can choose to enable automatic import of linked

packages (or packages in a monitored Network Directory), and can also specify how often the Remote Application
Catalog or Network Directory will be checked for updates.
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The following options are included:

Table 6-82 « Schedule Panel Properties

Option

Schedule AdminStudio
to update the changed
packages

Description

Select this option to enable automatic import of the linked packages (or
packages in the monitored Network Directory) at scheduled intervals. When this
option is selected, the rest of the scheduling fields on this panel are enabled.

Run the process

At

Starting on

Summary Panel

Select Daily or Weekly to specify how often you want the Remote Application
Catalog or Network Directory to be checked for updates.

Select the time of day that you want the automatic import to occur by selecting
the hour, minutes, seconds, or AM/PM setting and then clicking the up and down
arrows to adjust the setting.

Click on the arrow to open the Calendar and then select the first day that you
want automatic importing to occur.

The Summary panel provides a detailed summary of the options that were selected in the previous panels of the
Wizard. Click Finish to complete the remote link. Clicking Back returns you to the previous panel.

Merge Wizard

The Merge Wizard, available by clicking Merge on the Catalog menu, allows you to merge application data
between two Application Catalogs.

The source Application Catalog’s data is merged into the currently open Application Catalog. This is a one-time-
only database merge. The merged data is not linked in any way to the source Application Catalog.

Merging could be used in an organization where multiple people test packages. After the packages have been
tested, all of the “tested” applications could be consolidated into one centralized Application Catalog. Another
reason to merge Application Catalogs would be a need to have the same data available in multiple geographic
locations.

The following panels are included in the Merge Wizard:

380

Welcome Panel

Source Application Catalog Panel

Groups Panel

Progress Panel
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E

Note ° You can use the Merge Wizard to merge Windows Installer packages (.msi), legacy applications (.exe), and
Microsoft App-V applications (.sft). However, the Merge Wizard does not support merging Citrix XenApp profiles or
VMware ThinApp applications.

Welcome Panel

The Merge Wizard allows you to merge application data between two Application Catalogs. The source Application
Catalog’s data is merged into the currently open Application Catalog.

The first panel in the Merge Wizard is the Welcome panel. Click Next to proceed to the Source Application
Catalog panel.

Source Application Catalog Panel

The Source Application Catalog panel lists of all of the Application Catalogs that the user has permission to
view. Select the Application Catalog that contains the data that you want to merge.

If the Application Catalog that you select requires additional authentication, the Select Application Catalog Dialog
Box opens. Connect to that catalog as described in Connecting to an Existing Application Catalog.

Groups Panel

From the Groups panel, you can select the Windows Installer packages, legacy applications, and Microsoft App-V
applications that you want to merge. Selecting a Group icon selects all of the applications in that group.

The available groups displayed are from the source Application Catalog, and data from the selected groups will be
merged into the current Application Catalog. If you select the option to Replace duplicate application data, if a
duplicate package exists in the current Application Catalog, the source Application Catalog’s package will
overwrite the duplicate.

E

Note ° You can use the Merge Wizard to merge Windows Installer packages (.msi), legacy applications (.exe), and
Microsoft App-V applications (.sft). However, the Merge Wizard does not support merging Citrix XenApp profiles or
VMware ThinApp applications.

Progress Panel

The Progress panel displays messages from the merge process.

When the merge is complete, review the log as necessary and click Finish to exit the Wizard.
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OS Snapshot Wizard

The following topics contain information about each Wizard panel and dialog box available through the OS
Snapshot Wizard. The help topics in this reference are the same detailed documentation that is displayed when
you press the F1 key or click the Help button while working in a Wizard or dialog box.

Select one of the following links for OS Snapshot reference information:
e Welcome Panel

® Project Information Panel

® Analyzing Panel

® OS Snapshot Summary Panel

® Analysis Options Dialog Box

ISSnapshot.ini File

Welcome Panel

The Welcome panel appears when you first launch the OS Snapshot Wizard, providing some introductory
information about the use of the OS Snapshot Wizard.

The Next button advances you to the Project Information panel.

Project Information Panel

The Project Information panel gathers information necessary for taking the OS Snapshot.

You must provide the following information before the Start button is enabled, allowing you to take the snapshot.
Table 6-83 ¢ Project Information Panel Options

Option Description

OS Snapshot project name Provide a name for the snapshot file (.osc).

OS Snapshot project Provide the directory in which snapshot data will be stored. Either enter the

folder path in the field, or click the Browse (...) button to navigate to it. If the directory
already exists, a confirmation dialog box opens when you click the Next
button.

If you want to review or change current capture settings, click Edit to display the Analysis Options dialog box.

Analyzing Panel

The Analyzing panel appears while the OS Snapshot Wizard analyzes your system.

Following the snapshot, the Summary panel appears.
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OS Snapshot Summary Panel

At the end of the OS Snapshot process, the Summary panel is displayed, containing information about the OS
Snapshot that was just performed.

Prior to clicking Finish, review the information to ensure the snapshot contains the data you expected.

Following the OS Snapshot process, you can import the snapshot into the Application Catalog and use it as a
baseline to which setups can be compared.

AN

Caution * OS Snapshots should only be used for comparison in ConflictSolver. You should never attempt to
convert an OS Snapshot into an MSI package.

Analysis Options Dialog Box

The Analysis Options dialog box, accessible by clicking Edit from the Project Information panel, allows you to
specify capture types for the OS snapshots.

You can select the following:
e Files

e NI files

® Shortcuts

® Registry data

Additionally, you can restrict directory analysis to specific directories, which can significantly improve OS Snapshot
Wizard performance. Click New to add a directory restriction, edit to modify an existing restriction, or delete to
remove a restriction.

Options set in this dialog box apply to the current and subsequent snapshot sessions.

ISSnapshot.ini File

The ISSnapshot.ini file is the default exclusion file for the OS Snapshot Wizard. It contains exclusions to be applied
when capturing an OS snapshot, and mainly focuses on specific items that should not be included in applications,
such as InstallShield Professional-specific COM settings and OS Snapshot-specific registry entries.

The file is located in the Windows folder, and can be edited using the Exclusions Editor, or using a text editor. See
Exclusions Editor Interface.

E

Note - It is strongly recommended that you not modify this file, as it increases the likelihood of either inadvertently
omitting necessary pieces of the OS snapshot, or including registry entries or files that should not be part of the
snapshot.
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Publication Wizard

The Publication Wizard for Application Catalog Replication walks you through the process of creating an SQL
Server Publication from an Application Catalog database.

The Publication Wizard consists of the following panels:

Welcome Panel

Publication Details Panel

Publication Data Options Panel

Publication Access List Panel

Publication Packages Panel

Publication Summary Panel

Welcome Panel

384

The first panel of the Publication Wizard welcomes you to the Wizard.

This panel, and others in the Wizard, have four buttons located at the bottom of the Wizard. Depending on where
you are in the Wizard, certain buttons may be disabled. The buttons are:

Table 6-84 * Welcome Panel Buttons

Button Description

Next Advances you to the next panel in the Wizard.
Back Moves you to the previous panel in the Wizard.
Cancel Terminates the Wizard.

Help Brings up help about the specific Wizard panel.

ADS-1000-UG00

AdminStudio 10.0 User Guide




Chapter 6: Managing Application Catalog Databases
Reference

Publication Details Panel

On the Publication Details panel, you are prompted to enter basic Publication properties of name, description,
and the schedule. The Publication Details panel contains the following fields:

Table 6-85 ¢ Publication Wizard / Publication Details Panel Options

Option Description

Name Enter a name to identify this Publication. If you enter a duplicate name of an existing
Publication, you will receive an error message.

AN

Caution * The Publication Name cannot be a T-SQL reserved word.

Description Enter a description of the purpose or intended subscribers to this Publication. This
description will be listed on the Publication Manager.

Schedule In this field, you specify how often you would like this Publication to be automatically
updated. When a Publication is updated, all of its data is replaced by replicated data from the
Publisher’s local Application Catalog database.

This field is not directly editable. Click the Change button to access the Task Scheduling
dialog box, where you can specify how frequently a Publication will be automatically
updated.

Publication Data Options Panel

The Publication Data Options panel prompts you to specify the particular types of data to include in the
Publication. This panel contains the following fields:

Table 6-86 * Publication Wizard / Publication Data Options Panel Properties

Properties Description
Groups and Select this option if you want to select a specific set of packages from the various
Package Data groups in the Application Catalog to include in the Publication. If you select this option,

the Publication Packages panel opens, prompting you to select packages to include
in the Publication. If you do not select this option, all groups and all packages within
those groups will be included in the Publication.

Merge Module Select this option if you would also like to include all Merge Modules in the Application
Data Catalog in the Publication.
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Publication Access List Panel

On the Publication Access List panel, you specify the list of users allowed to access this Publication. It initially
shows a list of users who have the necessary privileges to access the Publication: those users who have been
assigned sysadmin privileges to this database server through the SQL Enterprise Manager. You can remove users
from the list.

The Publication Access List panel contains the following options:
Table 6-87 « Publication Wizard / Publication Access List Panel Options

Option Description

Type Displays an icon to identify each listing as either a user or a group.
Name Lists the name of the user or group.

Remove | Click to remove a user or group from the list. If a user is removed from the list, they will no longer be
able to access the Publication, but they still would be able to be a user of the SQL Server and
Publication database.

AN

Caution * Only users that have been assigned sysadmin privileges in SQL Enterprise Manager to the connected
database server can establish the Publisher-Subscriber relationship between the databases and are therefore listed
on this panel. You can remove a user from this list (so that they will not be able to access this Publication), but you
cannot add additional users to this list using AdminStudio. To add new users, you must use SQL Enterprise
Manager.

Click Next to access the Publication Packages panel (if you selected the Groups and Package Data option on
the Publication Data Options panel) or the Publication Summary panel if you did not select that option.

Publication Packages Panel

386

On the Publication Packages panel, the Groups and Packages in the Application Catalog you are connected to
are listed. Select the packages that you want to include in this Publication.

AN

Caution * You do not have to include all of the packages in the Application Catalog in this Publication. However,
when this Publication is replicated in the Subscriber's Application Catalog, all of the Groups in the Publisher's
Application Catalog will be listed, even if they do not contain any packages.

AN

Caution * When a user subscribes to this Publication, they are subscribing to all of the packages in all of the
Groups that the Publisher has included. However, if the Publisher adds a new package to one of these same Groups

after he has created the Publication, the new package is not automatically added to the existing Publication, making
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it unavailable for Subscription. To publish this new package, a new Publication would have to be created or an
existing Publication would have to be edited.

E

Note ° This panel only appears if you selected the Groups and Package Data option on the Publication Data

Options panel.

Publication Summary Panel

This panel provides a detailed summary of the options that were selected in the previous panels of the Wizard

The Publication Summary panel contains the following options:

Table 6-88 * Publication Wizard / Publication Summary Panel Options

Option

Description

Generate publication as
script

Publish the publication
immediately after
creation

To generate an SQL script of the code necessary to create this Publication rather
than actually create it, select this option and enter a path name for the script file.
For more information, see Replicating Application Catalogs in Controlled SQL
Database Environments.

To publish this Publication immediately after the Publication Wizard is finished,
select this option. The name of this Publication would be listed on the Publication
Manager with a status of Executing, and the Publication data would be replicated
from your Application Catalog to the Publisher Database Server—making it
available for Subscription immediately.

If you do not select this option, you would have to click Run on the Publication
Manager to publish this Publication manually, or the Publication would
automatically be published on its scheduled date.

Click Finish to complete the creation of this Publication.

Subscription Wizard

The Subscription Wizard for Application Catalog Replication walks you through the process of creating an SQL
Server Subscription to an Application Catalog database.

The Subscription Wizard consists of the following panels:

e Welcome Panel

® Subscription Details Panel

® Subscription Selection Panel

® Subscription Summary Panel
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Welcome Panel

The first panel of the Subscription Wizard welcomes you to the Wizard. This panel, and others in the Wizard, have
four buttons located at the bottom of the Wizard. Depending on where you are in the Wizard, certain buttons may
be disabled. The buttons are:

Table 6-89 * Welcome Panel Buttons

Button Description

Next Advances you to the next panel in the Wizard.
Back Moves you to the previous panel in the Wizard.
Cancel Terminates the Wizard.

Help Brings up help about the specific Wizard panel.

Subscription Details Panel

On the Subscription Details panel, you are prompted to enter connection information for the Publisher database
and scheduling information. This panel contains the following fields:

Table 6-90 * Subscription Details Panel Properties

Properties Description

Database From the Catalogs list, select the Publisher Application Catalog you want to subscribe to, or
click Browse to open the Select Application Catalog Dialog Box and connect to an existing
Publisher Application Catalog as described in Connecting to an Existing Application Catalog

E

Note * You must connect to a SQL Server database that was identified as being intended for use as a
Publisher when it was created. See Application Catalog Wizard.

Schedule In this field, you specify how often you would like this Subscription to be automatically
updated. When a Subscription is updated, all of its data is replaced by replicated data from
the Publisher database.

This field is not directly editable. Click the Change button to access the Task Scheduling
dialog box, where you can specify how frequently the Subscription will be automatically
updated.
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Subscription Selection Panel

The Subscription Selection panel displays the Publications available from the selected Publisher database that
satisfy the Publication Access List requirements for the currently connected user. In other words, it lists the
Publications that this user has permission to subscribe to.

Select one Publication from this list to subscribe to and click Next to continue to the Summary panel.

Subscription Summary Panel

This panel provides a detailed summary of the options that were selected in the previous panels of the Wizard.

To generate an SQL script of the code necessary to create this Subscription rather than actually create it, select the
Generate subscription as script option and enter a path name for the script file. For more information, see
Replicating Application Catalogs in Controlled SQL Database Environments.

Click Finish to complete the creation of this Subscription.

Upgrade Wizard
When you attempt to open an AdminStudio 5.0, 5.5, 6.0, 7.0, or 7.5 Application Catalog in AdminStudio 10.0, you
are prompted to upgrade it to use the AdminStudio 10.0 schema.
Log files for the upgrade are created in the following directory:

AdminStudio Shared Directory\ConflictSolver\Logs

E

Note ° Note the following regarding upgrading an existing Application Catalog:

The upgrade of AdminStudio 3.0, 3.01, and 3.5 databases is not supported by AdminStudio 7.0 or later.
Starting with AdminStudio 8.0, Microsoft Access databases are not supported.
Starting with AdminStudio 9.01, Oracle databases are not supported.

When an SQL Server Application Catalog database is upgraded, the old tables are not dropped from the
Application Catalog.

The Upgrade Wizard consists of the following panels:

e Welcome Panel—Initial panel displayed when the Upgrade Wizard is launched. Click Next to proceed with
the upgrade.

® Progress Panel—Displays the results of the upgrade. Click Finish to exit the Upgrade Wizard.
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Upgrading Pre-AdminStudio 5.0 Application Catalogs

Pre-AdminStudio 5.0 Application Catalogs cannot be upgraded automatically by AdminStudio 7.0 or later.
However, you can upgrade them using the Legacy Upgrade Wizard, a standalone utility that was included with
AdminStudio 7.0 and 7.5. The Legacy Upgrade Wizard utility is installed in the following directory:

C:\Program Files\InstallShield\AdminStudio\7.x\Common\LegacyUpgradeWizard.exe

If you do not have a copy of AdminStudio 7.0 or 7.5 available to you, contact Technical Support.

Database Server Permissions

In order to operate some AdminStudio tools, AdminStudio users require specific database permissions.
Depending upon the type of user, you may wish to be more selective in the permissions you assign to these users.

If you have AdminStudio Enterprise Edition, you can assign permissions to individual users using the Role
functionality in AdminStudio Enterprise Server, as described in AdminStudio and Workflow Manager Roles and
Permissions. Otherwise, you can provide more selective restrictions at the database server level using the
information in the following table, AdminStudio Database Server Permissions.

Every AdminStudio user will need at a minimum read privilege to every table in the Application Catalog. The
minimum permissions are described below, based upon the type of operation you want the user to perform.

Table 6-91 ¢+ AdminStudio Database Server Permissions

Type Description

General User General administrative processes cover a range of activities such as adding groups,
Administrative moving packages around, adding comments, updating extending attributes, etc. For
Process example, these tables include cstblPackage, cstblGroups, and

cstblGroupPackages Any Application Catalog table which is not referenced
explicitly in the discussion for the other AdminStudio processes should be
considered a general user administrative table.

Most AdminStudio users should have write access to these tables.
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Table 6-91 « AdminStudio Database Server Permissions (cont.)

Type

Import Process

Validation Process

Dependency
Scanning Process

Conflict Detection
and Resolution
Process

Patch Impact
Analysis Process

Package Auto Import
Process

Workflow Operations
Process

Tools Properties
Operations

Description

The user importing MSI packages, merge modules, or just about anything will
require write access to a significant set of Application Catalog tables depending on
the type of import. For example:

e MSI package file—For MSI package file import operations, those Application
Catalog tables with a esmsi prefix are populated.

e Merge modules—For merge module import operations, the esmsm prefixed
tables are used.

e Patches—For patch import operations, the espch prefix tables are used.

e OS snapshots—For OS snapshot import operations, the osc prefix tables are
used.

Occasionally, the Import process will need to create new tables in the Application
Catalog to support the import of custom table data. Either the necessary server
privileges need to be given for these users, or the import of custom table data needs
to be disabled within the Application Manager Options dialog box.

For this process, the user will need to be able to write entries into the
cstblValidationResults and cstblIValidationConfiguration tables.

For this process, the user will need to be able to write entries into the
cstbiPackageExeDependencies table.

For this process, the user will need to be able to write entries into the cstblConflict
prefixed table names.

For this process, the user will need to be able to write entries into the
cstblPatchConflict prefixed table names. This process will create and delete some
temporary tables and, as such, the user performing this process should have the
necessary server privileges to perform these operations.

The Package Auto Import process will ultimately generate a series of Import
operations, and so the user performing these operations should have the Import
process rights described above.

If the user wants to edit these operations in the Wizard, then they will need write

accession to the cstblSubscribed prefixed tables.

For this process, the user will need to be able to write entries into the wftbl prefixed
table names.

For this process, the user will need to be able to write entries into the wftblTools
table name.
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Table 6-91 « AdminStudio Database Server Permissions (cont.)

Type Description

Job Manager For this process, the user will need to be able to write entries into the As prefixed
Process table names.

Pre-Deployment For this process, the user will need to be able to write entries into the pdt prefixed
Testing table names.

E

Note * A number of processes within AdminStudio generate data which can subsequently be deleted by the
AdminStudio user. Any discussion of the minimum privileges required for a specific AdminStudio process will also
imply the privileges to delete this same data.

Application Manager Command-Line Functionality

392

E

Note - If you invoke Application Manager using the command line iscmide.exe without passing any parameters,
Application Manager will launch in Ul mode.

i:}

Tip By default, all packages are imported into the root group. If you want to import packages to specific groups,
you must use a configuration file (-C parameter), and specify a group for each package.

ConflictSolver and Application Manager support the following command-line parameters. These parameters are
case-insensitive, and must be preceded with either a dash symbol (-) or a forward slash (/).

Table 6-92 « Command Line Parameters

Command Line Parameter & Examples Description

-? Displays version information and help text for command-

. . 5 line parameters.
1scmide.exe -«

-C"configuration_file_name" The name and location of a configuration file (.ini)

iscmide. exe co.ntalnlng a'ny re<:'|U|re.d parameters for import. If you are
-1 using a configuration file, the only necessary parameters
-C"C:\MyConfigs\myconfig.ini" to pass at the command line are -I and

-C"configuration_file_name".

You can include all other parameters inside the INI file.
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Table 6-92 « Command Line Parameters

Command Line Parameter & Examples Description
-D"application_catalog_name" The name of the Application Catalog.
iscmide.exe This parameter is only used for SQL Server Application

-S"mysql\sql1” Catalogs, and is a required parameter when using a SQL

-U"admin" iaati

Server-based Application Catalog.

-P"admin" PP 9

-D"mycatalog"

-IF"c:\mypackages\mymsi.ms1i;

c:\mypackages\mytrans.mst;"
-l This option indicates that a bulk import operation is to be
N performed. If you are using -IF or -IMM, you do not need
iscmide.exe ) ) . o

I to specify this, as these parameters inform Application

-C"c:\mypackages\myconfig.ini" Manager to perform an import operation.
-IF"msi_file_name[; mst1; mst2...]" The name and full path of the MSI file to be imported,
-IF"msi_file_name[; msp1; msp2...]" and optionally a semicolon-delimited list of transforms or
-IF"msi_file_name[; mst1; msp1; msp2...]" patches to be applied before importing the package.
iscmide.exe

-F"c:\mycatalogs\conflict.mdb"

-IF"c:\mypackages\mymsi.ms1i;

c:\mypackages\mytrans.mst;"
iscmide.exe

-F"c:\mycatalogs\conflict.mdb"

-IF"c:\mypackages\mymsi.ms1i;

c:\mypackages\mypatch.msp;

c:\mypackages\mytrans.mst;"
iscmide. exe

-F"c:\mycatalogs\conflict.mdb"

-IF"c:\mypackages\mymsi.msi
-IMM"merge_module_file_name" The name and full path of the merge module to be
iscmide.exe imported.

-F"c:\mycatalogs\conflict.mdb"

-IMM"c:\mymodules\crystal.msm"
-INCP Use to specify the Native Channel Packager (NCP) file
. . that is to be imported.
iscmide.exe

-INCP"C:\Acrobat.ncp"
-L"logfile_name" The output log file name.
iscmide.exe

-I

-C"c:\mypackages\myconfig.ini"

-L"c:\mypackages\mylog.txt"
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Table 6-92 « Command Line Parameters

Command Line Parameter & Examples

-P"password"

iscmide.exe
-S"mysqT\sq11"
-U"admin"
-P"admin"
-D"mycatalog"
-IF"c:\mypackages\mymsi.ms1i;
c:\mypackages\mytrans.mst;"

-Q

iscmide.exe -Q

-S"server_name[\instance_name]"

iscmide.exe
-S"mysqT\sq11"
-U"admin"
-P"admin"
-D"mycatalog"
-IF"c:\mypackages\mymsi.ms1i;
c:\mypackages\mytrans.mst;"

-U"login_id"

iscmide.exe
-S"mysqT\sq1l"
-U"admin"
-P"admin"
-D"mycatalog"
-IF"c:\mypackages\mymsi.ms1i;
c:\mypackages\mytrans.mst;"

Description

The password for the SQL Server Application Catalog.

This parameter is only used for SQL Server Application
Catalogs, and is a required parameter when using a SQL
Server-based Application Catalog. The only exception to
this requirement is if you want to take advantage of
AdminStudio’s integrated security. In this case, do not
use the -P parameter.

Starts Application Manager as a system tray icon
application without showing the full Application Manager
Interface. When this option is specified with bulk import
options, Application Manager exits once import is
complete.

The SQL Server where the Application Catalog resides. If
this parameter is passed, the -F parameter is ignored.

This parameter is only used for SQL Server Application
Catalogs, and is a required parameter when using a SQL
Server-based Application Catalog.

The user name for the SQL Server Application Catalog

This parameter is only used for SQL Server Application
Catalogs, and is a required parameter when using a SQL
Server-based Application Catalog. The only exception to
this requirement is if you want to take advantage of
AdminStudio’s integrated security. In this case, do not
use the -U parameter.

Specifying User Interface Mode via Command Line

There are three modes of operation for ConflictSolver: Application Manager, ConflictSolver, and ConflictSolver
Process Assistant. The following Command Line options launch ConflictSolver in these modes of operation.

Table 6-93 * User Interface Mode Command Line Options

Option Description
-A Process Assistant Mode
-CS ConflictSolver Mode

394

ADS-1000-UG00 AdminStudio 10.0 User Guide



Chapter 6: Managing Application Catalog Databases
Reference

Table 6-93 ¢« User Interface Mode Command Line Options

Option Description

-APP Application Manager Mode

Using a Configuration File

This section explains how to define a configuration file to use during the import process and how to use a
configuration file with command-line options. The following topics are included:

e Application Manager Configuration File

® Using a Configuration File with Command-Line Options

Application Manager Configuration File

In addition to supporting individual command-line parameters, Application Manager can also use a configuration
file (when specified using the -C"configuration_file_name" parameter). This INI file can contain the values for all
required parameters during the import process.

Configuration File Examples

The following examples are provided:

e Configuration File for SQL Server Application Catalog for a Named User
e Configuration File for SQL Server Application Catalog for a Trusted User

e Configuration File for Applying Transforms and/or Patches During Command-Line Import

Configuration File for SQL Server Application Catalog for a Named User

[General]

DatabaseType=SQL
LogFile=c:\temp\importlog.txt
MSIFile=3

MSMFile=1

[sQL]
Server=ConflictSolverSQL2K
UserID=Admin
Password=mypassword
Database=AdminStudio70

[MSIFile-1]
File=\\server\Datal.msi
Transforml=\\server\Datala.mst
Transform2=\\server\Datalb.mst
Group=0fficeApps

[MSIFile-2]
File=\\server\Data2.msi
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Group=0fficeApps\Secondary

[MSIFile-3]
File=\\server\Data3.msi

[MSMFile-1]
File=\\server\CrystalReports.msm

Configuration File for SQL Server Application Catalog for a Trusted User

[General]

DatabaseType=SQL
LogFile=c:\temp\importlog.txt
MSIFile=3

MSMFile=1

[sqL]
Server=ConflictSolverSQL2K
Database=AdminStudio70

[MSIFile-1]
File=\\server\Datal.ms1i
Transforml=\\server\Datala.mst
Transform2=\\server\Datalb.mst
Group=0fficeApps

[MSIFile-2]

File=\\server\Data2.ms1i
Group=0fficeApps\Secondary[MSIFile-3]
File=\\server\Data3.msi[MSMFiTle-1]
File=\\server\CrystalReports.msm

Configuration File for Applying Transforms and/or Patches During Command-Line Import

[General]

DatabaseType=Access
LogFile=c:\temp\importlog.txt
MSIFile=3

MSMFile=1

OtherSetupFile=1

[MSIFile-1]

File=\\server\Datal.MSI
Transforml=\\server\Datala.MST
Transform2=\\server\Datalb.MST
Patchl=\\server\Datalp.MSP
Patch2=\\server\Data2p.MSP
AdminInstallLocation=\\Server\Shared\Datal

[MSIFile-2]

File=\\server\Data2.MSI
Patchl=\\server\Datalp.MSP
AdminInstalTlLocation=\\Server\Shared\Data2

[MSIFile-3]
File=\\server\Data3.MSI
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Transforml=\\server\Data3a.MST
Patchl=\\server\Datalp.MSP
AdminInstallLocation=\\Server\Shared\Data3

[OtherSetupFile-1]
SetupName=AdminStudio for Macintosh

SetupDirectory=C:\AdminStudio\MacFiles
FullDirectory=1

Parameter Explanation

[General] Section

Table 6-94 « Parameter Explanation: [General] Section

Parameter Description

LogFile Using this parameter, you can specify the name and location of the output log file. The
LogFile parameter corresponds to the -L command-line parameter.

MSIFile Use this parameter to indicate the number of MSI files to be imported. Each MSI file is
denoted in subsequent INI file sections.

If you are only importing merge modules, you can omit this parameter from your
configuration file.

MSMFile Use this optional parameter to indicate the number of merge modules to be imported.
Each merge module file is denoted in subsequent INI file sections.

E

Note - If you are only importing Windows Installer packages, you can omit this parameter from
your configuration file.

[SQL] Section
Table 6-95 * Parameter Explanation: [SQL] Section

Parameter Description

Server Using this required parameter, you can provide the name of the SQL Server. It corresponds to
the -S command-line parameter.

UseriD Using this parameter, you can provide the login name for the SQL Server. It corresponds to
the -U command-line parameter. This is required for non-trusted logins.

Password Using this parameter, you can provide the password for the SQL Server. It corresponds to the
-P command-line parameter. This is required for non-trusted logins.
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Table 6-95 « Parameter Explanation: [SQL] Section

Parameter Description

Database Use the Database parameter to provide the catalog name for the SQL Server. It corresponds
to the -D command-line parameter. If a value is not specified, the default SQL Server
Application Catalog for the specified login will be used.
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Each Windows Installer package to be imported into the Application Catalog must be described in its own section,
numbered sequentially ([MSIFile-1], [MSIFile-2], etc.). Each section must contain the name and location of the file,
and any transforms or patches to apply to the file prior to import.

Table 6-96 ¢ Parameter Explanation: [MSIFile-n] Section

Parameter Description

File Using the File parameter, you can specify name and location of the Windows
Installer package (.msi) you are importing. This parameter is required.

Transformn Use this parameter to specify the name and location of a transform to apply to the
Windows Installer package prior to import. Each subsequent transform increases
the value of n (Transform1, Transform2, Transform3, etc.).

Patchn Use this parameter to specify the name and location of a patch to apply to the

AdminlinstallLocation

Windows Installer package prior to import. Each subsequent patch increases the
value of n (Patch1, Patch2, Patch3, etc.).

When applying a patch to an MSI package, it is necessary to perform an
Administrative install of the MSI package and then perform an Administrative install
of each patch package one by one. Use this parameter to specify the location
where the Administrative install will be performed.

Group

SetupName

SetupDirectory

You can use the Group parameter to specify the group into which the package
should be imported. Use a “\” to indicate a group hierarchy. If no group is specified,
the package is imported into the root group.

Identifies the name of the imported setup package (an Other Setup Type).

Identifies the location of the Other Setup Type setup files.

FullDirectory

[MSMFile-n] Section

Specifies whether to import files in the selected directory and all subdirectories (1)
or just the files in the selected directory (0).

Each merge module to be imported into the Application Catalog must be described in its own section, numbered
sequentially ((MSMFile-1], [MSMFile-2], etc.). Each section must contain the name and location of the file.

Table 6-97 « Parameter Explanation: [MSMFile-n] Section

Parameter Description
File Use this parameter to specify the name and location of the merge module (.msm) you are
importing.
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[NCPFile-n] Section

Each Native Channel Packager (NCP) file to be imported into the Application Catalog must be described in its own
section, numbered sequentially ([NCPFile-1], [NCPFile-2], etc.). Each section must contain the name and location
of the file.

Table 6-98 ¢ Parameter Explanation: [NCPFile-n] Section

Parameter Description

File Use this parameter to specify the name and location of the NCP file (.ncp) you are importing.

Using a Configuration File with Command-Line Options

Application Manager supports use of a configuration file to pass parameters during command-line import. This is
extremely useful if you are importing multiple packages and/or merge modules simultaneously. Use the following
command line to use a configuration file:

iscmide.exe -C"configuration_file_name"

Replace configuration_file_name with the name and location of the configuration file to use.

Importing

400

This section includes topics on how to perform import operations from the command line. The following topics are
included:

® Applying Transforms and Patches During Command-Line Import

e Importing Multiple Windows Installer Packages Simultaneously

e Importing Multiple Merge Modules Simultaneously

e Simultaneously Importing Windows Installer Packages and Merge Modules
e Using the Command Line to Import All Packages in a Directory

®  Running Import Silently

e (Creating a Log File During Command-Line Import
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Applying Transforms and Patches During Command-Line Import

Application Manager provides two mechanisms for applying transforms or patches to a Windows Installer package
during import. First, if you are only importing a single package into Application Manager from the command line,
you can pass transforms or patches after the file name, as in the following command lines:

Table 6-99 * Applying Transforms and Patches During Import

Function Command

TRANSFORM: | iscmide.exe -IF'msi_file;[mst1;mst2;]"
PATCH: iscmide.exe -IF"'msi_file;[msp1;msp2;]"

BOTH: iscmide.exe -IF'msi_file;[mst1;msp1;]"

Replace msi_f1ile with the name and location of the Windows Installer package, and mst1 and mst2 or msp1 and
msp2 with the names and locations of the transforms or patches to apply. For example, if your MSI file was named
datal.msi and your two MST files were named alpha.mst and gamma.mst, your command line would look like the
following:

iscmide.exe -IF"datal.msi;alpha.mst;gamma.mst;

E

Note * Depending on the situation, it may be necessary to pass additional command-line parameters.

If you are importing multiple Windows Installer packages, and applying transforms or patches to them, use a
configuration file in which you can specify the names and locations of the packages and associated transforms or
patches. Use the following command line to use a configuration file:

iscmide.exe -C"configuration_file_name"

Replace configuration_file_name with the name and location of the configuration file to use.

Importing Multiple Windows Installer Packages Simultaneously

The best way of importing multiple Windows Installer packages simultaneously into an Application Catalog is via a
configuration file. Use the following command line to call your configuration file, in which you can specify multiple
Windows Installer packages to import.

iscmide.exe -C"configuration_file"

Replace configuration_file with the name and location of the configuration file containing the names and
locations of the packages you want to import.
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Importing Multiple Merge Modules Simultaneously

The best way of importing multiple merge modules simultaneously into an Application Catalog is via a
configuration file. Use the following command line to call your configuration file, in which you can specify multiple
merge modules to import.

iscmide.exe -C"configuration_file"

Replace configuration_file with the name and location of the configuration file containing the names and
locations of the merge modules you want to import.

Simultaneously Importing Windows Installer Packages and Merge Modules

To simultaneously import both Windows Installer packages and merge modules into an Application Catalog, use a
configuration file from the command line. In this configuration file, you can specify the names and locations of both
merge modules and Windows Installer packages you want to import.

Use the following command-line to specify your configuration file:
iscmide.exe -C"configuration_file_name"

Replace configuration_file_name with the name and location of the configuration file to use.

Using the Command Line to Import All Packages in a Directory

402

It is possible from the command line to import all packages in a directory. This can be done by placing the
following line in a batch file (modifying it as necessary for your specific environment):

for %%a in (*.msi) do ISCMIDE

-S"server_name"

-U"userid"

-P"password"

-D"Application_Catalog_Name"

-IF"%%a"

-Q

-L"%%alLog.txt"
The above statement runs Application Manager, importing each MSI package in the Application Catalog, and
creates a log file with the name of the .msi file prepended to the log file name.

However, the above command makes the following assumptions:
® ISCMIDE.exe is in the path; otherwise, include the full path to ISCMIDE. exe.

e All packages are being imported into the specified SQL Server Application Catalog (provide the server name,
userid, password, and Application Catalog name with the appropriate parameters -S,-U,-R and -D,
respectively).

e The above command will start Application Manager, import a file, exit Application Manager, and then restart
Application Manager for each MSiI file. If this is not acceptable, use a configuration file instead.

e No transforms are applied to the imported packages. If you need to apply transforms, use a configuration file
instead.
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e Application Manager starts in quiet mode. If it is switched to full mode, it is your responsibility to end the
Application Manager process so the next file can be imported.

Running Import Silently

Application Manager can be run silently in system tray mode by using the following command line:

iscmide.exe -Q

An icon for Application Manager, with a corresponding context menu available by right-clicking on the icon,
appears in the system tray. If you pass the -Q parameter in addition to other parameters, progress is displayed in
the tool tip available when you mouse over the icon. This is beneficial if you are importing a sizeable amount of
packages, yet want to monitor the progress periodically.

In quiet mode, when import from the command line ceases, Application Manager automatically exits.

Creating a Log File During Command-Line Import

It may be necessary or beneficial to create a log file during package/merge module import from the command line.
You may want to see the results of the import, or determine why certain packages were not processed as
expected. To create a log file, use the following command-line:

iscmide.exe -L"Tog_file_name"

Replace Tog_file_name with the name and location of the log file you want to create.

E

Note - It may be necessary to pass additional command-line parameters, depending on the task you are
performing from the command line.

Connecting to Standalone Application Catalogs

This section includes the following topics:
e Connecting to a Specific Standalone Application Catalog Using Command-Line Options

e Creating Shortcuts to Specific Standalone Application Catalogs

Connecting to a Specific Standalone Application Catalog Using Command-Line Options

Using the following command line, you can connect to a specific SQL Server Application Catalog:
iscmide.exe -S"sql_server_name" -U"user_id" -P"password"

Replace sql_server_name with the specific SQL Server name (including path information). Replace user_id and
password with the UserID and password for the server.
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E

Note * Depending on the Application Catalog configuration, it may be necessary to pass additional command-line
parameters, such as the Application Catalog name.

Creating Shortcuts to Specific Standalone Application Catalogs

For convenience, you may want to create a Windows shortcut to launch ConflictSolver and automatically connect
to a specific Application Catalog.

W

Task: To create the shortcut:
1.  On the Windows Desktop, right-click, point to New, and select Shortcut. The Create Shortcut Wizard appears.

2. Click the Browse button and navigate to the ConflictSolver executable (ISCMIDE.exe). Typically, it is in the
AdminStudio Installation Directory\ConflictSolver directory. When you have located it, click OK and
then click Next.

3. Type a name for the shortcut and click Finish. The new shortcut appears on the Desktop.
4. Right-click on the shortcut and select Properties.

5. Inthe Properties dialog box, append the necessary command-line parameters to the end of the target, such
as:

iscmide.exe -S"sql_server_name" -U"user_id" -P"password"

6. Click OK to dismiss the dialog box.

E

Note - If you are creating a shortcut to a Microsoft SQL Server Application Catalog, you need to provide values for
the SQL Server name, UserlD, password, and Application Catalog name using the -S or -O, -U, -R, and -D
parameters. See Application Manager Command-Line Functionality or Connecting to a Specific Standalone
Application Catalog Using Command-Line Options.
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Application Catalog Replication Command Line Functionality

E

Note ° These options are provided in case you would like to run Application Catalog Replication using the
command line. However, this functionality can be invoked from the main AdminStudio interface.

The following Application Catalog Replication command-line options are supported by AdminStudio:

Table 6-100 * Replication Command Line Options

Option Description

-c"Connection String" Optional, if not present we attempt to connect to the default database.
Otherwise, we will prompt the user for a connection of an existing database.

-q Silent launch without splash dialog box.

-h[number] Parent window handle. (Optional)
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Part 3

Repackaging and
Customizing Installations

This part of the AdminStudio 10.0 User Guide includes the following chapters:

® Repackaging Legacy Installations Using the Repackaging Wizard

e (Converting Legacy Installations Using the Repackager Interface

e Performing Automated Repackaging and Virtualization Using the Automated Application Converter
e Using the Virtual Package Editor

e (Creating Customized Virtual Applications

e Customizing and Authoring Installations Using InstallShield

e Customizing Installations Using Tuner
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Repackaging Legacy Installations
Using the Repackaging Wizard

Installations created for the Windows Installer service dramatically differ from traditional installations, making
reusing legacy installations impossible without using a repackaging tool. You can use Repackager’'s Repackaging
Wizard to capture the data placed on your system during installation and convert it into a Windows Installer (.ms1)
package, which you can then customize and distribute according to your organization’s needs.

Documentation regarding using the Repackaging Wizard is presented in the following sections:

Table 7-1 « Using the Repackaging Wizard

Section

Description

About Repackaging

Repackaging Methods

Introduces you to repackaging, explains various repackaging methods, lists
Repackaging Best Practices, explains how to include the InstallScript Engine
with a Windows installer package, and reviews Repackager options.

Describes the methods of repackaging that the Repackaging Wizard
supports.

Configuring Repackager to
Ensure Optimal Installation
Capture

Repackaging Legacy

Installations Using the
Repackaging Wizard
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Describes how to configure Repackager in order to get optimal results when
capturing an installation.

Explains how to use the Repackaging Wizard to convert the following
installations:

InstallShield Professional 1.x to 5.1.x
InstallShield Professional 5.5 to 7.x
InstallShield InstallScript MSI
InstallShield DevStudio 9.x InstallScript
InstallShield Editor InstallScript
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Table 7-1  Using the Repackaging Wizard (cont.)

Section Description
Repackaging Wizard Describes each of the dialog boxes and Wizard panels that you might
Reference encounter when using the Repackaging Wizard.

E

Note ° For information on other Repackager features, see Converting Legacy Installations Using the Repackager
Interface.

About Repackaging

This section introduces you to repackaging, lists Repackaging Best Practices, and explains how to set Repackager
options.

e Purpose of Repackaging Applications
® Supported Legacy Installation Types

® Repackaging 64-Bit Applications

® Repackaging Options Comparison

® Repackaging Wizard Best Practices

e About Repackaging on Clean Systems

e Including the InstallScript Engine With a Windows Installer Package

Purpose of Repackaging Applications

410

Installations created for the Windows Installer service dramatically differ from traditional installations, making
reusing legacy installations impossible without using a repackaging tool. Repackager assists you by capturing the
data placed on your system during installation and converting it into a Windows Installer (.msi) package, which
you can then customize and distribute according to your organization’s needs.

Repackaging an installation into a Windows Installer package provides the following benefits:

e Can customize it using InstallShield Editor or Tuner—You can further configure or customize the
Windows Installer package to meet your specific needs by editing the .msi file in InstallShield Editor or by
creating transforms in InstallShield Editor or Tuner.

e Can perform conflict analysis and resolution—You can use ConflictSolver to check the Windows Installer
package for conflicts that may exist between it and other known Windows Installer packages in an Application
Catalog database, ensuring the proper installation and functioning of your installations.
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e Can implement application repair and feature advertising—Finally, once converted to a Windows
Installer package, the installation can take advantage of Windows Installer functionality such as application
repair and feature advertisement.

Supported Legacy Installation Types

You can use both the Repackaging Wizard and the Repackager interface to create Repackager projects. The tool
that you use depends upon the type of installation you are converting:

Table 7-2 » Methods of Creating Repackager Projects

Tool Installation Source

Repackaging You can use the Repackaging Wizard to convert the following installations:

Wizard e InstallShield Professional 1.x to 5.1.x

e |[nstallShield Professional 5.5 to 7.x

e |[nstallShield InstallScript MSI

e |[nstallShield DevStudio 9.x InstallScript
e |[nstallShield Editor InstallScript

See Repackaging Legacy Installations Using the Repackaging Wizard.

Repackager You can use the Repackager interface to convert the following installations:

| f .
nterface ® Repackager 3.x output (.inc)

® Microsoft SMS projects (.ipf)

e Novell ZENworks 3.0, 3.1, or 4.0 projects (.axt/.aot)
®  WInINSTALL projects (.txt) (6.0, 6.5, 7.x)

e Wise installation projects (.wse)

e |nstallShield Professional log files (.isl)

See Converting Legacy Installations Using the Repackager Interface.

Edition -
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Repackaging 64-Bit Applications

412

Repackager has the capability to repackage both 32-bit and 64-bit applications, as well as hybrid applications
(both 32-bit and 64-bit). The Repackaging Wizard remains a 32-bit application, but can be run on both 32-bit (x86)
and 64-bit (x64) Windows operating systems. The following table lists the operating systems to use to repackage
both 32-bit and 64-bit applications, and the operating systems those repackaged applications will run on.

Table 7-3 » Repackaging 32-Bit and 64-Bit Applications

Application Type

64-bit application

32-bit application

Repackage on ...

Windows 64-bit OS

E

Note * You can use either the Installation Monitoring or
Snapshot method to repackage a 64-bit application on a 64-bit
operating system.

Windows 32-bit OS

7]

Important  While it is possible to repackage a 32-bit application
on a 64-bit OS, it is recommended that you use a 32-bit OS, to avoid
inadvertently capturing any 64-bit data. If Repackager captures any
64-bit data, it will flag the package as a 64-bit application, meaning
that it will only run on a 64-bit OS. See Excluding 64-Bit Data.

Excluding 64-Bit Data

It is strongly recommended that you repackage 32-bit applications on a 32-bit OS. However, if you choose to
repackage a 32-bit application on a 64-bit OS, you need to make sure that you exclude any unnecessary 64-bit
data, such as data from a 64-bit Windows Service that could be running or 64-bit files (stored in the
System64Folder, ProgramFiles64Folder, or CommonFiles64Folder directories) or 64-bit registry entries (any entries
stored in a node other than WOwW6432Node).
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Will run on ...

Windows 64-bit OS

Windows 64-bit OS or
Windows 32-bit OS
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About Repackaging

The following table details the different options available to you when using Repackager, based upon source type,

product and version:

Table 7-4 » Repackaging Options Comparison Chart

Source Product / Version

Repackaging Method

Result

Media IS Professional 1.x to 5.1.x

L -
|

IS Professional 5.5 to 7.x

IS InstallScript MSI

IS Editor InstallScript

IS DevStudio 9.x InstallScript

Project Repackager 3.x output (.1inc)
Microsoft SMS projects (.1pf)
Novell ZENworks 3.0, 3.1, or 4.0

projects (.axt/.aot)

WIinINSTALL projects (. txt) (6.0,

6.5, 7.x)

Wise installation projects (.wse)

InstallShield Editor Pro log files

(.isT)

Repackaging Wizard

Installation Monitoring or Snapshot

Repackaging Wizard

Installation Monitoring or Snapshot
and SmartScan Wizard
Repackaging Wizard

Installation Monitoring or Single
Step Snapshot

Repackaging Wizard

InstallShield Professional Logging
Method

Repackager Interface

Select Open on the File menu to
have Repackager automatically
convert file to a Repackager project

Repackager Interface

Select Open on the File menu to
have Repackager automatically
convert file to a Repackager project

Repackager project with no feature
delineation

Repackager project with feature
delineation, including registry
entries and shortcuts

Repackager project with feature
delineation, including registry
entries and shortcuts

Repackager project with feature
delineation, including registry
entries and shortcuts. Also
captures path variables and
converts them into properties
(using text substitution rather than
hard-coded path names).

Repackager project with no feature
delineation

Repackager project with feature
delineation

Once you have created a Repackager project, you can visually examine the files, .1in1 files, shortcuts, and registry
data from the installation, and exclude any non-essential items. Then, you can build the Repackager project into an
InstallShield Editor project (.1sm) for further editing, or create a Windows Installer package (.ms1).
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Repackaging Wizard Best Practices

414

To ensure optimal performance of the Repackaging Wizard during repackaging and when working with
Repackager projects, the following best practices are recommended:

® Repackage on a Clean System

e Launch Repackager Remotely or Install Repackager on the Clean Machine
e Use the Repackager Interface to Exclude Unwanted Items

e Exit All Other Applications

® Only Repackage Non-Windows Installer Setups

Repackage on a Clean System

It is essential that you repackage applications on a “clean” system to ensure you capture all changes made by the
installation. A clean system typically consists of a computer with only the operating system and necessary service
packs installed on it. Repackaging on a clean system provides the following benefits:

e Prevents you from capturing Repackager files—By repackaging on a clean system, you are ensuring
that you do not inadvertently capture Repackager files during repackaging.

e Ensures that you capture all of the necessary setup files—If you do not repackage on a clean system,
you may not capture all of the necessary files for the setup because the files may already be installed on the
system.

E

Note * For more information, see About Repackaging on Clean Systems.

Launch Repackager Remotely or Install Repackager on the Clean Machine

Because it is best to keep the number of packages installed on the clean machine to a minimum, you should
launch Repackager remotely from the clean machine or install Repackager on the clean machine:

e Launch Repackager Remotely—You could install Repackager on a shared network drive and then launch
Repackager remotely from the clean machine. See Launching Repackager Remotely.

e Install Repackager on clean machine—You could install a copy of Repackager onto the clean machine.
While it is preferable to launch Repackager remotely from the clean machine, if you do not have network
access to an installation of the AdminStudio client tools, this is your best option. See Installing Repackager on
a Clean Machine.

Both of these options are explained in Configuring Repackager to Ensure Optimal Installation Capture.

Use the Repackager Interface to Exclude Unwanted Iltems

You should repackage using the provided exclusions and then use the Repackager interface to visually remove
unwanted items from the capture.

Because this occurs post-capture, you do not need to recapture the legacy setup if you inadvertently exclude items
from the Windows Installer package you are building.
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E

Note - Since Windows Installer does not support packaging device drivers, you would need to create Custom
Actions to install device drivers. See Using Custom Actions in the Windows Installer help section for more
information.

Exit All Other Applications

Other applications may lock files or directories, and may hinder the performance of the setup and repackaging.
Therefore, exit all applications prior to repackaging.

Only Repackage Non-Windows Installer Setups

Windows Installer setups should not be repackaged. They should either be edited in InstallShield Editor, or, as
Microsoft recommends, by creating a transform. This can be done using InstallShield Editor or Tuner.

You should not repackage Windows Installer (.msi) packages for the following reasons:
® Repackaging a Windows Installer package is against Microsoft Best Practices.
e [f you make changes to a Windows Installer package, vendors will no longer provide support for that product.

e If you repackage a Windows Installer package, the component codes within the package are not retained and
hence future patching or upgrades will not work.

e Traditionally, repackaging tools will ignore the Windows Installer-specific data in the Registry. This will result in
an incomplete package.

Also, Repackager is not intended for repackaging operating system installations or service packs, or deeply
integrated operating system components such as Internet Explorer. Moreover, components such as MDAC or
DCOM should be included in the clean image, or installed by a setup using the vendor’s redistributable.

Exception to This Rule

In general, due to the reasons listed above, it is not recommended to repackage a vendor-created Windows
Installer package to create a new Windows Installer package. However, some IT organizations may elect to
repackage Windows Installer packages in order to simplify them, which should make them more reliable and less
likely to violate the organization’s and Microsoft’s recommended best practices.

If you choose to repackage a Windows Installer package, you need to keep in mind that you may no longer be
able to:

e Directly deploy vendor-provided patches for this package, OR
e Use any vendor-provided automatic updating service for this package.

Therefore, you should only consider repackaging a Windows Installer package if your IT staff is also willing to
invest resources into periodically repackaging that application’s vendor patches into an updated Windows Installer
package.

E

Note - Tightly-controlled organizations probably would not want to have automatically-updating software, so the
inability to use an automatic updating service may not be of concern to them.
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About Repackaging on Clean Systems

For optimal results when using Repackager or OS Snapshot, you should perform these processes on a clean
system. A clean system typically consists of a computer with only the operating system and necessary service
packs installed on it. It is the baseline system that the computer requires to run.

Although it may be tempting to consider basic software, such as Microsoft Office, as part of the clean system, this
can result in poor snapshots and repackaged setups. Each application you install on the baseline system adds to
the DLLs, changes versions of files, makes new registry entries, etc. This may cause Repackager or the OS
Snapshot Wizard to miss these during capture, which ultimately may lead to missing files or registry entries in
repackaged setups, or unexpected conflicts between the operating system and Windows Installer packages.

E

Note * For more information on setting up a clean system to repackage on, see Configuring Repackager to Ensure
Optimal Installation Capture.

Alternate-Language Repackaging on Clean Machines

The standalone Repackager setup for clean machines does not install any language resources other than US
English. Therefore, if you are Repackaging a setup on a clean system in a language other than in US English, you
need to ensure you point to the correct template in the Repackaged Output View.

This can be on a mapped network drive, or you can copy the language-populated template (for example,
ISProjBlankTp1.1sm) to your clean system from the AdminStudio Installation Directory\Ed1i tor\Support directory.

Language-specific templates are available when you purchase InstallShield Editor Language Packs.

Including the InstallScript Engine With a Windows
Installer Package

Should you need to include the InstallScript engine with your setup, all the major releases of the InstallScript
engine are available in the Instal1Script_Engines folder on the AdminStudio installation CD. For more
information, see the Update to the Latest InstallShield Installation Engines Knowledge Base article at:

http://consumer.installshield.com/kb.asp?id=Q108322
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Repackaging Methods

Repackager supports three methods of repackaging:

Table 7-5 * Repackaging Methods

Repackaging Method

Installation
Monitoring Method

Description

Repackager monitors system changes as an application is installed, and that data
can be converted into a Windows Installer package. Installation Monitoring is the
default method.

Edition -

Snapshot Method

InstallShield
Professional
Logging Method

Repackager compares a system snapshot before and after an installation,
determines the changes that were made, and that data can be converted to a
Windows Installer package.

Repackager reads logged output of InstallShield Editor and DevStudio 9.x
InstallScript installations to obtain additional information that would not be captured
by repackaging, such as path variables and a feature tree.

Installation Monitoring Method

When using the Installation Monitoring method, the Repackaging Wizard monitors a system for any processes
that are created during an installation. The Installation Monitoring method determines the dynamic
interdependencies between files.

By monitoring these processes in the background, the Repackaging Wizard can identify files, shell links, and
registry entries that are added, modified, or removed by the installation. The resulting files and Repackager output
file can be converted into a Windows Installer package.

Installation Monitoring Method Considerations

Consider the following about Installation Monitoring when selecting a repackaging method:

e Faster than Snapshot—Installation Monitoring is significantly faster than the Snapshot repackaging method.

e Clean system not required—Although it is still a good practice to repackage on a clean system, it is not as
important when using Installation Monitoring technology as it is when you use the Snapshot method.

e Can exclude processes from the project—When using the Installation Monitoring method, you can
specify the processes that you want to exclude from the Installation Monitoring.

e Enhanced system reboot handling—On Windows Vista and newer, system reboots are almost
instantaneous and do not allow running applications to properly shut down, which may result in a loss of data.
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When using the Installation Monitoring method, Repackager successfully handles a system reboot and delays
it until you click the Reboot button on the Repackaging Wizard.

e Windows side-by-side support—The Repackager Installation Monitoring method scans and detects
changes made to the Windows SxS (Side-by-Side) store and automatically includes the proper merge
modules.

Snapshot Method

When using the Snapshot method, the Repackaging Wizard takes a reference snapshot of a system as a baseline
configuration, performs the installation, and then takes a second snapshot.

The difference between the two snapshots is stored in a directory you specify, along with the Repackager output
file (.inc). This file can then be converted into a Windows Installer package (.ms1i) using Repackager.

Snapshot Method Considerations
Consider the following about Snapshot technology when selecting a repackaging method:

e Slower than Installation Monitoring—The Snapshot method is significantly slower than the Installation
Monitoring repackaging method.

e Clean system is required—When repackaging using Snapshot technology, you should use a clean system,
with a baseline configuration for your target environment. If you do not repackage on a clean system, you may
not capture all of the necessary files for the setup because the files may already be installed on the system.

e Exclude anti-virus software directories—Any machine that you use to repackage most likely has anti-
virus software installed on it, even a “clean” machine. While you are repackaging an application, the real-time
virus detection feature of anti-virus software could automatically update various cached files in its directories.
In order to avoid repackaging errors when using the Snapshot method, you should exclude these directories.
See Excluding Directories and Subdirectories for more information.

E

Note - Anti-virus software does not affect repackaging using the Installation Monitoring method.

InstallShield Professional Logging Method

418

E

Note -« The InstallShield Professional Logging Method is supported for InstallShield Editor and DevStudio 9.x
InstallScript installations.

Using the InstallShield Professional Logging Method, Repackager can read logged output of InstallShield
Editor and DevStudio 9.x InstallScript installations. This enables Repackager to capture additional information from
those installations that would not be captured by the Installation Monitoring or Snapshot methods: path
variables and the feature tree.
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Path Variables

When using the InstallShield Professional Logging Method, path variables are captured and converted into
properties (using text substitution rather than hard-coded path names).

For example, if you were using a standard repackaging method, the path name of the application’s executable file
would be captured as follows:

C:\Program Files\CompanyName\App1icationName\ProgramName.exe

When using the InstallShield Professional Logging Method, the executable path name would be captured using a
path variable instead of a hard-coded path name:

[INSTALLDIR]\ProgramName.exe

Feature Tree

The InstallShield Professional Logging Method is able to group files, shortcuts and registry entries into features
corresponding to InstallShield Professional components. Any items (files, folders, shortcuts, or registry entries) that
are attached to a component directly or indirectly (through File Groups), are attached to corresponding features.

= J Features

2% DemaPlayerapp
ED InstallShieldProDema
ED DemoShigldDemo

If you do not use the InstallShield Professional Logging Method to repackage an InstallShield Editor or DevStudio
9.x InstallScript installation, all files, shortcuts and registry entries would be installed together as one feature.

Selecting the InstallShield Professional Logging Method

You access the InstallShield Professional Logging Method through the Repackaging Wizard, but InstallShield
Professional Logging Method is not offered as a choice on the Method Selection Panel of the Repackaging
Wizard. Only Installation Monitoring and Snapshot are listed:

Repackaging Wizard @
Method Selection
Select a repackaging method. EDH

@ Installation Monitoring  {Recommended)

Repackager watches lowerlevel system activities and records changes made to the system
by the setup programis). It then analyzes these activities and stores the sstup data in an
output file which can be converted into a Windows Installer package.

Snapshot

Repackagertakes an initial snapshot of the local system, runs the setup programis). and
then takes a second snapshot. The difference between the two snapshots is stored in an
output file which can be converted into a Windows Installer package.

* . The newly improved Install Monitoring method is the default method as it holds the
\_l) potential for cost savings through increased reliability and shorter repackaging times.

< Back |[ Mext = ]| Cancel || Help
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When you are repackaging an InstallShield Editor or DevStudio 9.x InstallScript installation and want to use the
InstallShield Professional Logging Method, you can select either Installation Monitoring or Snapshot on the
Method Selection Panel. However, if you select the Snapshot method, you must select Single Step on the
Snapshot Method Panel (which would open next).

AN

Caution - If you select the Snapshot | Multiple Steps repackaging method, Repackager will not recognize the
setup as an InstallShield Editor or DevStudio 9.x InstallScript installation and the InstallShield Professional Setup
Panel will not open.

After you select the Installation Monitoring or Snapshot method, and then specify an InstallShield Editor or
DevStudio 9.x InstallScript installation on the Repackaging Wizard’s Collect Product Information Panel,
Repackager will automatically detect the InstallScript installation and will display the InstallShield Professional
Setup Panel. On this panel, you can choose to use the InstallShield Professional Logging Method instead of
the repackaging method you chose on the Method Selection Panel.

For instructions on how to use the InstallShield Professional Logging Method when repackaging InstallShield
Editor or DevStudio 9.x InstallScript installations, see Repackaging Using the InstallShield Professional Logging
Method and InstallShield Professional Setup Panel.

Configuring Repackager to Ensure Optimal
Installation Capture

420

Both repackaging methods, Installation Monitoring and Snapshot, involve installing an application and
recording the system changes made by that installation. To ensure that you capture all changes made by the
installation, you should, ideally, install the application onto a “clean machine” (a computer with only the operating
system installed), as described in About Repackaging on Clean Systems.

Depending upon your network connectivity, you should configure Repackager on a clean machine in one of the
following ways:

Table 7-6 * Methods to Configure Repackager

Repackager Configuration Description
Launching Repackager If you have connectivity from a clean machine to a computer or network
Remotely location that contains an installation of Repackager, you should launch

Repackager remotely.

Installing Repackager on a If you do not have any network connectivity on the clean machine, you
Clean Machine should install Repackager on the clean machine.

ADS-1000-UG00 AdminStudio 10.0 User Guide



Chapter 7: Repackaging Legacy Installations Using the Repackaging Wizard
Configuring Repackager to Ensure Optimal Installation Capture

E

Note - You cannot repackage remotely from a Windows NT4 system because a file required during repackaging on
that operating system, MSCVRT.d11, must be installed locally. Therefore, when repackaging on a Windows NT4
system, install Standalone Repackager on that machine, as described in Installing Repackager on a Clean Machine.

Launching Repackager Remotely

Task:

Because you want to avoid installing applications on the clean machine, you should launch Repackager remotely
from the clean machine.

To launch Repackager remotely, perform the following tasks:
e Sharing Directories on a Machine with an Installation of AdminStudio
e Creating a Shortcut to Repackager on the Clean Machine

e |aunching Remote Repackager on the Clean Machine

Sharing Directories on a Machine with an Installation of AdminStudio

To share directories on a machine where AdminStudio is installed, perform the following steps:

To share the Repackager and AdminStudio Shared folders:

1. Locate a production machine with network access that has AdminStudio installed on it.

Tip * Check to make sure that this installation of AdminStudio has already been activated before proceeding.

2. Open Windows Explorer and locate the following directory:
C:\Program Files\AdminStudio\10.0\Repackager

3. Right-click the Repackager directory and then click Sharing and Security. The Sharing tab of the
Repackager Properties dialog box opens.

4. Select Share this folder and configure sharing rights as necessary.
5. Click OK to close the dialog box.
6. Repeat the steps above to also share the AdminStudio Shared directory used by that installation of

AdminStudio.

Creating a Shortcut to Repackager on the Clean Machine

To create a shortcut to Repackager on the clean machine, perform the following steps:
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W

Task:

Task:
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To create a shortcut to Repackager on the clean machine:

1.

2
3.
4
5

o

On this clean machine with network access, launch Windows Explorer.

Select Map Network Drive from the Tools menu. The Map Network Drive dialog box opens.
Specify the drive letter you want use to represent the shared location.

Click Browse. The Browse for Folder dialog box opens.

Select the shared Repackager directory on the production machine (that you configured in Sharing Directories
on a Machine with an Installation of AdminStudio) and click OK.

Click Finish to exit the Map Network Drive dialog box.

From Windows Explorer, navigate to the drive mapped to the shared Repackager directory on the production
machine.

Right-click on the is1c.exe file (the Repackager executable file), point to Send To, and click Desktop
(create shortcut). A shortcut to Repackager in the shared directory is now on the Desktop.

Launching Remote Repackager on the Clean Machine

To launch Repackager on the clean machine, perform the following steps:

To launch Remote Repackager on the clean machine:

1.

On the clean machine, double-click the Repackager shortcut on the desktop (that you created in Creating a
Shortcut to Repackager on the Clean Machine). The Repackager Start Page opens.

7]

Important < Because you are running Repackager remotely, the online help topics cannot be viewed.
However, you can view a version of AdminStudio Help Library online at:

http://helpnet. flexerasoftware.com

Click the Capture an Installation Using Repackaging Wizard link. The Welcome panel of the
Repackaging Wizard opens.

Continue using the Repackaging Wizard to capture a legacy setup, following the instructions in Repackaging
Legacy Installations Using the Repackaging Wizard.

AN

Caution * On the Set Target Project Information and Capture Settings panel of the Repackaging
Wizard, do not set the Project path to store files field to a location on the clean machine; instead choose a
network location.
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Installing Repackager on a Clean Machine

It is essential that you repackage applications on a “clean" system to ensure you capture all changes made by the
installation. A clean system typically consists of a computer with only the operating system and necessary service
packs installed on it. It is the baseline system that the computer requires to run.

While you want to avoid installing applications on the clean machine, if the clean machine does not have network
connectivity to an installation of Repackager (which is required in order to run Repackager remotely), you have to
install Repackager locally on a clean machine by running the Repackager installation.

To install a standalone version of Repackager on a clean machine, perform the following steps.

Task: To install Repackager on a clean machine:

1.

o g s o

N

10.

11.

12,

13.

Build a “clean machine”—a computer with only the operating system and necessary service packs installed
oniit.

On the AdminStudio installation DVD, locate the standalone Repackager installation in the Tools directory:
\Tools\StandaloneRepackager.exe

Copy StandaloneRepackager.exe to the clean machine.

Launch the setup. The Welcome Panel opens.

Click Next. The License Agreement panel opens.

Select the 1 accept the terms of the license agreement option and click Next. The Customer
Information panel opens.

Enter a User Name and Organization name to identify this installation of Repackager.
Enter the Serial Number you received for the Edition of AdminStudio that you purchased.
Click Next. The Destination Folder panel opens.

If you want to install Repackager in the specified directory, click Next. If you want to select a different directory,
click Change, select a new directory, and then click Next. The AdminStudio Shared Location panel opens.

Specify the location of your organization’s AdminStudio Shared directory, and click Next. The Ready to
Install panel opens.

Click Install to begin the installation process. The Installing Repackager panel opens. When installation is
complete, the InstallShield Wizard Completed panel opens.

Click Finish to exit the Wizard. A Repackager shortcut will be added to the Windows Start menu under
AdminStudio, AdminStudio Tools.
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Repackaging Legacy Installations Using the
Repackaging Wizard

424

One frequently used method of creating a Repackager project is to repackage a legacy setup. Fundamentally, this
involves monitoring the execution of a non-Windows Installer setup and converting changes made by the setup
into a Windows Installer file.

Repackager provides the Repackaging Wizard for accomplishing this task. Using this Wizard, you can select the
repackaging method (either Snapshot or Installation Monitoring), specify the setup(s) you want to repackage, and
run the setup(s). When the Repackaging Wizard has finished its analysis, Repackager automatically creates a
Repackager project (.1 rp) file, which can be modified in Repackager. You can then convert this file to an
InstallShield Editor project (.1ism) for further editing, or convert it directly to a Windows Installer package (.ms1).

For InstallShield Editor or DevStudio 9.x InstallScript installations, you can choose to use the InstallShield
Professional Logging Method instead of the Snapshot or Installation Monitoring methods.

AN

Caution - It is highly recommended that you repackage applications on a “clean” system. See Configuring

Repackager to Ensure Optimal Installation Capture for more information.

When using the Repackaging Wizard to repackage a legacy setup, you can use any of the following methods:
Table 7-7 « Repackaging Methods

Repackaging Method Description

Installation Monitoring = Repackager monitors system changes as an application is installed, and that data
Method can be converted into a Windows Installer package. Installation Monitoring is the
default method.

See Repackaging Using the Installation Monitoring Method.

Edition -

Snapshot Method Repackager compares a system snapshot before and after an installation,
determines the changes that were made, and that data can be converted to a
Windows Installer package. This is the default method.

See Repackaging Using the Snapshot Method.

InstallShield Repackager reads logged output of InstallShield Editor and DevStudio 9.x
Professional Logging InstallScript installations, allowing you to get additional information that would not
Method be captured by standard repackaging.

See Repackaging Using the InstallShield Professional Logging Method.
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Table 7-7 » Repackaging Methods (cont.)
Repackaging Method Description

Using InstallScript You can use the Repackaging Wizard and InstallScript Scan to convert an

Scan InstallScript MSI installation to a Basic MSI package with InstallScript support.
InstallScript Scan preserves the original components and much of the InstallScript
installation logic, architecture, and maintainability of the original installation
package.

See Repackaging an InstallScript MSI Setup to a Basic MSI Setup

Repackaging Using the Installation Monitoring Method

When you choose the Installation Monitoring method of repackaging, Repackager monitors system changes as
an application is installed, and then you can convert that data into a Windows Installer package. Installation
Monitoring is the default method.

AN

Caution - It is highly recommended that you repackage applications on a “clean” system. See Configuring
Repackager to Ensure Optimal Installation Capture for more information.

To repackage an installation using the Installation Monitoring method, perform the following steps:
e Step 1: Selecting the Repackaging Method.

e Step 2: Excluding Processes (Optional)

e Step 3: Collecting Product Information

e Step 4: Adding Additional Setup Programs (Optional)

e Step 5: Set Target Project Information

e Step 6: Set Capture Settings (Optional)

e Step 7: Beginning the Repackaging Process

Step 1: Selecting the Repackaging Method

In this step, you launch the Repackaging Wizard and select the Installation Monitoring repackaging method.
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&

Task:

426

To select a repackaging method:

1.

From the Repackager interface, launch the Repackaging Wizard by clicking on the link or by selecting
Repackaging Wizard from the Tools menu. The Welcome Panel opens.

Welcome to Repackaging Wizard

E3

This wizard enables you to create a completely new
installation for an existing, packaged application.  can
also create an installation project that can be further
enhanced using Install Shield.

run remotehy from @ mapped location. See the Help
Library topic "Repackaging Wizard Best
Practices” for details.

=  Foroptimal use, Repackaging Wizard should be
1)

< Back [ Mext = ]I Cancel JI Help

Repackaging Wizard @

2. Click Next. The Method Selection Panel opens.

Repackaging Wizard @

Method Selection
Select a repackaging method. E

@ Installation Monitoring  (Recommended) Advanced Settings

Fepackager watches lowerdevel system activities and records changes made to the system
by the setup programis). It then analyzes these activities and stores the setup datain an
output file which can be converted into @ Windows Installer package.

") Snapshot
Repackager takes an initial snapshot of the local system, runs the setup programis), and

then takes a second snapshot. The difference between the two snapshots is stored in an
output file which can be converted into a Windows Installer package.

2 . The newly improved Install Monitoring method is the default method as it holds the
1 potertial for cost savings through increased reliabilty and shorter repackaging times.

[ < Back ][ Mext > ][ Cancel ][ Help ]

3. Select Installation Monitoring.
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E

Note ° The InstallShield Professional Logging Method, which should be used to repackage InstallShield Editor
and DevStudio 9.x InstallScript installations, is not offered as a choice on the Method Selection panel. See
Repackaging Using the InstallShield Professional Logging Method for more information on using that method.

4. Continue with Step 2: Excluding Processes (Optional).

Step 2: Excluding Processes (Optional)

Task:

During Installation Monitoring, Repackager captures all of the activity of each service or process running on the
machine, and then processes this collected data. However, many services running on a machine may have nothing
to do with the installation being repackaged.

e If you want to modify the default excluded processes list, perform the following steps.

e If you do not want to modify the default excluded processes list, continue with Step 3: Collecting
Product Information.

Q
Tip * If you know that the installation that you are capturing is from a self-extracting . exe file and if you want to use
the Installation Monitoring method, you should add the name of that . exe file to the excluded processes list.

To exclude processes from Installation Monitoring:

1. On the Method Selection Panel, click the Advanced Settings link. The Excluded Processes dialog box
opens, listing a default set of processes.

Repackaging Wizard @I
The following processes should not be monitored.

Excluded Processes:

ALDIODG EXE -
Dy EXE
FNPLICEMSINGSERVICE. EXE
LSM.EXE

MOTGEVC.EXE
REPACK.EXE
SEARCHFILTERHOST EXE |4
SEARCHINDE=ER.EXE
SEARCHPROTOCOLHOST EXE
SERVICES.EXE

SMSVCHOST.EXE

SPPSYLCEXE

TASKHOST.EXE -

[ 0K ] [ Cancel

2. To add a process to this list, click the New (
of the process that you want to exclude.

-+|) button to add a new blank line to this list, and enter the name

3. To delete a process from this list, select the process and click the Delete () button.
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E

Note * The changes you make to the excluded processes list are persisted for future Repackaging sessions.
Therefore, once you have entered an appropriate set of processes to exclude for your machine, you can skip
this optional step.

4. Click OK to return to the Method Selection Panel.

5. Continue with Step 3: Collecting Product Information.

Step 3: Collecting Product Information

%

Task:

428

In this step, you will specify the installation you want to repackage and enter any command-line arguments to be
used when the installation is run.

To enter product information:

On the Method Selection Panel, click Next. The Collect Product Information Panel opens.

Repackaging Wizard E|
Collect Product Information
Provide product information For repackaging. Ttems with asterisks (*) are E“H
required.

Setup Programs
Prograr Fila: *
agesPHIProgramFilesFolderInstallshisld\PackageFo! Theteb \pFtwwiz, exe E]

Command-line Argumentis):

Edit Setup List
Product Infarmation
Product Mame: * Wersion:
PackageForTheweb 4,00
Company Mame: *
Installshield Software Corporation IMare.
[ < Back. ” Mext = ] [ Cancel ] [ Help ]

Click the Browse ((..]) button next to the Program File field and select the installation program that you are
repackaging.

In the Command-line Argument(s) field, enter any command-line arguments to be used when the
installation is run.

In the Product Information area, modify the Product Name, Version, and Company Name, as necessary.

If you want to associate Web sites with this installation, click the More link to open the Additional Product
Information dialog box, enter the Product URL and Support URL for the application you are repackaging,
and click OK.
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6. Continue with Step 4: Adding Additional Setup Programs (Optional).

Step 4: Adding Additional Setup Programs (Optional)

You can specify additional setup programs to repackage together with this installation. Additional setup programs
share the same product name, version number, and company name in the repackaged installation. However, as
you locate each additional setup program to repackage, you can specify command-line parameters pertaining only
to that setup. You can also specify the order in which the setups are run, should it be necessary.

e If you want to add additional setup programs, perform the following steps.

e If you do not want to add additional setup programs, continue with Step 5: Set Target Project
Information.

Task: To add additional setup programs, perform the following steps:

1.  On the Collect Product Information Panel, click the Edit Setup List link. The Additional Setup Programs
dialog box opens.

Additional Setup Programs |£|
Specify the setup programs you want to repackage. Repackaging Wizard wil
package them into a single M3I package.

Repackaging Wizard will run the setups in the order
Setup Program Command-line Argurments Mew, ..
C:iPackagesPHi...
Ci\PackagesPHY...
Up
[ OK l [ Cancel ]

2. If you want to add a setup program, perform the following steps:

a. Click New. The Setup Information dialog box opens.

Setup Information &|

Modify the setup location and its command-line arguments.
Program File:
I |

Command-line Argumentis):

(]

[ Ok ] [ Cancel ]

b. Click the Browse ([..]) button next to the Program File field and select the setup program that you want
to add.
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c. Inthe Command-line Argument(s) field, enter any command-line arguments to be used when this
setup is run.

d. Click OK to return to the Additional Setup Programs dialog box.
e. If necessary, click the Up and Down buttons to change the order in which the setups are run.
3. If you want to edit an existing setup program, perform the following steps:

a. Onthe Additional Setup Programs dialog box, select the program that you want to edit and click Edit. The
Setup Information dialog box opens.

Setup Information PZ|

Modify the setup location and its command-line arguments.

Program File:

rogramFilesFolderiInstallShieldiPackageFor TheWeb 41s

Carmmand-line Argumentis):

[ Ok ] [ Cancel ]

b. Modify the Program File and Command-line Argument(s) fields.
c. Click OK to return to the Additional Setup Programs dialog box.
4. If you want to delete a listed setup program, perform the following steps:

a. Select the program that you want to delete and click Delete. A dialog box opens prompting you to
confirm the deletion.

b. Click OK to confirm the deletion and return to the Additional Setup Programs dialog box, where the
deleted program is no longer listed.

5. Click OK to return to the Collect Product Information panel.

6. Continue with Step 5: Set Target Project Information.

Step 5: Set Target Project Information
In this step, you identify the location where you want files created by Repackager to be stored. For the Installation

Monitoring repackaging method, it is recommended that this location not be located on your clean machine, but
rather on the same machine as the Repackager executable (most likely on your administrator machine).
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%

Task: To set target project information and capture settings:

1.  On the Collect Product Information Panel, click Next. The Set Target Project Information and Capture Settings
Panel opens.

Repackaging Wizard g|

Set Target Project Information and Capture Settings
Provide the target project path and review capture settings. E’ﬂ

Specify the location where Repackaging Wizard will store Files created during syskem change
analysis, The Repackaging Wizard output file {inc) will be saved to this location,

Project path to store files

Ci\PackagesPH E]

Review or edit the current settings

Any changes made to these settings will apply to the current and
future analysis. (E00500

< Back ][ Start: ][ Cancel ] | Help |

E

Note - If you specified an InstallShield Editor or DevStudio 9.x InstallScript installation in the Program File
field of the Collect Product Information Panel, the InstallShield Professional Setup Panel appears instead of the
Set Target Project Information and Capture Settings Panel. See Repackaging Using the InstallShield
Professional Logging Method.

2. Click the Browse ([.J) button next to the Project path to store files field and select the directory where you
want the Repackaging Wizard to place its output, including the Repackager project file (.1rp), the
Repackaging Wizard output files, and source files.

You can also enter the name of a new folder in the Project path to store files field, and you will be prompted
to create it when you exit this panel.

3. Continue with Step 6: Set Capture Settings (Optional).

Step 6: Set Capture Settings (Optional)

From the Set Target Project Information and Capture Settings Panel, you can specify the following capture types for
the repackaging session:

e Files and deleted files
® .inifiles and .ini files with non-.ini extensions

e Shortcuts
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® Registry data and deleted registry data
Options set in this dialog box apply to the current and subsequent repackaging sessions.
e [f you want to set capture settings, perform the following steps.
e If you do not want to set capture settings, continue with Step 7: Beginning the Repackaging Process.
g
Task: To set capture settings:

1. On the Set Target Project Information and Capture Settings Panel, click Edit. The Analysis Options dialog box

opens.
Analysis Options |z|
Capture types
Files Shortcuts
[ Deleted files Registry data
INI files [ Deleted registry data

[ Mort-ini extensions

Restrict directory analyzis ta the following [Snapzhaot mode anly):

u] ][ Cancel ][ Help

E

Note * Options set in this dialog box apply to the current and subsequent repackaging sessions.

2. Select the capture types that you want to use for this repackaging session:
® Files
o Deleted files
e INI files
®  (INI files with) Non-.ini extensions
e Shortcuts
¢ Registry data
o Deleted registry data
3. Click OK to return to the Set Target Project Information and Capture Settings Panel.

4. Continue with Step 7: Beginning the Repackaging Process.
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Step 7: Beginning the Repackaging Process
In this step you will begin the repackaging process.

&

Task: To begin the repackaging process:

1. To begin the repackaging process, click Start on the Set Target Project Information and Capture Settings

Panel. The Repackaging Panel opens and the Repackaging Wizard captures the initial system status. Then,
the selected setup program will be launched.

Repackaging Wizard [$__<|
Repackaging ...
Flease wait while Repackaging \Wizard performs system analysis, E’ﬂ

Repackaging Wizard is analvzing vour system and setupis) ...

Running the setup programis)...

2. Follow the prompts until the installation has completed. When the installation is complete, you are prompted to

make any additional changes to the system (such as deleting files and shortcuts) that you want to be recorded
in this repackaged installation.
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Repackaging Wizard g|

Repackaging ...
Flease wait while Repackaging Wizard performs system analysis, E’ﬂ

Repackaging Wizard is analvzing your system and setupis) ...
Al sekupis) have been launchad.
Once the installation is complete, vou may make additional changes to the system such

as deleting files and shortcuts, Click Process when vou are ready to complete the
repackaging pracess.

[ Process ] [ Cancel ] [ Help ]

analyzes the system and setup data that it collected.

3. When you are ready to complete the repackaging process, click Process. The Repackaging Wizard then

Following repackaging, the Summary Panel is displayed, providing confirmation that the repackaging was

successful.

Repackaging Wizard Pz

Summary

Review the summary information below. Click Finish ko exit Repackaging E’ﬂ
Wizard,

Summary:

Repackaging Methad: Installation Monitaring

Product Mame: QuickTime
Output Files:

Qutput file created: C:\PackagesSiQuickTime,inc
Next Steps:

Click Finish ta launch the Repackager to edit and build vour praject.

5. Continue with the instructions in Working With Repackager Projects.

ADS-1000-UG00
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Repackaging Using the Snapshot Method
When using the Snapshot method of repackaging, the Repackaging Wizard takes a reference snapshot of a
system as a baseline configuration, performs the installation, and then takes a second snapshot.

The difference between the two snapshots is stored in a directory you specify, including the Repackager project file
(.1rp), the Repackaging Wizard output files, and the source files. The Repackager project file can then be
converted into a Windows Installer package (.ms1).

AN

Caution - It is highly recommended that you repackage applications on a “clean” system. See Configuring
Repackager to Ensure Optimal Installation Capture for more information.

Types of Snapshot Repackaging

There are two types of Snapshot repackaging:

Single Step

When Repackaging in a single step:

® You specify at least one setup program to repackage.

® Repackager first takes an initial system snapshot.

® Repackager then runs the setup program(s) you selected.

e Then Repackager takes a second snapshot to create the script file that can be converted into a Windows
Installer package.

You also have the option of requiring the Repackager to prompt you before running the setup program(s), allowing
you the opportunity to make changes to your system that you want included in the final package.

See Performing Single Step Snapshot Repackaging.

Multiple Step

When repackaging in multiple steps:
e You run the Repackager to obtain an initial system snapshot, after which the Repackager exits.

® You can then perform any modifications to the system, such as changing configurations, running installations,
and so forth.

® After making the necessary modifications, you would then run the Repackager again to analyze system status
changes.

® Repackager compares the final snapshot to the initial snapshot to determine the system changes that were
made, and then records that information in a script file.

See Performing Multiple Step Snapshot Repackaging.
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Performing Multiple Step Snapshot Repackaging

To repackage an installation using the Multiple Step Snapshot method, perform the following steps:
e Step 1: Selecting the Repackaging Method.

e Step 2: Initial Analysis

e Step 3: Install Setup and Make Manual System Changes

e Step 4: Entering Product Information

e Step 5: Set Target Project Information

e Step 6: Set Capture Settings (Optional)

e Step 7: Beginning the Repackaging Process

Step 1: Selecting the Repackaging Method

In this step, you launch the Repackaging Wizard and select the Snapshot repackaging method.

&

Task: To select a repackaging method:

1. From the Repackager interface, launch the Repackaging Wizard by clicking on the link or by selecting
Repackaging Wizard from the Tools menu. The Welcome Panel opens.

=)

Repackaging Wizard

Welcome to Repackaging Wizard

This wizard enables you to create a completely new
installation for an existing, packaged application. It can
also create an installation project that can be further
enhanced using InstallShield.

* . Foroptimal use, Repackaging Wizard should be
\‘]-J run remotely from a mapped location. See the Help
Library topic "Repackaging Wizard Best
Practices" for details.

< Back [ Mext > ]I Cancel JI Help

2. Click Next. The Method Selection Panel opens.
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Repackaging Wizard @
Methed Selection
Select a repackaging method. Erﬂ

@ Installation Menitoring  {Recommended)

Fepackager watches lowerdevel system activities and records changes made to the system
by the setup programis). It then analyzes these activities and stores the setup datain an
output file which can be converted into a Windows Installer package.

Repackager takes an initial snapshot of the local system, nuns the setup programis), and

then takes a second snapshot. The difference between the two snapshots is stored in an
output file which can be converted into @ Windows Installer package.

2 "\ The newly improved Install Monitoring method is the default method as it holds the
\_1) potential for cost savings through increased reliability and shorter repackaging times.

< Back ][ Mext = ][ Cancel ][ Help

E

Note ° The InstallShield Professional Logging Method, which should be used to repackage InstallShield Editor
and DevStudio 9.x InstallScript installations, is not offered as a choice on the Method Selection panel. See
Repackaging Using the InstallShield Professional Logging Method for more information on using that method.

3. Select Snapshot and click Next. The Snapshot Method panel opens.

4.

Repackaging Wizard §|

onapshot Method
Select either a single-step or multiple-step snapshot method.

In a single pass, automatically analyze the initial svstem status First, run one or
more setup programs (ko modify the local system), and then analyze the
syskem status changes,

Prompt befFore running the setup programis)

() Multiple Steps

. IF wou want ko convert an InstallScript MSI package ko a Basic MSI that preserves
\_12 the InstallScript installation logic, select either Installation Monitoring or Single Step
Snapshot, If vou select Multiple Step Snapshot, the InstallScript installation logic wil
not be preserved,

[ < Back. ” ek = l[ Cancel ] [ Help ]

enabled.
5. Select the Analyze the initial system status option.

6. Continue with Step 2: Initial Analysis.
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Step 2: Initial Analysis
In this step, the Repackaging Wizard takes an initial snapshot of your system.
Task: To perform initial analysis:

1.  On the Snapshot Method panel, click Next. The Repackaging Panel of the Repackaging Wizard opens,
displaying the progress of the initial system status capture.

Repackaging Wizard
Repackaging ...
Flease wait while Repackaging Wizard performs system analysis, E’H

Repackaging Wizard is analyzing your system and sekupis) ...

Capturing the initial system status, ..

Reading file structure. ..
35000 entties read
Cihadminstudio Sharedh, 4., \Program

NRRRRRENNRRRANRRNNRRRANNERRRRR ]

Cancel | [ Help ]

When Repackager finishes capturing the initial system status, the Summary panel opens, prompting you to
install the application you are repackaging.

Repackaging Wizard [g|
Summary
Review the summary information below, Click Finish ko exit Repackaging Ej
Wizard,
Summary:

Initial snapshot in the multiple snapshot process is complete,
Next Steps:

1. Install the setup(s) vou want to repackage.

2. Make anv manual changes to the system that vou want captured in the M3,

3. Run Repackaging Wizard again using Snapshat technology and the multi-step
option ko create the repackager output File,
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Click Finish to close the Repackaging Wizard.

3. Continue with Step 3: Install Setup and Make Manual System Changes.

Step 3: Install Setup and Make Manual System Changes

In this step, you will manually launch the installation of the application you are repackaging, and then you will make
any manual changes to the system that you want captured in the Windows Installer package.

%

Task: To install setup and make manual system changes:
1. Launch the installation program of the application you are repackaging.
2. Follow the prompts until the installation has completed.
3. When the installation is complete, make any additional changes to the system (such as deleting files and
shortcuts) that you want to be recorded in this repackaged installation.
4. Launch the Repackaging Wizard again. The Welcome Panel opens.
5. Click Next. The Method Selection Panel opens.
6. Select Snapshot and click Next. The Snapshot Method Panel opens with Multiple Steps already
selected, and the Analyze system status changes option now enabled and selected.
Repackaging Wizard g|
enapshot Method
Select either a single-step or multiple-step snapshot method. E’H
) single Step
In a single pass, automatically analyze the initial svstem status First, run one or
more setup programs (ko modify the local system), and then analyze the
syskem status changes,
10} :
() analyze the initial system status
() Analyze system status changes
. IF wou want ko convert an InstallScript MSI package ko a Basic MSI that preserves
1 the InstallScript installation logic, select either Installation Monitoring or Single Step
Snapshot, If vou select Multiple Step Snapshot, the InstallScript installation logic wil
not be preserved,
[ < Back. ” Mext = l [ Cancel ] [ Help
7. Continue with Step 4: Entering Product Information.

Step 4: Entering Product Information

In this step, you will enter product information for the application that you just installed.
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Task: To enter product information:
1.  Onthe Snapshot Method Panel, click Next. The Collect Product Information Panel opens. Because you

are now performing the second step of a multiple-step Snapshot, the Setup Programs area is disabled
(because you have already installed the application you are repackaging).

Repackaging Wizard r5__<|
Collect Product Information
Pravide product information For repackaging. Ttems with asterisks (*) are E’H
required.

|:| Setup Programs
Prograrm Fila: *

Command-line Argumentis):

Product Infarmation
Product Mame: * Wersion:

| 1.0

Company Mame: *

=
=
=
i

[ Cancel ] [ Help ]

2. Inthe Product Information area, modify the Product Name, Version, and Company Name, as necessary.
3. If you want to associate Web sites with this installation package, perform the following steps:

a. Click the More link. The Additional Product Information dialog box opens.

Additional Product Information [‘S__<|
Product URL:
|
Support URL:
[ QK. ] l Cancel J

b. Enter the Product URL and Support URL for the application you are repackaging.
c. Click OK.

4. Continue with Step 5: Set Target Project Information.

Step 5: Set Target Project Information

In this step, you identify the location where you want files created by Repackager to be stored.
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o

Task: To set target project information and capture settings:

1. Onthe Collect Product Information Panel, click Next. The Set Target Project Information and Capture
Settings Panel opens.

Repackaging Wizard g|
Set Target Project Information and Capture Settings
Provide the target project path and review capture settings. E’ﬂ

Specify the location where Repackaging Wizard will store Files created during syskem change
analysis, The Repackaging Wizard output file {inc) will be saved to this location,

Project path to store files

Ci\PackagesPH E]

Review or edit the current settings

Any changes made to these settings will apply to the current and

future analysis.

[ < Back ][ Start: ][ Cancel ] | Help |

2. Click the Browse ([...]) button next to the Project path to store files field and select the directory where you
want the Repackaging Wizard to place its output, including the Repackager project file (.1rp), the
Repackaging Wizard output files, and source files.

You can also enter the name of a new folder in the Project path to store files field, and you will be prompted
to create it when you exit this panel.

3. Continue with Step 6: Set Capture Settings (Optional).

Step 6: Set Capture Settings (Optional)

From the Set Target Project Information and Capture Settings Panel, you can specify capture types for the
repackaging session such as files, .ini files, shortcuts, and Registry data. You can also restrict directory analysis to
specific directories, which can significantly improve repackaging performance.

e |f you want to modify the default capture settings, perform the following steps.

e If you do not want to modify the default capture settings, click Next and continue with Step 7:
Beginning the Repackaging Process.
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Task:
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To modify capture settings:

1.

On the Set Target Project Information and Capture Settings Panel, click Edit. The Analysis Options

dialog box opens.

Analysis Options

Capture types
Files Shortcuts
[ Deleted files Registry data
INI files [ Deleted registry data

[ Morr-ini extensions

Restrict directory analysis to the following [Snapzhot mode only):

C:h

3

[ 0K H Cancel H

Help

E

Note ° Options set in this dialog box apply to the current and subsequent repackaging sessions.

Select the capture types that you want to use for this repackaging session:

o Files

e Deleted files

e INIfiles

@  (INI files with) Non-.ini extensions
e Shortcuts

e Registry data

o Deleted registry data

If you want to restrict directory analysis to specific directories, click New. The Choose Directory dialog box

opens.

ADS-1000-UG00
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Choose Directory.

Choose Mew Drive/Path

=%
]} 3% Floppy (A:)
% Server\Builds (B:)
“g Local Disk (C:)
b DVD Drive (D)
Gf Contral Panel

¥ FTP &RDS

% Mobile Device

\é My Metwork Places
2 Recycle Bin

b
>

l

O H Cancel ]

Repackaging Legacy Installations Using the Repackaging Wizard

4. Select a directory and click OK. The selected directory is now listed on the Analysis Option dialog box.

5. If you want to modify an existing restriction, or delete a restriction, select the directory and click Edit or

Delete.

6. Click OK to return to the Set Target Project Information and Capture Settings Panel.

7. Continue with Step 7: Beginning the Repackaging Process.

Step 7: Beginning the Repackaging Process

In this step you will begin the repackaging process.
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&

Task: To begin the repackaging process:

1. To begin the repackaging process, click Start on the Set Target Project Information and Capture Settings
Panel. The Repackaging Panel opens and the Repackaging Wizard captures the system state changes.

Repackaging Wizard |§|
Repackaging ...
Flease wait while Repackaging Wizard performs system analysis, E’H

Repackaging Wizard is analvzing your system and setupis) ...

Analyzing the system state changes...

Reading stored registry database. ..
77000 entries read

[ Cancel ] [ Help ]

When the Repackaging Wizard has finished analyzing the system state changes and creating the Repackager
project, the Summary Panel opens, providing confirmation that the repackaging was successful and listing the
location of your new Repackager project.

Repackaging Wizard |§|
Summary
Review the summary information below. Click Finish ko exit Repackaging E’H
Wizard,
Summary:

Repackaging Method: Snapshot

Product Marme: Package for the web
Output Files:

Cutput file created: :\PackagesS\Package for the Web.inc
Next Steps:

Click Finish to launch the Repackager to edit and build your project,

2. Click Finish. Repackager launches and opens the Repackager project file (*.1rp) that you just created.
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= Package for the Web.irp - Repackager

File ‘iew Project Build Tools Help

=2 ¥ B oG de
= d Captured Installation 5 Captured Installation
Files and Folders py
Reqistry Entries
U Shortcuts Captured Installation Summary
% INI Files
= (ﬁ Repackaged Qutput Operating Syskem: ‘Windows ¥P Professional, version 5.1,2600 Service Pack 2 (English)
ﬁl Package Information
f_} Advanced Settings Path to original setup: E
Criginal karget Falder: | [ProgramFilesFolder InstallShield\PackageFor Theweb 4 ~ |
Lj 71 files UE| Zshortauts
@ 126 registry entries % 21Nl file entries

Captured Installation Tasks

Create sefup capture report
Generate an HTML or text document that summarizes the captured setup data,

Sican For sebup intent
Analyze the captured sebup data For missing Files and files that the original setup intended to deploy,

|4

[~
|l

Ready

3. Continue with the instructions in Working With Repackager Projects.

Performing Single Step Snapshot Repackaging

To repackage an installation using the Single Step Snapshot method, perform the following steps:
e Step 1: Selecting the Repackaging Method.

e Step 2: Collecting Product Information

e Step 3: Set Target Project Information

e Step 4: Set Capture Settings (Optional)

e Step 5: Beginning the Repackaging Process

Step 1: Selecting the Repackaging Method

In this step, you launch the Repackaging Wizard and select the Snapshot repackaging method.
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&

Task:

446

To select a repackaging method:

1.

2.

From the Repackager interface, launch the Repackaging Wizard by clicking on the link or by selecting
Repackaging Wizard from the Tools menu. The Welcome Panel opens.

Repackaging Wizard @

Welcome to Repackaging Wizard

E3

This wizard enables you to create a completely new
installation for an existing, packaged application. t can
also create an installation project that can be further
enhanced using InstallShield.

=  Foroptimal use, Repackaging Wizard should be
\._I:) run remately from a mapped location. See the Help
Library topic "Repackaging Wizard Best
Practices” for details.

< Back [ Mext = ]I Cancel JI Help

Click Next. The Method Selection Panel opens.

Repackaging Wizard @
Method Selection
Select a repackaging method. Eiﬂ
@ Installation Monitoring  (Recommended) Advanced Settings

Fepackager watches lowerdevel system activities and records changes made to the system
by the setup programis). It then analyzes these activities and stores the setup datain an
output file which can be converted into @ Windows Installer package.

") Snapshot
Repackager takes an initial snapshot of the local system, runs the setup programis), and
then takes a second snapshot. The difference between the two snapshots is stored in an
output file which can be converted into a Windows Installer package.

2 . The newly improved Install Monitoring method is the default method as it holds the
. | potertial for cost savings through increased reliabilty and shorter repackaging times.

< Back ][ Mext > ][ Cancel ][ Help ]

E

Note ° The InstallShield Professional Logging Method, which should be used to repackage InstallShield Editor
and DevStudio 9.x InstallScript setups, is not offered as a choice on the Method Selection panel. See
Repackaging Using the InstallShield Professional Logging Method for more information on using that method.
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3. Select Snapshot and click Next. The Snapshot Method panel opens.

Repackaging Wizard E|
snapshot Method
Select either a single-step or multiple-step snapshot method. E‘ﬂ

In a single pass, automatically analyze the initial svstem status Firsk, run one or
more setup programs (to modify the local system), and then analvze the
system status changes.

Prompt beFore running the setup programis)

) Multiple Steps

L IF wou want ko convert an InstallScript MSI package ko a Basic MSI that preserves
\_12 the InstallScript installation logic, select either Installation Monitoring or Single Step
Snapshot. IF wou select Mulkiple Step Snapshot, the InstallScript installation logic will
not be preserved,

[ < Back. ” Mext = ][ Cancel ] [ Help

4. On the Snapshot Method panel, select Single Step.

5. If you want to be prompted before the selected setup program is launched, select the Prompt before
running the setup program(s) option. If you do not select this option, the setup program will automatically
be launched as soon as the Repackaging Wizard has finished analyzing the system status.

6. Continue with Step 2: Collecting Product Information.

Step 2: Collecting Product Information

In this step, you will specify the installation you want to repackage and enter any command-line arguments to be
used when the installation is run.
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&

Task: To enter product information:

1.  On the Snapshot Method panel, click Next. The Collect Product Information Panel opens with the Setup
Programs and Product Information areas enabled.

Repackaging Wizard Pz|
Collect Product Information
Provide product information for repackaging. Items with asterisks (*) are E’ﬂ
required,

Setup Prograrns
Program File: *
Command-line Argumentis):
| Edit Setup List

Product Information

Product Mame: * Wersion:
| | [0

Comnpany Mame: *

=
(=]
=]
i

(o) (o]

2. Click the Browse ([-.]) button next to the Program File field and select the installation program that you are
repackaging.

3. Inthe Command-line Argument(s) field, enter any command-line arguments to be used when the
installation is run.

4. Inthe Product Information area, modify the Product Name, Version, and Company Name, as necessary.
5. If you want to associate Web sites with this installation package, perform the following steps:

a. Click the More link. The Additional Product Information dialog box opens.

Additional Product Information r5__<|
Product URL:
[ |
Support URL:
| |
[ ak. l [ Cancel ]

b. Enter the Product URL and Support URL for the application you are repackaging.
c. Click OK.

6. Continue with Step 3: Set Target Project Information .
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Step 3: Set Target Project Information
In this step, you identify the location where you want files created by Repackager to be stored.

o

Task: To set target project information:

1.  On the Collect Product Information Panel, click Next. The Set Target Project Information and Capture
Settings Panel opens.

Repackaging Wizard g|
%et Target Project Information and Capture Settings
Provide the target project path and review capture settings. E’H

Specify the location where Repackaging Wizard will store Files created during system change
analysis, The Repackaging Wizard output file {inc) will be saved to this location,

Project path to store files

Ci\PackagesPH E]

Feeview or edit the current settings

Ainy changes made to these settings will apply ko the current and

Future analysis.

[ < Back. ][ Start ][ Cancel ] | Help

2. Click the Browse ([..J) button next to the Project path to store files field and select the directory where you
want the Repackaging Wizard to place its output, including the Repackager project file (.1rp), the
Repackaging Wizard output files, and source files.

You can also enter the name of a new folder in the Project path to store files field, and you will be prompted
to create it when you exit this panel.

3. Continue with Step 4: Set Capture Settings (Optional).

Step 4: Set Capture Settings (Optional)

From the Set Target Project Information and Capture Settings Panel, you can specify capture types for the
repackaging session such as files, .ini files, shortcuts, and Registry data. You can also restrict directory analysis to
specific directories, which can significantly improve repackaging performance.

e If you want to modify the default capture settings, perform the following steps.

e [f you do not want to modify the default capture settings, click Next and continue with Step 7:
Beginning the Repackaging Process.
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Task:
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To modify capture settings:

1.

On the Set Target Project Information and Capture Settings Panel, click Edit. The Analysis Options

dialog box opens.

Analysis Options

Capture types
Files Shortcuts
[ Deleted files Registry data
INI files [ Deleted registry data

[ Morr-ini extensions

Restrict directory analysis to the following [Snapzhot mode only):

C:h

3

[ 0K H Cancel H

Help

E

Note ° Options set in this dialog box apply to the current and subsequent repackaging sessions.

Select the capture types that you want to use for this repackaging session:

o Files

e Deleted files

e INIfiles

@  (INI files with) Non-.ini extensions
e Shortcuts

e Registry data

o Deleted registry data

If you want to restrict directory analysis to specific directories, click New. The Choose Directory dialog box

opens.

ADS-1000-UG00
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Choose Directory.

Choose Mew Drive/Path

=%
]} 3% Floppy (A:)
% Server\Builds (B:)
“g Local Disk (C:)
b DVD Drive (D)
Gf Contral Panel

¥ FTP &RDS

% Mobile Device

\é My Metwork Places
2 Recycle Bin

b
>

l

O H Cancel ]

Repackaging Legacy Installations Using the Repackaging Wizard

4. Select a directory and click OK. The selected directory is now listed on the Analysis Option dialog box.

5. If you want to modify an existing restriction, or delete a restriction, select the directory and click Edit or

Delete.

6. Click OK to return to the Set Target Project Information and Capture Settings Panel.

7. Continue with Step 7: Beginning the Repackaging Process.

Step 5: Beginning the Repackaging Process

In this step you will begin the repackaging process.
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&

Task: To begin the repackaging process:

1. To begin the repackaging process, click Start on the Set Target Project Information and Capture
Settings Panel. The Repackaging Panel opens and the Repackaging Wizard captures the initial system

status.
Repackaging Wizard E|
Repackaging ...
Flease wait while Repackaging \Wizard performs system analysis, E’H

Repackaging Wizard is analvzing vour system and setupis) ...

Capturing the initial system status...

Reading Registry daka. ..
86000 entries read

[ Cancel ] [ Help ]

Depending upon whether you chose the Prompt before running the setup program(s) option on the
Snapshot Method Panel, either the installation that you selected will start or you will be prompted to start it.

Repackager

! E Click 0K when you are ready ko run the setup(s).
.

2. Install the application by following the prompts until the installation has completed.

3. When the installation is complete, you are prompted to make any additional changes to the system (such as
deleting files and shortcuts) that you want to be recorded in this repackaged installation.
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Repackaging Wizard g|

Repackaging ...
Flease wait while Repackaging Wizard performs system analysis, E’ﬂ

Repackaging Wizard is analvzing your system and setupis) ...
Al sekupis) have been launchad.
Once the installation is complete, vou may make additional changes to the system such

as deleting files and shortcuts, Click Process when vou are ready to complete the
repackaging pracess.

[ Process ] [ Cancel ] [ Help ]

4. When you are ready to complete the repackaging process, click Process. The Repackaging Wizard then
analyzes the system and setup data that it collected.

Following repackaging, the Summary Panel is displayed, providing confirmation that the repackaging was
successful and listing the location of the Repackager project that was just created.

Repackaging Wizard Fz|
Summary
Review the summary information below. Click Finish ko exit Repackaging E’ﬂ
Wizard,
Summary:

Repackaging Methad: Sniapshot

Product Mame: PackageForTheweb 4
Output Files:

Qutput file created: C:\PackagesPTFW\PackageForTheweb 4.inc
Next Steps:

Click Finish ta launch the Repackager to edit and build vour praject.

5. Click Finish. Repackager launches and opens the Repackager project file (*.1rp) that you just created.

6. Continue with the instructions in Working With Repackager Projects.
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Repackaging Using the InstallShield Professional
Logging Method

Task:

454

If you are repackaging an InstallShield Editor or DevStudio 9.x InstallScript installation, you can use the
InstallShield Professional Logging Method to read logged output of those setups to obtain additional information
that would not be captured by the Installation Monitoring or Snapshot methods: Path Variables and the Feature

Tree.

See InstallShield Professional Logging Method for more information.

Using the InstallShield Professional Logging Method

To repackage an InstallShield Editor or DevStudio 9.x InstallScript installation using the InstallShield Professional
Logging Method, perform the following steps:

To repackage using the InstallShield Professional Logging Method:

1. Launch the Repackaging Wizard from Repackager. The Welcome Panel opens.

Repackaging Wizard

E3

(el

Welcome to Repackaging Wizard

This wizand enables you to create a completely new
installation for an existing. packaged application. I can
also create an installation project that can be further
enhanced using InstallShield.

* . Foroptimal use, Repackaging Wizard should be
._1 run remotely from a mapped location. See the Help
Library topic "Repackaging Wizard Best
Practices” for details.

<Back |[ MNei> | [ Camcel | [ Hebp

2. Click Next. The Method Selection Panel opens.

ADS-1000-UG00

AdminStudio 10.0 User Guide



Chapter 7: Repackaging Legacy Installations Using the Repackaging Wizard
Repackaging Legacy Installations Using the Repackaging Wizard

Repackaging Wizard @
Methed Selection
Select a repackaging method. E‘E

@ Installation Monitoring {Recommended)

Fepackager watches lowerdevel system activities and records changes made to the system
by the setup programis). It then analyzes these activities and stores the setup datain an
output file which can be converted into a Windows Installer package.

Snapshot

Repackager takes an initial snapshot of the local system, nuns the setup programis), and
then takes a second snapshot. The difference between the two snapshots is stored in an
output file which can be converted into @ Windows Installer package.

2 "\ The newly improved Install Monitoring method is the default method as it holds the
‘_1‘) potential for cost savings through increased reliability and shorter repackaging times.

| < Back |[ Mext = ]| Cancel || Help

3. Select the Installation Monitoring method.

The InstallShield Professional Logging Method is not offered as a choice on this panel, but when you
select an InstallShield Editor or DevStudio 9.x InstallScript installation on the Collect Product Information
Panel (the next panel in the Repackaging Wizard), Repackager will automatically detect the InstallScript
installation and will display the InstallShield Professional Setup Panel. On this panel you can choose to
use the InstallShield Professional Logging Method instead of the method you chose on the Method
Selection Panel.

AN

Caution » When you are attempting to repackage a setup using the InstallShield Professional Logging Method,
you are permitted to select either Installation Monitoring or Snapshot on the Method Selection Panel, but it
is recommended that you select Installation Monitoring.

If you select the Snapshot method, an additional panel opens, entitled Snapshot Method. On this panel, if you
select Multiple Steps instead of Single Step, Repackager will not recognize the setup as an InstallShield
Editor or DevStudio 9.x InstallScript installation and the InstallShield Professional Setup Panel will not
open. You can avoid this extra and possibly troublesome step by selecting Installation Monitoring on the
Method Selection Panel.

4. Onthe Method Selection Panel, click Next. The Collect Product Information Panel opens.
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Repackaging Wizard Pz|
Collect Product Information
Provide product information for repackaging. Items with asterisks (*) are E’H
required,
Sebup Prograrns
Program File: *
Command-line Argumentis):
Edit Setup Lisk
Froduct Infarmation
Product Mame: * Wersion:
1.0
Comnparny Mame: *
Maore
(o] (]

AN

Caution * Do not use the Edit Setup List link to add an additional setup program to this project. If you do,
Repackager will not recognize the specified installation as an InstallShield Editor or DevStudio 9.x InstallScript
installation and the InstallShield Professional Setup Panel will not open.

Click the Browse ([...]) button next to the Program File field and select the InstallShield Editor or DevStudio
9.x InstallScript installation that you are repackaging.

In the Command-line Argument(s) field, enter any command-line arguments to be used when the
installation is run.

In the Product Information area, modify the Product Name, Version, and Company Name, as necessary.
If you want to associate Web sites with this installation package, perform the following steps:

a. Click the More link. The Additional Product Information dialog box opens.

Additional Product Information r5__<|
Product URL:
|
Support URL:
[ ak. ] l Cancel J

b. Enter the Product URL and Support URL for the application you are repackaging.
c. Click OK.

Click Next. Because you specified an InstallShield Editor or DevStudio 9.x InstallScript installation in the
Program File field, the InstallShield Professional Setup Panel opens.
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Repackaging Wizard

Installshield Professional Setup
Optionally change repackaging method for ISPro setup

The zetup you are launching was created with InstallShield Profezsional. The Repackager
can directly read logged output of InstallShield Profeszional Engine operations, removing
the need for repackaging InstallShield Professional setups.

It iz recommended that you use thiz method instead of repackaging.

Use InstallShield Professional logging instead of repackaging.

Repackaging Legacy Installations Using the Repackaging Wizard

=3

[ < Back ” Mexk = l[ Cancel

] [ Help ]

10. Select the Use InstallShield Professional logging instead of repackaging option.

11. Click Next. The Set Target Project Information and Capture Settings Panel opens.

Repackaging Wizard

P

%et Target Project Information and Capture Settings
Provide the target project path and review capture settings.

Specify the location where Repackaging Wizard will store Files created during system change
analysis, The Repackaging Wizard output file {inc) will be saved to this location,

Project path to store files

Feeview or edit the current settings

Aany changes made to these settings will apply to the current and
Future analysis.

(]

[ < Back. ” Start l[ Cancel

] [ Help ]

12. Click the Browse ([...]) button next to the Project path to store files field and select the directory where you
want the Repackaging Wizard to place its output, including the Repackager project file (.1rp), the
Repackaging Wizard output files, and source files.

You can also enter the name of a new folder in the Project path to store files field, and you will be prompted
to create it when you exit this panel.

13. To begin the repackaging process, click Start on the Set Target Project Information and Capture Settings
Panel. The selected InstallShield Editor or DevStudio 9.x InstallScript installation is launched.

14. Follow the prompts until the installation has completed.
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Repackager then launches and opens the Repackager project file (*.1rp) that you just created.

15. Continue with the instructions in Working With Repackager Projects.

Repackaging an InstallScript MSI Setup to a Basic MSI
Setup
InstallScript MSI installations use a Windows Installer database for storage of all file/registry information, but the

actual user interface, and much of the installation logic is driven by the InstallScript engine via a setup. exe file. This
type of installation architecture can cause difficulties during deployment, such as:

® inability to customize or transform the application
® inability to perform conflict detection

® inability to suppress the user interface

e (difficulty patching or upgrading the application

Also, if an InstallScript MSI installation is repackaged using traditional methods (OS Snapshot or Installation
Monitoring), significant platform-specific or custom installation, maintenance, and uninstallation logic, and user
interface information is lost because those methods only record the installation activities for the specific platform
used during repackaging.

Therefore, it is recommended that you use InstallScript Scan to convert an InstallScript MSI installation to a Basic
MSI package with InstallScript support. InstallScript Scan preserves the original components and much of the
InstallScript installation logic, architecture, and maintainability of the original installation package.

E

Note - If you want to convert an InstallScript MSI package to a Basic MSI package that preserves the InstallScript
installation logic, and you are using the Snapshot method, you must select Single Step rather than Multiple Steps. If

you select Multiple Steps, the InstallScript installation logic will not be preserved.

Task: To convert an InstallScript MSI Setup to a Basic MSI Setup with InstallScript support:
1. Launch the Repackaging Wizard from Repackager. The Welcome Panel opens.
2. Click Next. The Method Selection Panel opens.
3. Select a repackaging method: Installation Monitoring or Snapshot.
4

Click Next. If you selected Snapshot on the Method Selection Panel, the Snapshot Method Panel
appears. (If you selected Installation Monitoring, skip to Step 6.)

5. Select Single Step and click Next. The Collect Product Information Panel opens.
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AN

Caution « Because you are converting an InstallScript MSI package to a Basic MSI package with InstallScript

support, you must select the Single Step Snapshot method (or use the Installation Monitoring method). If you
select Multiple Step Snapshot, the InstallScript installation logic will not be preserved.

On the Collect Product Information Panel, select the InstallScript MSI setup file and enter other product
information.

AN

Caution  While it is possible to click the Edit Setup List button and select additional setups, because you are
converting an InstallScript MSI package, do not select additional setups.

Click Next. Repackager will automatically determine if this is an InstallScript-based setup. If it is an
InstallScript-based setup, the InstallScript MSI Identified Panel opens, informing you that the
Repackaging Wizard has identified this setup as being an InstallScript MSI setup and prompting you to use
InstallScript Scan to convert this setup.

Select Yes and click Next. The InstallScript MSI Conversion Output Panel opens.

In the Project Path to store files field, specify the location where you want the Repackaging Wizard to store files
created during InstallScript Scan Analysis and where it will save the converted MSI package.

E

Note - To specify capture types for the repackaging session, click the Edit button to access the Analysis
Options dialog box.

Click Next. The Repackaging Panel appears, displaying the progress of the repackaging operation.

Following repackaging, the Summary Panel is displayed, providing confirmation that the repackaging was
successful.

Click Finish to launch the Repackager to edit and build your project. See Working With Repackager Projects.

Running the Repackaging Wizard from the Command

Line

To run the Repackaging Wizard from the command line, perform the following steps.

W

Task: To run the Repackaging Wizard from the command line:

1.

2.

Open a command-line prompt.

Type Repack.exe followed by any command-line options you want to pass. See Repackaging Wizard
Command-Line Options.

Press Enter.
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An example of a typical command line is as follows:

Repack.exe -app Setup.exe -o C:\MyRepackagedApps\Output
-pp SomeApp -cs Custom -cf MyOptions.ini -sb

In the above example, the following options are used:
Table 7-8 » Repackager Command-Line Options used in Example

Option Description

-app Specifies the name of the setup.

-0 Specifies the location of the output directory

-pp Specifies the name of the product (and the name of the Repackager output file).
-Cs Specifies the name of the custom analysis options file to use.

-cf Name of the analysis options file to use.

-sb Allows you to run Repackager silently, with no user interaction.

Repackaging a Windows Installer (.msi) Package

While it is not recommended that you repackage a Windows Installer (.ms1) package, it sometimes may be
necessary to repackage a Windows Installer package in order to convert it to a virtual package (perhaps due to the
use of custom actions or other features that are not supported in application virtualization).

To repackage a Windows Installer (.msi) package, perform the following steps:

Task: To repackage a Windows Installer package:

1. From the Repackager interface, launch the Repackaging Wizard by clicking on the link or by selecting
Repackaging Wizard from the Tools menu. The Welcome Panel opens.

2. Click Next. The Method Selection Panel opens.
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Repackaging Wizard

Method Selection
Select a repackaging method.

@ Installation Menitoring  {Recommended)

output file which can be converted into a Windows Installer package.

output file which can be converted into @ Windows Installer package.

Fepackager watches lowerdevel system activities and records changes made to the system
by the setup programis). It then analyzes these activities and stores the setup datain an

Repackager takes an initial snapshot of the local system, nuns the setup programis), and
then takes a second snapshot. The difference between the two snapshots is stored in an

2 "\ The newly improved Install Monitoring method is the default method as it holds the
\_1) potential for cost savings through increased reliability and shorter repackaging times.

=]

[ < Back ][ Next > ][ Cancsl ]

[ Help ]

3. Select Installation Monitoring and click Next. The Collect Product Information Panel opens.

E

Note ° The Installation Monitoring method is recommended, but you may also choose the Snapshot
method when repackaging a Windows Installer package. The Installation Monitoring method was used in
the instructions that follow. For instructions on using the Snapshot method, see Repackaging Using the

Snapshot Method
Repackaging Wizard
Collect Product Information
Provide product information for repackaging. [tems with asterizks [*] are
required.
Setup Programs
Program File: *
Command-line Argument[z]:
Edit Setup List
Froduct Information
Product Mame: * Wersion:
1.0
Company Mame: *
More
(o) (e

4. Click the Browse ([..]) button next to the Program File field to open the Choose Setup Program File

dialog box.
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Choose Setup Program File

Loak in: |D My Documents v| € ? o [~
) @My Music
" 2? @My Pictures
My Recent
Documents
Desklop

T,
My Documents

3

My Computer

File name: | A | [ Open ]

My Metwork Files of type: | Setup Files [*.exe) v | [ Cancel ]

5. From the Files of type list, select All Files (*.*). All files in the selected directory are listed.

6. Click Open and select the Windows Installer package (.msi) that you are repackaging. A message appears
warning you that MSI setups should not typically be repackaged.

Repackager

The current: setup is an MSI setup, M3 setups should bypically not be repackaged.
' Instead, you should consider creating a transform For the MSI setup,
Do you wish to continue?

[ ‘es ] [ Mo ]

7. Click Yes to close the message. Several fields in the Collection Product Information panel have been
populated with the commands necessary to repackage a Windows Installer package.

Repackaging Wizard PS_<|

Collect Product Information

Provide product information for repackaging. [tems with asterizks [*] are
required.

Setup Programs

Program File: *

|EI:\W’INDDW’S\system32\msiexec.exe | m
Command-line Argument[z]:

|.-"i "ChadminStudio Sharedorca. msi™ Edit Setup List

Froduct Information

Product Mame: * Wersion:

| | o

Company Mame: *

| | b
TR
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The following information was filled in:

Field Entry
Program File C:\WINDOWS\system32\msiexec.exe
Command line Argument(s) /i "C:\DIRECTORYPATH\PACKAGENAME.msi"

AN

Caution * Do not edit the entries in the Program File or Command line Argument(s) fields.

8. Inthe Product Information area, make entries in the Product Name, Version, and Company Name fields.

9. Click Next. The Set Target Project Information and Capture Settings Panel opens.

Repackaging Wizard E|
5et Target Project Information and Capture Settings
Provide the target project path and review capture settings. E’ﬂ

Specify the lacation where Repackaging Wizard will store files created during syskem change
analysis, The Repackaging Wizard output File {.inc) will be saved to this location,

Project path to store files

Ci\PackagesPH E]

Review ot edit the currant settings

Aany changes made to these settings will apply to the current and
future analysis. tait...

[ < Back ][ Start: ][ Cancel ] | Help |

10. Click the Browse ([...]) button next to the Project path to store files field and select the directory where you
want the Repackaging Wizard to place its output, including the Repackager project file (.1rp), the
Repackaging Wizard output files, and source files.

You can also enter the name of a new folder in the Project path to store files field, and you will be prompted
to create it when you exit this panel.

11. To begin the repackaging process, click Start on the Set Target Project Information and Capture Settings
Panel. The Repackaging Panel opens and the Repackaging Wizard captures the initial system status. Then,
the selected setup program will be launched.
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Repackaging Wizard [z|

Repackaging ...
Flease wait while Repackaging Wizard performs system analysis,

Repackaging Wizard is analvzing your system and setupis) ...

Running the setup programis)...

12. Follow the prompts until the installation has completed. When the installation is complete, you are prompted to
make any additional changes to the system (such as deleting files and shortcuts) that you want to be recorded
in this repackaged installation.

Repackaging Wizard g|
Repackaging ...
Flease wait while Repackaging Wizard performs system analysis, E’H

Repackaging Wizard is analyzing your system and setupis) ...
Al sekupis) have been launched.
Once the installation is complete, you may make additional changes to the system such

as deleting files and shortcuts, Click Process when vou are ready to complete the
repackaging process,

[ Process ] [ Cancel ] [ Help ]

13. When you are ready to complete the repackaging process, click Process. The Repackaging Wizard then
analyzes the system and setup data that it collected.

Following repackaging, the Summary Panel is displayed, providing confirmation that the repackaging was
successful.
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Repackaging Wizard g|
Summary

Fieview the summary information below. Click Finizh to exit Repackaging E’ﬂ
“izard.

Summary:
Fepackaging Method: Installation Monitoring
Product Mame: My Package

Output Files:
Output file created: C:\Packages‘\My Package.inc

Mext Steps:
Click Finizh to launch the Repackager to edit and build your project.

14. Click Finish. Repackager launches and opens the Repackager project file (*.1rp) that you just created.

15. Continue with the instructions in Working With Repackager Projects.

Repackaging Wizard Reference

This section describes each of the dialog boxes and Wizard panels that you might encounter when using the
Repackaging Wizard. The help topics in the Repackager Reference are the same detailed documentation that is
displayed when you press the F1 key or click the Help button while working in a dialog box.

Reference information is organized as follows:

Table 7-9  Organization of Repackager Reference Section

Section

Description

Repackaging Wizard
Additional Repackaging
Wizard Dialog Boxes

Repackaging Wizard
Command-Line Options

This section provides a panel-by-panel description of the Repackaging
Wizard.

This section describes the dialog boxes that can be accessed from the
Repackaging Wizard.

This section lists the command-line options that are supported by the
Repackaging Wizard.

Reboot Handling in the
Repackaging Wizard
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Repackaging Wizard Reference

Repackaging Wizard

Repackager provides the Repackaging Wizard to convert a legacy setup into a Repackager project. Using this
Wizard, you can select the repackaging method (either Snapshot or Installation Monitoring), specify the setup(s)
you want to repackage, and run the setup(s). When the Repackaging Wizard has finished its analysis, Repackager
automatically creates a Repackager project (.1 rp) file, which can be modified in Repackager. You can then convert
this file to an InstallShield Editor project (.1sm) for further editing, or convert it directly to a Windows Installer
package (.ms1).

The Repackaging Wizard includes the following panels:

Welcome Panel

Method Selection Panel

Snapshot Method Panel

Collect Product Information Panel

InstallScript MSI Identified Panel

InstallShield Professional Setup Panel

Set Target Project Information and Capture Settings Panel
InstallScript MSI Conversion Output Panel

Repackaging Panel

Summary Panel

Additional Repackaging Wizard Dialog Boxes

Welcome Panel

466

The Welcome panel appears when you first launch the Repackaging Wizard, providing some introductory
information about the use of the Wizard, including that it is for use with traditional (non-Windows Installer-based)
installations.

ADS-1000-UG00
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Welcome to Repackaging Wizard

E3

This wizard enables you to create a completely new
installation for an existing, packaged application. t can
also create an installation project that can be further
enhanced using InstallShield.

=  Foroptimal use, Repackaging Wizard should be
\,‘I:) run remately from a mapped location. See the Help
Library topic "Repackaging Wizard Best
Practices” for details.

< Back [ Mext > ]I Cancel JI Help

Repackaging Wizard @

Figure 7-1: Repackaging Wizard Welcome Panel

Method Selection Panel

Repackaging Wizard Reference

From the Method Selection panel, select the method(s) you want to use for repackaging.

Repackaging Wizard

Method Selection
Select a repackaging method.

@ Installation Monitoring  (Recommended) Advanced Settings

Fepackager watches lowerdevel system activities and records changes made to the system
by the setup programis). It then analyzes these activities and stores the setup datain an
output file which can be converted into @ Windows Installer package.

") Snapshot
Repackager takes an initial snapshot of the local system, runs the setup programis), and

then takes a second snapshot. The difference between the two snapshots is stored in an
output file which can be converted into a Windows Installer package.

2 . The newly improved Install Monitoring method is the default method as it holds the
1 potertial for cost savings through increased reliabilty and shorter repackaging times.

[ < Back ][ Mext > ][ Cancel ][ Help ]

Figure 7-2: Repackaging Wizard Method Selection Panel
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The available choices include:
Table 7-10 < Method Selection Panel Options

Options Description

Snapshot The Snapshot method involves taking system snapshots before and after an
installation, and then creating the Windows Installer package from the difference
between them. Any configurations you make between snapshots is also included
in the generated Windows Installer package.

Installation Monitoring Installation Monitoring watches all activities generated by an installation, and then
determines the files, .ini files, registry entries and shortcuts that should be
included in the generated Windows Installer package.

Installation Monitoring is significantly faster than the Snapshot repackaging
method.

If there are services running on the machine that have nothing to do with the
installation being repackaged, click the Advanced Settings link to open the
Excluded Processes Dialog Box, where you can choose to exclude those
processes.

Tip ° If you know that the installation that you are capturing is from a self-extracting . exe file
and if you want to use the Installation Monitoring method, you should click Advanced
Settings and add the name of that . exe file to the excluded processes list.

Using the InstallShield Professional Logging Method

The InstallShield Professional Logging Method, which should be used to repackage InstallShield Editor and
DevStudio 9.x InstallScript installations, is not offered as a choice on the Method Selection panel.

However, if you specify an InstallShield Editor or DevStudio 9.x InstallScript installation on the Collect Product
Information panel (the next panel in the Repackaging Wizard), Repackager will automatically detect the
InstallScript installation and will display the InstallShield Professional Setup panel. On this panel, you can
choose to use the InstallShield Professional Logging Method instead of the Installation Monitoring or
Snapshot methods.

It does not matter which option you select on the Method Selection panel, but if you select the Snapshot
method, you must select Single Step on the Snapshot Method panel (which appears next). If you instead select
Multiple Steps, Repackager will not recognize the setup as an InstallShield Editor or DevStudio 9.x InstallScript
installation and the InstallShield Professional Setup panel will not appear.

System Changes Captured by Repackager

Regardless of the repackaging method used, Repackager captures system changes made to the following:
® Application Paths

e Environment Variables
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e Files

e INIFiles

® NT Services

e ODBC Data Sources
e ODBC Drivers

®  Printer Drivers

® Registry Entries

e Shortcuts

Repackaging Wizard Reference

If you are using the InstallShield Professional Logging Method to repackage an InstallShield Editor or DevStudio

9.x InstallScript installation, the following additional information is also collected:

e Path Variables

e Feature/Component Tree

Snapshot Method Panel

The Snapshot Method Panel, which is only displayed if you use the snapshot technology, allows you to specify the

way in which you perform repackaging.
Repackaging Wizard

onapshot Method
Select either a single-step or multiple-step snapshot method.

(%) single Step
syskem status changes,

Prompt beFore running the setup programis)

() Multiple Steps

not be preserved,

In a single pass, automatically analyze the initial svstem status First, run one or
more setup programs (ko modify the local system), and then analyze the

. IF wou want ko convert an InstallScript MSI package ko a Basic MSI that preserves
\_12 the InstallScript installation logic, select either Installation Monitoring or Single Step
Snapshot, If vou select Multiple Step Snapshot, the InstallScript installation logic wil

[ < Back. ” Mext = l[ Cancel

Help ]

Figure 7-3: Repackaging Wizard Snapshot Method Panel
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Collect

470

On the Snapshot Method Panel, you have the following two options:
Table 7-11 « Snapshot Method Panel Options

Option Description

Single Step Repackaging in a single step requires you specify at least one setup program to
repackage. The Repackager first takes an initial system snapshot, then runs the setup
program(s) you specify, and then takes a second snapshot to create the script file that
can be converted into a Windows Installer package.

You also have the option of requiring the Repackager to prompt you before running the
setup program(s), allowing you the opportunity to make changes to your system that
you want included in the final package.

E

Note -« If you are repackaging an InstallShield Editor or DevStudio 9.x InstallScript installation and
want to use the InstallShield Professional Logging Method, select Single Step.

Multiple Steps Repackaging in multiple steps allows you to run the Repackager to obtain an initial
system snapshot, after which the Repackager exits. You can then perform any
modifications to the system, such as changing configurations, running installations, and
so forth. After making the necessary modifications, run the Repackager again to analyze
system status changes. The difference between the second Repackager execution and
the first results in the script file that ultimately can be converted into a Windows Installer
package.

The single step method is very straightforward if you are repackaging applications and not performing many
system changes. The multiple step method allows greater flexibility because a setup is not required. This allows
you to capture system configurations within the Repackager output, and ultimately within a Windows Installer
package. For example, you could modify the screen color depth and create an MSI package for just that
configuration.

If Single Step is selected, the Collect Product Information Panel is displayed when you click Next. If Multiple
Steps is selected and you are performing the initial snapshot, the Collect Product Information panel is displayed,
but the Setup Programs area is disabled. If you are performing a system status change analysis, the Repackaging
Panel appears when you click Next.

Product Information Panel

The Collect Product Information panel gathers information necessary for repackaging the installation(s).
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Repackaging Wizard Pz|
Collect Product Information
Provide product information for repackaging. Items with asterisks (*) are E’H
required,

Setup Progrars
Program File: *
| Cihadminstudio SharediRepackaging WizardiInstallScript MST Conversion’ap) | E]

Command-line Argumentis):
| | Edit Setup List

Product Information
Product Mame: * Wersion:
[ iTunes | [45031

Company Mame: *

=
(=]
=]
i

| Apple Computer, Inc, |

[ < Back. ” Mext = l[ Cancel ] [ Help ]

Figure 7-4: Repackaging Wizard Collect Product Information Panel

The information on the Collect Product Information Panel is divided into two sections: Setup Programs and
Product Information.

Setup Programs Area

The Setup Programs area contains information about the setup you are repackaging. Repackager uses this
information to launch the setup correctly following pre-analysis. The information collected includes:

Table 7-12 « Setup Programs Options

Properties Description

Program File The name and location of the setup executable. Click the Browse (-] button to
locate this file. This is a required field.

Command-Line Any command-line arguments to be used when the setup is run.
Argument(s)

AdminStudio 10.0 User Guide ADS-1000-UG00 471



Chapter 7: Repackaging Legacy Installations Using the Repackaging Wizard
Repackaging Wizard Reference

Table 7-12 « Setup Programs Options (cont.)

Properties

Edit Setup List

Description

Click to display the Additional Setup Programs dialog box, from which you can
enter additional installations to repackage together with this installation. Additional
setups share the same product name, version number, and company name in the
repackaged installation. However, as you locate each additional setup to repackage,
you can specify command-line parameters pertaining only to that setup. You can
also specify the order in which the installations are run, should it be necessary.

AN

Caution -« If you are repackaging an InstallShield Editor or DevStudio 9.x InstallScript
installation and want to use the InstallShield Professional Logging Method, specify only one
Program File. If you specify multiple setup program files, the InstallShield Professional
Setup Panel will not appear, and the Repackaging method that you chose on the Method
Selection Panel will be used instead.

Product Information Area

In the Product Information area, you identify the repackaged installation’s Product Name, Version Number, and

Company Name.

Table 7-13 ¢« Product Information Options

Field

Product Name

Version Number

Company Name

Description

Enter the name for final repackaged installation. This could be the name of the original
installation (for example, Tuner), the name of a collective group of products (for
example, Microsoft Applications), or another name of your selection (for example, My
Apps). This is a required field.

Enter the version of the product.

Enter the name of the company.

Product Support Information

If you want to associate Web sites with this installation, click the More link in the Product Information area to open
the Additional Product Information dialog box, where you can enter the Product URL and Support URL for the
application you are repackaging.

InstallScript MSI Identified Panel

472

This panel opens if the Repackaging Wizard identifies an installation as an InstallScript MSI installation created with
InstallShield Editor, InstallShield DevStudio, or InstallShield Developer.
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Repackaging Wizard

InstallScript MSI Identified
This installation is an InskallScript 1MSI package

i The Repackaging “Wizard has identified the installation you are repackaging as being an
-\.2 InstallScript MS1 installation. InstallScript M51 setups contain an embedded MS1 setup
driven by an InstallScript user interface.

These zetups may pose difficulties for deplopment as they require setup.exe to diive the
inztallation. [t is recommended that you uze InstallScript Scan to convert the ariginal MSI
to a basic M5 package, while preserving the original components and much

of the installation logic.

‘wiould you like to use InstallS cript Scan?

@?‘(es, usge [nstallScript Scan to automatically extract the M5| package, preserve the |

ioniginal components, conyvert it to Basic MS1, and preserve installation logic,

() Mo, just repackage the setup uzing the repackaging method | have selected.

[ < Back. ” Mext = ][ Cancel ] [ Help ]

Figure 7-5: Repackaging Wizard InstallScript MSI Identified Panel

InstallScript MSI installations use a Windows Installer database for storage of all file/registry information, but the
actual user interface, and much of the installation logic is driven by the InstallScript engine via a setup. exe file. This
type of installation architecture can cause difficulties during deployment, such as:

® inability to customize or transform the application
e inability to conflict detect

® inability to suppress the user interface

e (difficulty patching or upgrading the application

Also, if an InstallScript MSI installation is repackaged using traditional methods (OS Snapshot or Installation
Monitoring), significant platform-specific or custom installation, maintenance, and uninstallation logic, and user
interface information is lost because those methods only record the installation activities for the specific platform
used during repackaging.

Therefore, it is recommended that you use InstallScript Scan to convert an InstallScript MSI installation to a Basic
MSI package with InstallScript support. InstallScript Scan preserves the original components and much of the
InstallScript installation logic, architecture, and maintainability of the original installation package.

Select one of the following options:

® Yes—Use InstallScript Scan to automatically extract the MSI package and convert it to Basic MSI, while
preserving the original components and installation logic. This is the default selection.

® No—Repackage the installation using the repackaging method selected on the Method Selection Panel
(Installation Monitoring or Snapshot).

Click Next to proceed.
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InstallShield Professional Setup Panel

This panel appears in the Repackaging Wizard if you specified an InstallShield Editor or DevStudio 9.x InstallScript
installation in the Program File field of the Collect Product Information Panel, and if:

® You specified only one program file on the Collect Product Information Panel, and
® You selected the Installation Monitoring method on the Method Selection Panel, or

® You selected the Snapshot method on the Method Selection Panel and then selected Single Step on the
Snapshot Method Panel.

Repackaging Wizard g|

Installshield Professional Setup
Optionally change repackaging method for ISPro setup E‘H

The zetup you are launching was created with InstallShield Professional. The Repackager
can directly read logged output of InstallShield Professional Engine operations, removing
the need for repackaging InstallShield Professional setups.

It iz recommended that vou use this method instead of repackaging.

[lilse InstalShield Professional logging instead of repackaging.;

[ < Back. ” Mext = ][ Cancel ] [ Help ]

Figure 7-6: Repackaging Wizard InstallShield Professional Setup Panel

If you want to use the InstallShield Professional Logging Method, select the Use InstallShield Professional Logging
instead of repackaging check box.

Using the InstallShield Professional Logging Method, Repackager can read logged output of InstallShield Editor
and DevStudio 9.x InstallScript installations. This method replaces the other repackaging methods (Installation
Monitoring and Snapshot) for InstallShield Editor or DevStudio 9.x InstallScript installations. By using this method,
you will be able to get additional information that would not be captured by repackaging, including path variables
and a feature tree. For more information, see InstallShield Professional Logging Method.

Set Target Project Information and Capture Settings Panel

The location where you want files created by Repackager stored is defined in the Project path to store files field
on the Set Target Project Information Panel.
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Repackaging Wizard rz|
Set Target Project Information and Capture Settings
Provide the target project path and review capture settings. E’H

Specify the location where Repackaging Wizard will store files created during syskem change
analysis, The Repackaging Wizard output file {.inc) will be saved to this location,

Project path to store files

| L]

Review or edit the current settings

Any changes made to these settings will apply to the current and

Future analysis.

[ < Back ” Start l[ Cancel ] [ Help ]

Figure 7-7: Repackaging Wizard Set Target Project Information and Capture Settings

It is recommended that this location not be located on your clean machine, but rather on the same machine as the
Repackager executable (most likely on your administrator machine).

You can also review or edit current capture settings by clicking Edit, which displays the Analysis Options dialog
box.

Click Start to begin repackaging and display the Repackaging Panel.

InstallScript MSI Conversion Output Panel

On this panel, specify the location where you want Repackager to store the files it creates during InstallScript Scan
analysis. The converted Windows Installer MSI package will be saved to this location.
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Repackaging Wizard rz|
InstallScript MSI Conversion Output
Specify where you would like to save the M3I files to. E’ﬂ

Specify the location where Repackaging Wizard will store files created during InstallScripk
Scan analysis, The converted MSI package (.msi) will be saved ko this location,

Project path to store files

Review or edit the current settings

Any changes made to these settings will apply to the current and

Future analysis.

[ < Back. ” Mext = l[ Cancel ] [ Help

]

Figure 7-8: Repackaging Wizard InstallScript MSI Conversion Output Panel

It is recommended that this location not be located on your clean machine, but rather on the same machine as the
Repackager executable (most likely on your administrator machine).

You can also review or edit current settings by clicking Edit to open the Analysis Options dialog box. On the
Analysis Options dialog box, you can specify capture types for the repackaging session, and, for snapshot-mode
captures, you can restrict directory analysis to specific directories.

Click Start to begin repackaging and display the Repackaging Panel.

Repackaging Panel

476

The Repackaging panel appears while Repackager analyzes your system.
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Repackaging Wizard

Repackaging ...
Flease wait while Repackaging Wizard performs system analysis, E’g

Repackaging Wizard is analvzing your system and sekupis) ...

Capturing the initial system status...

Reading file structure. ..
35000 entries read
CAdminStudio Sharedt. ...\, \Pragram

LLLLLL AL L E L] l

Cancel | [ Help ]

Figure 7-9: Repackaging Wizard Repackaging Panel 1

Depending on settings configured before starting repackaging, the analysis may stop following the initial phase,
and again after setup has been run.

After the setups have been completed, you are prompted to click the Process button to complete the repackaging

process.
Repackaging Wizard [g
Repackaging ...
Flease wait while Repackaging \Wizard performs system analysis, E’ﬂ

Repackaging Wizard is analvzing vour system and setup(s) ...
Al setupis) have been launched.
Once the installation is complete, you may make additional changes ko the system such

as deleting files and shortcuts, Click Process when you are ready to complete the
repackaging process.

[ Pracess ] [ Cancel ] [ Help ]

Figure 7-10: Repackaging Wizard Repackaging Panel 2

When you click Process, the repackaging is performed and its progress is displayed.
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Repackaging Wizard fgl

Repackaging ...
Flease wait while Repackaging Wizard performs system analysis,

Repackaging Wizard is analvzing vour system and setupis) ...

Analyzing the system state changes...

Processing monitoring data. ..

[T ]

Cancel | [ Help ]

Figure 7-11: Repackaging Wizard Repackaging Panel 3

Following repackaging, the Summary Panel is displayed.

Summary Panel

The final panel displayed by Repackager is the Summary panel.

Repackaging Wizard
Summary

Review the summary information below, Click Finish ko exit Repackaging
Wizard,

Summary:
Repackaging Method: InstallScript Conversion with Recapturing
Product Marne: iTunes

Output Files:
Cutput Folder: C:\Packages!,
Cutput file created: iTunes. msi

Figure 7-12: Repackaging Wizard Summary Panel

This panel provides confirmation that repackaging was successful, and provides the location of the source setup
program(s), the Windows Installer package, and the InstallShield Editor project.
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Additional Repackaging Wizard Dialog Boxes

The following dialog boxes can be accessed from the Repackaging Wizard:
e Additional Setup Programs Dialog Box

® Setup Information Dialog Box

e Excluded Processes Dialog Box

® Analysis Options Dialog Box

Additional Setup Programs Dialog Box

This dialog box, which is accessed by clicking the Edit Setup List button on the Collect Product Information
Panel of the Repackaging Wizard, displays a list of additional setup programs you want to add to the final
Windows Installer package.

Additional Setup Programs El

Specify the setup programs you want ko repackage. Repackaging Wizard wil
package them into a single M3I package.

Repackaging Wizard will run the setups in the order

Setup Program Command-line Argurents Mew, ..

Cihadminstudio ...

[ OF ] [ Caneel ]

Figure 7-13: Repackaging Wizard’s Additional Setup Programs Dialog Box

Essentially, this is a list of the other executables to run, in the order they are to be run, prior to final analysis. The
following buttons are available:

Table 7-14 - Additional Setup Programs Dialog Box Buttons

Button Description

New Brings up the Setup Information dialog box to enter information about the setup programs.

Edit Displays the Setup Information dialog box to edit information about the currently selected
setup.

Delete Removes the currently selected setup.

Up Moves the selected setup up in the setup programs list.
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Table 7-14 « Additional Setup Programs Dialog Box Buttons (cont.)

Button Description

Down Moves the selected setup down in the setup programs list.

Setup Information Dialog Box

The Setup Information dialog box allows you to enter or edit information pertaining to the installations you are
repackaging.

Setup Information EI

Modify the setup location and its command-line arguments.

Program File:

I L
Carmmand-line Argumentis):

[ Ok l [ Cancel ]

Figure 7-14: Setup Information Dialog Box

Accessible from the Additional Setup Programs dialog box, you can provide the name and location of an
additional setup program, and any command-line arguments for the setup.

Excluded Processes Dialog Box

During Installation Monitoring, Repackager captures all of the activity of each service or process running on the
machine, and then processes this collected data. However, many services running on a machine may have nothing
to do with the installation being repackaged. Therefore, you may choose to exclude those processes by adding
them to the list on the Excluded Processes dialog box.

Repackaging Wizard P§|

The following processes should not be monitored.

Excluded Processes:

IDRIVER.EXE
IDRIVERT.EXE
REPACK.EXE
SERVICES EXE
WMWARE EXE
WMWARESERVICE EXE
YMWARETRAY.EXE
YMWARELISER.EXE
WIMWARE VM EXE
WINLOGON.EXE

[ ar ] [ Cancel ]

Figure 7-15: Repackaging Wizard Excluded Processes Dialog Box
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You can open the Excluded Processes dialog box by clicking the Advanced Settings link on the Repackaging
Wizard Method Selection Panel. The Excluded Processes dialog box initially lists a default set of processes.

e To add a process to this list, click the New (1) button to add a new blank line to this list, and enter the
name of the process that you want to exclude.

e To delete a process from this list, select the process and click the Delete ([%]) button.

Analysis Options Dialog Box

The Analysis Options dialog box, accessible by clicking Edit from the Set Target Project Information and
Capture Settings Panel or the InstallScript MSI Conversion Output Panel, allows you to specify capture
types for the repackaging session.

Analysis Options E|
Capture types
Files Shortcuts
[ Deleted files Registry data
IMI files [] Deleted registry data

[ Mor-.ini extensions

Restrict directory analysis to the following [Snapshot mode only):

[ u] ][ Cancel ][ Help

Figure 7-16: Analysis Options Dialog Box

You can select the following:

® Files

® Deleted files

® .inifiles

® .ini files with non-.ini extensions
e Shortcuts

® Registry data

® Deleted registry data

Additionally, for snapshot-mode captures, you can restrict directory analysis to specific directories, which can
significantly improve repackaging performance. Click New to add a directory restriction, Edit to modify an existing
restriction, or Delete to remove a restriction.

AdminStudio 10.0 User Guide ADS-1000-UG00 481



Chapter 7: Repackaging Legacy Installations Using the Repackaging Wizard
Repackaging Wizard Reference

Options set in this dialog box apply to the recurrent and subsequent repackaging sessions.

Repackaging Wizard Command-Line Options

The following command-line options are supported by the Repackaging Wizard:
Table 7-15 * Repackaging Wizard Command-Line Options

Option Description

-? Displays a dialog box containing usage information for all Repackager
command line options:

e If a option name is provided, detailed help for the specified option will
be displayed.

e If no option name is provided, a dialog box containing general usage
information for all options is displayed.

-app <setup program Tlist> Enables you to provide a pipe (|) delimited list of setups to run during
repackaging. You can also pass command-line arguments to the setup by
separating them from the setup name with a semicolon.

If entering multiple setups, proper double quoting—including escaping
nested quotes—is necessary:

-app "\"exelpath\";cmdlinel|\"exe2path"|...exeN; cmdlineN

-b [<project file path and Specifies the build/release destination folder.

name>.ism]
You can, optionally, specify a location for the .1sm file that will be created. If

this is not specified, then the .ismand .msi files will be created in a sub-folder
of the Repackager project files location called MSI_Package. The project name
must end in .ism.

E

Note - In addition, the -0 and -pp options should, at a minimum, be specified to allow
for the location of the Repackager project files.
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Table 7-15 » Repackaging Wizard Command-Line Options (cont.)

Option

-buildonly

-bv appv
-bv thinapp

-bv citrix

Description

If this “build MSI only” command line option is used, the Repackaging Wizard
will skip the repackaging step and just build a Windows Installer package
based on existing Repackager project files (.1inc, .irp, etc.).

e The -b option, which specifies the build/release destination folder, also
needs to be used in conjunction with the -buildonly option.

e The -o option, which specifies a folder path not including the filename,
and the -pp option, which sets the product name, also need to be used in
conjunction with the -buildonly option.

The following is a sample command line that uses the -b, -o, -pp, and -
buildonly command line options:

repack.exe -b [optional path to ISM file to create] -o <required
path to folder of existing Repackager project files> -pp <required
name of product - should match existing INC and IRP file names> -
buildonly [optional -bv parameter] [-sb or -sn]

Build App-V application.
Build ThinApp application.

Build Citrix profile.

-cf <config.ini>

This option allows you to select your own configuration template containing
exclusions. A sample of this type of file (named Default.ini) can be found in
the following directory:

AdminStudio Installation Directory\Repackager

This particular file contains the default exclusion information.

-cs <configuration type>

AdminStudio 10.0 User Guide ADS-1000-UG00

This option allows you to select the configuration file type for exclusions.
Possible values are:

e Shared—Use shared settings from those stored in the AdminStudio
Shared directory.

e Custom—Use a custom configuration file (in conjunction with -cf).
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Table 7-15 » Repackaging Wizard Command-Line Options (cont.)

Option

-is

-mode <snapshot mode>

Description

Regarding the Repackaging an InstallScript MSI Setup to a Basic MSI Setup
procedure, use this parameter in the command line using the following
syntax:

Repack.exe -app "c:\setup.exe" -o C:\apps\output -mm -is

In the above example, the user wants to repackage c:\setup.exe using the
Installation Monitoring repackaging method (as specified by -mm) and
InstallScript conversion (as specified by -is). Repackager would perform the
InstallScript conversion process and produce a Basic MSI package with
InstallScript support as output. Without the -is parameter, Repackager would
perform repackaging without performing InstallScript conversion, and would
only create a Repackager .1inc file as the output.

E

Note * The command line parameter -is will be considered only if the setup to be
repackaged is a InstallScript MSI setup. If user specified any other legacy setup that is
not a InstallScript MSI setup then -is will be ignored.

E

Note - If user chooses to use the Multiple Step Snapshot repackaging method, then the
-is parameter will be ignored. Even if the setup is an InstallScript MSI setup, -is will still
be ignored when using the Multiple Step Snapshot repackaging method.

Repackager supports the following repackaging modes for snapshots:

e single—Single step repackaging that creates an INC file as its output.
e pre—Pre-scanning only scans the local drive for a baseline snapshot of
the system.

e post—Post-scanning only scans the local drive and compares the result
with the pre-scan. The differences are written to the INC file as output.

-mm Instructs Repackager to use installation monitoring as the repackaging
technology.

-mp Instructs Repackager to use the InstallShield Professional Logging Method as
the repackaging technology.

-ms Instructs Repackager to use snapshots as the repackaging technology.

-0 <.inc path name>

-of <inc file name>

484

Specifies a folder path not including the filename. The file name is derived
from the Product Name unless overridden with the -of switch.

Specifies the .inc file name that should be used instead of the product name.
Use -0 to specify the path.
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Table 7-15 » Repackaging Wizard Command-Line Options (cont.)

Option

-onp

-pC <company name>

-pp <product name>

-pv <product version>

Description

When using the Installation Monitoring method via command line to
perform repackaging on a 64-bit operating system, you can use the -onp
command line option to cause the Installation Monitoring method to only
monitor new processes created on the system and to ignore any existing/
running ones. This option is useful to optimize the monitoring process on a
64-bit operating system.

Allows you to set the company name.

Allows you to set the product name. This will be the same name as the
generated Repackager output file (.1inc).

Allows you to set the product version.

-sb This option allows you to run Repackager silently, with no user interaction. A
progress dialog box is displayed. If no .ini file is specified using the -i
parameter, Repackager uses Repack.ini as the default input file. If an output
folder is not specified using -o, the default output folder is C:\Packages.

-sn This option allows you to run Repackager silently, with no user interaction and
no progress dialog box. If no .ini file is specified using the -i parameter,
Repackager uses Repack.ini as the default input file. If an output folder is not
specified using -o, the default output folder is C: \Packages.

-version This option displays standard version information for Repackager, including

the full version and copyright information.

Tip * To open a help topic from the command line that lists command line options, enter the following:

repack.exe /?

E

Note -« In addition to the - sign for command-line arguments, you can also use the | symbol.

Reboot Handling in the Repackaging Wizard

During repackaging, a setup may require a reboot. For example, some operations may require a file which is in use
be replaced, which can only be done after a reboot. Some nuances exist depending on the repackaging
technology you are using (Snapshot or Installation Monitoring). In either case, when the Repackaging Wizard
detects that a reboot is necessary, the Repackaging Wizard saves the appropriate data and waits until you confirm
that you are ready to reboot the machine.
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For Snapshot repackaging, the operating system completes the reboot operation. During startup, the operating
system restarts all applications and processes and performs any pending file operations. One of the applications
that restarts is Repackager. Before you continue processing in Repackager, be patient and ensure all processes
and applications have restarted. This may take a minute or two. After the applications and processes have been
launched, you can continue repackaging by clicking Process.

For Installation Monitoring, on reboot the operating system launches the Repackaging Wizard, which in turn
launches applications and processes and waits until these are finished before prompting you to continue
repackaging. However, in some cases the processes or applications launched by the Repackaging Wizard will
launch other applications and processes. As in Snapshot repackaging, it is generally a good idea to wait a minute
or two before clicking Process.

In both circumstances, waiting helps ensure the setup is fully installed and that captured data contains the
necessary information to properly rebuild the setup as an MSI installation.

E

Note * On Windows Vista and newer, system reboots are almost instantaneous and do not allow running
applications to properly shut down, which may result in a loss of data. When using the Installation Monitoring
method, Repackager successfully handles a system reboot and delays it until you click the Reboot button on the
Repackaging Wizard.
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A Repackager project file (.irp) can be built into an InstallShield Editor project (.ism) or a Windows Installer
package (.msi). You can use the Repackager interface to create and modify Repackager project files. You can also
use it to build an isolated Windows Installer package and to configure the exclusions used when repackaging a

legacy installation.

Information about the Repackager interface is presented in the following sections:

Table 8-1 * Using the Repackager Interface

Section

About the Repackager
Interface

Description

Explains how to launch the Repackager interface and how to set options.

Creating Repackager
Projects

AdminStudio 10.0 User Guide ADS-1000-UG00

Explains how to create a Repackager project file (.irp), which can then be built

into an InstallShield Editor project (.ism) or a Windows Installer package
(-msi).
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Table 8-1 » Using the Repackager Interface (cont.)

Section

Working With Repackager
Projects

Isolating Windows Installer
Packages

Configuring Exclusions

Scanning InstaliShield
Professional Setups for
Additional Data

Creating an InstallShield
Editor Template to Use
Within Repackager

Repackager Interface
Reference

Description

Explains how to build an InstallShield Editor project and Windows Installer

package from a Repackager project. The topics in this section include:

e Building an InstallShield Editor Project

e Building a Windows Installer Package

e Automatically Generating a Virtual Application During Repackager Project
Build

e Viewing Repackager Project Properties

e Using the Setup Intent Wizard to Detect File Dependencies in a
Repackager Project

e (Creating a Setup Capture Report for a Project

® Saving Repackager Projects

e Opening InstallShield Editor from Repackager

Isolation reduces versioning conflicts by modifying an application so it always
loads the versions of components—such as DLLs—with which it was
originally developed and tested. This section reviews isolation concepts and
options, and explains how to build an isolated Windows Installer package.

Explains how to use Repackager and the Exclusions Editor to configure the
exclusions used when repackaging a legacy installation.

Explains how to scan InstallShield Professional setups for possible additional
files.

Explains how to create an InstallShield Editor template to use to speed up the
Repackaging process.

Describes each of the views and dialog boxes that you might encounter when
using the Repackager interface. The help topics in this section are the same
detailed documentation that is displayed when you press the F1 key or click
the Help button while working in a dialog box.

E

Note  For information on other Repackager features, see Repackaging Legacy Installations Using the

Repackaging Wizard.
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About the Repackager Interface

Information about using the Repackager interface is presented in this section:
e launching the Repackager Interface

e Setting Repackager Options

Launching the Repackager Interface

&

Repackager can be launched from within the AdminStudio interface. Additionally, if you install Repackager on a
network, use Windows Explorer to browse to the is1c.exe executable on the shared drive.

Task:

To launch Repackager from the AdminStudio interface:
1. Launch AdminStudio.
2. Click the Tools tab.

3. From the Tools Gallery, click the Repackager icon on the left side.

J

Repackager
The Repackager Start Page opens and you can begin the repackaging process.

E

Note ° You can also launch Repackager directly from the Windows Start menu by pointing to All Programs,
AdminStudio, AdminStudio 10.0 Tools, and clicking Repackager.

AN

Caution - It is highly recommended that you repackage applications on a “clean” system. See Configuring
Repackager to Ensure Optimal Installation Capture for more information.

Setting Repackager Options

On the Options Dialog Box, which is opened by selecting Options from the Tools menu, you can specify the
following Repackager options:

e Selecting Data Display Colors
® Specifying Additional Merge Module Directories

e (Controlling the Display of ICE Validation Warnings
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Selecting Data Display Colors

On the Colors tab of the Repackager Options dialog box, you can configure the color of scanned items and
deleted items in Repackager’s exclusion views (Files, .ini Files, Registry Data, and Shortcuts).

&

Task: To change the way excluded and included data is displayed in Repackager:

1. Open the Repackager interface.

2. From the Tools menu, select Options. The Colors tab of the Options dialog box opens.
3. Configure the display colors for Excluded, SmartScan, and Setup Intent items.
4

Click OK.

Specifying Additional Merge Module Directories

If you have custom merge modules that should be used when building a Windows Installer package, you need to
specify the directories that contain those custom merge modules on the Merge Modules tab of the Options
dialog box.

&

Task: To specify directories of additional Merge Modules:
1. Open the Repackager interface.
2. From the Tools menu, select Options. The Colors tab of the Options dialog box opens.

3. Open the Merge Modules tab.

Options

(X)

Colors | Merge Modules | Build Options

Additional Merge Module Path

If you have custom merge modules that should be used when building the “indows Installer
package, enter the path to those merge modules here. [f pou specify multiple locations,
separate the folder paths with commas.

Browse...

L Ok J[ Cancel ]

4. Enter the directory paths to the custom merge modules. To specify multiple directories, separate the folder
paths with commas.
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E

Note ° You can click Browse and navigate to a directory, but if you browse to a second directory, its directory
path will replace the one you initially selected. Therefore, if you want to specify multiple directories separated
by commas, you need to manually enter the directory paths.

5. Click OK.

Controlling the Display of ICE Validation Warnings

On the Build Options tab of the Options Dialog Box, you can specify whether or not you want to list ICE validation
warnings in the Repackager output window during the Build process.

&

Task: To set the display of ICE validation warnings during builds:

1. From the Repackager interface, select Options from the Tools menu. The Options dialog box opens.

2. Open the Build Options tab.

Colors | Merge Modules | Build Options

[ Display ICE walidation wamings

[ Ok ][ Cancel ]

3. Todisplay any ICE validation warnings that occur during the Repackager Build process, select the Display
ICE validation warnings option. By default, this option is not selected.

Creating Repackager Projects

Repackager projects (.1irp) allow you to visually analyze the files, .1ini files, shortcuts, and registry entries
captured or changed during the conversion of a legacy setup into a Windows Installer package. You can also
exclude files, shortcuts, registry entries, and .1ini files from the resulting Windows Installer package, without
affecting the original setup data.
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T

here are two methods of creating Repackager projects:

Table 8-2 * Methods of Creating Repackager Projects

Method Installation Source

Repackaging @ You can use the Repackaging Wizard to convert the following installations:

Wizard e InstallShield Professional 1.x to 5.1.x

e |nstallShield Professional 5.5 to 7.x

e |nstallShield InstallScript MSI

e |[nstallShield DevStudio 9.x InstallScript
e |[nstallShield Editor InstallScript

See Repackaging Legacy Installations Using the Repackaging Wizard.

Repackager You can use the Repackager interface to convert the following installations:

Interface e Repackager 3.x output (.inc)

® Microsoft SMS projects (.ipf)

e Novell ZENworks 3.0, 3.1, or 4.0 projects (.axt/.aot)
®  WIinINSTALL projects (.txt) (6.0, 6.5, 7.X)

e Wise installation projects (.wse)

e InstallShield Professional log files (.isl)

See Converting Legacy Installations Using the Repackager Interface.

Converting Legacy Installations Using the Repackager
Interface

492

In addition to repackaging a legacy installation using the Repackaging Wizard, you can also convert many setup
types directly to Repackager projects (.1irp)—and ultimately to InstallShield Editor projects (.1ism) and Windows
Installer packages (.ms1i). Repackager can directly convert the following setup types:

Converting Repackager 3.x Output Files

Converting a Microsoft SMS Project to a Repackager Project
Converting Novell ZENworks Projects

Converting WinINSTALL Projects

Converting Wise Installation Projects

Converting InstallShield Professional Log Files
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Converting Repackager 3.x Output Files

To convert a Repackager 3.x output file to a Repackager project, perform the following steps.

4

Task: To convert a Repackager 3.x output file (.inc) to a Repackager project (which can subsequently be
built into a Windows Installer package):

-k
.

2
3
4
5

Launch Repackager.

On the File menu, click Open. The Open dialog box opens.

Change the Files of type filter to Legacy Repackager Files (*.inc).
Browse to locate the Repackager 3.x output file you want to convert.

Select the file and click OK.

The Repackager 3.x project is updated to the Repackager project (.1irp) format. Files, .1ini files, shortcuts, and
registry entries within the project are visible through the appropriate views in the Repackager Interface.

Converting a Microsoft SMS Project to a Repackager Project

To convert a Microsoft SMS project to a Repackager project, perform the following steps.

4

Task: To convert a Microsoft SMS project (.ipf) to a Repackager project (which can subsequently be built
into a Windows Installer package):

-k
.

2
3.
4,

5.

Launch Repackager.

From the File menu, select Open.

In the Open dialog box, change the Files of type filter to SMS Installer (*.ipf).
Browse to locate the SMS project you want to convert.

Select the project, and click OK.

The legacy project is converted to a Repackager project. Files, .1ini files, shortcuts, and registry entries within the
project are visible through the appropriate views in the Repackager Interface.

Converting Novell ZENworks Projects

You can convert Novell ZENworks 3.0, 3.1, or 4.0 projects (.axt/.aot) to Windows Installer packages (.msi) one at
a time or in bulk:

Repackager Interface—You can convert a ZENworks project to a Windows Installer package using the
Repackager interface. See Converting a Novell ZENworks Project Using the Repackager Interface.
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e Command Line—You can use the Command Line to bulk convert multiple ZENworks projects to Windows
Installer packages. See Converting Multiple Novell ZENworks Projects Using the Command Line.

E

Note - In order to convert an .aot file, the ZENworks Desktop Management Agent 6.5 or later (zenlite.dll) must be
installed on the workstation where Repackager is installed. If this agent is not installed, Repackager can only
convert ZENworks .axt files. See About .axt and .aot Application Object Template Files for more information.

Converting a Novell ZENworks Project Using the Repackager Interface

Using Repackager, you can convert Novell ZENworks 3.0, 3.1 or 4.0 projects (.axt/.aot) to Windows Installer
packages (.ms1).
About .axt and .aot Application Object Template Files

In ZENworks Desktop Management, the snAppShot utility generates application object template files—with either
an .axt or .aot extension—that contain the details that are required for the Application Launcher to be able to
distribute an application to a workstation:

® registry entries to be added
e files to be copied
® changes to be made in the .1ini files and system text files (autoexec.bat and config.sys)

Because an .axt file is a text file that can be edited with a text editor in order to modify it after it has been created,
it can be opened and converted by Repackager.

However, in order to convert a . aot file (which is not a text file), the ZENworks Desktop Management Agent 6.5 or
later (zen1ite.d11) must be installed on the workstation where Repackager is installed. If this agent is not installed,
Repackager can only convert ZENworks .axt files.

E

Note ° For information on installing the ZENworks Desktop Management agent (version 6.5 or later) to a
workstation, see one of the following:

e Novell ZENworks 6.5 Desktop Management Installation Guide
http://www.novell.com/documentation/zenworks65/dminstall/data/front.html

e Novell ZENworks 7 Desktop Management Installation Guide
http://lwww.novell.com/documentation/zenworks7/index. html?page =/documentation/zenworks7/dm?7install/
data/front.html

Task: To convert a Novell ZENworks project (.axt/.aot) to a Repackager project (which can subsequently be
built into a Windows Installer package):

1. Launch Repackager.

2. On the File menu, click Open.
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3. Inthe Open dialog, change the Files of type filter to either Novell ZENworks (*.axt) or Novell ZENworks

(*.axt/*.aot).

E

Note - If the ZENworks Desktop Management Agent 6.5 or later (zenlite.dll) is installed on the workstation

where Repackager is installed, the Files of type filter will be Novell ZENworks (*.axt/*.aot). If this agent is not
installed, the Files of type filter will be Novell ZENworks (*.axt) and you will be unable to select .aot files as the

legacy setup source. See About .axt and .aot Application Object Template Files for more information.
4. Browse to locate the ZENworks project you want to convert.

5. Select the project, and click OK.

The legacy project is converted to a Repackager project. Files, .1ini files, shortcuts, and registry entries within the

project are visible through the appropriate views in the Repackager Interface.

Converting Multiple Novell ZENworks Projects Using the Command Line

To perform a bulk conversion of ZENworks 3.0, 3.1, or 4.0 projects to Windows Installer packages, you use the -Z

command line switch.

o

Task: To convert multiple Novell ZENworks projects (.axt/.aot) to a Windows Installer package, a
Repackager project, or an InstallShield Editor project:

1. Create an .1ini file using the following format:

[General]

OutputFormat=MSI|INC|ISM

[AXT]

C:\myData\Projectl.
C:\myData\Project2.
C:\myData\Project3.

[AOT]

C:\myData\Projectl.
C:\myData\Project2.
C:\myData\Project3.
C:\myData\Project4.
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The following table describes the elements of this file:

Section Description

[General] Controls the output format of the entire conversion process. Select one of the following to

identify the output format:

e MSI—Windows Installer package
e [INC—Repackager output file
® ISM—InstallShield Editor project file

[AXT] List the names and locations of the legacy ZENworks projects (.axt) you want to convert.
Include the paths (absolute or relative) to the .axt files.

[AOT] List the names and locations of the ZENworks .aot projects you want to convert. Include the

paths (absolute or relative) to the .aot files.

2. Run the repackaging process from the command line using the -Z parameter:

ISLC.exe -Z"C:\DirectoryName\FileName.ini"

AN

Caution « You must enter a fully qualified path to identify the location of your .ini file.

Repackager loads the .1ini1 file and begins the conversion process. A dialog box opens to display progress

messages.

InstallShield Repackager

[ sl
=

x|

Source File d:M\mportDatat1-DFSLE \mypastilef. 24T not found

Parsing: c:\mportDatataccesshaetup. ast

Converting Movell ZEMworks file '\ mportD atahaccesshsetup. ast’

Output folder : c:YmportDatahaccess

Uging exclugion file : C:\adminS tudichddminS tudio\Admin StudichCurenthSystemdefault. ini

Parzing zection : [Application Mame]
Parzing section : [Macra]
=iatarning => Excluding Section : [Application Caption]
=ehafarning => Excluding Section : [Application lcon]
==gfarning => Excluding Section : [&pplication Platform)
Parsing section : [File Copy]
Parsing section : [Directon Createl |
< 1l

[werbose

Cancel

™

(2

To limit the volume of messages listed, clear the Verbose check box.

3. When the repackaging process is complete, the Cancel button changes to a Close button. Click Close to

close this dialog box.

You will find the converted files in the location specified in the .1ini file as the location of the .aot/.axt input

files.
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Converting WinINSTALL Projects

4

Task:

To convert a WinINSTALL 6.0, 6.5, or 7.x project (.txt) to a Repackager project (which can
subsequently be built into a Windows Installer package):

-k
.

o o 2 0 b

E

Launch Repackager.

From the File menu, select Open.

In the Open dialog box, change the Files of type filter to WinINSTALL (*.txt).

Browse to locate the WinINSTALL project you want to convert.

Select the project, and click OK.

If the WinINSTALL Conversion dialog box opens, fill in the WinINSTALL-specific variables and click OK.

The legacy project is converted to a Repackager project. Files, .1in1 files, shortcuts, and registry entries within
the project are visible through the appropriate views in the Repackager Interface.

Note * WinINSTALL projects must be converted to .txt files prior to conversion to Repackager projects.

Converting Wise Installation Projects

4

Task:

To convert a Wise Installation project (.wse) to a Repackager project (which can subsequently be
built into a Windows Installer package):

-k
.

@ b

Launch Repackager.

From the File menu, select Open.

In the Open dialog box, change the Files of type filter to Wise Projects (*.wse).
Browse to locate the Wise Installer project you want to convert.

Select the project, and click OK.

The legacy project is converted to a Repackager project. Files, .1in1 files, shortcuts, and registry entries within
the project are visible through the appropriate views in the Repackager Interface.

Converting InstallShield Professional Log Files

You can convert an InstallShield Professional log file (.1is1) to a Repackager project if you have access to the
original setup media. When you open the log file, following the steps below, Repackager will try to find the original
setup media automatically (in the location specified in the log file), but if it cannot, it will allow you to browse to it
before continuing. If you do not have access to the original setup media, the conversion will fail.
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%

Task: To convert an InstallShield Professional Log File (.isl) to a Repackager project (which can
subsequently be built into a Windows Installer package):

1. Launch Repackager.

2. From the File menu, select Open.

3. Inthe Open dialog box, change the Files of type filter to InstallShield Pro Log Files (*.isl).
4. Browse to locate the InstallShield Professional log file you want to convert.

5. Select the file, and click OK.

The log file is converted to a Repackager project. Files, .1ini files, shortcuts, and registry entries within the
project are visible through the appropriate views in the Repackager Interface.

Working With Repackager Projects

After creating a Repackager project—by Repackaging Legacy Installations Using the Repackaging Wizard or by
Converting Legacy Installations Using the Repackager Interface—you can perform the following tasks:

Building an InstallShield Editor Project

Building a Windows Installer Package

e Automatically Generating a Virtual Application During Repackager Project Build

e Viewing Repackager Project Properties

e Using the Setup Intent Wizard to Detect File Dependencies in a Repackager Project
e Creating a Setup Capture Report for a Project

® Saving Repackager Projects

® Opening InstallShield Editor from Repackager

Building an InstallShield Editor Project

You can build an InstallShield Editor project (.1ism) from your Repackager project (.1 rp).

You can also choose to build just an InstallShield Editor project, so that you can open it in InstallShield Editor and
make some modifications prior to building.
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4

Task: To build an InstallShield Editor project (.ism):

1. In the Repackager interface, open the Repackager project that you want to convert to an InstallShield Editor
project.

2. Select Repackaged Output from the View List. The Repackaged Output View opens.

@ iTunes - Repackager

File Wiew Project Build Tools Help

BH *¥ e )
=% Captured Installation Repackaged Output
Files and Folders 2 Settings and Co
Registry Entries
_ [EE Shorbcuts Repackaged Output Summary
=2 (_% Repackaged Cutput - -
Package Information Editor Project: CriPackagesiiTunes.ism E

i Advanced Settings
L e Windows Installer Package:  (not builk)

Repackaged Output Options

Create single compressed . msi file w

[Jcreate an isolated version of the Windows Installer package

Run automated tests against the Windows Installer package

APP'V Create a Microsoft App-Y package Learn More

ThinApp™ Create a YMware Thinipp application Leatn mare

cirn!x Create a Citrix Xendpp profile Leatn more
EVY () Use the default Editor template

St () Use a customized template

Repackaged Output Tasks

| £

IDone

3. Inthe Editor Project field, enter the name and location of the InstallShield Editor Project file you want to
create.

4. |Ifyou do not want to Create a Windows Installer package (.msi) after creating the Editor project, clear
this option. If you want to create a Windows Installer Package, see Building a Windows Installer Package.
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5. A project template contains all of the default settings and design elements that you want to use as a starting
point when you create an installation project. In the Repackaged Output Options area, select the
InstallShield Editor Project Template you want to use when creating the project:

o Use the default Editor template—Select this option to use the default InstallShield Editor Project
Template.

e Use a customized template—Select this option to use a customized InstallShield Editor Project
Template.

For example, if you wanted all of your InstallShield Editor projects to have a special custom dialog, a set of
required redistributables, and a particular SQL script, you could create a project template that has all of
those settings. Then, any time that you wanted to create a new project, you could base it off of your
custom template. This enables you to avoid re-creating the custom dialog, re-adding the redistributables,
and re-adding the SQL script every time that you create a new InstallShield Editor Project.

6. Select Package Information from the View List. The Package Information View opens, where you can specify
information for the Windows Installer package that you build from the Repackager project. Much of this
information may be prepopulated based on settings used in the Repackaging Wizard.

@ ilunes.irp - Repackager
File Wwiew Project Build Tools Help

SH 4%« %
= j Captured Installation Package Information
Files and Folders Summary
Registry Entries
E‘ﬁ Shortcuts Windows Installer Package

= (:% Repackaged Output
Package Information
&3 Advanced Settings Company Name: | Apple Computer, Inc,

Product Name: | iTunes

Wersion: 6.0.2.23

Product URL:

Suppoark URL:

JReady

7. Enter the following information:
a. Company Name—The name of the company that developed the product you are repackaging.
b. Product Name—The name of the product you are repackaging.
c. Version—The product’s version number.

d. Product URL—The URL for product information. This appears in Add/Remove Programs in the
Control Panel.
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e. Support URL—A URL for support information. This also appears in Add/Remove Programs in the
Control Panel, and is often changed during repackaging to provide an internal support URL.

8. Select Advanced Settings from the View List. The Advanced Settings View opens.

B ilunes.irp - Repackager g@@

File Wwiew Project Build Tools Help

SH 4 ¥ &« oy
= Captured Installation Advanced Package Settings
|_] Files and Folders ¥ Captured Dat Lt
Reqistry Enkries
{EJ Shartouts Package Conversion

= \'3\ Repackaged OQutput

Package Inf i
@ SR P |n [¥]use Editor path variables instead of physical source paths,
L =

Display only the Welcome dialog during installation.
Replace files with merge modules whenever possible,
[use the language captured by the Repackager as the language of the setup

Include files from Setup Inkent scan

Component Settings

Mark components destined for the System Folder as permanent.
Mark components destined Far the CommonFiles Folder as shared.
Map reqistry data to the appropriate COM tables,

[IMap registry data to the appropriate ODBC tables,

[IMap NT Service events to the ServiceContral table,

Installshield SmartScan

Include files from InstallShield legacy media scan

[CJEsactly match legacy setup's Operating System requirements

Ready

9. Select the options that you want to use, as described in Configuring Advanced Conversion Options.
10. Select Repackaged Output on the View List. The Repackaged Output View opens.
11. Click the Build button. The build process begins, and its progress is reported in the output window.

When the build process is complete, a Conversion completed message appears in the output window, and a
link to the build log file is provided.

Building a Windows Installer Package

You can simultaneously build an InstallShield Editor project (.ism) and a Windows Installer package (.msi) from
your Repackager project (.1rp). However, before you do so, you must configure options in your Repackager
project necessary for the build.

AdminStudio 10.0 User Guide ADS-1000-UG00 501



Chapter 8: Converting Legacy Installations Using the Repackager Interface
Working With Repackager Projects

E

Note - For information on building a virtual application, see Automatically Generating a Virtual Application During
Repackager Project Build.

Task: To build an InstallShield Editor project (.ism) and a Windows Installer package (.msi):

1. Inthe Repackager interface, open the Repackager project that you want to convert to an InstallShield Editor
project and build a Windows Installer package.

2. Select Repackaged Output from the View List. The Repackaged Output View opens.

@ iTunes - Repackager
File View Project Build Tools Help

EH ¥+

=% Captured Installation Repackaged Output
Files and Folders ; 5 and « 1 Options
Reqistry Entries
i [fg Shiortcuts Repackaged Output Summary
= l'\'_% Repackaged Output
ﬁ‘ Package Information Editor Praject: CriPackagesiiTunes. ism E]
f_j Advanced Settings

windows Inskaller Package:  (not builk)
Repackaged Dutput Options

Create a Windows Installer package {.msi) after creating the Editar project:

Create single comprassed .nsi file w

[ Create an isalated version of the Windows Installer package

Fun automated tests against the Windows Instaler package

AH:"V Create a Microsoft App-Y package Learn More
ThinApp™ Create a YMware Thindpp application Learn more
CiTIl!X Create a Citrix ¥enapp profile Learn more
EYY (%) Use the default Edicor template
L

) Use a customized template

Repackaged Dutput Tasks

Done

3. Inthe Editor Project field, enter the name and location of the InstallShield Editor Project file you want to
create.

4. Select the Create a Windows Installer package (.msi) after creating the Editor project option, and
select the following additional options:
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The compression option that you select for this package depends upon the size of your application’s
installation and your delivery method.

Neither Setup.exe nor your .msi file can be spanned across multiple disks. So, if the source files
associated with your Windows Installer package cannot fit on the same disk as the setup.exe and .msi
file, you will need to include them in . cab files on other disks. But if you are performing a network
installation and have unlimited space, there is no need to compress files or include additional files in .cab

files.

From the list, select one of the following options:

Option

Create single compressed
.msi file

Create single compressed
setup.exe file

Create .msi file + external
compressed .cab file

Create .msi file + external
compressed .cab file +
setup.exe

Create uncompressed .msi

file

Create uncompressed .msi
file and setup.exe

Description

Select this option if you want to compress all necessary files inside
the .msi package, as opposed to storing them outside of the .msi
database.

Select this option if you want to compress all files inside a setup.exe
file, including the .msi file and all other necessary files.

Select this option if you want to create an .msi file and want to
compress the rest of the necessary files in an external .cab file.

For example, you might have an installation that contains three
features—each containing a 1.5 MB file, Setup.exe, and the
installation files for Windows NT—and you want to create a custom
media type that is 2 MB in size. The build will span multiple disks.

e Disk one will contain Setup.exe, InstMsiW.exe (which contains
the logic to install the Windows Installer service on Windows NT
machines), Setup.ini (which is required for installations that
include Setup.exe), and your .msi file.

® The remaining disks will contain .cab files that store
compressed copies of all your source files.

Select this option if you want to create an .msi file and a setup.exe
file, and want to compress all the rest of the necessary files in an
external .cab file.

Select this option if you want to create an uncompressed .msi file.
All of the rest of the necessary files, in uncompressed format, would
be shipped with the .msi file.

Select this option if you want to create an uncompressed .msi file
along with a setup.exe file. All of the rest of the necessary files, in
uncompressed format, would be shipped with the .msi and
setup.exe files.

b. To reduce versioning conflicts by modifying an application so it always loads the versions of

components—such as DLLs—with which it was originally developed and tested, select the Create an
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isolated version of the Windows Installer package. An additional Windows Installer package will be
created in the same directory as the .1ism file and the other .msi file, with the naming convention of:

appname.isolated.msi

For more information on how Repackager isolates applications and the available isolation options, see
Isolating Windows Installer Packages.

Select the Run automated tests against the Windows installer package option to automatically run
PackageExpert tests against the newly built Windows Installer package to determine if it is built according
to Windows Installer standards, and if it is in compliance with the installation requirements of the Windows
Vista operating system. All of the tests that are currently selected on the PackageExpert Configuration
View are run, and those selected tests that are automatically resolvable, will be resolved.

To build a virtual application, select the Create a Microsoft App-V application, Create a VMware
ThinApp application, and/or Create a Citrix XenApp profile option. See Automatically Generating a
Virtual Application During Repackager Project Build.

E

Note - In order to select one of these virtualization options, you must have already selected the Create a
Windows Installer package (.msi) after creating the Editor project option.

5. A project template contains all of the default settings and design elements that you want to use as a starting
point when you create an installation project. In the Repackaged Output Options area, select the
InstallShield Editor Project Template you want to use when creating the project:

Use the default Editor template—Select this option to use the default InstallShield Editor Project
Template.

Use a customized template—Select this option to use a customized InstallShield Editor Project
Template.

For example, if you wanted all of your InstallShield Editor projects to have a special custom dialog, a set of
required redistributables, and a particular SQL script, you could create a project template that has all of
those settings. Then, any time that you wanted to create a new project, you could base it off of your
custom template. This enables you to avoid re-creating the custom dialog, re-adding the redistributables,
and re-adding the SQL script every time that you create a new InstallShield Editor Project.

6. Select Package Information from the View List. The Package Information View opens, where you can
specify information for the Windows Installer package that you build from the Repackager project. Much of this
information may be prepopulated based on settings used in the Repackaging Wizard.
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® ilunes.irp - Repackager

File Wwiew Project Build Tools Help

OH %« &

=] 'a Captured Installation | package Information
Files and Folders 5 Summary
Reqistry Enkries
fﬁ Shortcuts Windows Installer Package

(=472 Repackaged Output

Package Information

advanced Settings Company Name: | Apple Compuker, Inc. |
Praduct Mame: | iTunes |
Version: | 6.0.2.23 |

Product URL: | |

Suppork LIRL: | |

JReady

7. Enter the following information:

a.

b.

Company Name—The name of the company that developed the product you are repackaging.
Product Name—The name of the product you are repackaging.
Version—The product’s version number.

Product URL—The URL for product information. This appears in Add/Remove Programs in the
Control Panel.

Support URL—A URL for support information. This also appears in Add/Remove Programs in the
Control Panel, and is often changed during repackaging to provide an internal support URL.

8. Select Advanced Settings from the View List. The Advanced Settings View opens.
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B ilunes.irp - Repackager
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9. Select the options that you want to use, as described in Configuring Advanced Conversion Options.
10. Select Repackaged Output on the View List. The Repackaged Output View opens.
11. Click the Build button. The build process begins, and its progress is reported in the output window.

When the build process is complete, a Conversion completed message appears in the output window, a link
to the build log file is provided, and the location of the .msi file is listed. For example:

Output file: C:\1516261\WinZip.msi

About the Context.msi File

506

When some Windows Installer packages are repackaged, some of their data (such as files or registry entries) are
excluded according to the normal Repackager exclusion settings. For example, files destined for the
\Windows\Installer folder are typically excluded. However, this type of information is occasionally necessary in
order to successfully convert a Windows Installer package to a virtual package.

To address this issue, when Repackager builds a Windows Installer package, it now produces two .msi files:
packagename.msi and packagename.context.msi.
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ﬁghﬂy.ﬁ.pplicatiun.msi
ﬁ%lMy.ﬁ.pplicatian.Cantext.msi

Figure 8-1: Repackaged Output: application.msi and application.context.msi

The .context.msi file contains context data that is necessary in order to convert a .msi file to a virtual package.
When creating a virtual package, Repackager combines the data in both the main .msi file and the .context.msi
file to produce the final virtual package.

For more information on the . context.msi file, see Capturing Virtualization Context.

7]

Important - If you are not converting a package to a virtual package, you can ignore its . context.msi file.

E

Note ° Context data is not displayed in the Repackager interface when viewing captured Files/Registry details.

Configuring Advanced Conversion Options

To set package conversion, component settings, and InstallShield SmartScan options in your Repackager project,
perform the following steps.

W

Task: To configure advanced conversion options:
1. Select Advanced Settings from the Repackager View List. The Advanced Settings View opens.

2. Under Package Conversion, select the package conversion options you want to use during conversion:

Option Description

Use Editor path variables When storing files in the InstallShield Editor project (.1 sm), the Wizard

AdminStudio 10.0 User Guide

instead of physical source
paths

Display only the Welcome
dialog box during installation
Replace files with merge
modules wherever possible
Use the language captured by

the Repackager as the
language of the setup
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uses path variable locations whenever possible.

Only the Welcome dialog box is displayed when the Windows Installer
package is run on a target machine. If this option is unchecked, the
default Ul sequence is displayed when the setup is installed.

Following best practice rules, Repackager replaces components with
comparable merge modules whenever possible.

When selected, the target package's language will be the language
detected by Repackager (as displayed in the Captured Installation
view).
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508

Option

Include files from Setup Intent
scan

Option

Mark components destined
for the System folder as
permanent

Mark components destined
for the CommonfFiles folder as
shared

Map registry data to the
appropriate COM tables

Map registry data to the
appropriate ODBC tables

Description

Any files identified when running the Setup Intent Wizard will be
included in the package (unless you have manually excluded them
from the project).

3. Under Component Settings, select the component settings options you want to use during conversion:

Description

Executable files installed to the system folder (System32Folder) are
marked as Permanent files and will not be uninstalled when the
package is uninstalled. This eliminates ICEQ9 validation errors.

Executable files installed to the CommonFilesFolder (or a subfolder of
CommonFilesFolder) are marked as shared files. This ensures that
these components can coexist with DLLs installed by previous setups.

Setting this option reduces the number of ICE33 warnings that can
occur during package validation, resulting from data not being
mapped to the appropriate MSI tables.

If selected, ODBC-related registry data is mapped to ODBC tables
instead of the Registry table. This data will only function correctly if
Windows Installer supports the ODBC resource being mapped; it is
recommended that you do not enable this option if you are unsure
whether the ODBC resources are supported correctly by Windows
Installer.

Map NT Service events to the
ServiceControl table

conversion:

If selected, NT Service—related registry data is mapped to
ServiceControl table instead of the Registry table.

4. Under InstallShield SmartScan, select the InstallShield SmartScan options you want to use during

Option

Description

Include files from InstallShield

legacy media scan

Files identified in the Media Scan Wizard will be included in the
package (unless you have manually excluded them from the project).
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Option Description

Exactly match legacy setup’s For SmartScan projects or projects using the Professional Logging
Operating System Method:

requirements e e - o .
q e if this option is selected, component conditions will store

specific operating system information: if the filter was NT4, the
condition will be (VersionNT=4).

e [f this option is not selected, component conditions will store
a grouping of the operating system: if the filter was NT4, the
condition will be (VersionNT).

By default, this option is not selected.

E

Note * For more information on InstallShield SmartScan, see Scanning InstallShield Professional Setups for

Additional Data.

Automatically Generating a Virtual Application During
Repackager Project Build

%

Edition * The features on the Repackaged Output View are available in AdminStudio Standard, Professional, and
Enterprise Editions.

You can simultaneously build an InstallShield Editor project (.1ism), a Windows Installer package (.ms1), a Microsoft
App-V application, a ThinApp application, and a Citrix profile from your Repackager project (.1irp). To do this, you
need to select options on the Repackager Repackaged Output view.

Task: To automatically generate a virtual application during Repackager project build:

1.

2.

In the Repackager interface, open a Repackager project.
Select Repackaged Output from the View List. The Repackaged Output view opens.

In the Editor Project field, enter the name and location of the InstallShield Editor Project file you want to
create.

Select the Create a Windows Installer package (.msi) after creating the Editor project option, and
select the associated compression, isolation, and automated test options as described in Building a Windows
Installer Package.
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7]

Important « When building a virtual package, the Create a Windows Installer package (.msi) after
creating the Editor project option must be selected. If it is not selected, the virtualization options are

disabled.

5. Select one or more of the virtual application options:
® Create a Microsoft App-V application
e Create a VMware ThinApp application

® Create a Citrix XenApp profile

Repackaged Output Summary

Editar Project: VschfilerscratchiPatHowe\RepackageriiTunes.ism [I]

windows Installer Package:  V\schfileriscratchiPatHowe\RepackageriiTunes. msi

Repackaged Output Options

Create a windows Instaler package {.msi) after creating the Editor project

Create single compressed .msi file e

[Jcreate an isolated version of the Windows Installer package

[Jrun sutomated kests against the Windows Installer package

[create a Microsoft App-4 application Learn Mare
[Ccreate a vMware Thinapp application Learn mare
Create a Citrix xenfpp profile Learn more

3 (%) Use the default Editor template
&

) Use a customized template

Repackaged Output Tasks

Modify the Editor project

Modify the Windows Installer package with Editor

E

Note - If you would like to further customize the virtual application using the InstallShield Microsoft App-V
Assistant, ThinApp Assistant, or Citrix Assistant, you can click the Modify the Editor project link below to
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open this project in InstallShield Editor. This option is not available until after you build the Repackager project
the first time.

E

Note ° You can also use the Automated Application Converter to convert a Windows Installer package to a
virtual package. See Performing Automated Repackaging and Virtualization Using the Automated Application
Converter.

6. Select whether to use the default Editor template or a customized template, as described in Building a
Windows Installer Package.

7. Select Package Information from the View List and set Package Information options as described in Building
a Windows Installer Package.

8. Select Advanced Settings from the View List and select the options that you want to use, as described in
Configuring Advanced Conversion Options.

9. Select Repackaged Output on the View List. The Repackaged Output View opens.
10. Click the Build button. The build process begins, and its progress is reported in the output window.

When the build process is complete, a Conversion completed message appears in the output window, and a
link to the build log file is provided.

e If you chose the App-V application option, a folder named App-VPackage was created in the location
you specified in the Editor Project field. This folder contains the App-V application for this package and
all of its associated files:

= 2 Apphame I1cons
=l [ App-¥Package— metadata.ami
|20 Icons Apphame, osd

| AppMame, sft
Apphlame_manifest, xml

e |f you chose the ThinApp application option, a folder named ThinAppPackage was created in the
location you specified in the Editor Project field. This folder contains the ThinApp application for this
package and all of its associated files:

: #¥ZPhotoBrowse40,EXE
FE #¥Z Photo Browse
| #¥Z Software, Inc,
Y ZPhotoTouchUp40, EXE
EE #¥Z Photo ToauchUp
it 2¥Z Software, Inc,
Package.DAT

DAT File
128,255 KB

e If you chose the Citrix XenApp profile option, a folder named CitrixProfile was created in the
location you specified in the Editor Project field. This folder contains the Citrix profile for this package
and all of its associated files:
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==| TextDocument EIN File
= | 1kB 1KE

MyApplication, profile
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SkB

Viewing Repackager Project Properties

You can view the properties of the currently open Repackager project by opening the Project Properties dialog box.

o

Task: To view properties for the current Repackager project:

1. Open a project in the Repackager interface.

2. From the Project menu, select Properties. The General tab of the Project Properties dialog box opens.

Project Properties §|

General | Exclusions

Praject Location:
C:AadminStudio SharedyFirefox

Project File:

Firefou.irp

Captured Data File:
Firefou. inc

Fegistry Data File:
Updated.isr

Conversion Options File:

Optionz.ini

Editar Project File:
C:\Packages\FirefaxhFirefax.izm

‘Wwindows Installer Package:

C:\Packages\FirefoxhFirefax. izolated. msi

L Ok Jl Cancel ] THJ

The following properties are listed:

o Project Location—The full path of the directory where the current Repackager project file (.1irp) is
located.

e Project File —The name of the current Repackager project file.

e Captured Data File—The name and location of the captured data file (.1inc), which was either created
by the Repackaging Wizard or during conversion of a Novell ZENworks project, Microsoft SMS project, or
WinINSTALL project. The path is relative to the current Repackager project file.
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e Registry Data File—The name and location of the file containing captured registry data. The path is
relative to the current Repackager project file.

e Conversion Options File—The name and location of the Options.ini file, which contains an exhaustive
list of all options you can use during conversion of the Repackager project to an InstallShield Editor
project and Windows Installer package.

e Editor Project File—The name and location of the InstallShield Editor project file as set in the Product
View (MSI Package). The path is relative to the current Repackager project file.

e Windows Installer Package—The name and location of the Windows Installer package. The path is
relative to the current Repackager project file.

3. When finished viewing properties in the General tab, click OK.

Using the Setup Intent Wizard to Detect File
Dependencies in a Repackager Project

Task:

Although an installation may have intended to install certain files, these files sometimes may not be installed—often
because the files already exist on the target machine (either as the same version or a newer version). These files,
although not installed or updated, are needed for the product to execute properly when the setup is run on a
system that does not already have these files.

You can use the Setup Intent Wizard to detect file dependencies that may not be included in your Repackager
project (.irp). The Setup Intent Wizard scans a setup to identify files that may not have been captured during
repackaging—effectively recognizing the installation’s intent for these files.

To use the Setup Intent Wizard, perform the following steps:

To detect file dependencies:

1. From the Project menu, select Setup Intent Wizard. The Welcome Panel opens.

2. From the Welcome panel, click Next. The Scanning Project Panel opens.

3. Once scanning is finished, the Results Panel opens, listing new files that your setup requires.

4. From the Results Panel, select the files you want added to your Repackager project and click Finish.

5. Save your Repackager project.

E

Note - Because the Setup Intent Wizard analyzes files in the Repackager project and searches for dependent files,
you must run the Setup Intent Wizard from the same machine where repackaging was performed (with the
Repackaging Wizard). You can then save the Repackager project and transfer it to another machine.
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Creating a Setup Capture Report for a Project

You can generate an HTML or text document that summarizes the data that was captured when a setup was
repackaged.

Repackager Setup Capture Report

Project Hame:  C:\PackageshiTunes.inc

Date Generated: Wednesday, January 13, 2010 02:53:13PM

Captured Data Summary

2202 files captured, O marked for exclusion.

6630 registry entries captured, O marked for exclusion.
11 shortcuts captured, O marked for exclusion.

0 INI entries captured, O marked for exclusion.

Captured Files

[ProgramFilesFolder]apple Software Update
scriptinghbjectModel.d1l
SoftwarelUpdate. exe
softwareUpdatesdmin., d11
softwareUpdateFiles. d11

[ProgramFilesFolder]ipple Software Update\plugins
ExEInstallPlugin.dl]
MsIInstallPlugin.dll

[ProgramFilesFolder]ipple Software Update\Softwarellpdate.Resources
software Update.tiff

[ProgramFilesFolder]apple Software UpdatehSoftwarellpdate.Resourceshda.lproj
SoftwareUpdatelocalized. d11

Figure 8-2: Sample Repackager Setup Capture Report

The following information is available to be displayed in this report:
e (Captured files

e Captured shortcuts

® Captured .ini file entries

e (Captured Registry entries

The report also indicates which of the files, shortcuts, .in1 file entries, or Registry entries, if any, have been marked
for exclusion. Those marked for exclusion are not included in the Repackager project.
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Task: To create a report detailing captured data:

1. From the Project menu, select Create Report. The Create Report dialog box opens.

Create Report

Report Opkions

(&Y HTML

() sl captured data (files, registry entries, shortcuts, etc.)
[5ummary anly

Indicate excluded items

Report File Format

() Text

X

l

Create ] [ Cancel ] [ Help

]

2. Select whether you want the report to contain All captured data (all of the data collected during the entire
capture), or just the Current view.

3. If you want the report to contain data from the entire capture, specify whether you want to just display
summary information.

4. Specify whether you want to display excluded items in the report.

5. Select the file format for the report. You can generate an HTML report or a Text report.

6. Click Create. A Save As dialog box opens.

7. From the resulting Save As dialog box, browse to the location where you want to save the file, and provide a
name for the report.

8. Click Save. The report is saved to the specified location and automatically opens.

Saving Repackager Projects

Edition -

To save a Repackager project, perform the following steps:

Task: To save the current Repackager project:

1. Select Save

or

from the File menu.

2. Click the Save button (IH) on the toolbar.
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o

Task:

To save the current Repackager project under a different name:

Select Save As from the File menu.

Opening InstallShield Editor from Repackager

o

After building your Repackager project into a Windows Installer package and/or an InstallShield Editor project, you
may want to launch InstallShield Editor for additional modifications.

Task:

Task:

To launch the generated InstallShield Editor project (.ism) in InstallShield Editor:

From the Repackager Project menu, select Edit InstallShield Project. If installed, InstallShield Editor opens the
project file.

To launch the generated Windows Installer package (.msi) in InstallShield Editor:

From the Repackager Project menu, select Edit Windows Installer Package. If installed, InstallShield Editor
opens the package in Direct MSI Edit mode.

Isolating Windows Installer Packages

516

Application isolation is one solution to component versioning conflicts. Isolation reduces versioning conflicts by
modifying an application so it always loads the versions of components—such as DLLs—with which it was
originally developed and tested.

When building a Windows Installer package from your Repackager project, you can also choose to create an
isolated version of that package by selecting an option on the Repackaged Output View.

Information about application isolation is presented in the following topics:

About Application Isolation

About Assemblies

®  About Manifests

® About Digital Certificates
® Setting Isolation Options

e Building an Isolated Windows Installer Package
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About Application Isolation

Application isolation, which is a technique used to minimize the dependencies of an application on system
components or dynamic elements, is one solution to component versioning conflicts. Isolation reduces versioning
conflicts by modifying an application so it always loads the versions of components and dynamic elements with
which it was originally developed and tested.

Isolation is accomplished by:
e Providing DLLs and other shared components for specific applications, and

e Placing information traditionally stored in the Registry into other files that specify the locations of these isolated
components.

Application isolation provides increased stability and reliability for applications because they are unaffected by
changes caused by installation and ongoing maintenance of other applications on the system.

Depending on the isolation options chosen, you can partially or totally isolate an application. When using
assemblies and manifests to isolate applications for Windows XP systems, the assemblies can be updated
following deployment without necessitating application reinstallation.

Reasons to Isolate Applications
You would want to isolate an application if:

® You want to resolve incompatibilities between different versions of shared components.

® You want to reduce the complexity of the installation by storing COM activation data in a manifest instead of
the registry.

® You want to insulate the application from changes to shared components.

Reasons Not to Isolate an Application

You would not want to isolate an application if, following application isolation, you discover that the application no
longer works because of an internal dependency on a component that has been moved during the isolation
process.

Tip * Following isolation, you can use the Dynamic Dependency Scanner in InstallShield Editor to verify isolated
files are loaded from a different directory.

Isolating Windows Installer Packages Using Application Isolation Wizard

In addition to being able to generate an isolated version of a repackaged setup immediately after the build step in
Repackager, you can also use Application Isolation Wizard to isolate a Windows Installer package.

Application Isolation Wizard is a stand-alone tool which accepts a Windows Installer package as input and outputs
a new, isolated Windows Installer package.
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The Application Isolation Wizard provides a user interface experience that allows the user to extend the initial
“dependency scanning” process for identifying file isolation candidates, while in Repackager you specify your
assembly and digital signing isolation options on the Isolation Options dialog box, and then those selections are
applied to all isolated packages created by Repackager.

For more information, see Isolating Applications Using Application Isolation Wizard.

About Assemblies

Assemblies are DLLs or other portable executable files that applications require to function. Under Windows XP,
these can be either shared or private. Private assemblies are typically stored in the same directory as the
application they support. Shared assemblies are stored in the WinSxS directory, and are digitally signed.

By creating manifests for assemblies, Repackager allows you to create self-contained applications that can use
different versions of the same DLL or other portable executable, without any version conflicts.

Shared Assemblies

Shared assemblies are assemblies available to multiple applications on a computer. Applications that require these
assemblies specify their dependence within a manifest. Multiple versions of shared assemblies can be used by
different applications running simultaneously.

These assemblies are stored in the WinSxS directory, and must be digitally signed for authenticity. After
deployment, the version of shared assemblies can be changed, allowing for changes in dependencies.

Private Assemblies

Private assemblies are assemblies created for exclusive use by an application. They are accompanied by an
assembly manifest, which contains information normally stored in the registry. Private assemblies allow you to
totally isolate an application, eliminating the possibility that dependent files may be overwritten by other
applications.

These assemblies are always stored in the same location as their associated executable.

About Manifests

Manifests, which are used during isolation, are XML files that describe an application. Repackager can create two
types of manifests: application manifests and assembly manifest.

Application Manifests Describe an Isolated Application

Application manifests are XML files that describe an isolated application. This descriptive information includes the
relationship between the application and its dependent files.

Typically, the naming convention for a manifest is:
ApplicationName.Extension.manifest

For example, if the application was HelloWor1d.exe, the manifest file is called:
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HelloWorld.exe.manifest

Assembly Manifests Describe an Application’s Assemblies

Assembly manifests are XML files that describe an application’s assemblies. This includes components such as
DLLs.

Information stored in the assembly manifest, such as COM registration information, ProgIDs, etc., is usually stored
in the Registry. However, by making it independent from the Registry, only that application can use the dependent
files described in the manifest. This enables you to have multiple versions of the same DLL or other portable
executable file on a system without generating compatibility conflicts.

Typically, the naming convention for a manifest is:
AssemblyName.Extension.manifest
For example, if the component was Goodbye.d11, the manifest file is called:

Goodbye.d11.manifest

Manifests as New Components

When you create manifests, Repackager supports putting them into new components. If you do not select the
Create new component for each assembly option on the Manifest Options tab of the Isolation Options
dialog box, the manifest will be added to the same component as the assembly.

About Digital Certificates

Digital certificates identify you and/or your company to end users to assure them the assembly they are about to
use has not been altered. They are issued by a certification authority such as VeriSign, or created using a
combination of software publishing credentials (.spc) and a private key (.pvk), both also issued by a certification
authority. The certificate includes the public cryptograph key, and, when used in combination with a private key,
can be used by end users to verify the authenticity of the signor.

The following digital certificate concepts are defined in this topic:
® Private Keys

e Software Publishing Credentials

e Using a Certificate Store

e (Creating a Certificate File

Private Keys

A private key (a file with the extension .pvk) is granted by a certification authority. Repackager uses the private key
you enter in the Digital Signature tab of the Isolation Options dialog box to digitally sign your shared assembly
and ensure end users of its content's authenticity.

The .spc (Software Publishing Credentials) file and .pvk file you enter in the Digital Signature tab compose the
digital certificate for shared assemblies.

AdminStudio 10.0 User Guide ADS-1000-UG00 519



Chapter 8: Converting Legacy Installations Using the Repackager Interface
Isolating Windows Installer Packages

Contact a certification authority such as VeriSign for more information on the specifics of software publishing
credentials.

Software Publishing Credentials

You must supply a certification authority with specific information about your company and software to obtain
software publishing credentials in the form of an .spc file. Your software publishing credentials are used to generate
a digital signature for your assembly.

The .spcfile and . pvk (private key) file you enter as in the Digital Signature tab of the Advanced Options dialog box
compose the digital certificate for shared assemblies.

Contact a certification authority such as VeriSign for more information on the specifics of software publishing
credentials.

Using a Certificate Store

To perform code signing, both private key and software publishing credential information must be supplied. This
must occur each time a package is signed. Most server operating systems store a certificate locally on the
computer that the user used to request the credential information.

Instead of having to store credential files on each of the user computers, you can create a Certificate Store, a
storage location which will have numerous certificates, which enables all users or computers with adequate
permissions to retrieve the certificate as needed.

Using a Certificate Store allows you to associate the same credentials and private key files with multiple packages.
This simplification is particularly useful when isolating applications, as typically the code signing information will be
identical for all shared assembilies. Ultimately, the Certificate Store removes the burden of managing private key
and software publishing credential information.

Creating a Certificate File

You can create a certificate file from the constituent PVK and SPC files and import it into the Certificate Store using
the PVK Digital Certificate Files Importer. You can then export the certificate (. cer) file for use outside of the
Certificate Store.

AN

Caution - Certificate files must be 2048-bit or higher. For more information, see the article: Assembly Signing
Example on the Microsoft Developer Network Web site.

Setting Isolation Options

520

Application isolation is one solution to component versioning conflicts. Isolation reduces versioning conflicts by
modifying an application so it always loads the versions of components—such as DLLs—with which it was
originally developed and tested.

On the Isolation Options Dialog Box, which is opened by selecting Isolation Options from the Tools menu, you
can specify the following Repackager isolation options:
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e Assembly Options—Specify the type of assemblies Repackager will create: private side-by-side assemblies
in the application folder or shared side-by-side assemblies in the WinSxS folder. You can also specify the
assembly naming conventions. See Specifying Manifest Options.

e Digital Signature Options—You can configure the certificate information required when using shared
assemblies. This required digital signature provides an extra layer of protection, allowing you to obtain
information about the company who created a global assembly. See Setting Digital Signature Options for
Shared Assembilies.

Specifying Manifest Options
On the Manifest Options tab of the Isolation Options Dialog Box, which is opened by selecting Isolation
Options from the Tools menu, you can specify the following options:
® Selecting the Assembly Type

e Specifying the Assembly Naming Conventions

E

Note ° For more information on assemblies and manifests, see About Assemblies and About Manifests.

Selecting the Assembly Type

On the Manifest Options tab of the Isolation Options Dialog Box, which is opened by selecting Isolation
Options from the Tools menu, you can specify the type of assemblies Repackager will create: private side-by-side
assemblies in the application folder or shared side-by-side assemblies in the WinSxS folder.

Task: To select the assembly type:
1. Open the Repackager interface.

2. From the Tools menu, select Isolation Options. The Manifest Options tab of the Isolation Options dialog
box opens.

3. Select one of the following Assembly Type options:
e Create private side-by-side assemblies in the application folder.

e (Create shared side-by-side assemblies in WinSxS directory.

E

Note ° Manifests for shared assemblies must be digitally signed. See Setting Digital Signature Options for Shared
Assemblies.

E

Note ° The modifications you make on the Isolation Options dialog box will be recorded in the
isolationconfig.ini file, which is stored in the AdminStudio Shared directory.
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Specifying the Assembly Naming Conventions

Task:

Setting

Task:

522

On the Manifest Options tab of the Isolation Options Dialog Box, which is opened by selecting Isolation
Options from the Tools menu, you can specify the type of naming conventions Repackager will use when creating
assemblies.

To set the default naming convention for assemblies:
1. Open the Repackager interface.

2. From the Tools menu, select Isolation Options. The Manifest Options tab of the Isolation Options dialog
box opens.

3. Inthe Assembly Naming Conventions area, enter your Company name and Division. These two fields
create the default assembly naming convention (in the form Company.Division.Assembly followed by a
number).

4. If you want to create a new component for each assembly, select the Create new component for each
assembly option.

Assemblies created during application isolation will follow the naming convention as specified.

E

Note ° The modifications you make on the Isolation Options dialog box will be recorded in the
isolationconfig. ini file, which is stored in the AdminStudio Shared directory.

Digital Signature Options for Shared Assemblies

You can configure the certificate information required when using shared assemblies on the Digital Signature tab
of the Isolation Options dialog box.This required digital signature provides an extra layer of protection, allowing
you to obtain information about the company who created a global assembly.

E

Note * The modifications you make on the Isolation Options dialog box will be recorded in the

isolationconfig. ini file, which is stored in the AdminStudio Shared directory.

E

Note * For more information, see About Digital Certificates.

To set digital signature options:
1. Open the Repackager interface.

2. From the Tools menu, select Isolation Options. The Manifest Options tab of the Isolation Options dialog
box opens.

ADS-1000-UG00 AdminStudio 10.0 User Guide



Chapter 8: Converting Legacy Installations Using the Repackager Interface
Configuring Exclusions

3. Open the Digital Signatures tab.

4. Click the Browse ([..J) button next to the Certificate File field and navigate to the certificate file you are using
to sign assemblies.

A digital certificate identifies you and/or your company to end users and assures them the data they are about
to receive has not been altered.

5. Inthe Code Signing Technology area, select the type of code signing technology you want to use for the
digital signature. You can use one of the following technologies:

Technology Description

Credentials Select this option to use credential files as the code signing technology. If you
select this option, you must supply the name and location of both your software
publishing credential files:

® SPC File—Specify the name and location of your software publishing
credentials file (.spc).

e PVK—Specify the name and location of your private key file (.pvk).

In order to receive a software publishing credentials and a private key, you must

supply a certification authority, such as VeriSign with specific information about
your company and software.

Certificate Name in Select this option to use the name of an existing certificate file in the Certificate

the store Store as the code signing technology. The Certificate Store is a central
repository for certificate files. Using a Certificate Store allows you to reuse the
certificate files for different purposes as necessary.

As an alternative to providing .spc and .pvk files, you can specify the certificate
name as it appears in the certificate store.

Building an Isolated Windows Installer Package

To reduce versioning conflicts by modifying an application so it always loads the versions of components—such as
DLLs—with which it was originally developed and tested, select the Create an isolated version of the Windows
Installer package option on the Repackager Repackaged Output view. An additional Windows Installer

package will be created in the same directory as the . 1ismfile and the other .msi file, with the naming convention of:

appname.isolated.msi

For more information on how Repackager isolates applications and the available isolation options, see Isolating
Windows Installer Packages.

Configuring Exclusions

Repackaging exclusions refer to exclusions made during repackage time using the Repackaging Wizard. Any files,
registry entries, .ini files, or shortcuts excluded at this point are not included in the Repackager project.
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There are two methods of configuring exclusions:

e Configuring Exclusions Using Repackager

e Configuring Exclusions Using the Exclusions Editor

Configuring Exclusions Using Repackager

There are three types of exclusions used when repackaging a legacy installation:

Table 8-3 * Repackager Exclusion Types

Exclusion Type

Repackaging
Exclusions

Project
Exclusions

Individual
Project
Exclusions

Description

Repackaging exclusions refer to exclusions made during repackage time using the
Repackaging Wizard. Any files, registry entries, .ini files, or shortcuts excluded at this point
are not included in the Repackager project. Therefore, if you exclude a directory you later
need, you need to repackage the legacy setup again.

The Repackager best practice is to capture everything using the Repackaging Wizard, and
then exclude visually in the Repackager Interface. This way, you avoid having to run the
Repackaging Wizard again if you accidentally exclude necessary files.

In some cases, you may want to avoid capturing specific data types during repackaging.
For example, your organization may never want to capture shortcuts. You can disable
capture of shortcuts during repackage time, thereby eliminating the need to exclude them
later. In Snapshot mode, you may want to limit the analysis to a certain directory to reduce
the time it takes to capture the initial and final snapshot.

Each Repackager project can use a project exclusion list which marks files, registry
entries, shortcuts, and .ini files as excluded in the Repackager project. If your process
dictates that you capture everything and only exclude items in the Repackager Interface,
then you should set up commonly captured but unnecessary items from the project by
default. Because all the data from the original capture is intact, if you accidentally exclude
necessary files, you can always reinclude them from the Repackager Interface and quickly
rebuild your Windows Installer package.

Because each project is different, and may require you to make decisions as to whether
certain captured data is necessary, you can also selectively exclude or reinclude items on
a per-package basis. These individual project exclusions allow you a fine-level of control
as you prepare to build your Windows Installer package from the Repackager project.

Excluding Files

To exclude a captured file from the InstallShield Editor project and Windows Installer package, perform the

following steps.
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4

Task: To exclude a captured file from the InstallShield Editor project and Windows Installer package:
1. Select Files and Folders from the View List. The Files and Folders View opens.
2. Expand the directory tree and select the directory containing the file you want to exclude.

3. Inthe file list, right-click the file and then click Exclude.

Excluding All Files in a Directory

To exclude all captured files in a directory from the InstallShield Editor project and Windows Installer package,
perform the following steps.

4

Task: To exclude all captured files in a directory from the InstallShield Editor project and Windows Installer
package:

1. Select Files and Folders from the View List. The Files and Folders View opens.
2. Expand the directory tree and select the directory containing the files you want to exclude.

3. Right-click the directory and then click Exclude.

Excluding Directories and Subdirectories

To exclude all captured files and subdirectories within a directory from the InstallShield Editor project and Windows
Installer package, perform the following steps.

4

Task: To exclude all captured files and subdirectories within a directory from the InstallShield Editor
project and Windows Installer package:

1. Select Files and Folders from the View List. The Files and Folders View opens.
2. Expand the directory tree to display the directory containing the files and subdirectories you want to exclude.

3. Right-click the directory and then click Exclude All.
Excluding Registry Keys

To exclude a registry key from the InstallShield Editor project and Windows Installer package, perform the following
steps.
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4

Task: To exclude a registry key from the InstallShield Editor project and Windows Installer package:
1. Select Registry Entries from the View List. The Registry Entries View opens.
2. Expand the Registry tree to display the registry key you want to exclude.

3. Right-click the registry key and then click Exclude.

Excluding Registry Values

To exclude a captured registry value from the InstallShield Editor project and Windows Installer package, perform
the following steps.

4

Task: To exclude a captured registry value from the InstaliShield Editor project and Windows Installer
package:

1. Select Registry Entries from the View List. The Registry Entries View opens.
2. Expand the Registry tree and select the registry key containing the value you want to exclude.

3. Inthe Registry Value list, right-click the value and then click Exclude.

Excluding .ini Files

To exclude a captured .ini file from the InstallShield Editor project and Windows Installer package, perform the
following steps.

4

Task: To exclude a captured .ini file from the InstallShield Editor project and Windows Installer package:
1. Select INI Files from the View List. The INI Files View opens.
2. Expand the INI Files tree to display the .ini file you want to exclude.

3. Right-click the .ini file and then click Exclude.

Excluding .ini File Sections

To exclude a section in a captured .ini file from the InstallShield Editor project and Windows Installer package,
perform the following steps.
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4

Task: To exclude a section in a captured .ini file from the InstallShield Editor project and Windows Installer
package:

1. Select INI Files from the View List. The INI Files View opens.
2. Expand the INI Files tree to display the .ini file containing the section you want to exclude.

3. Right-click the section and then click Exclude.

Excluding Shortcuts

To exclude a captured shortcut from the InstallShield Editor project and Windows Installer package, perform the
following steps.

%
Task: To exclude a captured shortcut from the InstallShield Editor project and Windows Installer package:
1. Select Shortcuts from the View List. The Shortcuts View opens.

2. Expand the Shortcuts tree to display the shortcut you want to exclude.

3. Right-click the shortcut and then click Exclude.

Excluding All Shortcuts in a Directory

To exclude all captured shortcuts in a directory from the InstallShield Editor project and Windows Installer package,
perform the following steps.

4

Task: To exclude all captured shortcuts in a directory from the InstallShield Editor project and Windows
Installer package:

1. Select Shortcuts from the View List. The Shortcuts View opens.
2. Expand the Shortcuts tree to display the directory containing the shortcuts you want to exclude.

3. Right-click the directory and then click Exclude.

Excluding Shortcuts from Subdirectories

To exclude all captured shortcuts within a directory or its subdirectories from the InstallShield Editor project and
Windows Installer package, perform the following steps.
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&

Task: To exclude all captured shortcuts within a directory or its subdirectories from the InstallShield Editor

project and Windows Installer package:

1. Select Shortcuts from the View List. The Shortcuts View opens.

2. Expand the Shortcuts tree to display the directory containing the shortcuts and/or subdirectories containing
shortcuts you want to exclude.

3. Right-click the directory and then click Exclude All.

Specifying the External Configuration File

To specify an external configuration file which you want to use as a filter when converting legacy setups, perform

the following steps.

&

Task: To specify an external configuration file which you want to use as a filter when converting legacy

setups:

1. From the Repackager Project menu, select Properties. The General tab of the Project Properties dialog

box opens.

2. Open the Exclusions tab.

Project Properties

|

——
General | Exclusions

) Do not use any external configuration file,

C' Usze zettings from the ghared location:

(&) Use settings from a custom file:

(x]

[ ok

][ Cancel ][

Apply

J

Help

]

3. Select the Use settings from the shared location or the Use settings from a custom file option. The
Browse button for that option is activated.

4. Click Browse and select the configuration file you want to use.
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Tip « After you select a configuration file, the Edit button is activated, enabling you to open the file in the
Exclusions Editor.

5. Click OK.

When you apply a configuration file, Repackager automatically updates all views to reflect the configuration file’s
exclusions. However, if you have already excluded items using Repackager, item states are retained.

Modifying External Configuration Files

o

To configure an external configuration file, perform the following steps.

Task:

To configure an external configuration file:

1. From Repackager's Project menu, click Properties. The General tab of the Project Properties dialog box
opens.

2. Select the Exclusions tab.

@«

Select the file you want to modify in either the Use settings from the shared location option or Use
settings from a custom file options.

4. Click Edit. The Exclusions Editor opens.

5. Make necessary modifications using the Exclusions Editor.
6. When you finish editing the configuration file, click OK.

7. Click OK to close the Project Properties dialog box.

When you apply a configuration file, Repackager automatically updates all views to reflect the configuration file's
exclusions. However, if you have already excluded items using Repackager, item states are retained.

Configuring Exclusions Using the Exclusions Editor

The Exclusions Editor allows you to configure three types of exclusions: Repackaging, Project, and OS Snapshot.

Repackaging Exclusions

Repackaging exclusions refer to exclusions made during repackage time using the Repackaging Wizard. Any files,
registry entries, .1ini files, or shortcuts excluded at this point are not included in the Repackager project. Therefore,
if you exclude a directory you later need, you need to repackage the legacy setup again.

The Repackager best practice is to capture everything using the Repackaging Wizard, and then exclude visually in
the Repackager Interface. This way, you avoid having to run the Repackaging Wizard again if you accidentally
exclude necessary files.
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In some cases, you may want to avoid capturing specific data types during repackaging. For example, your
organization may never want to capture shortcuts. You can disable capture of shortcuts during repackage time,
thereby eliminating the need to exclude them later. In Snapshot mode, you may want to limit the analysis to a
certain directory to reduce the time it takes to capture the initial and final snapshot.

Project Exclusions

Each Repackager project can use a project exclusion list which marks files, registry entries, shortcuts, and .1ini
files as excluded in the Repackager project. If your process dictates that you capture everything and only exclude
items in the Repackager Interface, then you should set up commonly captured but unnecessary items from the
project by default. Because all the data from the original capture is intact, if you accidentally exclude necessary
files, you can always reinclude them from the Repackager Interface and quickly rebuild your Windows Installer
package.

OS Snapshot Exclusions

Like pre-capture repackaging exclusions, you can use the Exclusions Editor to configure exclusions to apply
during the capture of OS snapshots. However, to maximize the usefulness of OS snapshots, you should avoid
editing the default snapshot exclusion list (ISSnapshot.ini).

Exclusions and Repackager

Exclusions in Repackager refer to files, registry entries, shortcuts, and . ini files that are marked as excluded in the
Repackager Interface by default when you open a Repackager project or if you change your exclusions file. The
captured data is only marked as excluded and not ignored or discarded during capture. You can create an
exclusion file in the Exclusions Editor, and link it to Repackager from the Exclusions Tab of the Project
Properties dialog box in Repackager.

Exclusions and the OS Snapshot Wizard

When using the Exclusions Editor to configure analysis options for capturing OS snapshots, you are creating an
exclusion list for files, directories, .1ini files, .1ini file sections, and registry data. ltems in the exclusion list are not
captured during the OS snapshot process, and will not be included in the OS snapshot file which is created.

Launching Exclusions Editor

530

The Exclusions Editor can be launched either within the Repackager interface or outside of Repackager. You can
edit the default exclusions file, isrepackager.ini, using either interface.

However, if you want to create a new, custom exclusions file, you must launch the Exclusions Editor outside of
Repackager.

e launching Exclusions Editor Outside of Repackager

® Launching Exclusions Editor Within Repackager

ADS-1000-UG00 AdminStudio 10.0 User Guide



Task:

Chapter 8: Converting Legacy Installations Using the Repackager Interface
Configuring Exclusions

Launching Exclusions Editor Outside of Repackager

To launch the Exclusions Editor outside of the Repackager interface, perform the following steps.

To add a file to the exclusion list:

1.

Launch the Exclusions Editor by locating and executing the following file:
AdminStudio Installation Directory\Repackager\AnalysisOptions.exe
The Files tab of the Exclusions Editor opens.

Perform one of the following to open an exclusions file:

e Shared Exclusions—To edit the shared exclusions file, on the Files menu, point to Open and click
Shared Exclusions. The exclusions in the shared exclusions file are now listed on the Files tab.

e Custom Exclusions—To create a new custom exclusions file, on the Files menu, click New. A default
set of exclusions is listed.

Make edits to the file.
Save the file by selecting Save on the File menu.

If you were creating a custom exclusions file, specify a name and location for this exclusions file and click
Save.

Launching Exclusions Editor Within Repackager

To add a file to the exclusion list, perform the following steps.

Task:

To add a file to the exclusion list:

Launch Repackager and open a project.

On the Project menu, click Properties. The Project Properties dialog box opens.

On the Exclusions tab, do one of the following:

e To edit the default exclusions file, select Use settings from the shared location and click Edit.

e To edit a custom exclusions file, select Use settings from a custom file, browse to the file you want to
open (if it is not listed), and click Edit.

The Files tab of the Exclusions Editor opens, with the appropriate exclusions file open.
Make edits to the file.

Save the file and close the Exclusions Editor by clicking OK.

E

Note * Note that when opening the Exclusions Editor from within Repackager, there is no File menu displayed,
meaning that you can only edit an existing exclusions file; you cannot create a new exclusions file.
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Excluding Files

You use the Exclusions Editor to create an exclusion list for files so that those files are not captured during the OS
snapshot process, and will not be included in the OS snapshot file.

o

Task: To add a file to the exclusion list:

1. Launch the Exclusions Editor and open an exclusions file by performing the steps listed in Launching
Exclusions Editor.

2. Onthe Files tab, click New. The File Exclusion Information dialog box opens.

3. Enter or browse to the directory Path containing the file you want to exclude.

4. Enter the name of the file you want to exclude, or browse to it by clicking the Browse ([...]) button to the right
of the Excluded Files field. If you want to exclude multiple files from the same directory, separate them with
pipes (|). If you want to exclude all files in a directory, enter an asterisk (*).

5. Click OK to close the File Exclusion Information dialog box. The new exclusion appears in the Files tab.

6. Save the exclusions file as described in Launching Exclusions Editor.

E

Note » When configuring file exclusions for Repackager, you are only configuring Repackager to automatically
mark the file as excluded; this can be changed from within Repackager on a file-by-file basis. However, when
configuring file exclusions for the OS Snapshot Wizard, files in the exclusion list are not captured in the OS snapshot
file.

Excluding Files with Specific Extensions

To exclude files with specific extensions from the exclusion list, perform the following steps.

W

Task: To exclude files with specific extensions from the exclusion list:

1. Launch the Exclusions Editor and open an exclusions file by performing the steps listed in Launching
Exclusions Editor:

2. Onthe Files tab, click New. The File Exclusion Information dialog box opens.

3. Inthe File Exclusion Information dialog box, enter or browse to the directory containing the files you want
to exclude. If you want to exclude files with a certain extension from all directories, enter an asterisk (*) for the
Path value.

4. Enter an asterisk followed by the extension you want excluded in the Excluded Files field. For example, if you
want to exclude all .bak files, enter *.bak. If you want to exclude multiple file types from the same directory (or
from all directories), separate each exclusion with a pipe (1).

5. Click OK to close the File Exclusion Information dialog box. The new exclusion appears in the Files tab.
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6. Save the exclusions file as described in Launching Exclusions Editor:

E

Note  When configuring file exclusions for Repackager, you are only configuring Repackager to automatically
mark the file as excluded; this can be changed from within Repackager on a file-by-file basis. However, when
configuring file exclusions for the OS Snapshot Wizard, files in the exclusion list are not captured in the OS snapshot
file.

Excluding Directories

o

To add a directory to the exclusion list, perform the following steps.

Task:

To add a directory to the exclusion list:

1. Launch the Exclusions Editor and open an exclusions file by performing the steps listed in Launching
Exclusions Editor:

2. Onthe Files tab, click New. The File Exclusion Information dialog box opens.

3. Inthe File Exclusion Information dialog box, enter or browse to the directory Path containing the files you
want to exclude.

4. Enter an asterisk (*) in the Excluded Files field.
5. Click OK to close the File Exclusion Information dialog box. The new exclusion appears in the Files tab.

6. Save the exclusions file as described in Launching Exclusions Editor:

E

Note » When configuring file exclusions for Repackager, you are only configuring Repackager to automatically
mark the file as excluded; this can be changed from within Repackager on a file-by-file basis. However, when
configuring file exclusions for the OS Snapshot Wizard, files in the exclusion list are not captured in the OS snapshot
file.

Editing Existing File Exclusions

o

Task:

To edit an existing file exclusion, perform the following steps.

To edit an existing file exclusion:

1. Launch the Exclusions Editor and open an exclusions file by performing the steps listed in Launching
Exclusions Editor:

2. Select the appropriate exclusion and click Edit. The File Exclusion Information dialog box opens.

3. Inthe File Exclusion Information dialog box, modify the Path and Excluded Files information.
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4. Click OK to close the File Exclusion Information dialog box. The edited exclusion is listed in the Files tab.

5. Save the exclusions file as described in Launching Exclusions Editor:

E

Note  When configuring file exclusions for Repackager, you are only configuring Repackager to automatically
mark the file as excluded; this can be changed from within Repackager on a file-by-file basis. However, when
configuring file exclusions for the OS Snapshot Wizard, files in the exclusion list are not captured in the OS snapshot
file.

Removing File Exclusions

To remove an existing file exclusion, perform the following steps.
Task: To remove an existing file exclusion:

1. Launch the Exclusions Editor and open an exclusions file by performing the steps listed in Launching
Exclusions Editor:

2. Select the appropriate exclusion and click Delete.
3. Confirm the exclusion by clicking OK. The deleted exclusion is removed from the list.

4. Save the exclusions file as described in Launching Exclusions Editor:

E

Note  When configuring file exclusions for Repackager, you are only configuring Repackager to automatically
mark the file as excluded; this can be changed from within Repackager on a file-by-file basis. However, when
configuring file exclusions for the OS Snapshot Wizard, files in the exclusion list are not captured in the OS snapshot
file.

Excluding .ini Files

To add an .ini file to the exclusion list, perform the following steps.
Task: To add an .ini file to the exclusion list:

1. Launch the Exclusions Editor and open an exclusions file by performing the steps listed in Launching
Exclusions Editor:

2. Open the INI Files tab.
3. Click New. The INI File Exclusion Information dialog box opens.

4. Enter or browse to the .1ini file you want to exclude.
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If there are specific sections you want to exclude from the .1in1 file, put the section names in brackets ([]) and
separate them with pipes () in the Excluded Sections field. If you want to exclude all sections, put an
asterisk (*) in the Excluded Sections field.

Click OK to close the INI File Exclusion Information dialog box. The new exclusion appears in the list on
the INI Files tab.

Save the exclusions file as described in Launching Exclusions Editor.

Note  When configuring .ini file exclusions for Repackager, you are only configuring Repackager to automatically
mark the .ini file and/or sections as excluded; this can be changed from within Repackager on an .ini file by .ini file

basis. However, when configuring .ini file exclusions for the OS Snapshot Wizard, .ini files in the exclusion list are not

captured in the OS snapshot file.

Excluding Sections from .ini Files

To add a specific .ini file section to the exclusion list, perform the following steps.

&

Task: To add a specific .ini file section to the exclusion list:

1.

8.

E

Launch the Exclusions Editor and open an exclusions file by performing the steps listed in Launching
Exclusions Editor:

Open the INI Files tab.
Click New. The INI File Exclusion Information dialog box opens.
Enter or browse to the .1ini file containing the section you want to exclude.

To exclude a specific . ini file section, enter the section name in brackets ([]) in the Excluded Sections field.
If there are multiple sections, separate them with pipes (|).

Click OK to close the INI File Exclusion Information dialog box. The new exclusion appears in the INI Files
and Sections Excluded During Analysis dialog box.

Click OK to close the INI File Exclusion Information dialog box. The new exclusion appears in the list on
the INI Files tab.

Save the exclusions file as described in Launching Exclusions Editor:

Note » When configuring .ini file exclusions for Repackager, you are only configuring Repackager to automatically
mark the .ini file and/or sections as excluded; this can be changed from within Repackager on an .ini file by .ini file
basis. However, when configuring .ini file exclusions for the OS Snapshot Wizard, .ini files in the exclusion list are not
captured in the OS snapshot file.
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Editing Existing .ini File Exclusions

o

Task:

To edit an existing .ini file exclusion, perform the following steps.

To edit an existing .ini file exclusion:

1. Launch the Exclusions Editor and open an exclusions file by performing the steps listed in Launching
Exclusions Editor.

Open the INI Files tab.
Select the appropriate exclusion and click Edit. The INI File Exclusion Information dialog box opens.

In the File Exclusion Information dialog box, modify the INI File and Excluded Sections information.

@ » w0 b

Click OK to close the INI File Exclusion Information dialog box. The edited exclusion appears in the list on
the INI Files tab.

6. Save the exclusions file as described in Launching Exclusions Editor:

E

Note » When configuring .ini file exclusions for Repackager, you are only configuring Repackager to automatically
mark the .ini file and/or sections as excluded; this can be changed from within Repackager on an .ini file by .ini file
basis. However, when configuring .ini file exclusions for the OS Snapshot Wizard, .ini files in the exclusion list are not
captured in the OS snapshot file.

Removing .ini File Exclusions

o

Task:

536

To delete an existing .ini file exclusion, perform the following steps.

To delete an existing .ini file exclusion:

1. Launch the Exclusions Editor and open an exclusions file by performing the steps listed in Launching
Exclusions Editor:

2. Open the INI Files tab.
3. Select the appropriate exclusion and click Delete.
4. Confirm the exclusion by clicking OK. The deleted exclusion is removed from the list.

5. Save the exclusions file as described in Launching Exclusions Editor:

E

Note « When configuring .ini file exclusions for Repackager, you are only configuring Repackager to automatically

mark the .ini file and/or sections as excluded; this can be changed from within Repackager on an .ini file by .ini file
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basis. However, when configuring .ini file exclusions for the OS Snapshot Wizard, .ini files in the exclusion list are not
captured in the OS snapshot file.

Excluding Registry Data

To add registry data to the exclusion list, perform the following steps.

o

Task: To add registry data to the exclusion list:

1. Launch the Exclusions Editor and open an exclusions file by performing the steps listed in Launching
Exclusions Editor:

2. Open the Registry tab.
3. Click New. The Choose Registry Key dialog box opens.

4. Enter or browse to the registry key you want to exclude and click OK. The key is added to the list on the
Registry tab.

5. If you want to exclude a certain value in the key, select it from the list and click Edit. The Edit Registry Key
dialog box opens.

6. Provide the Value Name you want to exclude, and click OK to close the dialog box. The exclusion information
is reflected in the list on the Registry tab.

7. Save the exclusions file as described in Launching Exclusions Editor:

E

Note « When configuring registry exclusions for Repackager, you are only configuring Repackager to automatically
mark the registry entry and/or values as excluded; this can be changed from within Repackager on an registry key
by registry key basis. However, when configuring registry exclusions for the OS Snapshot Wizard, registry data in the
exclusion list is not captured in the OS snapshot file.

Editing Existing Registry Exclusions
To edit existing registry exclusions, perform the following steps.
Task: To edit an existing registry exclusion:

1. Launch the Exclusions Editor and open an exclusions file by performing the steps listed in Launching
Exclusions Editor:

2. Open the Registry tab.

3. Select the registry key that you want to edit and click Edit. The Edit Registry Key dialog box opens.

AdminStudio 10.0 User Guide ADS-1000-UG00 537



Chapter 8: Converting Legacy Installations Using the Repackager Interface
Configuring Exclusions

4. Modify the exclusion as necessary and click OK. The edited information is reflected in the list on the Registry
tab.

5. Save the exclusions file as described in Launching Exclusions Editor:

E

Note « When configuring registry exclusions for Repackager, you are only configuring Repackager to automatically
mark the registry entry and/or values as excluded; this can be changed from within Repackager on an registry key
by registry key basis. However, when configuring registry exclusions for the OS Snapshot Wizard, registry data in the
exclusion list is not captured in the OS snapshot file.

Removing Registry Exclusions

W

Task:

To delete an existing registry exclusion, perform the following steps.

To delete an existing registry exclusion:

1. Launch the Exclusions Editor and open an exclusions file by performing the steps listed in Launching
Exclusions Editor:

2. Open the Registry tab.
3. Select the registry key that you want to delete and click Delete.
4. Confirm the deletion by clicking OK. The deleted exclusion is removed from the list.

5. Save the exclusions file as described in Launching Exclusions Editor:

E

Note * When configuring registry exclusions for Repackager, you are only configuring Repackager to automatically

mark the registry entry and/or values as excluded; this can be changed from within Repackager on an registry key
by registry key basis. However, when configuring registry exclusions for the OS Snapshot Wizard, registry data in the
exclusion list is not captured in the OS snapshot file.

Repackaging and Anti-Virus Software

538

Any machine that you use to repackage most likely has anti-virus software installed on it, even a “clean” machine.
During repackaging, the real-time virus detection feature of anti-virus software could automatically update various
cached files in its directories.

Therefore, in order to avoid repackaging errors when using the Snapshot repackaging method, you should
exclude the software directories containing your anti-virus software.
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Task: To exclude anti-virus software directories:

1.

[]

Launch the Exclusions Editor and open an exclusions file by performing the steps listed in Launching
Exclusions Editor:

On the Files tab, click New. The File Exclusion Information dialog box opens.

File Exclusion Information g|
Path:
Ci\Program FilesiSymantec Antivirus
Excluded Files:
" (]
[ OF ] [ Cancel ]

Enter or browse to the directory Path containing the anti-virus files that you want to exclude. For example, if
you wanted to exclude Symantec AntiVirus software, you would select the following directory:

C:\Program Files\Symantec AntiVirus
Enter an asterisk (*) in the Excluded Files field.
Click OK to close the File Exclusion Information dialog box. The new exclusions appear on the Files tab.

Save the exclusions file as described in Launching Exclusions Editor:

Important - It is strongly recommended that you leave your anti-virus software running during repackaging.

Scanning InstallShield Professional Setups for
Additional Data

If you are repackaging a legacy installation that was originally created using InstallShield Professional 5.5 and later,
you can use the SmartScan Wizard to scan the setup for possible additional files, .1ini files, shortcuts, or registry
data (such as for language-specific setups or platform-specific setups).

The SmartScan Wizard is also able to group files, shortcuts and registry entries into features corresponding to
InstallShield Professional components. Any items (files, folders, shortcuts, or registry entries) that are attached to a
component directly or indirectly (through File Groups), are attached to their corresponding features.

- -J Features

Ej DemoPlayerdpp
Ej InstallshieldProbemo
Ej DemoshigldDemo
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Automatic Launch of the SmartScan Wizard

For your convenience, if a Repackaging project is opened (either by using Open on the File menu or by using the
Repackaging Wizard), and the project meets certain conditions, the SmartScan Wizard is automatically launched.
The SmartScan Wizard is automatically launched:

e f the original setup was an InstallShield Professional 5.5 or later installation, and

e the file has not already been repackaged using the InstallShield Professional Logging Method (available
for InstallShield Editor and DevStudio 9.x InstallScript installations only), and

e the SmartScan Wizard has not already been run on this project

Task:

540

To scan an InstallShield Professional setup:
1. From the Project menu, select SmartScan Wizard. The Welcome Panel appears.
2. Click Next. The Original InstallShield Professional Setup Panel appears.

3. The Specify the path of the original setup executable field will be filled in by default if that information
exists. Browse to the InstallShield Professional setup you want to scan, and specify a password if required.

4. Inthe Original target folder field, enter the directory where the product was installed during the repackaging
process. In most cases, this will be a subdirectory of [ProgramFilesFolder].

5. Click Next. The Scanning Panel appears.

6. When scanning is complete, click Next. The Setup Feature Tree Panel appears, listing the features and
components that were configured in the InstallShield Professional project.

7. Select the Add feature tree option if you want to use the feature information defined in the Professional
media.

8. Click Next. The Scanning Media Panel appears, showing the results of Repackager's search for any extra
setup information in the media.

9. Click Finish to apply the results to the project.

e The setup is scanned, and any additional files, shortcuts, .1in1 files, or registry data is added to the
appropriate view.

e The data captured by the SmartScan Wizard appears in the color designated in the SmartScan items
field on the Colors tab of the Options dialog box.

e If you selected the Add feature tree option, the files, shortcuts and registry entries are grouped into
features corresponding to the InstallShield Professional components.

E

Note - After you have scanned an InstallShield Professional project and included data from it in your Repackager
project, you can save the project. When you reopen it, this collected data no longer retains the “scanned” color,
since it is now part of the Repackager project.
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Creating an InstallShield Editor Template to
Use Within Repackager

One of the main reasons you use AdminStudio is to significantly reduce the time it takes to package an application
for deployment. You can use the following procedure to speed up the packaging process even more.

You can create an InstallShield Editor template that you can use within the Repackager interface to save additional
time when customizing a package. By using this template, all future InstallShield Editor .1ism project files generated
by Repackager will contain the company-specific default settings that were specified in the template. Using a
template is also beneficial for organizations with multiple packagers, since it helps enforce consistency by enabling
all packagers to make the same standard customizations to packages.

To create an InstallShield Editor template to use within Repackager, perform the following steps.

Task: To create a customized InstallShield Editor template:

1. Create a new Basic MSI Project in the InstallShield Editor.

2. Onthe Installation Designer tab, select the General Information node under Installation Information,
and enter your company-specific information as required.
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e-3 - InstallShield 2008 Professional - AdminStudio Edition [Basic MSI Project]

File Edit Wiew Go Project Build Tools Window Help

De 0o+ & « E LB e
StartPage ] Project Assistant I Installation Designer I Citrix Assistank ] Thinstall Assistant
=13 Installation Information & | = General Infarmation Summary
General Information E&' Project Properties Title Installation Database
% Update Motifications ﬁﬂ Sumnmary Information Stream | Subject Blark Project Template
Triahware 3_5 Add or Remove Pragrams Authaor Macrovision Corporation
=1E3) Organization = Product Properties Keywords Installer,MSI,Database
% Setup Design [=-gb% String Tables Package Code {6FEACEFA-EE3A-41A6-8E92-89552F3E554 1}
Features Q" English (United States) Template Summary Inkel; 1033
" Components Comments Conktact: Your local administrator
kil DIM References Schema Z00
=13 Application Data Require Administrative Privieges | Yes
Files and Folders
Redistributables

Mobile Devices
=ET) System Configuration
sharteuts
' Registry
ODEC Resources

Commenkts Property

3 IMI File Changes Enter any comments about your product into this field. These comments are

B Ervironment Yariable: displaved to your end users in the Summary panel in your setup package's

|ﬂ #ML File Changes Froperties dialog. A typical value for the Comments property is *This installer
[=1+ICT) Server Configuration database contains the logic and data reguired to install <product name=.”

Internet Information !
Component Services
L S0QL Scripts
=12 Behavior and Logic
@ InstallScript
B custom actions and 5
, Support Files
g Swskem Search
[17] Property Manager
=I5y User Inkerface
£ 7 Dialogs
=) Media
Path Yariables
3 Upgrades
) Releases
é Patch Design
=5 Additional Tools
E Dependency Scanner:
%= MSI Debugger b S
< > < % | Property | String Table |
Ready | |

3. Under Behavior and Logic, select the Property Manager node and add the required properties like
ALLUSERS, ISSCRIPTDRIVEN, etc.
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[<] My Project Name-3 - InstallShield 2008 Professional - AdminStudio Edition [Basic MS] Project]

File Edit %iew Go Project Build Tools ‘window Help

=N Dfh 4+ ¥« 5]

Lt'a=de

Il SkartPage ] Project Assistank

(=) Installation Information
General Information
i Update Matifications
Trialware
[=1+C7) ©rganization
% Setup Design
Feakures
Components
a DIM References
[=-c3) Application Data
Files and Folders
Redistributables
Mobile Devices
[=+CT) System Configuration
Shortcuts
" Reqgistry
= ODBC Resources
4 IMI File Changes
B Ervironment Yariables
|ﬂ ¥ML File Changes
[=+C7) Server Configuration
i Internet Information Services
2

Component Services
SOL Scripks
[=1{c%) Behavior and Logic
@ InstallScript
El Cuskom Actions and Sequences
, Support Files
g Swyskemn Search
[17] Property Manager
[=-c%) User Interface
g1 Dialogs
=T Media
Path Yariables
@ Upgrades

(1) Releases

< |

~

] Installation Designer I Citrix Assistant ] Thinstall Assistant pperty Manager Bl

Yalue

_IsMainktenance Change

_IssetupTypelin Twpical

AgreeTolicense Mo

AL 1

ApplicationlJsers AllUsers

ARPPRODUCTICON ARPPRODUCTICOMN, exe
DefaultUIFont Tahomad

DialogCaption InstallShield for Windows Installer
DiskPrompt [1]

Display _IsBitmapDlg 1

DisplayMameCuskarm 4IDS_ DisplayMame_Custom} Custom
DisplayMarmelinimal {IDS__ Displayhame_Minimal: Minimal
DisplayMameTypical {1D5_ DisplayMame_Typical} Typical
DAWLISINTER VAL 30

CWIISLIME CEABSOEFOESED 7 AFCOACEFFDESC 7 SFSE4BCFSFCESBFOAFCEFET 753A9FEF7FE
ErrorDialog SetupError

InstallChoice AR

IMSTALLLEVEL 100

15_COMPLUS_PROGRESSTERT_Ct {IDS_COMPLUS_PROGRESSTERT_COSTH Costing COM+ application: [1]
15_COMPLUS_PROGRESSTERT_IN {ID5_COMPLUS_PROGRESSTERT_INSTALL} Instaling COM+ application: [1]
15_COMPLUS_PROGRESSTEXT_UN {ID5_COMPLUS_PROGRESSTEXT_UMINSTALL} Uninstalling COM+ application: [1]
I5_PREVENT _DOWNGRADE_EXIT {IDS_PREYEMT_DOWMNGRADE_EXITH A newer wersion of this application is already

T RReRAES LN TR TR AR LmRAES LA e TR o L - Gl

Property Manager

The Property Manager allows you to set project-wide Windows Installer properties. These properties
can be used throughout vour setup project, but need to be changed in only one location.

To create a property, right-click in the Property Manager grid, select New Property, and enter the
property narme, value, and optional corrment. Ta edit an existing property, double-click its value and
type in a new value,

See the help topics under Property Manager in the Help Library for more information.

Ready

[ )

You can also optionally set Shallow Folder Structure to Yes in the Releases view under Media.
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|=~| My Project Mame-3 - InstallShield 2008 Professional - AdminStudio Edition [Basic MSI Project]

File Edit Wiew Go Project Build Tools Window Help

Do W Do+ 4« & I, ! |s=
StartPage ] Project Assistant I Installation Desigrer 'I Citriz: Assistant ] Thinstall Assistant Releases ‘ I
(=5 Installation Infarmation ) I?g_,leases Build | Setup.exe | Signing | JMET/J# | Internet | Postbuild
General Information |2 Product Configuration 1
I Release 1 se
i Update Motifications =" Release 1 = T TS
- -
Trishware 23 Disk Image{s) elease Location rojectDataFolder
1) Organization ) Loas =
=) Application Data ) Reports Compression Uncompressed
+-{5) System Canfiguration Yalidations
‘!:l b § : X =] File Marme Format Long File Mames
[ Server Configuration
= . X Data Languages Language Independent
() Behavior and Logic = -
p- UI Languages English {United States)
[=-i5) User Interface : -
47 Diclogs Default Language English (Urited States)
= g:l Media I(_jant.gu.agess. Dialog mo
Path Yariables pHmize size 0
3 Previous Package
¥y Upgrades :
AR Generate File Hash Yalues ‘es
Shallovs Folder struckure

Patch Design
=T Additional Tools - 2
3| Dependency Scanners clease Flags
Q D . Use Path Yariable Test Yalues Mo
%= MSI Debugger

ﬂ Direct Editar keep Unused Directories Mo ﬂ

Puim bl Tuiohinen Build [

Generate Autorun.inf {]

Shallow folder structure

If you want InstallShield to create the .msi file and related files directly in
the location that is specified in the Release Location setting, without any
of the subfolders, select ves.

To build the release if the release location is in
<ISProjectDataFolder= or «ISProjectFolder=, click Build Tables &
Refresh Files on the Build menu.

| ~
v

Ready [ ]

5. After making all required changes, save the project as an InstallShield Editor Template (.1ist) type.

Save As

Savein: | [ InstallShield 2008 Frojects v| D F EF M-

ICiMy Project Mame-2

File: name: | My Template M amne-3.ist | [ Save l

Save ag type: |Install5hield Template [".ist] v| [ Cancel ]

[[] Create 'Project Mame' subfalder and save the project in the created folder

Create and aszign a new project GUID to the saved project

Update the project settings appropriately based on the new project name
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6. This new template should now be available along with other project types in the InstallShield Editor.

New Project |’§|

windows Installer | Mabile | Al Types |

These are all the project types available and any custom templates,

§] © @ ml m a] °

Merge Module  QuickPatch  Web Project  MSI Database MSM Database  Transform
Project Project

=

X X 2
Wisual Basic  Wisual Basic L MET Wisual C++  Smark Device My Template-3
6.0 Wizard  NET Wizard Wizard JMET Wizard  Setup Wizard

E3]

This project bype uses only the Windows Installer service to drive the entire installation, ’—
o
a0

Project Mame:

| My Project Mame-4

Location:
| C:\Installshield 2009 Projects v| [ Browse. .. ]

[ create praject file in 'Project Name' subfolder

I OK l [ Caniel ]

7. From within the Repackager interface, you can start using this customized template by selecting the Use a
customized template option in the Repackaged Output view, and selecting the InstallShield Editor
template that you just created.
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@ ilunes - Repackagern

File View Project Build Tools

BkH ¥«

Help

=% Captured Installation
Files and Folders
é Reqgistry Entries
[tFy Shortcuts
= Qg Repackaged Qutput
ﬁl Package Information
3 Advanced Settings

Repackaged

Editor Project:

“Windows Instal

AppV
ThinApp™
ciTRIX

Repackaged Output Options

Repackaged Dutput Tasks

Output Summary
C:\Packages\iTunes.ism C]

ler Package:  {not built)

Create a Windows Installer package (.msi) after creating the Editor project
Creake single compressed Jmsi file v

[ create an isolaked version of the Windaows Installer package

Run automated tests against the Windows Installer package

Create a Microsoft App-V package Learn More
Create a VMware ThinApp application Learn more
Create a Citrix Xendpp profile Learn more

() Use the default Editor template
(&) Use a customized template

Cr\InstallShield 2009 ProjectsiMy Template-3.ist

|Done

Repackager Interface Reference

546

This section describes each of the dialog boxes and Wizard panels that you might encounter when using the
Repackager interface. The help topics in this section are the same detailed documentation that is displayed when
you press the F1 key or click the Help button while working in a dialog box.

Repackager Interface
SmartScan Wizard

Setup Intent Wizard

Options.ini File

VMware Repackaging Wizard

Exclusions Editor Interface
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e Files Associated with Repackager
e Using InstallShield to Chain Multiple Windows Installer Packages Together

® Troubleshooting

Repackager Interface

From the Repackager Interface, you can:

e Open the Repackaging Wizard and repackage legacy setups.

e Open the Exclusions Editor and configure exclusions.

e Convert Novell ZENworks, Microsoft SMS, and WinINSTALL projects into Repackaging projects.
e Create a package exclusion list.

e Build a Repackager project into an InstallShield Editor project and Windows Installer package.

The Interface consists of several menus, a toolbar, the status bar, the output window, the View List, and several
associated views.

® Menus and the toolbar are discussed in the Menus and Toolbar topic.
e [ndividual views are covered in their respective help topics.

e The status bar, output window, and View List are described in the following table.
Table 8-4 * Repackager Interface Elements

Interface Element Description

Status Bar The status bar, which can be toggled from the View menu, displays information when
you hover over buttons in the toolbar.
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Table 8-4 » Repackager Interface Elements

Interface Element Description

View List The View List allows you to navigate to different views in the Repackager project. The
corresponding view is displayed when you select an item in the tree. You can also use
the Forward, Back, Navigate Up, and Navigate Down buttons in the View List.

The View List includes the following views:

e Captured Installation View

e Files and Folders View

® Registry Entries View

® Shortcuts View

e INI Files View

® Deleted Files View

® Deleted Registry Entries View
® Repackaged Output View

® Package Information View

e Advanced Settings View

Output Window When you open Repackager 3.x output, Novell ZENworks projects, Microsoft SMS
projects, WinINSTALL projects, or Wise installation projects in the Repackager
Interface, conversion information appears in the Output window. This window can be
toggled from the View menu.

Repackager Start Page

When you first launch Repackager, the Repackager Start Page opens.

This page gives you a brief overview of Repackager functionality and uses, and gives you links to launch the
Repackaging Wizard, convert a Windows Installer package to an application virtualization format, open an existing
Repackager project, convert a legacy setup to a Repackager project, upgrade a legacy Repackager file, and open
a recently accessed package.
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= Repackager

File View Project Build Tools Help

COkH| t+4 e 25 | ¥

Repackager

‘fou can use Repackager bo convert a legacy setup into @ Windows Installer package.
For more information, see About Repackaging,

. Capture an Installation Using Repackaging Wizard
Use the Repackaging Wizard to create a new Repackager project by capturing a non-windows-Installer setup,
‘fou can then build & Windows Installer package.

and

-, Convert a Windows Installer Package to an Application Virtualization Format

ar ant ‘ Use the Windows Installer Converker to convert a Windows Installer package into the Following Formats:
» Microsoft Application Yirtualization

» YWMware Thindpp Application

»  Citrix Profile For Cikrix XenApp

_ Open a Repackager Project
; (Oipen an existing Repackager project.

Re-open project: CiiPackagesiiTunes.irp

%  Convert a Legacy Project to a Repackager Project
u Convert the Following setup bvpes directly to Repackager projects:
» Microsoft SMS Projects
Movell ZEMNworks Projects
WinIMSTALL Projects
‘Wise Installation Projects

» Upgrade a Legacy Repackager File
& Upgrade a legacy Repackager file {*.inc) to a Repackager project,

Figure 8-3: Repackager Start Page
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